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 121 .................................................................................................. ترکیبات کلاس ها

 424 ....................................................................... (class nestingتودرتو کردن کلاس ها )

 404 ........................................................................................... کلاسی به عنوان فیلد

 141 ............................................................................. استفاده از کلاس به عنوان فیلد

 402 .......................................................................................... کلاس به عنوان یک نوع

 142 ........................................................................................ بازگرداندن شی از متد

 400 ................................................................................. ارسال کلاس به عنوان آرگومان

 442 .............................................................. بازگرداندن یک شی یا ارسال آن به عنوان آرگومان

 444 ............................................................... ارسال یک کلاس به عنوان آرگومان خود آن کلاس

 444 .......................................................................... بازگرداندن کلاسی از متد همان کلاس

 112 .............................................................................................. مقدمه ای بر شرطی ها

 Boolean............................................................................................ 440  متغیر های

 Boolean ................................................................................... 112تعریف متغیرهای 

 Boolean ................................................................................ 114بازیابی مقدار متغیر 

 Boolean ......................................................................................... 114ایجاد فیلد 
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 Boolean ....................................................................................... 111آرگومان های 

enumeration .................................................................................................. 444 

 enumeration .......................................................................................... 128ایجاد 

 enumeration .................................................................................. 122تعریف متغیر 

 enumeration ..................................................................... 122مقداردهی اولیه ی متغیر 

 enumeration ................................................................... 121، دسترسی به قابلیت رویت

enumeration 123 .......................................................................... به عنوان متغیر عضو 

 124 ..................................................................... به عنوان آرگومان enumerationارسال 

 enum ....................................................................... 121تعریف و استفاده از نوع داده ای 

 182 .............................................................................. از متد enumerationبرگرداندن 

 274 ................................................................................................ عملگرهای منطقی

 181 ........................................................................................................ مقدمه

 181 .............................................................................................. عملگر تساوی ==

 Not ............................................................................................. 182عملگر منطقی 

 184 ................................................................................................ > کوچکتر از : 

 184 ....................................................................................... =>کوچکتر یا مساوی : 

 181 ................................................................................................... <بزرگتر از: 

 181 ........................................................................................... =<بزرگتر  یا مساوی 

 122 .................................................................................................... دستورات شرطی

 202 ........................................................................................ چنانچه شرطی درست بود

 122 ............................................................................................. عبارت های شرطی

 if .................................................................................................. 122ایجاد شرط 

 if ....................................................................................... 202به کاربردن شرط ساده ی 

if...else ........................................................................................................ 204 

 if...else .................................................................................... 118استفاده از شرط 

 if...else ......................................................................................... 113عملگر های 

if...else if  وif...else ...................................................................................... 111 

 Switch ......................................................................................... 112دستورهای شرطی 
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 Case switch ................................................................................... 220 ساختار شرطی 

 switch ........................................................................................ 220 دستورات شرطی 

Case 240 .............................................................................................. های ترکیبی 

 Enumeration ..................................................................................... 244استفاده از 

 AND ............................................................................................. 244 عطف منطقی 

 133 ....................................................................................................... مقدمه

 or : ................................................................................................ 220 فصل منطقی

 124 ........................................................................................................ مقدمه

 148 ............................................................................................. فصل های ترکیبی

 148 ............................................................................................ نحوه ی شمارش در حلقه

 207 ............................................................................................. تارار/ حلقه ی شرطی

 148 ........................................................................................... معرفی تکرار شرطی

 While ................................................................................................. 204حلقه ی 

 while ........................................................................................... 143به کاربردن 

 do...while ............................................................................................. 200 دستور 

 204 .................................................................................................. شمارش و تارار

 247 ........................................................................................ مدیریت دستورات شرطی

For .......................................................................................................... 118 

 112 ................................................................................... تودرتو کردن دستور شرطی

 111 ......................................................................................... تودرتو کردن شرط ها

 244 .............................................................................................. قفل کردن تراکنش

 111 .................................................................................... نحوه ی قفل کردن تراکنش

 242 .............................................................................. ایجاد وقفه در جریان دستور شرطی

break;  ...................................................................................................... 112 

 247 ......................................................................................... ادامه دادن دستور شرطی

continue; .................................................................................................... 118 

 240 ........................................................................................... اصلاح مقداری در حلقه

 244 ........................................................................................ رفتن به لیبل تعیین شده
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 111 ............................................................................................. رفتن به یک لیبل

 112........................................................................................... متدها و دستورات شرط ها

 242 ..................................................................................... مقداری را از متد بازگرداندن

 240 ................................................................................................. متدها و شرط ها

 422 .................................................................................................. بازگشت شرطی

 322 .......................................................................... بازگرداندن مقداری به صورت شرطی

While (true) .................................................................................................. 420 

 while (true) ..................................................................................... 321استفاده از 

 381 ............................................................................................................ بازگشت

 474 .................................................................................................. معرفی بازگشت

 474 .............................................................................................. ایجاد متد بازگشتی

 383 ........................................................................................... ایجاد متد بازگشتی

 382................................................................................... استفاده از متدهای بازگشتی

 384 ................................................................................. به کاربردن متدهای بازگشتی
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 مقدمه

 حضرت علی)ع(زکات علم نشر آن است. 

تخصصین مجرب در زمینه برنامه نویسی در نظر دارد،مطالب آموزشی خود را در قالب کتاب موسسه آموزشی تحلیل داده ، با حضور جمعی از م

 اهای آموزشی و فیلم ، به صورت رایگان در دسترس عموم  قرار دهد تا حتی آن دسته از عزیزانی که بنا به دلایل مالی،مسافت جغرافیایی و ی

 ی آنها میسر نیست،از یادگیری بی بهره نمانند.نداشتن وقت کافی ، امکان شرکت در دوره های حضوری برا

علاوه بر این علاقه مندان می توانند ، با ثبت نام در انجمن سایت تحلیل داده،سوالات خود را مطرح نموده و مدرسین آموزشگاه و اعضای 

 انجمن در اسرع وقت،پاسخ های خود را، حتی الامکان به صورت فیلم، در دسترس عموم قرار دهند.

ح طا از کلیه فعالان در این زمینه دعوت می شود، در این حرکت جمعی در کنار ما باشند و با حضور فعال خود در انجمن،گام موثری در بهبود سلذ

 علمی جوانان کشور عزیزمان،ایران بردارند.

  http://www.tahlildadeh.comآدرس سایت : 

 :توجه 

 را کلیک کنید. اینجا نلود سورس کد  مثال های کتاب ،برای دا

 

  

http://www.tahlildadeh.com/
http://www.tahlildadeh.com/ArticleList/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D8%A8%D8%B1%D9%86%D8%A7%D9%85%D9%87-%D9%86%D9%88%DB%8C%D8%B3%DB%8C-%D9%85%D8%A7%DA%A9%D8%B1%D9%88%D8%B3%D8%A7%D9%81%D8%AA/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D8%AC%D8%A7%D9%85%D8%B9-Csharp
http://www.tahlildadeh.com/ArticleList/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D8%A8%D8%B1%D9%86%D8%A7%D9%85%D9%87-%D9%86%D9%88%DB%8C%D8%B3%DB%8C-%D9%85%D8%A7%DA%A9%D8%B1%D9%88%D8%B3%D8%A7%D9%81%D8%AA/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D8%AC%D8%A7%D9%85%D8%B9-Csharp
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 MS Visual Studio مقدمه ای بر 

 C# که سی شارپ تلفظ می شود، یک زبان برنامه نویسی برای دستور دادن به کامپیوتر می باشد. این دستورات را می توان از طریق برنامه ،

هم نوشت. شیوه ی دیگر برای نوشتن دستور، استفاده از محیط برنامه نویسی می باشد که با مجهز بودن به ابزار  NotePadی ساده ای مثل 

 گوناگون عملیات گوناگونی همچون کار با پروژه ها، ایجاد فایل های ضروری و توزیع برنامه ی کاربردی تکمیل شده را بسیار سهل و آسان می

 کند.

می باشد. چنانچه، هدف اصلی شما یادگیری این  C# ،Microsoft Visual Studioنویسی برای نوشتن دستورات محبوب ترین محیط برنامه 

 کمک بگیرید.  Microsoft Visual C# 2010 Expressزبان برنامه نویسی است، می توانید از 

استفاده کنید. برای  Microsoft Visual C# 2010 Expressیا  Microsoft Visual Studio 2010برای یادگیری این دروس، می توایند از 

 Visual Studio Express، کافی است به سایت مایکروسافت مراجعه کرده و روی لینک Microsoft Visual C# 2010 Expressدانلود 

 کلیک کنید.

 Microsoft Visual C# Expressراه اندازی 

 Start -> (All) Programs -> Microsoft، روی گزینه های زیر کلیک کنید : Visual C# 2010 Expressبه منظور راه اندازی برنامه ی 

Visual Studio 2010 Express -> Microsoft Visual C# 2010 Express 
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 The Microsoft Visual Studio  رابط )کاربری( 

 (main menuفهرست گزینه ی اصلی )

تقسیم  Editو  Fileمنوی اصلی را نشان می دهد که به دسته هایی همچون  Microsoft Visual Studioبالاترین قسمت رابط برنامه ی 

 شده. منو اصلی همان کارایی فهرست گزینه ی یک برنامه ی کاربردی ساده را دارد.

 (Toolbarsنوارابزارها )

 Standard)الا می آید، نوارابزار استاندارد . معمولاً، هنگامی که برنامه ب(toolbar)زیر )قسمت( منوی اصلی بخشی است به نام نوارابزار 

toolbar)  را به عنوان پیش فرض خود نمایش می دهد. تعدادی نوارابزار اضافه بر سازمان هم در نتیجه ی گزینه هایی که شما انتخاب می

 کنید یا عملیاتی که انجام می دهید نمای

 رعی(ش داده می شود. برای انجام این کار )دیدن نوارابزارهای ف
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 مورد نظر را انتخاب کنید. toolbarکلیک کرده، سپس  View -> Toolbarsروی  main menuدر بخش 

  toolbarیا هر  main menuروی 

 دلخواه دیگر راست کلیک کنید. فهرستی نمایان می شود که می توان در آن نوارابزار دلخواه را انتخاب کرد.

 

 کرد. می توان با اضافه کردن یک  (customize) را می توان مطابق میل تنظیم Microsoft Visual Studioفهرست ها و نوارابزارهای 

menu item به فهرست گزینه، آن را مطابق میل تنظیم کرد یا با اضافه کردن تنها یک دکمه به نوارابزار، آن را )سفارشی( تغییر داد. برای

را انتخاب کنید. می خواهیم آیتمی  customizeراست کلیک کرده، سپس گزینه ی ( toolbarیا  main menuشروع، روی هر گزینه ای )در 

 اضافه کنیم. Start buttonرا به سمت چپ  Start without debuggingبه نام 
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 برای این کار مراحل زیر را دنبال کنید.

 ( کلیک کنید. toolbarیا  main menu)در  customizeروی گزینه ی 

 کلیک کنید. Commands، روی تَبِ (dialog box) در پنجره ی محاوره

 کلیک کنید. Toolbars radio buttonروی 

 .Standard، آن نوارابزاری که میزبان دکمه ی مورد نظر خواهد بود را انتخاب کنید. برای مثال، نوارابزار Toolbars combo boxدر قسمت 

 Start / Continueن مثال، ، روی دکمه ی بعدی کلیک کنید. در ایControlsدر لیست 
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 کلیک کنید. Add Commandروی 

 Debug، دسته ای را انتخاب کنید که دکمه ی موردنظر شما را دارد. برای مثال، Categoriesدر لیست 

 باشد. می Start Without Debuggingانتخاب کنید. در این مثال، منظور  Commandsحال، آیتم منو یا دکمه ی مورد نظر را از لیست 
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 کلیک کنید. okسپس، روی گزینه ی 
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 کلیک کنید. closeاکنون می توانید روی گزینه ی 
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 ( the Start pageشروع ) صفحه 

Start page بدنه ی اصلی برنامه ی ،Microsoft Visual Studio/Microsoft Visual C# Express  محسوب می شود. هنگام بالا آمدن

رچسب دارد : به نام های ببخش سمت چپ برنامه دو  نام دارد. Start pageترین قسمت( مشاهده می کنید که برنامه، تبی را )در بالا

New Project...  وOpen Project... . آن دسته از پروژه هایی که قبلاً به وجود آمده و مورد استفاده قرار گرفته اند، تحتOpen Project 

در پس زمینه فعال است و توسط یک تب نشان  Start pageدر حال کار با پروژه ی خاصی هستید، به نمایش گذاشته می شوند. هنگامی که 

 Start pageداده می شود. برای مشاهده ی 

 کلیک کنید. Start page برچسبروی 

 را انتخاب کنید. View -> Start Page(، گزینه ی main menuسپس، )در 

 نحوه ی بازکردن و بستن پنجره

آمدن برنامه، تعدادی پنجره در اختیار شما قرار می گیرد. پنجره های مزبور مرتب مورد استفاده ی کاربران قرار می گیرند. چنانچه  پس از بالا

ه نپنجره ای مناسب کار شما نیست، می توانید به راحتی آن را از صفحه حذف کنید. برای بستن پنجره نیز همان طور که می دانید باید روی گزی

 آن کلیک کنید. closeی 

به نمایش گذاشته شده.بنابراین، می توانید پنجره ی دلخواه را از فهرست نام برده  View Menuتمامی پنجره های انتخابی در فهرست 

 انتخاب کنید.

 (auto-hideپنهان سازی پنجره به صورت خودکار )

جداگانه دارند. برخی از پنجره ها با تنها یک آیکون نشان داده می  هنگام کار با پروژه، از پنجره هایی استفاده می کنیم که هریک کاربردی

شوند و بدنه ی اصلی آن ها نمایش داده نمی شود. به منظور مشاهده چنین پنجره ای، کافی است مکان نمای موس را روی آن قرار دهید. این 

 کار پنجره ی مذکور را باز می کند.



 

27 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 

 می باشد. Auto hideای با سه دکمه پدیدار می شود. یکی از دکمه های نام برده ( title bar)پس از باز کردن پنجره، نوارعنوان 
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چنانچه پس از باز کردن پنجره متوجه شدید که دیگر به آن نیازی نیست، می توانید با برداشتن مکان نمای موس از روی آن، پنجره را محو 

گردد. اما، چنانچه مایلید پنجره ای )حتی پس از برداشتن مکان نمای موس از روی آن( باز  کنید. پنجره ی نام برده به حالت پیشین خود باز می

 کلیک کنید. Auto hideبماند باید روی دکمه ی 

 

به صورت پیش فرض، برنامه برخی از پنجره ها را در سمت چپ و برخی دیگر را در سمت راست صفحه قرار می دهد. همچنین، می توان آرایش 

پنجره کلیک کرده و آن را در جهت موقعیت مورد نظر ( title bar)پنجره ها را  مطابق میل تغییر داد. برای این منظور، روی نوارعنوان  و ترتیب

 خود بکشید. همان طور که در تصویر مشاهده می کنید، برنامه پنج موقعیت مختلف را به تصویر می کشد.
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 ط ویژوال استودیو(قرار دادن پنجره در کناره های برنامه )محی

 

، برای قرار دادن پنجره در کناره های برنامه، باید کلیک چپ را روی نوارعنوان پنجره نگه داشته و آن را به ناحیه ی موردنظر بکشید. حال

است یا چپ، مستطیلی آبی رنگ ظاهر می شود که ناحیه ی مورد نظر را نشان می دهد. برای قرار دادن پنجره در دورترین ناحیه ی سمت ر

 پنجره را در آن قسمت رها کنید. به مثال زیر توجه کنید.
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 یا
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 برای قرار دادن پنجره در بالاترین یا پایین ترین قسمت صفحه نیز مانند دستورالعمل ذکر شده عمل کنید.

 قرار دادن پنجره ای در بالا یا پایین پنجره ای دیگر

نجره ی جدید را در بالا یا پایین پنجره ی موجود قرار دهید. ابتدا، باید پنجره ای به عنوان پنجره ی برای داشتن دو پنجره در یک صفحه، باید پ

 مرجع یا اصلی داشته باشید،سپس پنجره ی دیگری را به پنجره ی موجود اضافه کنید.
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 به این تبدیل می شوید.
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 پنجره های شناور

با این وجود، می توان پنجره ای را روی پنجره های دیگر قرار داد. به چنین پنجره ای شناور  بیشتر پنجره ها در یک طرف صفحه قرار می گیرند.

 می گویند. برای این منظور، روی نوارعنوان پنجره کلیک چپ را نگه داشته و بکشید، سپس آن را در جایی وسط صفحه رها کنید. 

نمایی(. اگر روی این دکمه کلیک کنید، پنجره تمام صفحه نمایش را اشغال می )بزرگ Maximizeپنجره ی شناور گزینه ای دارد به نام دکمه ی 

 کند. این کار را می توانید با دوبار کلیک روی نوارعنوان نیز انجام دهید.
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نوان متصل کنید، باید روی نوارع /چنانچه پنجره ای شناور است و شما مایلید آن را در جای مشخصی از صفحه )مثلاً سمت راست( ضمیمه 

(title bar)  کلیک راست کرده و گزینه یDock .را انتخاب کنید 

 

را  Floatچناچه، پنجره ای به ناحیه ی خاصی از صفحه متصل است و می خواهید آن را شناور کنید، روی نوارعنوان کلیک راست کرده و گزینه ی 

 انتخاب کنید.



 

35 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 قرار دادن چند پنجره در یک ناحیه

فحه، چند پنجره را باهم گنجاند. ابتدا، پنجره ی پایه )اصلی( را بزرگ نمایی کرده و آن را به ناحیه ی مورد نظر متصل می توان در یک طرف ص

کنید. سپس، نوارعنوان پنجره را گرفته و آن را به سمت ناحیه ی مقصد بکشید، تا این که قسمت پایین پنجره ی اصلی دو بخش 

 . برجسته/پررنگ و غیر برجسته پیدا کند

 

 حال موس را رها کنید.
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 به منظور حذف پنجره، تب آن را بیرون بکشید. 
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برای قرار دادن پنجره در سمت راست یا چپ پنجره ی موجود، ابتدا پنجره ی فرعی را به محل پنجره ی اصلی )موجود( بکشید. سپس، کادر 

 ی سمت  چپ را انتخاب کنید.  (guiding box)راهنما 

 این



 

38 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 

 زیر در می آید.به صورت 
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 ( Tabbed Windowsپنجره های تب دار )

 نشان دهد. این کار را می توان به دو صورت انجام داد. Code editorمی توانید کاری کنید که پنجره تب خود را در بالاترین قسمت 

 رها کرد. Start pageمی توان پنجره را کشید و آن را روی تب 
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 را انتخاب کرد. Dock as Tabbed Documentک کرد و بعد گزینه ی می توان ابتدا راست کلی

 

 

 

  #C معرفی پروژه های



 

42 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

عنی ماز زبان برنامه نویسی برای دادن دستور انجام کار خاصی به کامپیوتر استفاده می شود. زبان برنامه نویسی مانند زبان محاوره از کلمات 

 که برای ساختن جملات و مفاهیم معنادار باید از آن قوانین پیروی کرد.دار، گرامر، فرمول ها و قوانین خاص تشکیل شده 

ا فزبان های برنامه نویسی متعددی وجود دارند. برخلاف زبان انسان ها، زبان های برنامه نویسی کامپیوتر بسته به اهداف یا نقش هایی که ای

 می کنند، طبقه بندی می شوند. 

اتی که دستور را از زبان برنامه نویسی دریافت می کنند. برخی زبان های برنامه نویسی برای بخش عبارتند از مجموعه قطع هاسخت افزار

)سخت افزاری( خاصی تعبیه شده اند و یا محیط خاصی را هدف دستورات خود قرار می دهند. چنین محیطی ، از سیستم عامل خاصی استفاده 

یگر )کامپیوتر( قابل انتقال نمی باشد. برخی زبان های برنامه نویسی هم بخش یا قطعه می کند که از یک وسیله )مثل موبایل( به وسیله ی د

 ی خاصی را هدف نمی گیرند. 

ی برخی زبان ها برای رفع یک مسئله ی خاص طراحی شده اند و توانایی انجام وظایف معمول )زبان های دیگر( را ندارند. برای مثال، زبان های

ه نشان دادن محتویات وب هستند و از آن ها نمی توان برای انجام محاسبات ریاضی و هندسی بهره گرفت. برخی وجود دارند که فقط قادر ب

( کار می کنند. تعدادی زبان برنامه نویسی هم داریم falseیا  trueخاصی مثل ) (value)برنامه ها طوری تعبیه شده اند که تنها با مقدارهای 

 د. که به حل تمام مسائل می پردازن

C#  از آن دسته زبان هایی است که علاوه بر اجرای دستورات، به حل مسائل نیز می پردازد. این زبان بر روی تمام سیستم عامل ها از جمله

 Microsoft.NET Frameworkبه کار می رود.  Microsoft.NET Frameworkاز جمله زبان هایی است که در  #Cویندوز قابل اجرا است. 

 از اشیاء است که به کمک آن می توان در کامپیوتر چیزهایی را به وجود آورد یا ترسیم کرد. کتابخانه ای

متشکل  #Cپروژه ی کامپیوتری عبارتند از گروهی فایل و شئ که دستورهای مورد نظر را برای انجام عملکرد های معین  تعبیه می کند. پروژه ی 

دربردارنده ی یک فایل است که تمام دستورات مورد نیاز  #Cارند. یک پروژه ی ساده ی از چند فایل است که دستورهای برنامه را دربرد

 حاوی بیش از یک فایل است.  #Cبرنامه را حمل می کند. این در حالی است که پروژه های ی پیشرفته 

 برنامه های کاربردی کنسول 

به کار می رود. برای طراحی چنین برنامه ای باید دستورات مورد  DOS به منظور طراحی و نوشتن برنامه های کاربردی #Cزبان برنامه نویسی 

 نوشت.  visual studioیا محیط برنامه نویسی مانند  Notepadنظر را در برنامه ی 
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 <- Start -> (All) Programs، دستورالعمل زیر را دنبال کنید : Microsoft Visual C# 2010 Expressبرای راه اندازی برنامه 

Microsoft Visual Studio 2010 Express -> Microsoft Visual C# 2010 Express 

 

 راه اندازی پروژه 

 را اجرا کنید. Microsoft Visual C# 2010 Expressبرنامه ی 

کلیک  ...File -> New Projectروی گزینه ی ( main menu)، در فهرست گزینه ی اصلی (app)به منظور ایجاد برنامه ی کاربردی جدید 

 کنید.

 را کلیک کنید. Console Applicationدر لیست وسطی نیز گزینه ی 

 تغییر دهید. gdcs1اسم مورد نظر را به 
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 کلیک کنید. okروی گزینه ی 

 ایجاد فایل برای کد مورد نظر

ا با زبان عادی ) مثلاً انگلیسی( و جملات هدف از نوشتن برنامه، دادن دستور )اجرای عملکرد خاص( به کامپیوتر است. البته، این برنامه ر

 معنی دار می نویسیم. به عبارت دیگر، یک دستور معمولی از متن ساده استفاده می کند ) که شامل حروف الفبا، ارقام و علامت های ناخوانا

 می باشد(.

و  Notepad ،Microsoft word ،wordpadاز قبیل ( text editor)می توان این دستورات را با کمک برنامه های ویرایشگر متن 

wordperfect  نیز نوشت. در برنامه نویسی، قوانین و دستور هایی وجود دارد که پیروی از آن ها الزامی است. به دستورات مزبور کد هم

 گفته می شود. 
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ر متنی وجود دارد که از آن با نام ویرایشگ، Microsoft Visual Studio Professionalو  Microsoft Visual C# Expressدر برنامه های 

code editor  یاد می شود. چناچه، پروژه ی خود را با فرمتconsole application  بنویسید، فایل پیش فرضی به وجود می آید که می توان

یک فایل به آن اضافه کنید. برای آغاز کنید، لازم است خود  خالیکرد. اما اگر برنامه ی خود را به عنوان پروژه ای  (customize)آن را تنظیم 

 این منظور دستورات زیر را انجام دهید.

Main menu  را باز کرده و روی گزینه هایProject -> Add New Item... .کلیک کنید 

دهید، قرار  Add، روی اسم پروژه ی مورد نظر راست کلیک کرده و مکان نمای موس را روی گزینه ی solution explorerحال، در قسمت 

 را انتخاب کنید. New Itemسپس 

کلیک کنید.  Code Fileرا نشان می دهد. حال، در لیست میانی، روی گزینه ی  Add new itemهریک از دستورهای مذکور، پنجره ی محاوره 

ی سیاهی نمایان می گردد. به ، پنجره okمی توانید اسم فایل مذکور را بپذیرید یا آن را مطابق میل تغییر دهید. پس از کلیک روی گزینه ی 

 همین شیوه، می توانید هر تعداد فایل که مایلید به پروژه اضافه کنید. 

 ایجاد فایل 

 Project -> Add Newمراجعه کرده و روی ( main menu)به منظور افزودن فایل جدید به کد مورد نظر، به فهرست گزینه ی اصلی 

Item... .کلیک کنید 

 کلیک کنید. code)در لیست سمت چپ( را بزرگ نمایی کرده و روی  #visual C، باید آیتم های visual studio در صورت استفاده از

 تغییر دهید. CleaningOrderاسم موردنظر را به 
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 را انتخاب کنید. Addاکنون، گزینه ی 

 #Cکد اصلی 

 بنویسید. کد مذکور به این صورت است.( basic)یک کد پایه ، کافی است تنها #Cبه منظور ایجاد ساده ترین نوع برنامه ی کاربردی 

 

    class Exercise 
    { 
        static void Main(string[] args) 
        { 
            System.Console.WriteLine("Hello world"); 
        } 
    } 
 

یک از آن ها مفصل پرداخته می شود.کد نام برده بخش های مختلفی دارد که در مباحث بعدی به هر   
 معرفی می شود. 3در درس  classکلید واژه ی 
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 تنها یک اسم است. درباره ی اسم ها و تمام قوانین مربوط به آن در درس بعدی بحث می کنیم. Exerciseواژه ی 

 معرفی می شوند. 1در درس }{ ، )(علامت های 

 بحث می شود. 82س در درstatic نحوه ی استفاده از کلیدواژه ی 

 توضیح داده می شود. 3درس  درvoid معنی کلیدواژه ی 

 Mainمفصل توضیح می دهیم. 22معرفی می کنیم و در درس  4در درس  را 

 تشریح می شود. 1درس  درsystem نقش واژه ی 

 تشریح می کنیم. 3را درس  "."نقش کاراکتر نقطه 

Console  و waterlineی شوند.توضیح داده م 2درس  در 

 تشریح می کنیم. 21معرفی می کنیم و مفصل در درس  1را در درس  )"(علامت 

به این کد را تا حد امکان ساده معرفی کرده ایم. تک تک کلمات و عملگرها در این کد وظیفه ی خاصی را انجام می دهد ولی می توان آن ها را 

 شیوه های مختلف به کاربرد.

 نوشتن کد اصلی 

 ر داکیومنت خالی بنویسید.کد زیر را د

    class Order 
    { 
        static void Main(string[] args) 
        { 
            System.Console.WriteLine("Georgetown Dry Cleaning Services"); 
            System.Console.ReadKey(); 
        } 

}     



 

48 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 توضیحات

 commentقرار دادن  /وجود دارد. برای نشان دادن  commentدو نوع  #Cکه جزء کد محسوب نمی گردد. در زبان خط یا پاراگرافی از متن 

آغاز کنید. هر چه در سمت راست این علامت قرار بگیرد، نادیده گرفته می شود. به مثال زیر  //در )خطی از( متن، خط مورد نظر را با علامت 

 توجه کنید.

e ignored. I can write in it anything I want// This line will b 

Comment  مذکور در تنها یک خط قابل استفاده است. می توانcomment  نیز آغاز کرد. این نوع  */را با علامتcomment  به علامت*/ 

را در چند خط )بیش از یک خط(  commentقرار گیرد، خوانده نمی شود. با این روش می توان،  /*و  */ختم می شود. هر چه بین این دو علامت 

، Standard toolbarدر خط، ابتدا روی خط مورد نظر کلیک کنید. حال، در )قسمت(  commentبه کار برد. به منظور قرار دادن )افزودن( 

ط های نام برده به خط های مجاور، روی متن خ commentرا انتخاب کنید. برای افزودن  Comment Out the Selected Linesگزینه ی 

ها، ابتدا روی متن  commentکلیک کنید. به منظور حذف  Comment Out the Selected Linesراست کلیک کرده، سپس روی گزینه ی  

 انتخاب کنید. Standard toolbarرا از  Uncomment the Selected Linesآن کلیک کنید. سپس، گزینه ی 

 توضیحاتایجاد 

 ، فایل مورد نظر را به صورت زیر تغییر دهید.commentبه منظور ایجاد 

//  Application Name: Georgetown Dry Cleaning Services 
    class Order 
    { 
        //  This application is used to perform processing orders for this business 
        static void Main(string[] args) 
        { 
            /* Always greet the customers before processing an order. 
           Check the types of clothes a customer has brought. 
           Find out the type of cleaning (starch، etc) the customer wants. 
           If there are special needs the customer has، make a note. */ 
            System.Console.WriteLine("Georgetown Dry Cleaning Services"); 
            System.Console.ReadKey();        
        } 
    } 
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 مدیریت فایل ها

وژه هایی که متشکل از چند فایل هستند، با ، پرMicrosoft Visual Studioو  Microsoft Visual C# 2010 Expressدر برنامه های 

 ( نمایش داده می شوند.code editorورچسب های معینی )واقع در قسمت بالای 

 ویندوز نیز قابل مشاهده است. main menuفایل های نام برده در 

 Solution Explorerپنجره 

Solution explorer  ه ی پروژه را به نمایش می گذارد.  برای دسترسی به پنجره ی پنجره ای است که فهرستی از فایل های تشکیل دهند

 در صفحه ی مانیتور نمایان نیست. Solution explorerچنانچه،  مزبور

 کلیک کنید. View -> Solution Explorerمراجعه کرده، سپس روی گزینه ی  main menuبه 

Standard toolbar  را باز کرده، و گزینه یSolution Explorer .را انتخاب کنید 

 در صفحه قابل رویت است، روی تبِ آن کلیک کنید. Solution Explorerچنانچه، 

که در سمت چپ آن سه گزینه ( title bar)این پنجره از چهار جز شکیل می شود. درست مانند پنجره های دیگر، بخشی دارد به نام نوارتیتر 

 وجود دارد.

 

 ، فهرستی پدیدار می گردد.(window position)با کلیک روی دکمه ی موقعیت پنجره 

http://articles.tahlildadeh.com/image.axd?picture=image_721.png
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فعال می باشد. چنانچه پنجره از قبل در حالت شناور قرار دارد،  floatدر صورتی که پنجره ی موردنظر به کناره ی صفحه متصل باشد، گزینه ی 

ه( شناور می شود. پی در پی، می توانید با پنجره ی )متصل به کناره ی صفح floatفعال نمی باشد. پس از کلیک روی گزینه ی  floatگزینه ی 

 خارج کنید. (docked) به وسط صفحه، آن را از حالت متصل titlebarگرفتن و کشیدن 

 

  

 (toolbar)، فهرستی وجود دارد که به آن نوارابزار (titlebar)را بکشید. زیر سرتیتر  titlebarبه منظور متصل کردن پنجره به کناره ی صفحه، 

 دمی گوین

 

 Propertiesگزینه ی 

 را نمایش می دهد.( hidden)؛ تمام فایل های مخفی show all filesگزینه ی 

 می کند.( refresh) ، فهرست منابع و فایل ها را باز سازیrefreshدکمه ی 

 ، برای نمایش کد یک کلاس به کار می رود.view codeدکمه ی 

ن است که در آن فایل ها، فولدرها و منابع تشکیل دهنده ی پروژه به نمایش گذاشته می بدنه ی اصلی آ solution explorerسومین بخش 

، روی اسم آن دوبار کلیک کنید ) یا روی دکمه ی آن کلیک کنید(. برای کوچک کردن گره، روی آن دوبار (node)شود. به منظور بزرگنمایی گره 

 کلیک کنید.

http://articles.tahlildadeh.com/image.axd?picture=image_722.png
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دارای چند پروژه  solution، اسم پروژه ی جاری قرار دارد. در صورتی که، rootاست. زیر  solutionلیست، در واقع اسم ( root)ریشه ی 

نمایش داده می شود. درون پروژه ها : فایل ها، فولدرها و منابع  وجود دارد. اولین آیتم زیر اسم  solutionباشد، اسم هر یک از پروژه ها زیر 

 )ارجاعات(، با اسم کلاس ها )ی تشکیل دهنده ی پروژه( مواجه می شویم. Referencesاست. پس از گره  Referencesپروژه 

 می باشد.( tab)تب  solution explorerچهارمین جز 

Properties Windows 

 آن، تمام جزئیات  فایل ها و منابع سیستم عامل ویندوز که در پروژه به کار برده شده را نمایش می دهد. برای نمایش propertiesپنجره ی 

 کلیک کنید. View -> Properties windowمراجعه کرده سپس روی  main menuبه  ،باشدنمایان ن Propertiesچنانچه، پنجره ی 

Standard toolbar  را باز کرده، گزینه یProperties .را انتخاب کنید 

 ید.، در صفحه ی نمایش قابل رویت است، روی تب آن کلیک کنPropertiesحال، اگر پنجره ی 

 (، روی شی دلخواه کلیک کنید.solution explorerبه منظور مشاهده ی ویژگی های سیستم عامل پروژه یا فایل موردنظر)در 

را انتخاب  projectچنانچه، گزینه ی . اسم و مسیر )مکان قرارگیری فایل( آن را نمایش می دهد Properties، پنجره ی solutionبا کلیک روی 

 فایل های پروژه ی موردنظر را نشان می دهد Propertiesکنید، پنجره ی 

 اسم و مسیر فایل نام برده را به نمایش می گذارد. Propertiesاگر روی فایل کلیک کنید، پنجره ی 

خی مختلفی را نشان می دهد. می توان بر (field)( قسمت های solution explorerبسته به آیتم انتخابی شما )در  Propertiesپنجره ی 

ای غیر فعال شود، بدین معنا است که دیگر نمی توان آن را  (field)دستکاری کرد. چنانچه، قسمت  Propertiesتنظیمات را در پنجره ی 

 اصلاح کرد.

 دسترسی به فایل و باز کردن آن

را با آن باز کنید، ابتدا لازم  #cیل . چناچه سعی دارید فاopen file، بخشی وجود دارد به نام Notepadدر برنامه های ویرایش گر متن مثل 

 کلیک کنید. openتغییر دهید. سپس، محل قرارگیری فایل را پیدا کرده و روی  (*) All files، نوع فایل را به combo boxاست که در 

 چنانچه فایل مذکور عضوی از پروژه جاری است برای باز کردن آن مراحل زیر را دنبال کنید.
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 و اسم فایل موردنظر کلیک کنید. Windowعه کرده، روی مراج main menuبه 

 ، روی برچسب حاوی اسم فایل کلیک کنید.code editorدر 

 ، روی اسم فایل دو بار کلیک کنید.solution explorerدر 

، روی main menuدر  ،  برای باز کردن فایلMicrosoft Visual Studioو  Microsoft Visual C# 2010 Expressدر صورت استفاده از 

 کلیک کنید. Open Fileمراجعه کرده و روی  Standard toolbarکلیک کنید یا به  ...click File -> Open Fileگزینه های 

 visual studioظاهر می گردد. حال، فایل را از فولدر مرتبط پیدا کرده و روی آن کلیک کنید. اگر  open fileدر نتیجه ی هریک از عملیات بالا 

خود نمایش می دهد. ولی اگر نتواند آن را باز کند، در کامپیوتر به دنبال  (interface) مکانات باز کردن فایل را داشته باشد آن را داخل رابطا

امه ی باز کنید، برن visual studioبرنامه ای که قادر به باز کردن فایل مزبور است می گردد. برای مثال، اگر سعی کنید فایل ویدئویی را با 

windows media player  .به کمک شما می آید و فایل را باز می کند 

 و پروژه solutionمدیریت  

می توان برنامه های کاربردی  visual studioمطالبی گفته شد. به کمک ( console app)درباره ی نحوه ی ایجاد برنامه ی کاربردی کنسول 

 را باز کنید. New Projectتدابرای انتخاب گزینه دلخواه پنجره ی محاوره ی متفاوتی ایجاد کرد. به همین دلیل، باید اب

Code Snippet 

visual studio  دارایskeleton code  های فراوانی است که می توان تنظیم کرد(customize ) و به کار برد. کد اصلی(primary code) 

عملیات بالا را انجام  skeleton codeر را به آن اضافه می کند. پس از این که را برای شما می نویسد و تمام رفتار های پیش فرض مورد نظ

های نام برده، روی قسمتی از فایل که  skeleton codeداد، می توانید هر بخشی را مایلید حذف کرده یا تغییر دهید. به منظور دسترسی به 

 را انتخاب کنید. insert snippetسپس گزینه ی  را اضافه کنید راست کلیک کرده،( skeleton code)می خواهید آن 
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 کلیک کنید. #visual cدر فهرستی که نمایان می گردد، روی  

 

 این کار لیستی از کدهای موجود را به نمایش می گذارد. 

http://articles.tahlildadeh.com/image.axd?picture=image_724.png
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 روی کد دلخواه دوبار کلیک کنید. 

 skeletonگروهی  code editorیا کدهای دیگری به آن اضافه کنید، چنانچه، از قبل تعدادی کد نوشته اید و مایلید که آن ها را اصلاح کنید 

code  در اختیار شما قرار می دهد. برای این منظور، روی کد دلخواه )کدی که می خواهید اصلاح کنید( راست کلیک کرده، سپس گزینه ی

surround with  شما در آن درج شده.را انتخاب کنید. اکنون، لیستی پدیدار می شود که گزینه ی موردنظر 

 رنگ کدها

کدها به صورت اساسی در محیطی گسترده با پس زمینه ای سفید نوشته می شوند. در این محیط است که شما با استفاده از صفحه کلید، کد 

های مختلف استفاده می به منظور تمیز دادن خط ها و کلمات متن از رنگ  code editorموردنظر را با کاراترهای خوانا و معمول درج می کنید. 

 کند. 

را انتخاب کنید. در پنجره ی   ..Tools -> Optionsرا باز کرده و گزینه ی  main menuبرای این منظور،   می توان این رنگ ها را تنظیم کرد.

options قسمت ،Environment روی گزینه ی ،fonts and colors  کلیک کنید. برای تنظیم رنگ دسته(category)  موردنظر، در قسمت ی

http://articles.tahlildadeh.com/image.axd?picture=image_726.png
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Display Items دسته ی دلخواه را انتخاب کنید. حال، می توانید رنگ انتخابی را در لیست پایین افتادنی ،item foreground  .تنظیم کنید

 مراجعه کنید.  item backgroundچنانچه مایلید پس زمینه ی کلمات دسته ی مورد نظر رنگی شود، به قسمت 

 

 customرست ثابتی از رنگ های معین پدیدار می شود. اگر مایلید رنگ جدیدی به این لیست اضافه شود، روی دکمه ی در هر دومورد، فه 

 نمایش داده می شود که می توان در آن رنگ دلخواه را به وجود آورده و اضافه کرد. colorکلیک کنید. حال، پنجره ی محاوره 

 (Indentationتوگذاری )

در واقع به گروه بندی  indentationاست. ( indentation)خوانایی هر چه بیشتر برنامه ی شما کمک می کند توگذاری  ویژه گی دیگر که به

کدها، باید آن ها را به اندازه ی دو جای ( delimit)خط های کد مورد نظر بر مبنای دسته ی مرتبط  گفته می شود. به منظور تعیین حد و مرز 

باید مراتب افزایشی داشته باشد. به عبارت دیگر، خطی که زیر مجموعه ی خط  (indentation)بگذارید. توگذاری  تو (tab)خالی یا یک تبَ 

 دیگری است، باید بیشتر تو گذاشته شود.

از را ب #Cکلیک کنید. در لیست سمت چپ،  ...Tools -> Optionsرا باز کرده و روی گزینه ی  main menuکد،  indentationبرای مدیریت 

 کلیک کنید. حال، می توان گزینه های سمت راست را تنظیم کرد. indentation، روی Formattingکرده و بعد از بزرگ نمایی گزینه ی 

http://articles.tahlildadeh.com/image.axd?picture=image_727.png


 

56 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 

 کلیک کنید. okپس از ایجاد تغییرات مورد نظر، روی گزینه ی  

 ذخیره سازی پروژه

یجاد می کنید، باید فایل های آن را در فولدری ذخیره کنید. در نسخه های قبلی )ویرایش گر متن( ا text editorاگر برنامه ی دلخواه خود را با 

visual studio (2221  کاربر مجبور بود خود به صورت رسمی یک پروژه ایجاد کند و بعد آن را ذخیره کند. بعد ها مایکروسافت 2222و ،)

د، جنبه ی آزمایشی دارد. بنابراین، امکان جدیدی به برنامه اضافه کرد که دریافت که خیلی از پروژه هایی که برنامه نویسان به وجود می اورن

کند یا نه. این کار، پروژه را در رسانه ی داده  saveبه کاربر اجازه می دهد یک پروژه به صورت موقت ایجاد کند و تصمیم بگیرد که آن را 

 ز آن استفاده کند.ذخیره می کند و کاربر می تواند بعد ه ها به آن مراجعه کرده و ا

به وجود می آید. فولدر  Visual Studio 2010فولدری به نام  Documents، در visual studio 2010پس از طی کردن تمام مراحل نصب 

doctments را با نام های دایرکتوری شخصی (personal derictory)  یاpersonal drive   نیز می شناسند. در فولدرVisual Studio 

2010 ،subfolder  دیگری بهprojects .به وجود می آید. در این دایرکتوری است که پروژه های شما به صورت پیش فرض ذخیره می شوند 
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 mainکلیک کنید. پی در پی، می توانید  Save allمراجعه کرده، و روی دکمه ی  Standard toolbarبه  منظور ذخیره سازی پروژه، به 

menu ینه ی را باز کرده و گزFile -> Save All  را انتخاب کنید. چناچه، پروژه، قبلاً ذخیره شده ولی می خواهید آن را تحت اسم دیگری ذخیره

 ...File -> Save project name Asکنید باید این دستور را دنبال کنید : 

 بازکردن پروژه

 شیوه های مختلف بازکردن پروژه، در زیر فهرست شده

 Main menu ->File-> Open project 

 Start -> Open project 

 Ctrl + Shift + O 

Solution 

Solution  به منظور هماهنگ سازی )ایجاد هماهنگی بین( بخش/جنبه های مختلف یک برنامه(app ) به کار می رود.هر پروژه، تنها یک بخش

 لازم است آیتم های دیگری نیز به برنامه اضافه کنید.از برنامه ی کاربردی مورد نظر را تشکیل می دهد. علاوه بر کدی که می نویسید، 

 مشاهده کنید. solution explorerیکسان می باشد. می توانید اسامی آن ها را در  solutionتوجه داشته باشید که اسم پروژه و 
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 Solution  و پروژه ممکن است اسامی متفاوت داشته باشند.به منظور تغییر اسمsolution در( ،solution explorer روی اولین گره ،)

(node)  ،در پنجره ی (کلیک کنید. سپسProperties روی ،)Name .کلیک کرده و اسم دلخواه را وارد کنید 

 

  

را به صورت دائم ذخیره کنید، دو روش پیش روی شما  solutionلازم به ذکر است که اسم مزبور به طور کامل موقتی است. اگر می خواهید 

 ارد.وجود د

 Microsoftپدیدار می گردد. به صورت پیش فرض،  Save Projectرا برای اولین بار ذخیره می کنید، پنجره ی  solutionدر صورتی که 

Visual Studio ، دایرکتوری شخصی شما را به عنوان مسیر ذخیره سازی فایل انتخاب می کند. به این مسیرlocation  می گویند. در

location نام برده ،Microsoft Visual Studio  فولدری به وجود می آورد به عنوانsolution  ،پروژه مورد نظر. حالsolution  باید در فولدر

نیز استفاده می  solutionاز اسم پروژه برای  Microsoft Visual Studioمختص به خود قرار گیرد. همان طور که پیش توضیح دادیم، 
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تغییر دهید. به خاطر داشته باشید  Solution Name( textbox)را در کادر متن ( string) اد، می توانید رشتهکند.برای جلوگیری از این رخد

 وارد کنید. به مثال زیر توجه کنید. Nameکه اسم دلخواه را باید در کادرمتن 

 

 Myفرض فولدری برای آن در مسیر به صورت پیش  #Microsoft Visual Cزمانی که )برای اولین ( پروژه ای را ذخیره می کنید،  

Documents\Visual Studio 2008\Projects folder  به وجود می آورد. هم چنین از اسمsolution  برای نام گذاری فولدر استفاده می

 solution ،subfolderکند. تعدادی فایل جدید ایجاد کرده و آن ها را در فولدر تازه به وجود آمده ذخیره می کند. سپس، داخل فولدر 

به وجود می  debugاست(، فولدر دیگری به نام  Project)ای که اسم آن  subfolderجدیدی با نام پروژه ی مورد نظر ایجاد می کند. جدا از 

 اسم پروژه به وجود می آورد. subfolder، در Debugآید. همچنین فولدر دیگری به اسم 

- Fileمراجعه کرده و روی  main menuرا عوض کنید، به  solutionباشد، ولی مایلید که اسم  چناچه، پروژه ی مورد نظر از قبل ذخیره شده

> Save solution-name.sln As..  کلیک کنید. این کار منجر به بالا آمدن کادرSave as  می شود که در آن اسمsolution  آماده ی تغییر

 و ذخیره سازی است.

 ساختن پروژه

بپردازید. این کار یک فایل اجرایی ( app)نوشتن کد، برای مشاهده ی نتیجه، ابتدا باید به ساختن برنامه  پس از ایجاد پروژه و

(executable ).خلق می کند 

 compiler)مترجم( را در اختیار کاربر قرار می دهد.  compiler، به منظور برنامه نویسی )ساختن برنامه ی جدید( امکانی به نام #Cزبان 

های داخلی متعدد دیگری تشکیل شده. اولین و مهم ترین این زیربرنامه ( subprogram)ه ی کامپیوتری است که خود از زیربرنامه یک برنام

اسکن یا پوییدن فایلی است که )خود بخشی از( برنامه را دربردارد. دستور  parserتجزیه کننده( خوانده می شود. وظیفه ی  (parserها 

در جستجو ی خود مشکل یا خطایی را  parserبررسی می شوند. اگر  parserواژه ها و تمامی کلمات ناشناس توسط ، کلید(syntax) نحوی

پیدا کند، یا همان جا متوقف می شود و یا لیستی از تمام مشکلاتی که به آن ها برخورده تهیه می کند، سپس لیست مذکور را برای شما به 
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اشاره می کند )تنها شما را به خطی ارجاع می دهد( که مشکل در آن یافت شده و گاهی نیز به خطی نمایش می گذارد. گاهی تنها به خطی 

ارجاع می دهد که مشکل اثر خودش را در آن جا نشان داده ولی خود مشکل در جای دیگری یافت می شود. البته، نحوه ی حل مشکلات فوق را 

 با تجربه یاد می گیرد. 

نتایج بدست  (parser)با مشکلی مواجه نشد )یا پس از اینکه مشکل مزبور را برطرف کردید(، برنامه ی نام برده در اسکن خود  parserاگر 

کلیه ی فایل های برنامه را  linkerرا فرا می خواند.  linkerبرنامه ی دیگری به نام  compilerارسال می کند. حال،  compilerآمده را به 

)تنها آن C# compiler تعدادی از فایل های ارسال شده توسط  linkerته باشد چه چند فایل (. سپس، بررسی می کند )چه یک فایل داش

فراهم می کند( را با فایل  Net Framework.دسته فایل هایی که برنامه برای فعالیت، نیاز مبرم به آن ها دارد و نه کلیه ی فایل ها یی که 

رست دریافت کند و نتایج دلخواه شما را ارائه دهد. در صورتی که مشکل جدی ای وجود نداشته های شما ادغام کرده تا دستورات شما را د

برنامه ی مورد نظر را می سازد. به خاطر داشته باشید که این بدین معنا نیست که اصلاً هیچ مشکلی وجود ندارد، بلکه  compilerباشد، 

compiler  دارد که نتیجه ی حاصل مورد دلخواه شما نباشد.مشکلی پیدا نکرده و هنوز احتمال این وجود 

 compilerهمه گی زیر مجموعه ی برنامه ی بزرگتری به نام  (linker ،parser ،debugger)باید در نظر داشته باشید که تمام برنامه های بالا 

 به زبان کامپیوتر ترجمه می کند. به عنوان برنامه ای یاد می شود که زبان )انگلیسی( را compilerهستند. از این به بعد، از 

Compiler  ای که برنامه یMicrosoft.NET Framework  ارائه می دهدcsc  ،گفته می شود. مشابه خیلی از برنامه های دیگر 

compiler پسوند.exe  .را داردCsc  اسم استانداردی برایcompiler  نمی باشد. به این معنا کهC# compiler : اسم دیگری دارد 

csc.exe  اسمcompiler .ای است که ما استفاده می کنیم 

 NET.استفاده می کنیم. پس از دانلود  csc.exe compilerاز (، command prompt)به منظور نوشتن برنامه از طریق پنجره ی فرمان 

Framework  نظر ما از سایت رسمی مایکروسافت، باید آن را روی رایانه ی خود نصب کنید. برنامه ی موردcsc.exe  است. مسیر نصب این

 می باشد. C:\Windows\Microsoft.NET\Framework\v4.0.21006برنامه به صورت پیش فرض 

کمک  windows explorerاضافه کنید. برای شروع،می توان از ابزاری همچون  Environment Variablesرا به مسیر  csc.exeباید مسیر 

 نصب شده نمایش دهید.  cscر جایی که گرفته و فولدر مورد نظر را د

را باز کرده و روی  control panelکپی کنید. پنجره ی  clipboardانتخاب کرده و آن را در قسمت  combo boxمسیر مورد نظر را از بالاترین 

 کلیک کنید. system and securityآیکون 
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 کنید. کلیک system، روی گزینه ی system and securityحال، در قسمت 

را باز کرده و روی  Advancedرا انتخاب کنید. اکنون، تب  change setting، گزینه ی systemپس از نمایان شدن پنجره ی 

Environment Variables .کلیک کنید 

  

 

 .را انتخاب کنید Editدو بار کلیک کنید، یا یک بار روی آن کلیک کرده سپس  Path، روی System Variablesدر بخش  
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کپی کرده بودید را در این قسمت پیاده  clipboardای را که از  (value)را تایپ کنید. حال، مقدار  ";"را فشار داده، علامت  Endدکمه ی  

 .(paste)کنید 
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 کلیک کنید. okسه بار روی  

 Enterرا تایپ کرده و دکمه ی \CD ، (root drive)را باز کنید. حال، برای وارد شدن به درایو اصلی  (command prompt)پنجره ی فرمان 

( هایی که فایل در آن قرار دارد را در subfolderرا فشار دهید و به دنبال آن فولدر )یا  spaceرا تایپ کرده و دکمه ی  \CDرا فشار دهید. 

اسم فایل و پسوندش )با تایپ  به دنبال راcsc ، (compile)را فشار دهید. برای ترجمه  Enterاین قسمت درج کنید. سپس دکمه ی 

 کردن( وارد کنید.

را دارد. به صورت پیش فرض، اسم این فایل با فایلی که ابتدای کار استفاده  exe.فایلی که در نتیجه ی این عملیات تولید می شود پسوند 

را تایپ کرده و به دنبال آن اسم :csc ، /outر ای با نام دلخواه، پس از کاراکت (executable)کردید یکی است. برای دریافت برنامه ی اجرایی 

، اسم فایلی که ابتدای کار ایجاد کرده بودید به همراه پسوند آن را وارد کنید. فرمول بالا (space)، فاصله exe.دلخواه، به علاوه ی پسوند 

 csc /out:NameOfExecutate.exe Filename.csبه این شکل است: 

NameOfExecutate م دلخواه نشانگر اسexecutable  شما می باشد.چنانچه اسم مورد نظر تنها یک کلمه است، می توانید به راحتی آن را

 قرار دهید. "تایپ کنید. ولی اگر اسم متشکل از چند کلمه است، باید آن را داخل علامت 

ی که ایجاد کرده اید زیاد است، باید هنگام انجام فرایند استفاده می کنید و تعداد فایل های text editorاگر برای تولید برنامه ی مورد نظر از 

. برای این منظور، لازم است که اسم هر فایل را به همراه پسوند مربوطه (reference)، به تک تک فایل ها ارجاع دهید (compiling)ترجمه 

 cscFileName1.cs FileName2.cs FileName_n.csی آن به بخش پایانی اضافه کنید :
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 ای پروژهاجر

(، اسم فایل را به command promptپس از ساختن پروژه، شما و کاربرانتان می توانید آن را اجرا کنید. به منظور اجرای پروژه، )از طریق 

 وارد کنید. Enterبا  exe.همراه پسوند 

 

 Debug -> Startکرده و روی گزینه های  مراجعه main menuکار می کنید، برای اجرای برنامه ، به  visual studioدر صورتی که با  

Debugging .کلیک کنید 

 اجرای برنامه

 را انتخاب کنید. Debug -> Start Debuggingرا باز کرده و گزینه ی  main menuبه منظور اجرای برنامه، 

 آن را ببندید. Enter، با زدن دکمه ی DOSپس از مشاهده ی نتیجه در پنجره ی 

 را نیز ببندید. visual studioبرنامه ی 

 را بزنید. Noکنید،  saveدر پاسخ به در خواست : آیا مایلید 

 (Variablesمتغییرها )
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 مبنع ذخیره سازی

کامپیوتر یک وسیله ی الکترونیکی است که به حل مشکل خاصی می پردازد یا وظیفه ی مشخصی را انجام می    دهد. برای مثال، یک دستگاه 

 مک می کند، هیکل خود را رو فرم نگه دارد یا یک دوربین دیجیتال از چیزهای مختلف عکس می گیرد.اندام به شخص ک تناسب

 وسایل الکترونیکی به منظور حل مسائل عمومی نیز به کار می روند. برای مثال، از رایانه ی شخصی برای انجام کارهای عمومی مثل محاسبات،

 اتی استفاده می شود. پردازش کلمه، یا ذخیره سازی بانک های اطلاع

مشخصی دریافت کند. این کار ممکن است توسط شخصی صورت بگیرد که دستوری  (value)برای انجام وظایف مختلف، کامپیوتر باید مقدارهای 

مقادیر موردنظر  در برخی از موارد، را از صفحه کلید تایپ می کند )به عنوان مثال از دستگاه تناسب اندام، تلفن همراه، یا کامپیوتر شخصی(.

 )از داخل( الکترونیکی و از منابع مختلف به کامپیوتر داده شود. 

استفاده می کند. خیلی از بخش های کامپیوتر به این تخته  motherboardبه منظور مدیریت این ارتباطات، کامپیوتر از صفحه ی تختی به نام 

یگری وجود دارد که وظیفه ی اصلی آن پردازش و انجام محاسبات است که به ی اصلی متصل هستند و از آن دستور دریافت می کنند. بخش د

 وصل می باشد. (motherboard)آن پردازش گر می گویند و به تخته ی اصلی 

ظور یا حافظه ذخیره شود. رایانه از دو نوع حافظه برای این من  yیاmem حال، مقادیری که کامپیوتر دریافت می کند باید در قسمتی به نام 

استفاده می کند. حافظه ی موقت و حافظه ی پایدار. از حافظه ی موقت برای ذخیره کردن اطلاعاتی استفاده می شود که حالت موقتی داشته و 

پس از گذشت زمان مشخصی پاک می شوند. برای مثال، حافظه ی نام برده اطلاعات را هنگامی که رایانه روشن است در خود حفظ می کند و آن 

 ا زمانی که کامپیوتر روشن است نگه می دارد ولی به محض خاموش شدن رایانه اطلاعات مزبور پاک می شوند.را ت

 نامیده می شود. RAMیا   y یاrandom access mem حافظه ای که اطلاعات و مقادیر به صورت موقت در آن ذخیره می شود 

 ند بخش، که هریک حامل چیزی است.فرض کنید، حافظه ی کامپیوتر یک سینی کیک است متشکل از چ

دستور می  compilerتوجه داشته باشید که حافظه بزرگ تر است یک کیک است و از میلیون ها جای خالی تشکیل شده.برنامه نویس مدام به 

طر داشته باشید جای ذخیره کند. اگرچه اندازه ی حافظه ی موقت چندان بزرگ نیست، باید به خا RAMدهد که مقادیر را به صورت موقتی در 

استفاده می کند. برای مثال، هنگامی که رایانه ی  RAMزیادی برای ذخیره ی اطلاعات لازم دارد. در واقع، این تنها برنامه ی شما نیست که از 

 را اشغال می کنند. RAMو دیگر برنامه ها ی آن  (windows)خود را راه اندازی می کنید، سیستم عامل 

 را به آن برنامه اختصاص می دهد. RAMبخشی از  compilerه ای را اجرا می کنید، هنگامی که برنام
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استفاده می کنند، به منظور ذخیره سازی مقادیر در آن، باید اطلاعاتی در اختیار آن قرار دهید. باید  RAMبه این خاطر که برنامه های زیادی از 

ها در آن ذخیره می شود انتخاب  valueاسم معینی برای آن قسمت خاص از حافظه که  مقدار حافظه ای را که به آن نیاز دارید مشخص کرده و

 گفته می شود. (variable)کنید. به ترکیبی از این اطلاعات متغییر  

 معرفی متغییرها

 Microsoft Visual Studio 2010یا  Microsoft Visual C# 2010 Expressبرنامه ی  .8

 را اجرا کنید. 

 کلیک کنید. New Projectروی گزینه ی  Start Pageجدید، در  (app)برنامه ی کاربردی  به منظور ایجاد .2

 را انتخاب کنید. Empty Projectدر فهرست میانی، گزینه ی  .1

 تغییر دهید.  ge town cleaning servicesیا gdcs2(ge) اسم موردنظر را به  .4

 کلیک کنید. okروی  .5

 را انتخاب کنید. projectمراجعه کرده و  main menuظر، به به نظور ایجاد فایل ویژه ی کد مورد ن .6

 را انتخاب کنید. code fileاز لیست میانی  .4

 تغییر دهید. derیا   cleaningاسم نام برده را به  .1

 کلیک کنید. Addروی گزینه ی  .1

 .در داکیومنت خالی دستورات زیر را تایپ کنید.82

    class Order 
    { 
        static void Main(string[] args) 
        { 
            System.Console.WriteLine("Georgetown Dry Cleaning Services"); 
            System.Console.ReadKey(); 
        } 

}     
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 نام گذاری متغییر ها

ین خاصی پیروی کرد. کلماتی وجود دارند که از آن ها نباید برای آن ها باید از قوان ناممشخصی داشته باشند و برای ایجاد  ناممتغییرها باید 

متغییر استفاده کرد زیرا خود برنامه کلیدواژهای مزبور را به کار می برد. این کلیدواژه ها در زیر فهرست  نامتحت هیچ شرایطی به عنوان 

 شده.

 

abstract continue finally interface out (generic) short typeof 

as decimal fixed internal out 

(methods) 

sizeof uint 

base default float is override stackalloc ulong 

bool delegate for lock params static unchecked 

break do foreach long private string unsafe 

byte double goto namespace protected struct ushort 

case else if new 

(generic) 

public switch using 

catch enum implicit new (LINQ) readonly this virtual 

char event in 

(foreach) 

new 

(variable) 

ref throw void 

checked explicit in 

(generic) 

null return true volatile 

class extern int object sbyte try while 

const false   operator sealed     

 

نیستند، استفاده از آن ها به شما توصیه نمی شود. به این خاطر که  #Cواژه های دیگری هستند که با وجود این که جز کلیدواژه های برنامه ی 

 contextual)اژه های متنی در کد شود. از واژه های داده شده  به عنوان کلیدو (conflict)به کار بردن آن ها ممکن است منجر به بروز اختلال 

keyw یا ds) .یاد می شود 
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add global let partial (type) set where 

(generic) 

dynamic group orderby remove value where (query) 

from into partial (method) select var yield 

get join         

 #Cر چیزی در برنامه نویسی قوانین خاص خود را دارد.قوانین استانداردی هست که توسط همان طور که پیش تر ذکر شد، اسم گذاری برای ه

وی رتعریف می شوند ولی شما می توانید قوانینی را بر مبنای سلیقه ی خود نیز به وجود بیاورید. قوانینی که برای تعیین اسم متغییر باید پی

 کنید به شرح زیر می باشد.

 ،A، B، C، D، E، F، G، H، I، J، K، L، M، N، O، P، Q، R، S، T، U، V، W، Xیک حرف تشکیل شود) از امی تواند تنه نام متغییر

Y، Z، a، b، c، d، e، f، g، h، i، j، k، l، m، n، o، p، q، r، s، t، u، v، w، x، y، یا z این حروف متعلق به الفبای انگلیسی آمریکایی می .)

 المللی را نیز می پذیرد. انگلیسی بین #Cباشد، ولی زبان 

ساخته شود. با این وجود، توصیه می شود از این کار خودداری کنید زیرا خواندن کدی  ) _ (ممکن است از تنها یک علامت  نام، #Cدر 

 که از تنها یک _ تشکیل شده آسان نیست.

 { ،} ،; ،[ ،] ،< ،> ،@ ،\ ،# ،+ ،( ،) ،* ،& ،? ،% ،$ ،/ ،" ،! ،|خودداری کنید.  نام متغییراز به کار بردن این علامت ها در 

 .شروع شود _متشکل از بیش ازیک کاراکتر باشد، باید با حرف یا  نامیدر صورتی که 

 .تشکیل شود _یا  /، و (9 یا، 1، 4، 2، 3، 1، 1، 2، 8، 2)می تواند از ترکیبی از حروف، ارقام    نامیا حرف،  _پس از آغاز کاراکتر با 

 .استفاده کرد (space)نمی توان از فاصله  نامدر 

علاوه بر قوانین بالا، برنامه نویس می تواند قوانین خود را تعریف کند. ولی در تعریف همین قوانین باید محدودیت های ذکر شده در نظر 

 گرفته شود.

 نند.در تنها یک کلمه خلاصه شود، اکثر برنامه نویسان از حروف کوچک استفاده می ک نامیاگر 
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استفاده می کنند که در آن اولین کلمه با  camel notationمتغییر متشکل از چند کلمه است، بیشتر برنامه نویسان از  نامزمانی که 

 حروف کوچک نوشته می شود و اولین حرف کلمات بعدی همگی با حروف بزرگ نوشته می شوند. 

همیشه  mainبا هم کامل متفاوت اند. برای مثال،  CASEو  case ،Caseبه کوچک بزرگی حروف حساس است، یعنی کلمات  #Cزبان 

Main .نوشته می شود 

 مقدارها و متغییرها در کنسول

 به نمایش می گذارند. به مثال زیر توجه کنید. DOSنتایج خود را در پنجره ی  #Cبرنامه های زبان 

 

 ()System.Console.Writeا داخل پرانتز برای نشان دادن مقدار معینی در پنجره ی فوق، می توانید آن ر

 قرار دهید. مانند دو نمونه ی زیر  ()System.Console.WriteLineیا

    class Exercise 
    { 
        static void Main() 
        { 
            System.Console.WriteLine(248); 
            System.Console.Write(1); 
        } 

}     
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 را خالی بگذارید، خطی تهی نمایش داده می شود. ()System.Console.WriteLineاگر داخل پرانتز 

 نمایش های عددی 

ن کند. ایبرنامه ی کامپیوتر عبارتند از مجموعه ای دستور که برای رایانه انجام کار مشخص، زمان اجرای آن و نحوه ی پیاده سازی آن را معیین می 

یا، البته  text editدستورها را می نویسد. همان طور که پیش تر نیز بیان شد، می توان دستورات مزبور را در برنامه ی  برنامه نویس است که

ولی با زبان شناس مانند انگلیسی نوشت. برای مثال، می توان دستوری نوشت که از کامپیوتر درخواست  #Cبر مبنای قوانین استاندارد زبان 

 فظه ذخیره کند. تمام دستوراتی که می نویسید باید به کامپیوتر منتقل شود.می کند عددی را در حا

تنها زبان برنامه نویسی نیست، و برنامه نویسان سرتاسر دنیا از  #Cمستحضر هستید که اشخاص دستورهای مختلفی می نویسند. همچنین، 

برای درک تمام این زبان ها و تفسیر تمام دستورهایی که از این برنامه  زبان های مختلف برای دادن دستور به رایانه استفاده می کنند. کامپیوتر

ن ه  آها ارسال می شود، از زبان مختص به خود استفاده می کند که تمام برنامه ها باید آن را بشناسند و از آن پیروی کنند. زبان های داده شد

 /ه از زبان انگلیسی استفاده می کند، دستورات خود را به برنامه ی میانجی ک #Cجور که باید از مسئله ی فوق پیروی نمی کنند. برای مثال، 

دستورات را به نسخه ی فشرده تر تبدیل می کند که با وجود استفاده از لغات  assemblerتحویل می دهد. Assemblerواسط ای به نام 

 به ورژنی ساده تر تبدیل می کند و در اختیار رایانه قرار می دهد. جدید، آن هم به زبان انگلیسی می باشد. کامپیوتر دوباره نسخه ی فشرده را

 8و  2را به  #cباید دستورات  assemblerها می باشد، یعنی  2ها و  8زبان ساده شده ای که کامپیوتر استفاده می کند، متشکل از ترکیبی از 

 تبدیل کند تا کامپیوتر بتواند آن را تفسیر کرده و اجرا کند.

 ای عددیسیستم ه

استفاده می کنند آشنایی دارید. ترکیبی از این ده عدد می تواند هر رقمی که شما  1و  1، 4، 6، 5، 4، 1، 2، 8، 2با سیستم هایی که از ده رقم  

 یا دهگانی می گویند. decimalرقم استفاده می کند به آن سیستم  82دوست دارید بسازد. به این خاطر که زبان کامپیوتر از 

می  binaryاستفاده می کند. به چنین سیستمی، سیستم دوتایی یا  8و 2ن طور که پیش تر ذکر شد، زبان کامپیوتر از ترکیب دو مقدار هما

 8و  2نمونه هایی از این سیستم می باشند. هر مقداری که به کامپیوتر داده می شود باید ترکیبی از  1010110111یا 1001 ،10، 1گویند. 

 ها تبدیل شود.

 6عدد سیستم دهگانی و 82همان طور که تصور می کنید نمایش دادن یک رقم بزرگ کار بسیار دشواری است. یک روش برای این منظور، از 

کاراکتر برای ایجاد یک  86. به این معنا که سیستم فوق از f و a، b، c، d، eیا  F، و A، B، C، E، Dحرف از الفبای انگلیسی استفاده می کند. 
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گویند. برای این که فرایند تشخیص یک رقم مبنای  می86یا مبنای  hexadecimalاستفاده می کند. به همین دلیل است که به آن سیستم رقم 

 .2x2 ،0xED8 ،0x962AAED3آغاز شود.نمونه های آن به این صورت است.  0xشود، رقم داده شده  باید با  آساناز کلمه  86

 علامت دار و بدون علامت

کوچکتر است، با آن برابر است یا از آن بزرگتر است. عددی که کوچکتر از صفر  2ویژه گی های رقم این است که مشخص می کند آیا از  یک از

می آید. چنانچه، عددی از صفر بزرگتر بود مثبت تلقی می گردد. چنین رقمی به  –است منفی محسوب می شود. چنین رقمی به دنبال علامت 

یا علامت دار می گویند. هر عددی هم که هیچ یک از  signedی آید. به ارقامی که یکی از این دو علامت را به یدک می کشند م +دنبال علامت 

 است. unsignedبدون علامت یا  2یا مثبت اتلاق می گردد. برای مثال، عدد  unsignedاین دو علامت را نداشته باشد 

 تعریف متغییرها

معینی در حافظه ابتدا باید مقدار حافظه ی مورد نیاز را مشخص کنید، سپس  (value)د، برای ذخیره سازی مقدار همان طور که پیش تر ذکر ش

)نوع داده( می گویند. مقدارهای متفاوت، مقدار حافظه ی متفاوت می  data typeباید برای آن اسم انتخاب کنید. مقدار حافظه ی مورد نیاز را 

 خوانده می شود. bitدر خود جای می دهد  8یا  2می بیند. آن قسمت حافظه که تنها یک  8و  2 ایانه مقدار راطلبد. این را هم گفتیم که ر

 یک شئ تهی است که می تواند خالی یا پر باشد. bitتصور کنید که 

 

 .8را نشان می دهد و زمانی که پر است، مقدار  2مقدار  bitهنگامی که آن شی خالی است، 

 تعریف متغییر

 (declaring a variable)پیغام می دهید که به متغییر نیاز دارید. از چنین فرایندی به عنوان  compilerها، به  bitا به کاربردن ترکیبی از ب

گفته می شود. بنابراین،  data typeتعریف متغییر یاد می شود. همان طور که قبل توضیح داده شد، مقدار حافظه ای که به آن نیاز دارید 
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با یک کلیدواژه نمایش داده می  (data type)، نوع داده #Cدلخواه را مشخص کنید. در  (data type)گام تعریف متغییرباید نوع داده ی هن

 شود.

 برای تعریف متغییر دو راه پیش رو دارید.

  .اگر نوع مقداری که مایلید در حافظه ذخیره شود را می دانید، از فرمول زیر پیروی کنید 

DataTypeVariableName; 

 .اگر نمی خواهید نوع مقدار را مشخص کنید، گزینه های دیگری برای شما فراهم است 

 کنید.استفاده  varمی توانید از کلید واژه ی 

 را به کار ببرید. objectمی توانید کلید واژه ی 

 نیز استفاده کرد. dynamicمی توان از کلیدواژه ی 

 مقدار دهی اولیه ی متغییر

به منظور  بیش تعریف شده)طور که از اسم آن پیدا است، مقدار دهی اولیه عبارتند از ذخیره سازی مقدار اولیه در جای )مشخص آن.  همان 

 .اختصاص دادن متغییر

 ، مقدار دلخواه ولی مناسب را تایپ کنید.=نوع داده، به دنبال آن اسم متغییر، علامت 

    class Exercise 
    { 
        static void Main() 
        { 
            DataTypeVariableName = DesiredValue; 
        } 

}     

با این روش، شما می توانید متغییر را در ابتدای کار با مشخص کردن اسم و نوع داده تعریف کنید و در انتهای آن علامت نقطه ویرگول 

 و مقدار مورد نظر را وارد کنید.  ،=ایپ کرده و به دنبال آن علامت قرار دهید. سپس، در خطی دیگر، اسم متغییر را ت

    class Exercise 
    { 
        static void Main() 
        { 
            DataTypeVariableName; 
            VariableName = DesiredValue; 
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        } 
}     

 و مقدار معین را درج کنید.  =دنبال آن، اسم متغییر، علامت را تایپ کرده و به  varابتدا کلیدواژه ی 

class Exercise 
   { 
        static void Main() 
        { 
            varVariableName = DesiredValue; 
        } 

}               

تعریف  (;)و نقطه ویرگول  varاسم متغییر را با قرار دادن این بار باید تمام مراحل را یکجا انجام دهید. در این مورد، نمی توان ابتدا 

 کرده و بعد )در خطی دیگر( مقدار دهی اولیه متغییر را انجام دهید. با این کار، پیغام خطا دریافت می کنید.

    class Exercise 
    { 
        static void Main() 
        { 
            varVariableName; 
 
            VariableName = DesiredValue; // Error 
        } 
} 

 می باشد. dynamicیا  objectدو گزینه ی پیش روی دیگر نیز، استفاده از کلیدواژه های 

توان  مقدار آن متغییر را حافظه ای که برای آن اختصاص یافته ذخیره می شود. حال، می compilerپس از تعریف و مقدار دهی اولیه ی متغییر، 

 .به آن مقدار دسترسی پیدا کرد و در صورت نیاز آن را تغییر داد

 (null valueمقدار تهی ) 

( null value) متغیر موردنظر، متغیر را طوری تعریف کنید که مقدار تهی (data type) به نوع داده)؟(  می توان با اضافه کردن علامت سوال

 را در اختیار شما قرار می دهد. nullواژه ی کلید #Cداشته باشد. برای این منظور زبان 

 را به آن اختصاص داد. nullمی توان هنگام تعریف متغیر، مقدار 

    class Exercise 
    { 
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        public static void Main() 
        { 
            DataType?VariableName= null; 
        // You can use the variable 
        } 

}     

 همچنین می توان این مقدار را پس از تعریف متغیر اختصاص داد.

    class Exercise 
    { 
        public static void Main() 
        { 
        DataType?VariableName; 
        VariableName= null; 
        // You can use the variable 
        } 

}     

 اهمیت دارد آن است که مقدار پیش از به کاربردن متغیر به آن اختصاص داده شود.آنچه 

 Byte 

 bitترکیبی از چهار 

 compilerقابل دسترس و استفاده است، باید به خاطر داشت که نمی توان در آن مقدار ذخیره کرد به این معنا که نمی توان از  bitاگرچه یک 

برای ذخیره شدن  bitنیز به بیش از یک  #Cذخیره کند. این امر به این خاطر است که، حتی کوچکترین مقدار  bitرا در یک  8خواست که مقدار 

گفته می  bit ،nibbleبه ترکیب چهار  assemblyوجود ندارد )در برخی زبان ها یا پیاده سازی زبان  bitنیاز دارد. ترکیبی کوچکتر از چهار 

 شود(.

 ترکیب به دست می آید. 82، همگی (2)و تهی  (8)از پر با ایجاد ترکیبات چهارتایی 

رده پایین خوانده  bit، (2)ای که در راست ترین کناره یا موقعیت قرار دارد  bitشمرده می شوند.  1و  2، 8، 2  هاbit در این ترکیبات چهارتایی، 

 .(LOBIT) می شود

 .(HIBIT) رده بالا خوانده می شودbit  ،(1)ای که در چپ ترین موقعیت قرار دارد  bitیا  bitآخرین 
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، 2822، 2288، 2282، 2228، 2222به این نتایج دست می یابیم  دهیمنمایش ( binary)ای را با سیستم دودویی  bitاگر بخواهیم ترکیبات چهار 

ترکیبات بالا ( decimal)آید. با فرمت دهدهی  ترکیب به دست می 82، که همگی 8888، 8882، 8828، 8822، 8288، 8282، 8228، 8222، 2888، 2882، 2828

 (82)مبنای  hexadecimal. حال، با فرمت 83، و 81، 81، 82، 88، 82، 1، 1، 4، 2، 3، 1، 1، 2، 8، 2این نتایج را به دست می دهد : 

Decimal Binary Hexadecimal 

0 0000 0x0 

1 0001 0x1 

2 0010 0x2 

3 0011 0x3 

4 0100 0x4 

5 0101 0x5 

6 0110 0x6 

7 0111 0x7 

8 1000 0x8 

9 1001 0x9 

10 1010 0xA 

11 1011 0xB 

12 1100 0xC 

13 1101 0xD 
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14 1110 0xE 

15 1111 0xF 

 جدول تبدیل عددی

 ای به این صورت است. bitحداقل و حداکثر مقدارها در ترکیب چهار 

  Decimal Hexadecimal Binary 

Minimum 0 0x0 0000 

Maximum 15 0xf 1111 

  

البته، باید در نظر داشته باشید که با ترکیبات چهارتایی هیچ کاری نمی توان کرد. زیرا ترکیبات بیان شده بسیار کوچک هستند و گنجایش 

شته می گیرد. دوم اینکه، پیش از کجا سر ر 82ذخیره هیچ چیز را ندارد. به دو دلیل درباره ی آن بحث کردیم : اول اینکه، باید بدانید که عدد 

 را فراهم آورد. byteزمینه ی معرفی 

  بیت 1 ی ازترکیب

) چپ ترین  bitو آخرین  2ای که در راست ترین قسمت قرار گرفته bit  (bit  )است که کنار هم قرار گرفته. اولین  bit  1ترکیبی از  byteیک 

bit  )4 .می باشد 
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 است. HIBIT محسوب می شود و نام دیگر آن  bitمهم ترین  4نیز می گویند.  LOBITه آن است که ب bitکم اهمیت ترین  2 

، binary :22222222 ،22222228 ،22222282 ،22222288 ،22222822 ،22222828 ،22222882 ،22222888 ،22228222تایی با سیستم  1ترکیبات 

. نمایش دادن یک عدد بزرگ با فرمت دودویی، خواندن 88888888تا  22228888، 22228882، 22228828، 22228822، 22228288، 22228282، 22228228

 8288 2822=  28228288آن را سخت می کند. روش مناسب تر، دسته بندی آن ها در گروه های چهارتایی است به این صورت 

، 1، 1، 2، 8، 2موردنظر ) bitاست(، را به توان  decimal) که نشانگر  2عدد (، decimal)به منظور ارزیابی  تعداد ترکیبات در فرمت دهدهی 

 ( برده، سپس عدد را اضافه می کنیم به این صورت7، 2، 3

27 + 26 + 25 + 24 + 23 + 22 + 21 + 20 

= 128 + 64 + 32 + 16 + 8 + 4 + 2 + 1 

= 255 

 ،2x1،0x2،...، 0xAنیز حساب کرد :  hexadecimalرمت ای داریم. ترکیبات بالا را می توان با ف bit 1ترکیب احتمالی  233بنابراین، 

0xA1،...، 0xC8،...، up to 0xFFFF  

 محاسبات در سه سیستم عددی مختلف

 Decimal Hexadecimal Binary 

http://articles.tahlildadeh.com/image.axd?picture=image_737.png
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Minimum 0 0x0 0000 

Maximum 255 0xff 1111 1111 

  

می باشد. همان طور که مستحضر هستید،  byteور ذخیره سازی ( به منظintel computerحداقل مقدار حافظه اختصاص داده شده )توسط  

در اختیار شما قرار داده می شود، تنها  byteمتوالی و کنارهم قرار گرفته است. مقدار حافظه ای که به اندازه ی یک  bit 1متشکل از  byteیک  

ین نشانه ها، که به آن ها کاراکتر هم گفته می شود، گنجایش ذخیره کردن یک نشانه )که بر روی صفحه کلید درج شده است( را دارد. ا

)  decimalعدد  821از تنها  ASCII، کد استاندارد آمریکایی به منظور تبادل اطلاعات تعبیه شده اند. اما باید در نظر داشت که ASCIIتوسط 

 (. 824تا  2ای ( استفاده می کند )از  bit 4بر مبنای فرمت 

ر صفحه کلید مشاهده می کنید، به عنوان یک مقدار عددی نمایش داده می شود، اما هریک از این نشانه ها چه کلیه ی کاراکترهایی که د

 ()Writeعدد، چه حرف و چه علامت همگی کاراکتر محسوب می شوند.  برای نمایش دادن هر کاراکتری در صفحه ی نمایش، می توان آن را با 

 قرار داد.( ' ')اراکتر مورد نظر را در علامت و ک (pass) ، ارسال کرد()WriteLineیا 

    class Exercise 
    { 
        public static void Main() 
        { 
            System.Console.WriteLine('n'); 
        } 
    } 

 

در  nو اجرا شدن، حرف ( compile)ترجمه  ذخیره گشت. پس از \:Cدر درایو   Variablesدر فولدر  Exercise.csفایل موردنظر با نام  

 صفحه نمایش داده می شود.

http://articles.tahlildadeh.com/image.axd?picture=image_738.png
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 کاراکترها  

 ،a، b، c، d، e، f، g، h، i، j، k، l، m، n، o، p، q، r، s، t، u، v، w، x، yدر الفبای زبان انگلیسی، حرف به یکی از نشانه های زیر گفته می شود : 

z، A، B، C، D، E، F، G، H، I، J، K، L، M، N، O، P، Q، R، S، T، U، V، W، X، Y وZ جدا از این کاراکترهای خوانا، به علامت های ذیل نیز .

. علامت های دیگری وجود دارند که به آن ها نیزکاراکتر می گویند : ` ~ ! @ # $ % ^ & * 1، 1، 4، 2، 3، 1، 1، 2، 8، 2می گویند : ( digit)رقم 

 ) (-  } ] { [ + = _\  ' : ; |." > ، / .? < 

هر چیزی را که بتوان به صورت نشانه ای به نمایش گذاشت را یک کاراکتر به حساب می آورد. به منظور تعریف متغیری که مقدارش  #Cزبان 

کرد. به  (initializeمقدار دهی اولیه )  ' 'استفاده کرد و متغیر را با کاراکتری درون علامت   varیک کاراکتر می باشد، می توان از کلیدواژه ی 

 مثال زیر توجه کنید.

     class Exercise 
    { 
        public static void Main() 
        { 
              var gender = 'F'; 
              System.Console.Write("Student Gender: "); 
              System.Console.WriteLine(gender); 
        } 

}     

 نتیجه ی زیر حاصل می گردد.

http://articles.tahlildadeh.com/image.axd?picture=image_739.png
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 استفاده کرد. توجه خود را به مثال زیر جلب کنید. charهمچنین، می توان از کلیدواژه ی  

    class Exercise 
    { 
        public static void Main() 
        { 
           char gender = 'M'; 
           System.Console.Write("Student Gender: "); 
           System.Console.WriteLine(gender); 
           System.Console.ReadKey(); 
        } 

}     

 نکته

 را پشتیبانی می کنند. charفعالیت می کنند نوع داده ی  Cتمام زبان هایی که بر مبنای 

 نتیجه ی زیر به دست می آید.

Student Gender: M 
Escape Sequence 

 

Escape sequence  کاراکتری ویژه است که در صفحه نمایش قابل رویت نمی باشد. برای نمونه می توان از این کاراکتر برای شروع نوشتن

  /  تدستور در خط  بعدی استفاده کرد )به برنامه فهماند که این خط به اتمام رسیده و خط دیگری باید شروع شود(. کاراکتر مزبور با این علام

http://articles.tahlildadeh.com/image.axd?picture=image_740.png
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ای که در خط بعدی  escape sequenceنشان داده می شود که به دنبال آن ممکن است یک کاراکتر یا نشانه ی دیگر قرار گیرد. برای مثال، 

  n\قرار می گیرد به این صورت نمایش داده می شود : 

  ."n\"قرار داد :  ." "را می توان داخل  هم چنین این کاراکتر. 'n\'قرار داده شود :  ' 'ممکن است داخل  escape sequenceکاراکتر 

 نکته

 هست، این کاراکتر ها را پشتیبانی می کنند. Cتمام زبان هایی که مبنای آن 

Escape Sequence Name Description 

\a Bell (alert)  صدایی از کامپیوتر پخش می کند 

\b Backspace  نشان گر موس را به عقب می برد 

\t Horizontal Tab  نشان گر موس را به صورت افقی به حرکت در می   آورد 

\n New line  نشان گر موس را به آغاز خط بعدی می برد 

\v Vertical Tab  جدول بندی عمودی ایجاد می کند 

\f Form feed   

\r Carriage return  فرایند بازگشت به ابتدای خط را فراهم می سازد 

\" Double Quote  (")مت نقل و قول را نمایش می دهد علا   

\' Apostrophe   (')  علامت آپستروف را نمایش می دهد 

\? Question mark   علامت سوال را نشان می دهد 

\\ Backslash  علامت(\) را نشان می دهد 

` Null    کاراکتر تهی را نمایش می دهد 
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دلخواه  escape sequenceمعرفی کرده، آن را با کاراکتر  charان یک متغیر ، همچنین می توEscape sequenceبرای استفاده از 

 قرار داد. ' 'مقداردهی اولیه کرد، سپس داخل  

 Byteنوع داده ی  

قابلیت  byteمتغیر می باشد، به این خاطر هیچ چیز در یک  233تا  2است که مقدار آن از ( unsigned number)عددی بی علامت  byteیک 

استفاده کرد مانند مثال  byteشدن ندارد. برای معرفی متغیری که دربردارنده ی یک عدد طبیعی کوچک است، می توان از کلیدواژه ی  ذخیره

 زیر

byte Age 

 .اربردهرا به ک byteرا در حین معرفی متغیر یا پس از انجام فرایند )معرفی( مقدار دهی اولیه کرد. مثال زیر نوع داده ی  byteمی توان متغیر 

    class Exercise 
    { 
        public static void Main() 
        { 
            byte age = 14; 
            System.Console.Write("Student Age: "); 
            System.Console.WriteLine(age); 
            age = 12; 
            System.Console.Write("Student Age: "); 
            System.Console.WriteLine(age); 
        } 

}     

 .که محصول زیر را به دست می دهد
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دریافت می کنید. همچنین، می توان از کلیدواژه  errorاستفاده نکنید، زیرا در آن صورت  byteبرای متغیر  233به هیچ وجه از مقداری بالای  

 فی متغیر استفاده کرد، سپس آن را با عددی کوچک مقداردهی اولیه کرد. به این مثال توجه کنید.برای معر varی 

    class Exercise 
    { 
        public static void Main() 
        { 
                var age = 14; 
                System.Console.Write("Student Age: "); 
                System.Console.WriteLine(age); 
                age = 12; 
                System.Console.Write("Student Age: "); 
                System.Console.WriteLine(age); 
               System.Console.ReadKey(); 
        } 
    } 

مقداردهی اولیه کرد. ابتدا،  (82)مبنای hexadecimalمی توان متغیر انتگرال را با مقدار (، decimal number)به جای عدد دهدهی 

 پایین تر است. به مثال زیر توجه کنید. 233از مقدار ( decimal equivalent)اطمینان کسب کنید که معادل دهدهی 

class Exercise 
    { 
        public static void Main() 
        { 
                var number = 0xFE;  
                System.Console.Write("Number: "); 
                System.Console.WriteLine(number); 
               System.Console.ReadKey(); 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

Number: 254 
Press any key to continue… 

  Byteاستفاده کردن از 

 .را به این صورت تغییر دهید Program.csفایل 

    class Order 
    { 
        static void Main() 
        { 
            byte? shirts = null; 
            byte? pants = null; 
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            shirts = 4; 
            pants = 1; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.WriteLine("Item Type  Qty"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.WriteLine(shirts); 
            System.Console.Write("Pants       "); 
            System.Console.WriteLine(pants); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 

}     

را انتخاب کنید. محصول زیر به دست  Debug -> Start Debuggingمراجعه کرده، سپس گزینه ی  main menuبه منظور اجرای برنامه به 

 .می آید

-/- Georgetown Cleaning Services -/- 
======================== 
Item Type  Qty 
------------------------ 
Shirts      4 
Pants       1 
======================== 

 را فشار دهید. Enterدکمه ی  DOSحال، برای بستن پنجره ی 

 Byte  علامت دار 

 byteگه دارد، این مقدار در یک را در خود ن 824تا  -821، زمانی علامت دار معرفی می شود که بتواند مقداری مثبت یا منفی از byteیک عددِ 

 .استفاده کنید. نمونه ی آن را در زیر مشاهده می کنید sbyteذخیره می شود. به منظور معرفی متغیری برای مقدار گفته شده، از کلیدواژه ی 

    class Exercise 
    { 
        static void Main() 
        { 
            sbyte roomTemperature = -88; 
            System.Console.Write("When we entered, the room temperature was "); 
            System.Console.WriteLine(roomTemperature); 
        } 
    } 

 که نتیجه ی زیر از آن به دست می آید. 

When we entered، the room temperature was -88 
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 (Wordواژه ) 

 .(2ها از راست به چپ شمرده می شوند )از  bitمتوالی است.  bit 82اژه متشکل از یک و

 

 bit، مهم ترین bit ،83می گویند. چپ ترین  LOBITسطح پایین و یا  bitیا  bitمی باشد که به آن کم اهمیت ترین  2یک واژه  bitراست ترین  

 و غیره. 1، 2، 8یگر بسته به موقعیتی که در آن قرار گرفته اند تعریف می شوند : های د bitخوانده می شود.  HIBITسطح بالا و یا  bitیا 

ای که در سمت  bit 8خوانده می شود و دیگر گروه  LOBYTEسمت راست همان  bit 8تشکیل شده، گروه  byteنظر به این که یک واژه از دو 

 نام دارد. HIBYTEچپ قرار می گیرد 

ها را  bit. برای خواناتر کردن آن، می توان 0000000000000000به این صورت است : ( binary)ب( دودویی نمایش یک واژه با فرمت )قال

. بنابراین، کمترین مقدار دودویی که واژه قادر به نمایش دادن آن 0000 0000 0000 0000در گروه های چهارتایی قرار داد به این صورت : 

می باشد. کمترین مقدار  2یک واژه معادل ( decimal). کمترین مقدار دهدهی 0000 0000 0000 0000است به این شکل خواهد بود : 

می باشد که البته به این اشکال نیز  0x0000000000000000که می توان در یک واژه ذخیره کرد برابر با ( hexadecimal) 82مبنای 

 است. 0x0ارقام یک مقدار را به دست می دهند و آن . تمام این 0x0و یا  0x0000یا  0x00000000نمایش داده می شود : 

می باشد. برای به دست آوردن  1111 1111 1111 1111   که یک واژه می تواند نشان دهد معادل :(  binary)دودویی  حداکثر مقدار

 .را قرار دهید 8عدد  bitاستفاده کنید و به جای هر  2یک واژه ، می توانید از فرمول پایه ( decimal)حداکثر مقدار دهدهی 

1*215+1*214+1*213 + 1*212 + 1*211 + 1*210 + 1*29 + 1*28 + 1*27 + 1*26 + 1*25 + 1*24 + 1*23 + 1*22 + 1*21 + 

1*20 

= 32768 + 16384 + 8192 + 4096 + 2048 + 1024 + 512 + 256 + 128 + 64 + 32 + 16 + 8 + 4 + 2 + 1 

= 65535 
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 4که در یک واژه قابلیت ذخیره شدن را داشته باشد، تمام گروه های ( hexadecimal) 82اکثر مقدار یا رقم مبنای برای به دست آوردن حد

bit  ای را باf  یاF جایگزین کنید. 

1111 1111 1111 1111 

f f f f 

= 0xffff 

= 0xFFFF 

= 0Xffff 

= 0XFFFF 

 

  

short integers   

را در خود جای دهد.  (natural number)می باشد، می تواند یک عدد طبیعی  byte 2همجوار یا  bit 16، که متشکل از (word) یک واژه

است. به منظور تعریف  65535که در یک واژه می توان ذخیره کرد ( numeric value)همان طور که قبلاً ذکر شد، بیشترین مقدار عددی 

مقداردهی اولیه کرد. به  32767تا  32768-را به کاربرد و متغیر نام برده را با مقداری از   varمتغیری برای این مقدار، می توان کلیدواژه ی 

 .مثال زیر توجه کنید

    class Exercise 
    { 
        static void Main() 
        { 
            var schoolEffective = 1400; // Number of Students 
            System.Console.Write("School Effective: "); 
            System.Console.WriteLine(schoolEffective); 
        } 

}     
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 .نتیجه ی زیر حاصل می گردد 

School Effective: 1400 
Press any key to continue… 

 
داشتید عددی را در برنامه ی خود به کار ببرید، توجه  تنها گنجایش کاراکترها و ارقام کوچک را دارد(، هر زمان قصد byte)به این خاطر که 

 داشته باشید که کوچکترین نمودی که می توان به کاربرد واژه است. 

می توان در یک واژه  shortرا تنها با کمک کلیدواژه ی ( integer)نیز می گویند. کوچکترین  integerرا ( natural number)عدد طبیعی 

متغیر  32767تا  32768-به صورت پیش فرض علامت دار می باشد، می تواند مقداری که از  integer shortن که ذخیره کرد. به دلیل ای

 را به کار می برد مشاهده می کنید.  integer shortاست را در خود ذخیره کند. در زیر نمونه ی برنامه ای که دو 

    class Exercise 
    { 
        static void Main() 
        { 
            short numberOfPages; 
            short temperature; 
            numberOfPages = 842; 
            temperature = -1544; 
            System.Console.Write("Number of Pages of the book: "); 
            System.Console.WriteLine(numberOfPages); 
            System.Console.Write("Temperature to reach during the experiment: "); 
            System.Console.Write(temperature); 
            System.Console.WriteLine(" degrees\n"); 
        } 

  }     

 .نتیجه ی زیر به دست می آید

Number of Pages of the book: 842 
Temperature to reach during the experiment: -1544 degrees 

 

 byteعلامت دار را در خود جای دهند(، هر مقداری که برای  byteبزرگتر از ( number)ها می توانند ارقام  short integer)به دلیل این که 

 هم تعریف کرد. shortتعریف می کنید را می توان برای متغیر علامت دار 
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 Short integer های بدون علامت 

یاد می شود. چنین متغیری را می توان با  unsigned short integerاز متغیری که دربردارنده ی اعداد مثبت و نسبتاً کوچکی است با نام 

قرار دارند را در برگیرد  65535تا  2ها ی بدون علامت می توانند اعدادی که در برد  short integerتعریف کرد.  varیا  ushortکلیدواژه های 

 جای می گیرند(. مثال های آن را در زیر مشاهده می کنید  bit 82)به همین دلیل است که در تنها 

    class Exercise 
    { 
        static void Main() 
        { 
            // These variables must hold only positive integers 
            ushort numberOfTracks; 
            ushort musicCategory; 
            numberOfTracks = 16; 
            musicCategory = 2; 
            System.Console.Write("This music album contains "); 
            System.Console.Write(numberOfTracks); 
            System.Console.WriteLine(" tracks"); 
            System.Console.Write("Music Category: "); 
            System.Console.Write(musicCategory); 
            System.Console.WriteLine(); 
        } 

}     

 .نتیجه ی زیر به دست می آید

This music album contains 16 tracks 
Music Category: 2 

 های بدون علامت short integerبه کاربردن  

 .ها، فایل را به صورت زیر تغییر دهید short integerبرای به کاربردن 

   
 
  class Order 
    { 
        static void Main() 
        { 
            byte? shirts = null; 
            byte? pants = null; 
            ushort? otherItems = null; 
            shirts = 4; 
            pants = 1; 
            otherItems = 3; 
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            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.WriteLine("Item Type  Qty"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.WriteLine(shirts); 
            System.Console.Write("Pants       "); 
            System.Console.WriteLine(pants); 
            System.Console.Write("Other Items "); 
            System.Console.WriteLine(otherItems); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 

}     

 .کلیک کنید. نتیجه ی زیر حاصل می گردد Debug -> Start Debuggingمراجعه کرده و روی  main menuبه منظور اجرای برنامه، به 

-/- Georgetown Cleaning Services -/- 
======================== 
Order Date: 7/15/2002 
------------------------ 
Item Type  Qty 
------------------------ 
Shirts      4 
Pants       1 
Other Items 3 
======================== 

 .بسته شود DOSرا بزنید تا پنجره ی  Enterکلید  

 .حال، محیط برنامه نویسی را نیز ببندید

 .را بزنید NOکنید یا نه،  SAVEهنگامی که از شما پرسیده شد، می خواهید 

 مواجهه با مقادیر بسیار بزرگ

Double-word  4)گروه دوکلمه( عبارتند از گروهی متشکل از دو واژه ی متوالی. به عبارت دیگر، گروه دوکلمه ترکیبی از byte  32یا bit  می

یا  bit، کم اهمیت ترین bit ،bit 0ختم می شوند. راست ترین  18آغاز شده و به  2ها که از راست به چپ شمرده می شوند، از  bitباشد. 

LOBIT  تلقی می گردد و چپ ترینbit ،bit 31 ، مهم ترینbit  یاHIBIT  خوانده می شود. بقیه یbit  ها، بسته به موقعیتی که در آن قرار

  گرفته اند تعریف می شوند.
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 byteکه (  18تا  21آخر ) از  bit 8خوانده می شود. گروه  LOBYTEسمت راست حساب می شود،  byte(، که 4تا  2اول ) از  bit 8گروه 

های دیگر نیز بسته موقعیتی که در آن قرار گرفته اند، تعریف می شوند. حال،  byteاطلاق می گردد.  HIBYTEسمت چپ محسوب می شود، 

ای سمت چپ، واژه ی سمت چپ،  bit 16خوانده می شود. گروه  LOWORDای سمت راست یا همان واژه ی سمت راست،  bit 16گروه 

HIWORD  .گفته می شود 

می باشد. حداقل  2نشان داد  (double-word)که می توان با یک گروه دوکلمه ای  (minimum binary number)حداقل عدد دودوئی 

می باشد. برای بدست آوردن بیشینه ی مقدار اعشاری  2یک گروه دوکلمه معادل ( minimum decimal value)مقدار اعشاری 

(maximum decimal value )2توان از فرمول پایه ی  یک واژه، می (base 2 formula)  استفاده کرد و به هرbit مقدار ،(value )8 داد. 

2n-1 230 229 228 227 226 225 224 

etc 1،073،74

1،824 

536،870،9

12 

268،435،4

56 

134،217،7

28 

67،108،8

64 

33،554،4

32 

16،777،2

16 

  

223 222 221 220 219 218 217 216 

8،388،608 4،194،304 2،097،152 1،048،576 524،288 262،144 131،072 65،536 

  

215 214 213 212 211 210 29 28 

32،768 16،384 8،192 4،096 2،048 1،024 512 256 

  

27 26 25 24 23 22 21 20 

128 64 32 16 8 4 2 1 
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1*231+1*230+1*229 + 1*228 + 1*227 + 1*226 + 1*225 + 1*224 + 1*223 + 1*222 + 1*221 + 1*220 + 1*219 + 1*218 + 

1*217 + 1*216 + 1*215 + 1*214 + 1*213 + 1*212 + 1*211 + 1*210 + 1*29 + 1*28 + 1*27 + 1*26 + 1*25 + 1*24 + 1*23 

+ 1*22 + 1*21 + 1*20 

  

= 2،147،483،648 + 1،073،741،824 + 536،870،912 + 268،435،456 + 134،217،728 + 67،108،864 + 33،554،432 + 

16،777،216 + 8،388،608 + 4،194،304 + 2،097،152 + 1،048،576 + 524،288 + 262،144 + 131،072 + 65،536 + 32،768 

+ 16،384 + 8،192 + 4،096 + 2،048 + 1،024 + 512 + 256 + 128 + 64 + 32 + 16 + 8 + 4 + 2 + 1 

= 4،286،578،708 

یا شانزده شانزدهی( که می توان در یک گروه دوکلمه ای جای داد )ذخیره کرد(  hexadecimal)  82 کم ترین مقدار مبنای 

0x00000000000000000000000000000000  0می باشد که در آخر برابر است باx0 )به منظور به دست آوردن حداکثر )بیشینه .

 جایگزین کرد. Fیا  fای را با )یک(  bit 4که می توان با یک واژه نشان داد، باید هر گروه  82عدد مبنای 

1111 1111 1111 1111 1111 1111 1111 1111 

f f f f f f f f 

= 0xffffffff = 0xFFFFFFFF 

  

 valueاستفاده کرده و متغییر را با  varبه منظور تعریف متغییری که قادر است مقادیر بزرگ را در خود جای دهد، می توان از کلیدواژه ی 

 واه مقداردهی اولیه کرد. دلخ

    class Exercise 
    { 
        static void Main() 
        { 
            var population = 72394475; 
            System.Console.Write("Country Population: "); 
            System.Console.WriteLine(population); 
        } 
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    } 

 ی زیر به دست می آید.نتیجه 

Country Population: 72394475 
Press any key to continue… 

 های بدون علامت integerبه کار بردن 

 را اجرا کنید. Microsoft Visual Studioابتدا، برنامه ی 

 کلیک کنید. ...File -> New Projectمراجعه کرده و روی  گزینه ی  main menu(، به applicationبرای ایجاد برنامه ی کاربردی جدید )

 .را از لیست میانی انتخاب کنید Empty Projectگزینه ی 

 .را کلیک کنید okتغییر داده، سپس  gdcs3اسم مورد نظر را به 

کلیک  ...Project -> Add New Itemرا باز کرده و روی  (main menu) به منظور ایجاد فایل  برای کد مورد نظر، فهرست گزینه ی اصلی

 .کنید

 .، آن را کلیک کنیدCode Fileدر لیست میانی گزینه ای است به نام 

 .تغییر دهید CleaningOrderاسم را به 

 .را انتخاب کنید Addگزینه ی 

 .در داکیومنت خالی که در اختیار شما قرار می گیرد، دستورات زیر را تایپ کنید

 class Order 
    { 
        static void Main() 
        { 
            byte? shirts = null; 
            byte? pants = null; 
            ushort? otherItems = null; 
            shirts = 4; 
            pants = 0; 
            otherItems = 3; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.WriteLine("------------------------"); 
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            System.Console.WriteLine("Item Type  Qty"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.WriteLine(shirts); 
            System.Console.Write("Pants       "); 
            System.Console.WriteLine(pants); 
            System.Console.Write("Other Items "); 
            System.Console.WriteLine(otherItems); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 

}     

 .. برنامه را اجرا کرده تا نتایج آن را مشاهده کنید82

 Signed integers 

گنجایش ذخیره ی اطلاعات یک گروه دوکمله ای، معادل با دو برابر حجم داده ای است که می توان در یک واژه ذخیره کرد. به عبارت دیگر، 

. بنابراین، از گروه دوکلمه ای برای ذخیره ی اعداد بزرگی 4،294،967،295و یا  byte 4یا  bit 32ظرفیت ذخیره سازی آن برابر است با 

 استفاده می شود که در یک واژه جای نمی گیرد.

معرفی   int، می توان آن را با کلیدواژه ی varبرای به کار بردن متغیری که قادر است اعداد بسیار بزرگ را در خود جای دهد، جدا از کلیدواژه ی 

متغیر است، مثبت یا منفی،   2،147،484،647تا   2،147،483،648معرفی می گردد، قادر است مقادیری که از  intنوان کرد. متغیری که به ع

 جای می گیرد(. به مثال های زیر توجه کنید. bit 32را در خود ذخیره کند ) که همگی در 

    class Exercise 
    { 
        static void Main() 
        { 
            int coordX; 
            int coordY; 
            coordX = 12; 
            coordY = -8; 
            System.Console.Write("Cartesian Coordinate System: "); 
            System.Console.Write("P("); 
            System.Console.Write(coordX); 
            System.Console.Write(", "); 
            System.Console.Write(coordY); 
            System.Console.WriteLine(")\n"); 
        } 
    } 

 پس از اجرا، نتیجه ی زیر به دست می آید.



 

94 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

Cartesian Coordinate System: P(12، -8) 

مقداردهی اولیه می کنید،  2،147،484،647تعریف کرده، سپس آن را با مقداری کم تر از  varای را با کلیدواژه ی  integerزمانی که متغیر 

compiler 32رای ذخیره ی متغیر مزبور خودکار تصمیم می گیرد که حافظه ی مورد نیاز ب bit .می باشد 

 

 82، می توان از مقدار مبنای (decimal number)، به جای عدد اعشاری (integral variable)هنگام مقداردهی اولیه ی متغیر انتگرال 

(hexadecimal value ) که معادل دهدهی( استفاده کرد(decimal ) نمون 2،147،484،647آن کم تر از .)ه ی آن را در زیر مشاهده است

 .می کنید

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 0xF0488EA; 
            System.Console.Write("Number: "); 
            System.Console.WriteLine(number); 
        } 

}     

 ی زیر به دست می آید. پس از اجرا، نتیجه

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_31.gif
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Number: 251955434 
.Press any key to continue.. 

Integer  های بدون علامت 

استفاده کرد )این کلیدواژه نشانگر  uintچنانچه متغیری تنها دربردارنده ی اعداد طبیعی مثبت باشد، می توان برای تعریف آن از کلیدواژه ی 
intger یدواژه ی بدون علامت می باشد(. از کلuint  به منظور شناساییinteger  32مثبت bit  تا  0ای استفاده می شود که مقدار آن از

  .متغیر است. نمونه های آن را در زیر مشاهده می کنید 4،294،967،295
 
    class Exercise 
    { 
        static void Main() 
        { 
            uint dayOfBirth; 
            uint monthOfBirth; 
            uint yearOfBirth; 
            dayOfBirth = 8; 
            monthOfBirth = 11; 
            yearOfBirth = 1996; 
            System.Console.WriteLine("Red Oak High School"); 
            System.Console.Write("Student Date of Birth: "); 
            System.Console.Write(monthOfBirth); 
            System.Console.Write("/"); 
            System.Console.Write(dayOfBirth); 
            System.Console.Write("/"); 
            System.Console.Write(yearOfBirth); 
            System.Console.ReadKey(); 
        } 
    } 
 

 .نتیجه ی زیر حاصل می گردد

Red Oak High School 
Student Date of Birth: 11/8/1996 

 های بدون علامت integerبه کابردن 

 .به منظور استفاده از متغیرهای بدون علامت، فایل را به این ترتیب تغییر دهید

    class Order 
    { 
        static void Main() 
        { 
            byte? shirts = null; 
            byte? pants = null; 
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            ushort? otherItems = null; 
            uint? orderDay = null; 
            uint? orderMonth = null; 
            uint? orderYear = null; 
            shirts = 4; 
            pants = 0; 
            otherItems = 3; 
            orderDay = 15; 
            orderMonth = 7; 
            orderYear = 2002; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------"); 
            System.Console.WriteLine("Item Type  Qty"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.WriteLine(shirts); 
            System.Console.Write("Pants       "); 
            System.Console.WriteLine(pants); 
            System.Console.Write("Other Items "); 
            System.Console.WriteLine(otherItems); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 
    } 

 . برنامه را اجرا کنید. نتیجه ی زیر را به دست می دهد.2 

-/- Georgetown Cleaning Services -/- 
        ======================== 
        Order Date: 7/15/2002 
        ------------------------ 
        Item Type  Qty 
        ------------------------ 
        Shirts      4 
        Pants       0 
        Other Items 3 
        ======================== 

 .را ببندید DOS. پنجره ی 1
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 (Quad – wordچهارکلمه ای )

از این ترکیب با عنوان گروه ای استفاده کرد.  bit 64کلمه ای جا نمی شوند، می توان از ترکیب  برای ذخیره سازی ارقام بزرگی که در گروه دو

، 854، 036، 372، 223، 9-گروه چهار کلمه ای آن قدر بزرگ است که ارقامی که در محدوده ی  ، نیز یاد می شود.(quad-core)چهار کلمه ای 

 قرار می گیرد را می تواند در خود ذخیره کند.  807، 775، 854، 036، 372، 223، 9تا   775،808

، 372،036، 223، 9تا  647، 484، 147، 2ای که از  valueتعریف کنید و آن را با  varای را به وسیله ی کلیدواژه ی  integer چنانچه، متغیر

 ذخیره می کند.  bit21 آن را در مقدار حافظه ی  compilerمتغیر است مقداردهی اولیه کنید،  807 ،775، 854

 

 Long integers 

حافظه نیاز داشته باشد(، باید از کلید واژه های  bit 64نگه داری ارقام بسیار بزرگ را داشته باشد ) و تا برای تعریف متغیری که گنجایش 

long  وvar .استفاده کرد 

 32تنها  compilerمقداردهی اولیه کنید،  647، 484، 147، 2ای کم تر از  valueهمان طور که پیش تر نیز گفته شد، چنانچه متغیری را با 

bit ظه به آن اختصاص می دهد. حال، چنانچهحاف variable  موردنظر را باvalue  036، 372، 223، 9تا   647، 484، 147، 2ای متغیر از ،

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[4]_4.gif
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، 036، 372، 223، 9حافظه کنار می گذارد. چنانچه مقدار مورد نظر از  bit 64برای آن  compilerمقدار دهی اولیه کنید،  807، 775، 854

 پیغام خطا صادر می کند.  compilerرگ تر بود، بز 807، 775، 854

 

محدود کنید. به مثال زیر  bit 64اختصاص می دهید را به  (integral variable)به عبارت دیگر، باید مقدارهایی که به متغیر های انتگرال 

 .توجه کنید

    class Exercise 
    { 
        static void Main() 
        { 
            var countryArea = 5638648; 
            System.Console.Write("Country Area: "); 
            System.Console.Write(countryArea); 
            System.Console.Write("km2\n"); 
            System.Console.ReadKey(); 
        } 
    } 

 نتیجه ی زیر به دست می آید.

Country Area: 5638648km2 
Press any key to continue... 

 مقدار دهی اولیه کرد.( hexadecimal) 82مبنای  valueرا با  longمی توان متغیر 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002_20.gif
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، همچنین میزان حافظه یا فضای دردسترس را نشان می دهد، ولی این امر بدین معنا نیست که باید حتماً از تمام فضا longنوع داده ی 

یا  short ،intبرای تعریف متغیری استفاده کرد در رینج عددی یکسان با نوع داده های  long. برای مثال، می توان از کلیدواژه ی استفاده کرد

uint  قرار دارد. پس اگر متغیری را به عنوانlong  64معرفی کرده ولی از آن برای اعداد کوچکی که به bit  ،نیاز ندارند استفاده کنید

compiler  میزان حافظه ی لازم برای ذخیره ی مقدارهای متغیر را محاسبه کرده وبه آن اختصاص می دهد. سرانجام، آن مقدار حافظه ای خود

را اختصاص دهد )رزرو  bit 64حتماً همان  compilerنخواهد بود. اما چنانچه اصرار دارید،  bit 64که در دسترس قرارمی گیرد به اندازه ی 

 را به آن اضافه کنید. به مثال زیر توجه کنید. Lار به متغیر، پسوند کند(، حین تخصیص مقد

    class Exercise 
    { 
        static void Main() 
        { 
            long countryArea; 
            countryArea = 5638648L; 
            System.Console.Write("Country Area: "); 
            System.Console.Write(countryArea); 
            System.Console.Write("km2\n"); 
            System.Console.ReadKey(); 
        } 
    } 

 جای می گیرند.  longهمگی در یک متغیر  ushortیا  short ،int ،uintپس به خاطر داشته باشید که نوع داده های 

Unsigned long integers 

ای استفاده کرد. در برخی موارد، برای ذخیره سازی اعدادی که فقط  bit 64های مثبت و منفی از ترکیب  integerمی توان برای ذخیره سازی 

کمک گرفت. متغیری که  ulongمثبت هستند ولی بزرگ، به متغیر نیاز پیدا می کنید. به منظور معرفی چنین متغیری، می توان از نوع داده ی 

 جای دهد. bit 64متغیر است را در  615، 551، 709، 073، 744، 446، 18تا  0تعریف می شود، می تواند اعدادی را که از  ulongعنوان به 

 (real numbersاعداد حقیقی )

و بخش را نشان می دهد. یک عدد می تواند به وسیله ی یک علامت به د( decimal part)عدد حقیقی، عددی است که یک بخش اعشاری 

یاد می شود. البته، این علامت از کشوری به کشور ( decimal separator/symbol)تقسیم شده باشد، که از آن علامت با نام علامت اعشار 

 نمایش داده می شود. ).( دیگر یا زبانی به زبان دیگر متفاوت است. برای مثال، در زبان انگلیسی آمریکایی این علامت به صورت نقطه 
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هر دو طرف این علامت اعداد مقدار یک رقم را مشخص می کنند. اعدادی که در سمت راست این علامت قرار می گیرند، در واقع میزان  در 

 دقت رقم مورد نظر را نشان می دهند.

 (floating-point numbersاعداد ممیز شناور )

Integer هایی که تاکنون با آن ها برخورد داشتیم، مقدارهای اعشاری (decimal ) .را نشان نمی دادندC#  برای این منظور، مقدارهای شناور

(floating values)  را برای برنامه نویس فراهم می کند. به منظور تعریف اصلی ترین مقدار شناور، از کلیدواژه یfloat  .استفاده می کنیم

قرار می   Ã‚Â±3.4 xÃ‚Â1038تا   Ã‚Â±1.5 xÃ‚Â10âˆ’45ج معرفی می شود، قادر است اعداد حقیقی ای که در رن floatمتغیری که با 

 .ذخیره کند. مثال آن را در زیر مشاهده می کنید bit 32رقم اعشار در  4گیرند را با 

    class Exercise 
    { 
        static void Main() 
        { 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[6]_3.gif
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            float distance; 
        } 
    } 

 اراعداد با دو رقم اعش

قادر به نشان دادن آن نیست( و همچنین به دقت اعشار بیشتری  floatبود )به اندازه ای بزرگ بود که  floatچنانچه متغیری بزرگتر از ظرفیت 

 .معرفی کرد. به مثال زیر توجه کنید doubleیا  varنیاز داشت، باید متغیر نام برده را با کلید واژه های 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 62834.9023; 
            System.Console.Write("Number: "); 
            System.Console.WriteLine(number); 
            System.Console.ReadKey(); 
        } 
    } 

 .نتیجه ی زیر حاصل می گردد

Number: 62834.9023 
Press any key to continue... 

 

قرار می گیرند را  Ã‚Â±1.7 x Ã‚Â10308تا   Ã‚Â±5.0 x 10âˆ’324معرفی می شود، ارقامی که در رنج   doubleمتغیری که با کلیدواژه ی  

به دست می دهد، به  varیا  floatنتایج دقیق تری را نسبت به  doubleذخیره می کند. نوع داده ی  bit 64رقم اعشار و در  82یا  83با 

برای معرفی متغیر استفاده  floatخصوص در ارتباط با ذخیره سازی اعداد با رقم اعشار طولانی. اما چنانچه اصرار دارید، حتماً از کلیدواژه ی 

 را به مقدار اضافه کنید. Fیا  fشود، هنگام تخصیص مقدار به متغیر نام برده، پسوند 

    class Exercise 
    { 
        static void Main() 
        { 
            float distance; 
            distance = 248.38F; 
            System.Console.Write("Distance = "); 
            System.Console.Write(distance); 
            System.Console.WriteLine("km\n"); 
            System.Console.ReadKey(); 
        } 
    } 

 زیر حاصل می گردد. نتییجه
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Distance = 248.38km 

را به  Fیا  fمعرفی می شود )و مایلید که مقدار یک رقم اعشار داشته باشد(، باید پسوند  varبه خاطر داشته باشید، هنگامی که متغیری با 

 مقدار بالا اضافه کنید.

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 62834.9023F; 
            System.Console.Write("Number: "); 
            System.Console.WriteLine(number); 
            System.Console.ReadKey(); 
        } 
    } 

 مثالرا به آن ضمیمه کنید.  Dیا  dپسوند  با دو رقم اعشار شناخته شود، باید( value)حال، چنانچه مایلید مقداری 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 62834.9023D; 
            System.Console.Write("Number: "); 
            System.Console.WriteLine(number); 
            System.Console.ReadKey(); 
        } 
    } 

 به کاربردن متغیری با دو رقم اعشار

 .به منظور استفاده از مقداری با دو رقم اعشار، فایل را به صورت زیر تغییر دهید

    class Order 
    { 
        static void Main() 
        { 
            byte? shirts = null; 
            byte? pants = null; 
            ushort? otherItems = null; 
            uint? orderDay = null; 
            uint? orderMonth = null; 
            uint? orderYear = null; 
            double? mondayDiscount = null; 
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            shirts = 4; 
            pants = 0; 
            otherItems = 3; 
            orderDay = 15; 
            orderMonth = 7; 
            orderYear = 2002; 
            mondayDiscount = 0.25D; // 25% 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------"); 
            System.Console.WriteLine("Item Type  Qty"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.WriteLine(shirts); 
            System.Console.Write("Pants       "); 
            System.Console.WriteLine(pants); 
            System.Console.Write("Other Items "); 
            System.Console.WriteLine(otherItems); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Monday Discount: "); 
            System.Console.Write(mondayDiscount); 
            System.Console.WriteLine('%'); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 
    } 
 

 . برای مشاهده ی نتیجه، برنامه را اجرا کنید.2 

-/- Georgetown Cleaning Services -/- 
        ======================== 
        Order Date: 7/15/2002 
        ------------------------ 
        Item Type  Qty 
        ------------------------ 
        Shirts      4 
        Pants       0 
        Other Items 3 
        ------------------------ 
        Monday Discount: 0.25% 
        ======================== 
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 را ببندید. DOSره ی . پنج1

 Decimal 

نیاز دارند( را در  bit 128، می توان برای تعریف متغیری که قادر است مقادیر بسیار بزرگ )که برای ذخیره به ترکیب decimalاز نوع داده ی 

ذخیره می ( decimal)دهدهی  استفاده می شود. مقادیری که در متغیر decimalخود جای دهد، استفاده کرد. برای این منظور از کلیدواژه ی 

رقم دارند. به خاطر این دقت بسیار بالا، از نوع  21تا  21متغیر بوده و دقت اعشاری از   Â±7.9 xÂ1028تا   Â±1.0 xÂ10âˆ’28شود، از 

 به منظور نشان دادن ارزش پول استفاده می شود.  decimalداده ی 

را با یک عدد طبیعی مقداردهی اولیه کرد. برای این منظور، هنگام مقدار دهی اولیه، می توان آن (، decimal)پس از تعریف متغیر دهدهی 

 را به مقدار مذکور ضمیمه کنید. Mیا  mپسوند 

 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            decimal hourlySalary; 
            hourlySalary = 24.25M; 
            System.Console.Write("Hourly Salary = "); 
            System.Console.WriteLine(hourlySalary); 
            System.Console.WriteLine(); 
            System.Console.ReadKey(); 
        } 
    } 

 نتیجه ی زیر به دست می آید.

Hourly Salary = 24 

 compilerکه پیش تر بیان شد، هنگام تعریف یا مقداردهی اولیه ی متغیر حقیقی، آن پسوندی که به مقدار ضمیمه می کنید به  همان طور

 می فهماند چه نوع مقدار و چه میزان حافظه برای ذخیره سازی متغیر نام برده باید تخصیص داده شود.

 )عدد ممیز اعشار( با تنها یک رقم اعشار محسوب می شود. floating point numberرا به یدک بکشد،  Fیا  fچنانچه مقداری پسوند 
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 .)عدد ممیز اعشار( با دو رقم اعشار تلقی می گردد floating point numberرا به یدک بکشد،  Dیا  dچنانچه مقداری پسوند  

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[8]_3.gif
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 اطلاق می شود( large decimal number) را داشت، یک عدد اعشاری بزرگ Mیا  mچنانچه مقداری پسوند 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002[4]_1.gif
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 .به برنامه زیر توجه کنید

    class Program 
    { 
        static void Main() 
        { 
            System.Console.Write("560 / 672 = "); 
            System.Console.WriteLine(560 / 672); 
            System.Console.ReadKey(); 
        } 
    } 

 است. 242بر  322هدف این برنامه به دست آوردن نتیجه ی تقسیم 

560 / 672 = 0 
Press any key to continue... 

  

http://articles.tahlildadeh.com/image.axd?picture=clip_image003_11.gif
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می شناسد و  integerآن ها را به عنوان  compilerهمان طور که مشاهده می کنید، هنگامی که چنین ارقامی به برنامه داده می شوند، 

 . حال، یک روش برای تصحیح این معادله، اضافه کردن جایی برای اعشار به حداقل یکی از ارقام است.را به دست می دهد 2نتیجه ی 

 مثال

    class Program 
    { 
        static void Main() 
        { 
            System.Console.Write("560 / 672 = "); 
            System.Console.WriteLine(560.00 / 672.00); 
            System.Console.ReadKey(); 
        } 
    } 

به صورت پیش فرض،  ؟)عدد با ممیز شناور( می شناسد، اما کدام  floating-point numberمقدار را به عنوان  compilerاین بار، 

compiler  نوع داده یdouble را به کار می برد. برنامه نتیجه ی زیر را تولید می کند. 

560 / 672 = 0.833333333333333 
Press any key to continue... 

 .( پسوند مربوط را به آن اضافه کنیدdecimalیا  float ،doubleبه منظور تعیین نوع مقدار داده شده )

    class Program 
    { 
        static void Main() 
        { 
            System.Console.Write("560 / 672 = "); 
            System.Console.WriteLine(560F / 672f); 
            System.Console.ReadKey(); 
        } 
    } 

 .این بار برنامه نتیجه ی زیر را می دهد

560 / 672 = 0.8333333 
Press any key to continue... 

 decimalبه کاربردن مقادیر 

 .، فایل را به صورت زیر اصلاح کنیدdecimalی به منظور استفاده از متغیرها

    
 class Order 
    { 
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        static void Main() 
        { 
            byte? shirts = null; 
            decimal? priceOneShirt = null; 
            byte? pants = null; 
            decimal? priceAPairOfPants = null; 
            ushort? otherItems = null; 
            decimal? priceOtherItems = null; 
            uint? orderDay = null; 
            uint? orderMonth = null; 
            uint? orderYear = null; 
            double? mondayDiscount = null; 
            shirts = 5; 
            priceOneShirt = 0.95M; 
            pants = 2; 
            priceAPairOfPants = 1.95M; 
            otherItems = 3; 
            priceOtherItems = 4.55M; 
            orderDay = 15; 
            orderMonth = 7; 
            orderYear = 2002; 
            mondayDiscount = 0.25D; // 25% 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------"); 
            System.Console.WriteLine("Item Type  Qty Unit Price"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.Write(shirts); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOneShirt); 
            System.Console.Write("Pants       "); 
            System.Console.Write(pants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceAPairOfPants); 
            System.Console.Write("Other Items "); 
            System.Console.Write(otherItems); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOtherItems); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Monday Discount: "); 
            System.Console.Write(mondayDiscount); 
            System.Console.WriteLine('%'); 
            System.Console.WriteLine("========================"); 
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            System.Console.ReadKey(); 
        } 
    } 

 . برنامه را اجرا کنید. نتیجه ی زیر به دست می آید.2 

  
        -/- Georgetown Cleaning Services -/- 
        ======================== 
        Order Date: 7/15/2002 
        ------------------------ 
        Item Type  Qty Unit Price 
        ------------------------ 
        Shirts      5     0.95 
        Pants       2     1.95 
        Other Items 3     4.55 
        ------------------------ 
        Monday Discount: 0.25% 
        ======================== 

 دید.را ببن DOS. پنجره ی 1

 (Accessory Data Typeنوع داده های جانبی )

 (Stringsرشته ها )

باید آن را " همان طور که هست " در نظر بگیرد، یعنی نباید  compilerرشته یک فضای خالی، یک کاراکتر، یک کلمه یا یک گروه کلمه است که 

دستور دهید. به عبارت دقیق  compilerمستقیم غیر این را به به این که رشته از چه چیزی تشکیل شده زیاد دقت کند، مگر این که شما 

 تر، می توانید هر چه دلخواهتان است در یک رشته بگنجانید.

آغاز می شود و به آن نیز ختم می شود. نمونه ی یک رشته به این صورت می باشد : )"( اصولاً، مقدار یک رشته با علامت نقل و قول 

"Welcome to the World of C# Programming!". . برای این که یک رشته در صفحه ی کنسول نمایش داده شود، می توان آن را در

 .قرار داد ()System.Console.Writeدستور 

    
 
 class Exercise 
    { 
        static void Main() 
        { 
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            System.Console.WriteLine("Welcome to the World of C# Programming!"); 
            System.Console.ReadKey(); 
        } 
    } 

 .نتیجه ی زیر به دست می آید

Welcome to the World of C# Programming! 
Press any key to continue... 

 string)رد، باید یک متغیر رشته ممکن است مجبور به استفاده از رشته ای شوید که مقدار آن از پیش برای شما شناس نباشد. در این مو

variable ) تعریف کرد. برای این منظور، از کلیدواژه هایvar  یاstring  استفاده می شود و به دنبال آن اسم متغیر مورد نظر قرار داده می

 (initialize)مقداردهی اولیه  nullشود. می توان یک رشته را با یک فضای خالی، یک کاراکتر، یک نشانه، یک کلمه ، یک گروه کلمه یا حتی 

قرار گیرد. )" "( ای که به رشته داده می شود باید حتماً داخل علامت  (value)استفاده کرد(. مقدار  ?stringکرد ) به هیچ وجه نباید از 

 .( باشد. دو نمونه زیر را مشاهده کنیدnull)مگر این که آن مقدار 

    class Exercise 
    { 
        static void Main() 
        { 
            var team = "Real Madrid"; 
            string country = "GuinÃ©e Equatoriale"; 
            System.Console.WriteLine("Welcome to the World of C# Programming!"); 
            System.Console.Write("Team:    "); 
            System.Console.WriteLine(team); 
            System.Console.Write("Country: "); 
            System.Console.WriteLine(country); 
            System.Console.WriteLine(); 
            System.Console.ReadKey(); 
        } 
    } 

 نتیجه

Welcome to the World of C# Programming! 
Team:    Real Madrid 
Country: GuinÃ©e Equatoriale 
Press any key to continue... 
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 به کار بردن رشته ها

 .، فایل را به صورت زیر تغییر دهید(string) . برای استفاده از رشته8

    class Order 
    { 
        static void Main() 
        { 
            string customerName; 
            string customerHomePhone; 
            byte? shirts = null; 
            decimal? priceOneShirt = null; 
            byte? pants = null; 
            decimal? priceAPairOfPants = null; 
            ushort? otherItems = null; 
            decimal? priceOtherItems = null; 
            uint? orderDay = null; 
            uint? orderMonth = null; 
            uint? orderYear = null; 
            double? mondayDiscount = null; 
            customerName = "Gregory Almas"; 
            customerHomePhone = "(301) 723-4425"; 
            shirts = 5; 
            priceOneShirt = 0.95M; 
            pants = 2; 
            priceAPairOfPants = 1.95M; 
            otherItems = 3; 
            priceOtherItems = 4.55M; 
            orderDay = 15; 
            orderMonth = 7; 
            orderYear = 2002; 
            mondayDiscount = 0.25D; // 25% 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.Write("Customer:   "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Home Phone: "); 
            System.Console.WriteLine(customerHomePhone); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------"); 
            System.Console.WriteLine("Item Type  Qty Unit Price"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
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            System.Console.Write(shirts); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOneShirt); 
            System.Console.Write("Pants       "); 
            System.Console.Write(pants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceAPairOfPants); 
            System.Console.Write("Other Items "); 
            System.Console.Write(otherItems); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOtherItems); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Monday Discount: "); 
            System.Console.Write(mondayDiscount); 
            System.Console.WriteLine('%'); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 
    } 

 .. حال، برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد2

-/- Georgetown Cleaning Services -/- 
        ======================== 
        Customer:   Gregory Almas 
        Home Phone: (301) 723-4425 
        Order Date: 7/15/2002 
        ------------------------ 
        Item Type  Qty Unit Price 
        ------------------------ 
        Shirts      5     0.95 
        Pants       2     1.95 
        Other Items 3     4.55 
        ------------------------ 
        Monday Discount: 0.25% 
        ======================== 

 .را ببندید DOS. اکنون می توانید پنجره ی 1
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 تاریخ و زمان 

تاریخ در واقع واحدی برای سنجش تعداد روزها، ماه ها، سال هایی است که در یک برهه ی مشخصی از زمان سپری شده. زمان نیز واحدی برای 

عداد ثانیه هایی است که از نیمه شب روز معین تا کنون سپری شده. به منظور تعریف متغیری ویژه ی زمان و تاریخ، باید از نوع داده شمارش ت

  بهره گرفت.  DateTimeی 

    class Exercise 
    { 
        static void Main() 
        { 
            DateTime DateHired; 
        } 
    } 
 

.NET Framework  تاریخ شروع یک دوره را بهJanuary 1، 0001 0:00، نیمه شب AM)  تنظیم می کند. چنانچه مقدار  12:00:00)یا

 نیمه شب، مقدار دهی اولیه می شود. 1/1/0001مشخصی به آن اختصاص داده نشده باشد، متغیر با  

 (Objectsشی ها )

به کار می رود که نوع آن از پیش تعیین نشده و ممکن است نوع آن هر یک از نوع داده هایی که  به منظور تعریف متغیری Objectنوع داده ی 

(، می توان مقدار آن را هر گونه که مایلید به کارببردید. برای object variableدر این مبحث تعریف کردیم باشد. پس از تعریف متغیر شی )

قرار داد تا در صفحه  ()System.Console.WriteLineیا  ()System.Console.Writeهای مثال، می توان متغیر موردنظر را داخل پرانتز

 ی کنسول به نمایش گذاشته شود.

    class Exercise 
    { 
        static void Main() 
        { 
            var EmployeeName = "Ernestine Lamb"; 
            object Address = "10244 Lockwood Drive"; 
            System.Console.Write("Employee Name: "); 
            System.Console.WriteLine(EmployeeName); 
            System.Console.Write("Home Address:  "); 
            System.Console.WriteLine(Address); 
            System.Console.WriteLine(); 
            System.Console.ReadKey(); 
        } 
    } 

 نتیجه ی زیر به دست می آید.
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Employee Name: Ernestine Lamb 
Home Address:  10244 Lockwood Drive 
Press any key to continue... 

 تعریف شود، قادر است هر مقداری را در خود جای دهد. objectمتغیری که با نوع داده ی 

    class Program 
    { 
        static void Main() 
        { 
            object propertyNumber = "293749"; 
            object propertyType = 'S'; 
            object stories = 3; 
            object bedrooms = 4; 
            object value = 425880; 
            System.Console.WriteLine("=//= Altair Realtors =//="); 
            System.Console.WriteLine("Properties Inventory"); 
            System.Console.Write("Property #:    "); 
            System.Console.WriteLine(propertyNumber); 
            System.Console.Write("Property Type:  "); 
            System.Console.WriteLine(propertyType); 
            System.Console.Write("Stories:        "); 
            System.Console.WriteLine(stories); 
            System.Console.Write("Bedrooms:       "); 
            System.Console.WriteLine(bedrooms); 
            System.Console.Write("Market Value:   "); 
            System.Console.WriteLine(value); 
            System.Console.ReadKey(); 
        } 
    } 

 .نتیجه ی زیر به دست می آید 
 
        =//= Altair Realtors =//= 
        Properties Inventory 
        Property #:    293749 
        Property Type:  S 
        Stories:        3 
        Bedrooms:       4 
      Market Value:   425880 
        Press any key to continue... 

 (constantsثابت ها )

 را بارها و بارها استفاده کنید. 39.37فرض کنید باید رقمی همچون 
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 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            double meter, inch; 
            meter = 12.52D; 
            inch = meter * 39.37D; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            System.Console.ReadKey(); 
        } 
    } 

 .جرا را در زیر مشاهده می کنیدنمونه ای از برنامه ی در حال ا

12.52m = 492.9124in 

 . برنامه ی زیر را در نظر بگیرد.3.937یا  3937تایپ کنید  11.14در صورت استفاده مکرر از این رقم، ممکن است اشتباهی کرده و به جای 

    class Exercise 
    { 
        static void Main() 
        { 
            double meter, inch; 
            meter = 12.52D; 
            inch = meter * 39.37; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            meter = 12.52D; 
            inch = meter * 3.937; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            meter = 12.52D; 
            inch = meter * 393.7; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            System.Console.ReadKey(); 
        } 
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    } 

 .زیر حاصل می گردد نتیجه ی 

82.32m = 492.9124in 
 82.32m = 49.29124in 
 82.32m = 4929.124in 

 

 یبه خاطر اشتباهاتی از این دست، همان محاسبه ممکن است نتایجی کاملاً متفاوت تولید کند. به منظور جلوگیری از خطاهایی از این دسته، م

مقدار استفاده کرد. حال، در صورت نیاز می توان به جای خود مقدار، به متغیر آن به راحتی توان از یک متغیر )به جای ثابت( برای ذخیره کردن 

 است.( constant)یک ثابت  39.37دسترسی پیدا کرد. لازم به ذکر است که رقمی همچون 

را  (variable)یک متغیر  می توان.  Trueحتی  یاASEC Mimosa"، 39.37"، 244ثابت مقداری است که هیچگاه تغییر نمی کند، مانند : 

 تغییر نکند. ( constant)طوری تعریف کرد و به کاربرد که مقدار آن مانند ثابت 

را در سمت چپ آن تایپ کنید. به خاطر داشته باشید که حین تعریف ثابت، باید مقدار  constبه منظور ایجاد یک ثابت، باید کلیدواژه ی 

 مناسب به آن اختصاص داد.

 مثال

const double ConversionFactor = 39.37D; 

ر زیر پس از ایجاد ثابت مورد نظر و مقداردهی اولیه ی مناسب آن، می توان اسم آن را در جایی که ثابت دلخواه باید قرار می گرفت وارد کرد. د

 ، که بارها استفاده شده مشاهده می کنید.(constant variable) نمونه ای از متغیر ثابت

    class Exercise 
    { 
        static void Main() 
        { 
            const double ConversionFactor = 39.37D; 
            double meter, inch; 
            meter = 12.52D; 
            inch = meter * ConversionFactor; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            meter = 12.52D; 
            inch = meter * ConversionFactor; 
            System.Console.Write(meter); 
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            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            meter = 12.52D; 
            inch = meter * ConversionFactor; 
            System.Console.Write(meter); 
            System.Console.Write("m = "); 
            System.Console.Write(inch); 
            System.Console.WriteLine("in\n"); 
            System.Console.ReadKey(); 
        } 

}     

 نتیجه ی زیر به دست می آید. 

82.32m = 492.9124in 
82.32m = 492.9124in 
82.32m = 492.9124in 

 

همان طور که مشاهده می کنید، این بار نتیجه دقیق تر درآمده است. همچنین اگر چیزی را اشتباه تایپ کنید، یک پیغام خطا صادر می شود  

 می دهد تا مشکل را برطرف کنید. که سر انجام زمان بیشتری در اختیار شما قرار

قرار می گیرد، باید حتماً یک ثابت یا مقداری باشد  =به منظور مقداردهی اولیه ی یک متغیر ثابت، مقداری که در سمت راست عملگر جایگزین 

که از پیش به عنوان ثابت به عنوان ثابت بشناسد. به جای استفاده از یک ثابت شناس، می توان متغیری به آن اختصاص داد  compilerکه 

 تعریف شده.

 ثابت های توکار

ثابت های مختص  #Cدر برنامه ها دو دسته ی اصلی ثابت کاربرد فراوان دارند. می توانید خود یک ثابت خلق کنید )مانند مثال بالا(. زبان 

گرفته می شوند. پیش از به  NET Framework.هستند و برخی دیگر از برنامه ی #Cخود را دارد. برخی از ثابت ها متعلق به خود زبان 

خود  کاربردن یک ثابت، ابتدا باید از وجود ثابت اطمینان کسب کنید. دوم، باید از نحوه ی دسترسی به آن آگاه باشید. ثابتی که بخشی از

تعریف می شوند  Systemی اسمی است به راحتی از طریق کد قابل دسترسی می باشد )به طور معمول، ثابت های مزبور در فضا #Cبرنامه ی 

.) 

Null  این کلیدواژه :(Null )نشان دادن متغیری استفاده می شود که مقدار مشخص و شناسی ندارد.  در واقع یک ثابت است و برای 
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PI  ریاضی است و برای: ثابتی است که برای نشان دادن نسبت محیط دایره به قطر آن به کار می رود. البته کاربرد این ثابت بیشتر در علم 

 را تایپ کنید.  Math.PIاستفاده از آن در برنامه نویسی باید 

 مدیریت کد

 یابزار اصلی نوشتن برنامه، نوشتن و وارد کردن کد در داکیومنت است. این کار با نوشتن و وارد کردن کد از طریق صفحه کلید امکان پذیر م

 ی توان روی آن انجام داد. معمولاً اولین کاری که باید انجام داد، انتخاب متن است. باشد. پس از به وجود آوردن کد، عملیات مختلف م

 دسترسی پیدا کردن به متغیر

نوشت.  Microsoft Visual Studioبرنامه ی  code editorیا  Notepadهمان طور که از قبل گفته شد، کد را می توان در برنامه هایی مثل 

 کلیک کنید. ...Edit -> Findمراجعه کرده و روی گزینه ی  main menuنه، کلمه در یک داکیومنت باید به برای پیدا کردن کاراکتر، نشا

 

کلیک  Findای نمایش داده می شود، که می توان در آن نام آیتم موردنظر را وارد کرده، سپس روی گزینه ی ( dialog box)پنجره ی محاوره  

استفاده می کنید برای پیدا کردن تمام کاراکترهای یک متن )منظور یک کاراکتر است که  Microsoft Visual Studioکنید. اگر از برنامه ی 

 چند بار در یک متن تکرار شده(، ابتدا آیتم مورد نظر را انتخاب کرده، سپس

Main menu  را باز کرده، و گزینه یEdit -> Quick Find .را انتخاب کنید 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_32.gif
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 دهید.را باهم فشار  Ctrl + Fحال، 

پیدا  به همین شیوه، چنانچه متغیری دارید که چند بار در یک متن به کار رفته و می خواهید تمام جاهایی که این متغیر در آن ها به کارفته را

 کنید، کافی است روی نام آن کلیک کرده و دو ثانیه صبر کنید تا تمام متغیرهای موردنظر یافت شوند ) و برجسته شوند(.

 

دستورات زیر را   Microsoft Visual Studioه منظور دریافت فهرستی از تمام مکان هایی که متغیر در آن به کار رفته، در برنامه ی  اکنون، ب

  دنبال کنید :

را انتخاب کنید. Find All References، اسم متغیر را راست کلیک کرده، سپس گزینه ی Code Editor. در 1

http://articles.tahlildadeh.com/image.axd?picture=clip_image002_21.gif
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2 .Ctrl + F12فشار دهید. ، را با هم 

 . نمایش داده می شود Symbol Results( Findدر نتیجه ی این کار، لیستی از تمام بخش هایی که متغیر در آن به کار رفته )در پنجره ی 

http://articles.tahlildadeh.com/image.axd?picture=clip_image003_12.gif
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 حال، به منظور دستیابی به بخشی که متغیر در آن به کار برده شده، روی ورودی آن دوبار کلیک کنید.

 کد بریدن، کپی کردن و جای گذاری

 Microsoft( آشنا است. این عملیات برای ذخیره سازی کد در cut ،copy ،pasteهر شخصی که با کامپیوتر کار کرده، با این عملیات )

Visual Studio  بسیار پرکاربرد هستند. به عبارت دیگر، چنانچه کدی دارید که مایلید در بخش های مختلف استفاده کنید، می توانید آن را

 به صورت ذخیره نگه داشته و هر زمان که به آن نیاز پیدا کردید از آن استفاده کنید. در جایی 

 Microsoft Visualبرنامه ی  code editorیا  word ،notepadابتدا، به منظور ذخیره سازی کد، کد را در هر برنامه ی ویرایش متنی مثل 

Studio را روی  تایپ کنید. کدِ نام برده را انتخاب کرده، سپس آنclipboard  کپی کنید. حال، برای حفظ کردن آن، )درMicrosoft Visual 

Studio )Toolbox ( را باز کنیدmain menu  را باز کرده، رویView -> Toolbox  یک فضای خالی را در .)کلیک کنیدtoolbox  انتخاب

 را فشار دهید. pasteکرده، روی آن راست کلیک کنید و بعد گزینه ی 

http://articles.tahlildadeh.com/image.axd?picture=clip_image004_15.gif
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رها کنید. به همین  Toolboxیوه ی دیگر انجام این کار، این است که کد دلخواه را انتخاب کرده، سپس آن را بکشید و روی صفحه ی ش 

، کد موردنظر قابل دسترس می Toolboxاضافه کنید. پس از جای گذاری کد در  Toolboxهای مختلفی به  code itemشیوه، می توانید 

 قرار دهید. code editorگرفته و روی قسمت مورد نظر در  Toolboxفاده از کد، آن را از شود. حال، به منظور است

 تغییر اسم متغیر

به منظور تغییر اسم آیتمی در کامپیوتر، ابتدا باید آن را پیدا کرده، سپس آن را ویرایش کنید. چنانچه آن اسم در قسمت های مختلفی به 

ه ی آن ها گشت و آن ها را ویرایش کرد. احتمال خطا کردن در این مورد بسیار بالا است. اگر کد خود را کارفته، همچنان می توان به دنبال هم

از همین روش  پیدا کرده و ویرایش کنید. Edit -> Replaceمی نویسید، می توانید تمام نمونه های آن اسم را با گزینه ی  text editor با 

کرد. متأسفانه این روش تنها برای یک فایل کارگر است. در صورتی که پروژه ی شما فایل های متعددی نیز استفاده  code editorمی توان در 

 دارد، واسم ها در آن فایل ها ذخیره شده باشند، این فرایند بسیار دشوار می گردد. 

 سان می سازد. کد زیر را در نظر بگیرد.فرایند پیدا کردن و تغییر دادن اسم را فوق العاده آ، Microsoft Visual Studioاما برنامه ی 

    class Order 

http://articles.tahlildadeh.com/image.axd?picture=clip_image005_8.gif
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    { 
        static void Main() 
        { 
            int nbr = 148; 
            System.Console.WriteLine(nbr); 
        } 
    } 

 دستورات زیر را انجام دهید. code editorبه منظور تغییر اسم یک متغیر، در 

 پدیدار می شود.(  _ underline)اسم موردنظر دوبار کلیک کرده، آن را ویرایش کنید. زیر اسم موردنظر یک خط زیرین  روی

 

آن، فهرست گزینه ی کوچکی ( arrow)اگر نشان گر موس خود را روی آن قرار دهید، تگی پدیدار می شود که با کلیک کردن روی پیکان  

 نمایان می شود.

 

نمایش داده  (next)نه ی اول کلیک کنید، تمام نمونه های آن متغیر عوض می شوند. حال، اگر می خواهید پنجره ی پیش نمایش اگر روی گزی 

 شود، روی گزینه ی دوم کلیک کنید.

http://articles.tahlildadeh.com/image.axd?picture=clip_image006_10.gif
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 را کلیک کنید. renameدهید، سپس گزینه ی  قرارRefactor روی آن راست کلیک کرده، نشان گر موس را روی 

  

 

روی گزینه  Comment check boxها تغییر دهد، در  comment، اسم ها را پیدا کرده و آن ها را در داخل studioد برنامه ی اگر می خواهی 

روی گزینه  Strings checkboxکلیک کنید. چنانچه، اسم در رشته ها نگه داشته می شود و شما خواهان تغییر آن هستید، در  Searchی 

روی صفحه  Preview Changes-rename (،dialog box) را اتنخاب کردید، پنجره ی محاوره okاینکه شما کلیک کنید. پس از  searchی 

به نمایش پدیدار می گردد. پنجره ی بالا تمام جاهایی که اسم در آن به کار رفته را برای شما به نمایش می گذارد. حال، می توانید اسم را 

 دلخواه تغییر دهید.

http://articles.tahlildadeh.com/image.axd?picture=clip_image009_17.jpg
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 را فشار دهید. Applyر جایگزین کردن اسم دکمه ی اکنون، به منظو

 (Variable's Declarationدسترسی پیدا کردن به تعریف متغیر )

چنانچه داکیومنتی بسیار طولانی در اختیار دارید که از خطوط بسیار زیادی تشکیل شده، در یک بخش خاص ممکن است با متغیری مواجه 

، به Microsoft Visual Studioشده برای شما برای شما شناس نیست. حال، در صورت استفاده از  شوید که مکانی که متغیر در آن تعریف

 منظور یافتن مکانی که متغیر در آن تعریف شده.

 را انتخاب کنید. Go to definitionروی متغیر موردنظر کلیک راست کرده، سپس گزینه ی 

http://articles.tahlildadeh.com/image.axd?picture=clip_image010_6.gif
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 را با هم فشار دهید. Shift + F2روی اسم متغیر کلیک کرده و کلید های  

 در هر دو صورت، برنامه شما را مستقیم به جایی که متغیر در آن تعریف شده می برد.

http://articles.tahlildadeh.com/image.axd?picture=clip_image011_2.gif
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 دسترسی به خطی از کد از طریق اندیس آن

شما را ، چنانچه داکیومنتی ایجاد کرده اید که خطوط فراوانی دارد و اگر می خواهید برنامه Microsoft Visual Studioدر صورت استفاده از 

 مستقیم به خط معینی از کد ببرد.

Main menu  را باز کرده، گزینه یEdit -> Go To... .را انتخاب کنید 

 را باهم فشار دهید. Ctrl + Gکلیدهای 

 حال، پنجره ی محاوره ای نمایان می گردد که شما می توانید با وارد کردن شماره ی خط در آن، خط مزبور را پیدا کنید.

 #Cاساسی عملگرهای 

 مقدمه

، عملیاتی است که به منظور اصلاح مقدار متغیر موجود، )یا ایجاد مقداری جدید با ترکیب مقدارهای جاری(، operationدر برنامه نویسی منظور از 

کان پذیر می شود. ام (value)و یک مقدار  (symbol)با استفاده از حداقل یک نشانه  operationروی مقدار معینی انجام می شود. بنابراین، 

 operandخوانده می شود. حال، مقداری که در عملیات نام برده استفاده شده  ))عملگر operatorنشانه ای که در عملیات به کار برده شده، 

 وند( گفته می شود. )عمل

Unary operator نانچه، عملگری عملیات مورد نیاز را )عملگر یگانی(، عملگری است که عملیات خود را روی تنها یک عملوند انجام می دهد.چ

 )عملگر دوگانی( اطلاق می گردد. binary operandروی دو عملوند انجام دهد، 

 معرفی عملگرها و عملوندها

 .را راه اندازی کنید Microsoft Visual Studioابتدا، برنامه ی  .8

کلیک ...File -> New Project کرده، سپس روی گزینه ی به منظور ایجاد برنامه ی کاربردی جدید، به فهرست گزینه ی اصلی مراجعه  .2

 .کنید

 .از فهرست میانی انتخاب کنید راEmpty Project گزینه ی  .1

 .کلیک کنید okتغییر داده، روی   gdcs4اسم را به  .4

 .کنیدرا انتخاب  ...Project -> Add New Itemرا باز کرده، سپس   main menuبرای ایجاد فایل ویژه ی کد مورد نظر، .5
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6. Code File را از لیست میانی انتخاب کنید. 

 .تغییر دهید CleaningOrderاسم را به  .4

 .را انتخاب کنید Addحال، گزینه ی  .1

{ } 

می باشد. از این علامت به منظور ایجاد بخشی از یک کد استفاده می شود.  #Cاین علامت در واقع پرکاربردترین و کارامدترین عملگر در زبان 

، کلاس ها، ساختارها و استثنات است. البته، می توان (name space)تیب، وظیفه ی آن تعیین حد و مرز و سامان دهی فضای نامی به این تر

 نیز استفاده می شود. (variable scope)آن را به دلخواه در دستورهای شرطی به کاربرد. از عملگر مزبور، به منظور ایجاد محدوده ی متغیر 

 از }{ نحوه ی استفاده

 در فایل خالی که در اختیار شما قرار داده می شود، دستور زیر را وارد کنید.

  class Order 
    { 
    } 

 پرانتز )(

می توان  خاص است. برای مثال، با پرانتز (entity)از عملگر پرانتز به منظور جداسازی گروهی از اقلام به کار می رود که متعلق به یک موجودیت 

 از یک متغیر عادی جدا کرد. مثال زیر را در نظر بگیرید. راMain متد 

    class Order 
    { 
        static void Main() 
        { 
        } 

}     

 )عبارت( نیز استفاده کرد. expression)عملیات( یا  operationاز عملگر پرانتز می توان به منظور جداسازی 

  انتزنحوه ی استفاده از عملگر پر

 برای به کاربردن این عملگر، اقدامات زیر را انجام دهید.
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class Order 
{ 
    static void Main() 
    { 
    } 
} 

 " ;عملگر نقطه ویرگول " 

 علامت نقطه ویرگول، نشانگر اتمام یک عبارت یا تعریف است.

 مثال

number; int 

  نحوه ی به کاربردن نقطه ویرگول

 اختیار شما قرار داده می شود، دستورات زیر را تایپ کنید. در فایل خالی که در

    class Order 
    { 
        static void Main() 
        { 
            double mondayDiscount; 
        } 

}     

 عملگر ویرگول "، " 

مک ویرگول می توان اسم متغیرهایی که با یک نوع داده تعریف ویرگول به منظور جداسازی متغیرهای یک گروه به کار می رود. برای مثال، با ک

 شده را از هم جدا کرد. به مثال زیر توجه کنید. 

 
    class Exercise 
    { 
        static void Main() 
        { 
            string firstName, lastName, fullName; 
        } 

}     
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 یا آرگومان های یک متد نیز استفاده کرد. enumerationر جداسازی اعضای یک از ویرگول می توان به منظو

 استفاده از ویرگول

 برای این منظور، فایل مربوطه را به صورت زیر تغییر دهید.

    class Order 
    { 
        static void Main() 
        { 
            string customerName, homePhone; 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            decimal priceOneShirt, priceAPairOfPants, priceOneDress; 
            uint orderMonth, orderDay, orderYear; 
            double mondayDiscount; 
        } 
    } 

 عملگر جایگزین )=(

مقدار مشخصی از حافظه ی کامپیوتر را به آن اختصاص می دهد. حال، آن میزان حافظه تا زمانی که شما آن را  compilerتغیر، پس از تعریف م

 " = "ن با مقدار معینی پر نکرده اید، خالی می ماند. برای قرار دادن مقداری در حافظه ی اختصاص داده شده به متغیر، می توان از عملگر جایگزی

 دستور نحوی آن به این شکل است. بهره گرفت.

VariableName = Value 

یا رشته ای که  (numeric value)باید اسم متغیر معتبری باشد. توجه داشته باشید که نمی توان از مقدار عددی  VariableNameفاکتور 

 به متغیر اختصاص داده. در مثال زیر یک مقدار عددی قرار داده شده باشد، برای این منظور استفاده کرد.  " "داخل 

    class Exercise 
    { 
        static void Main() 
        { 
            decimal salary; 
            // Using the assignment operator 
            salary = 12.55M; 
        } 
    } 

 ()WriteLineیا  ()Writeده شد، می توان برای مشاهده ی )نمایش( مقدار آن پس از این که متغیری تعریف شد و مقداری به آن اختصاص دا

 را فراخواند.
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 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            decimal salary; 
            // Using the assignment operator 
            salary = 12.55M; 
            System.Console.Write("Employee's Hourly Salary: "); 
            System.Console.WriteLine(salary); 
            System.Console.ReadKey(); 
        } 

}     

 نتیجه ی زیر به دست می آید.

Employee's Hourly Salary: $12.55 

پس مقدار را به آن تخصیص داده است.این رویه زمانی دنبال می شود که، بخواهید مقدار یک متغیر را کُدِ فوق ابتدا متغیر را تعریف کرده، س

 یاد می شود. initializingتغییر دهید. از فرایند تخصیص مقداری به متغیر، پس از اینکه متغیر تعریف شده، با نام مقداردهی اولیه یا 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            // Using the assignment operator 
            decimal salary = 12.55M; 
            System.Console.Write("Employee's Hourly Salary: "); 
            System.Console.WriteLine(salary); 
            System.Console.ReadKey(); 
        } 

}     

 از همان طور که پیش تر ذکر شد، می توان چند متغیر را با استفاده از تنها یک نوع داده همزمان تعریف کرد، سپس اسامی آن ها را با ویرگول

یه دلخواه و پیش از عملگر ویرگول یا نقطه ویرگول، مقداردهی اول valueهم جدا کرد. حین انجام این عملیات، همچنین می توان هر متغیر را با 

 کرد. به مثال زیر توجه کنید.

    class Exercise 
    { 
        static void Main() 
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        { 
            // Initializing various variables when declaring them with the same data type 
            double value1 = 224.58, value2 = 1548.26; 
            System.Console.Write("Value 1 = "); 
            System.Console.WriteLine(value1); 
            System.Console.Write("Value 2 = "); 
            System.Console.WriteLine(value2); 
            System.Console.WriteLine(); 
            System.Console.ReadKey(); 
        } 

}     

 نتیجه

Value 1 = 224.58 
Value 2 = 1548.26 

 نحوه ی تخصیص مقدار به متغیر

 ، فایل مرتبط را این گونه اصلاح کنید.=به منظور استفاده از عملگر جایگزین 

    class Order 
    { 
        static void Main() 
        { 
            string customerName, homePhone; 
            uint numberOfShirts = 5, numberOfPants = 2, numberOfDresses = 0; 
            decimal priceOneShirt = 0.95M, priceAPairOfPants = 2.95M, priceOneDress = 4.55M; 
            uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
            double mondayDiscount = 0.25; // 25%; 
        } 

}     

 ( ')علامت 

 تعریف شده باشد. charبه منظور دخیل کردن یک کاراکتر برای مقداردهی اولیه ی متغیری به کار می رود که با نوع داده ی  (')از 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            char gender; 
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            string firstName, lastName, fullName; 
            gender = 'M'; 
        } 

}     

 قرار داد. به عبارت دیگر، جمیع نشانه های به کاربرده شده  نباید به بیشتر از یک کاراکتر ارزیابی شود. ' ' نمی توان بیش از یک کاراکتر داخل

 مثال

class Exercise 
{ 
    static void Main() 
    { 
        System.Console.WriteLine('\n'); 
    } 
} 

 علامت )"(

می توان یک فضای خالی، یک کاراکتر، یک کلمه یا یک  " "استفاده می شود. داخل  (string)از این علامت به منظور تعیین حد و مرز یک رشته 

 یر توجه کنید.، یک رشته را تشکیل می دهد. به مثال ز" "گروه کلمه قرار داد. جمیع این اقلام داخل 

class Exercise 
{ 
    static void Main() 
    { 
        System.Console.WriteLine("The Wonderful World of C#!!!"); 
    } 
} 

 استفاده از علامت نقل و قول

 برای این منظور اقدامات زیر را انجام دهید. .8

class Order 
{ 
    static void Main() 
    { 
        string customerName = "James Burreck", 
        homePhone = "(202) 301-7030"; 
        uint numberOfShirts = 1, 
        numberOfPants = 1, 
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        numberOfDresses = 1; 
        decimal priceOneShirt = 0.95M, 
        priceAPairOfPants = 2.95M, 
        priceOneDress = 4.55M; 
        uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
        double mondayDiscount = 0.25; // 25%; 
        System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
        System.Console.WriteLine("========================"); 
        System.Console.Write("Customer:   "); 
        System.Console.WriteLine(customerName); 
        System.Console.Write("Home Phone: "); 
        System.Console.WriteLine(homePhone); 
        System.Console.Write("Order Date: "); 
        System.Console.Write(orderMonth); 
        System.Console.Write('/'); 
        System.Console.Write(orderDay); 
        System.Console.Write('/'); 
        System.Console.WriteLine(orderYear); 
        System.Console.WriteLine("------------------------"); 
        System.Console.WriteLine("Item Type  Qty Sub-Total"); 
        System.Console.WriteLine("------------------------"); 
        System.Console.Write("Shirts      "); 
        System.Console.Write(numberOfShirts); 
        System.Console.Write("     "); 
        System.Console.WriteLine(priceOneShirt); 
        System.Console.Write("Pants       "); 
        System.Console.Write(numberOfPants); 
        System.Console.Write("     "); 
        System.Console.WriteLine(priceAPairOfPants); 
        System.Console.Write("Dresses     "); 
        System.Console.Write(numberOfDresses); 
        System.Console.Write("     "); 
        System.Console.WriteLine(priceOneDress); 
        System.Console.WriteLine("------------------------"); 
        System.Console.Write("Monday Discount: "); 
        System.Console.Write(mondayDiscount); 
        System.Console.WriteLine('%'); 
        System.Console.WriteLine("========================"); 
        System.Console.ReadKey(); 
    } 
} 

 برای مشاهده ی نتیجه برنامه را اجرا کنید. این نتیجه حاصل می گردد. .2
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-/- Georgetown Cleaning Services -/- 
======================== 
Customer:   James Burreck 
Home Phone: (202) 301-7030 
Order Date: 3/15/2002 
------------------------ 
Item Type  Qty Sub-Total 
------------------------ 
Shirts      1     0.95 
Pants       1     2.95 
Dresses     1     4.55 
------------------------ 
Monday Discount: 0.25% 
======================== 

 به محیط برنامه نویسی بازگردید. Enterحال، با زدن کلید  .1

 []کروشه 

عد یک آرایه استفاده می شود. درباره ی کاربرد این عملگر در بخش آرایه ها بحث ی مدیریت و کنترل اندیس یا بٌاز این علامت بیشتر زمان ها برا

 می کنیم.

 عملگر مثبت )+(

قرار دارد. حال، ارقامی که در سمت چپ صفر  2علم جبر برای دسته بندی ارقام از یک جور خط کش استفاده می کند. وسط این خط کش عدد 

 یرند منفی تلقی می شوند و ارقامی که در سمت راست جای گرفته اند مثبت.قرار می گ

-∞   -6 -5 -4 -3 -2 -1   1 2 3 4 5 6   +∞ 

   0 

-∞   -6 -5 -4 -3 -2 -1   1 2 3 4 5 6   +∞ 

. در این 90335+، 228+، 4+نمایش داده می شوند :  +قرار دارد مثبت محسوب می شود. اعداد مثبت با علامت  2مقداری که در سمت راست 

تاثیر می گذارد. توجه داشته  (operand)حساب می شود، زیرا بر تنها یک عملوند  (unary operator)در واقع یک عملگر یگانی  +مورد، 

 باید همیشه سمت چپ عملوند قرار گیرد و نه سمت راست آن. +باشید که عملگر 
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می شود، و اگر عددی بدون هیچگونه علامت خاص نوشته شود، به طور معمول مثبت تلقی می البته، در علم ریاضی این علامت نشان داده ن

. به خاطر این که مقدار فوق هیچ گونه علامتی 90335، 4،228را می توان به این صورت نیز نوشت :   90335+و  228+،4+گردد. پس ارقام 

 انند.، یا بدون علامت می خوunsignedرا به  یدک نمی کشد، آن را 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            // Displaying an unsigned number 
            System.Console.Write("Number = "); 
            System.Console.WriteLine(+802); 
        } 

}     

 نتیجه

Number = 802 

 (-عملگر منفی )

 -همان طور که در خط کش بالا مشاهده می کنید، برای نشان دادن هر عددی که در سمت چپ صفر قرار می گیرد، مجبور به استفاده از علامت 

. عددی که با این علامت همراه باشد منفی اطلاق می شود. برخلاف عدد مثبت، عدد منفی باید با نشان مناسب -32706، -448، -12هستیم : 

 راه باشد. برای منفی کردن یک عدد مثبت هم کافی است فقط یک علامت منفی به آن اضافه کنید.هم (-)

    class Exercise 
    { 
        static void Main() 
        { 
            // Displaying an unsigned number 
            System.Console.Write("First Number  "); 
            System.Console.WriteLine(+802); 
            // Displaying a negative number 
            System.Console.Write("Second Number "); 
            System.Console.WriteLine(-802); 
        } 

}     

 نتیجه
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First Number  802 
Second Number -802 

 عملگر عملگرهای یگانی : اندازه ی

 را برای محاسبه ی مقدار حافظه ی مورد نیاز یک نوع داده، در اختیار برنامه نویس قرار می دهد. sizeof عملگر یگانی  #Cزبان 

 را داخل پرانتز عملگر مذکور قرار داد. (data type)به منظور محاسبه مقدار حافظه ی مورد نیاز یک نوع داده ی خاص، باید آن 

 مثال

 
    class Exercise 
    { 
        static void Main() 
        { 
            double period = 155.50; 
            int size = sizeof(double); 
            System.Console.Write("The value "); 
            System.Console.Write(period); 
            System.Console.Write(" uses "); 
            System.Console.Write(size); 
            System.Console.WriteLine(" bytes\n"); 
        } 

}     

 نتیجه

The value 155.5 uses 8 bytes 

 زیر نمونه های بیشتری را مشاهده می کنید.

  class Exercise 
    { 
        static void Main() 
        { 
            // Thesizeof operator used to get the memory size used by  
            // a variable declared with a certain a data type 
            System.Console.WriteLine("The sizeof Operator"); 
            System.Console.WriteLine("=========================="); 
            System.Console.WriteLine("Data Type     Memory Size"); 
            System.Console.WriteLine("--------------------------"); 
            System.Console.Write("char           "); 
            System.Console.Write(sizeof(char)); 
            System.Console.WriteLine("  Bytes"); 
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            System.Console.Write("bool           "); 
            System.Console.Write(sizeof(bool)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("int            "); 
            System.Console.Write(sizeof(int)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("uint           "); 
            System.Console.Write(sizeof(uint)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("short          "); 
            System.Console.Write(sizeof(short)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("ushort         ");  
            System.Console.Write(sizeof(ushort)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("byte           "); 
            System.Console.Write(sizeof(byte)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("sbyte          "); 
            System.Console.Write(sizeof(sbyte)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("float          "); 
            System.Console.Write(sizeof(float)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("double         "); 
            System.Console.Write(sizeof(double)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("decimal        "); 
            System.Console.Write(sizeof(decimal)); 
            System.Console.WriteLine(" Bytes"); 
            System.Console.Write("long           "); 
            System.Console.Write(sizeof(long)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.Write("ulong          "); 
            System.Console.Write(sizeof(ulong)); 
            System.Console.WriteLine("  Bytes"); 
            System.Console.WriteLine("==========================="); 
            System.Console.WriteLine(); 
            System.Console.ReadKey(); 
        } 
    } 

 نتیجه

The sizeof Operator 
========================== 
Data Type     Memory Size 
-------------------------- 
char            2 Bytes 
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bool            1 Bytes 
int             4 Bytes 
uint            4 Bytes 
short           2 Bytes 
ushort          2 Bytes 
byte            1 Bytes 
sbyte           1 Bytes 
float           4 Bytes 
double          8 Bytes 
decimal        16 Bytes 
long            8 Bytes 
ulong           8 Bytes 
=========================== 

 عمل جمع

یا عمل جمع بهره می  addition operationاد دفعه ای که لازم باشد(، از زمانی که بخواهیم دو چیز هم نوع را به هم اضافه کنیم )هر تعد

ات یگیریم. گاهی نیز، به جای اضافه کردن یک چیز به چیز دیگر، یک گروه را به گروه دیگر اضافه می کنیم. تنها تفاوت آن در سرعت انجام عمل

 نیز همین علامت کاربرد دارد. #Cد. در استفاده می شو +است. در ریاضی برای انجام فرایند جمع از علامت 

 برای به دست آوردن حاصل جمع دو مقدار، باید اولی را به دومی اضافه کرد. مقدار جدیدی در اختیار شما قرار می گیرد، به این صورت

value3 = value1 + value2 

 ندارد. value2 + value1هیچ فرقی با  value1 + value2 در مورد ارقام، نحوه و ترتیب قرارگیری اعداد چندان اهمیتی ندارد. برای مثال،

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            System.Console.Write("244 + 835 = "); 
            System.Console.WriteLine(244 + 835); 
        } 

}     

 نتیجه

244 + 835 = 1079 
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دریافت  همچنین می توان مقدارهایی که از پیش تعریف یا مقداردهی اولیه شده را در برنامه ی خود به کار برد، حتی می توان مقدارها را از کاربر

 کرد.

د، انجام ، می توان برای ایجاد یک رشته ی جدید، متغیرهای رشته را به آن اضافه کرد. عملیات همان طوری که جمع اعداد صورت می گیر#Cدر 

. به همین ترتیب، می توانید هر تعداد رشته که مایلید با دخیل کردن "PieChart" نتیجه می دهد "Pie" + "Chart" می شود. برای مثال، 

 به دستور اضافه کنید. + عملگر

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            varfirstName = "Alexander"; 
            varlastName = "Kallack"; 
            varfullName = firstName + " " + lastName; 
            System.Console.Write("Full Name: "); 
            System.Console.WriteLine(fullName); 
        } 

}     

 نتیجه ی زیر حاصل می گردد. 

Full Name: Alexander Kallack 
Press any key to continue... 

 استفاده از عملگر + 

 فایل را به صورت زیر تغییر دهید. .8

class Order 
    { 
        static void Main() 
        { 
            string customerName = "James Burreck", 
            homePhone = "(202) 301-7030"; 
            uint numberOfShirts = 1, 
            numberOfPants = 1, 
            numberOfDresses = 1; 
            uint totalNumberOfItems; 



 

142 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            decimal priceOneShirt = 0.95M, 
            priceAPairOfPants = 2.95M, 
            priceOneDress = 4.55M; 
            uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
            totalNumberOfItems = numberOfShirts + numberOfPants + numberOfDresses; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("========================"); 
            System.Console.Write("Customer:   "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Home Phone: "); 
            System.Console.WriteLine(homePhone); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------"); 
            System.Console.WriteLine("Item Type  Qty Sub-Total"); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.Write(numberOfShirts); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOneShirt); 
            System.Console.Write("Pants       "); 
            System.Console.Write(numberOfPants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceAPairOfPants); 
            System.Console.Write("Dresses     "); 
            System.Console.Write(numberOfDresses); 
            System.Console.Write("     "); 
            System.Console.WriteLine(priceOneDress); 
            System.Console.WriteLine("------------------------"); 
            System.Console.Write("Number of Items: "); 
            System.Console.WriteLine(totalNumberOfItems); 
            System.Console.WriteLine("========================"); 
            System.Console.ReadKey(); 
        } 
    } 

 

 حال، برنامه را اجرا کنید. نتیجه ی زیر به دست می آید. .2
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-/- Georgetown Cleaning Services -/- 
======================== 
Customer:   James Burreck 
Home Phone: (202) 301-7030 
Order Date: 3/15/2002 
------------------------ 
Item Type  Qty Sub-Total 
------------------------ 
Shirts      1     0.95 
Pants       1     2.95 
Dresses     1     4.55 
------------------------ 
Number of Items: 3 
======================== 

 را بسته، به محیط برنامه نویسی خود بازگردید. DOSپنجره ی  .1

 دادن متغییر افزایش

به آن، متغیر یا مقدار برای همیشه تغییر پیدا کرده،  8به آن است. پس از افزودن  8آسان ترین روش به منظور افزایش یک مقدار، اضافه کردن 

 .است و متغیر حاوی مقدار جدید خواهد بود. مثال زیر این نمونه را به زیبایی نمایش داده

ncrementing// This program studies value i 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of incrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value = value + 1; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

  نتیجه

Techniques of incrementing a value 
Value = 12 
Value = 13 
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 Value = Valueرا برای برنامه نویس فراهم می کند. به جای نوشتن  "++" (increment operator)برای این منظور، عملگر افزایش  #Cزبان 

 به این ترتیب نیز می توان نوشت. و نتیجه نیز همان خواهد بود. برنامه فوق را ++Value، می توان نوشت 1 +

    // This program studies value incrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of incrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value++; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

به متغیر،  1زیرا تنها یک متغیر را دستخوش تغییر خود قرار می دهد.این عملگر با اضافه کردن  نیز یک عملگر یگانی محسوب می شود، ++عملگر 

اضافه می کند. متغیر نیز سر انجام ،  1مقدار قبلی متغیر را گرفته و به آن  compilerاجرا می شود،  ++Valueآن را تغییر می دهد. هر بار که 

 کند. مقدار افزایش یافته را در خود ذخیره می

    // This program studies value incrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of incrementing a value"); 
            value++; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value++; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value++; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 نتیجه ی زیر به دست می آید.

Techniques of incrementing a value 



 

145 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

Value = 13 
Value = 14 
Value = 15 

Pre and post increment 

ک یموقعیتی که عملگر در آن قرار می گیرد، به خصوص در رابطه با متغیری که اصلاح می کند، بسیار حائز اهمیت است. به منظور افزایش مقدار 

 از استفاده ی دوباره از آن، باید عملگر را به طور حتم سمت چپ متغیر قرار داد. متغیر، پیش

// This program studies value incrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of incrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(++value); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 نتیجه ی زیر حاصل می گردد.

Techniques of incrementing a value 
Value = 12 
Value = 13 
Value = 13 

 (compound additionجمع مرکب )

 افزودن یک مقدار ثابت به متغیر امری غیر عادی نیست. کافی است متغیری که قرار است میزبان مقدار جدید باشد را تعریف کنید.

 مثال

    // This program studies value incrementing and decrementing 
 
    public class Exercise 
    { 
        static void Main() 
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        { 
            double value = 12.75; 
            double newvalue; 
            System.Console.WriteLine("Techniques of incrementing and decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            newvalue = value + 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(newvalue); 
        } 

}     

 نتیجه ی زیر را به دست می دهد.

Techniques of incrementing and decrementing a value 
Value = 12.75 
Value = 15.17 
 

د را وروشی که بالا به کار رفته، ایجاب می کند شما در برنامه ی خود دو متغیر داشته باشید. مزیت آن این است که هر متغیر می تواند مقدار خ

، با این وجود مقدار متغیردوم وابسته است به تغییراتی که به متغییر اصلی وارد می شود. گاهی اوقات نیازی به حفظ کردن مقدار داشته باشد

وی راولیه متغیر اصلی نیست، و لازم است که مقدار یک متغیر را به صورت دائمی تغییر دهید. برای این منظور، باید عملیات جمع را مستقیماً 

 پیاده کرد ) با اضافه کردن مقدار دلخواه به متغیر(. با این کار نه تنها مقدار متغیر اصلاح می شود، بلکه دیگر نیازی به متغیر اضافه خود متغیر

 بر سازمان نیست.

 .=+رد : ترکیب کرد و عملگری جدید به وجود آو +به منظور افزودن مقدار به متغیر و اصلاح آن، می توان عملگر جایگزین را با عملگر 

 مثال

    // This program studies value incrementing and decrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12.75; 
            System.Console.WriteLine("Techniques of incrementing and decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value += 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     
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 ه ی قبلی را به دست می دهد.برنامه همان نتیج

 عملیات ضرب

ضرب به شما اجازه می دهد یک عدد را تعداد دفعات مشخص )که توسط مقدار دومی مشخص می شود( به خود آن عدد اضافه کنید. برای 

که این مقدار در عملیات جمع ، می توان ابتدا تعداد دفعاتی A + A A + A +مثال، به جای این که مقداری را به این صورت به آن اضافه کنید : 

 می باشد. 4به کار رفته را پیدا کرده، سپس آن مقدار را در تعداد دفعات تکرار، ضرب کنید که در این مثال : همان عدد 

 .. دستور نحوی عمل ضرب از همان قوانین عمل جمع پیروی می کندa * b * c = c * b * aدرست مثل عمل جمع، ضرب نیز شرکت پذیر است : 

    class Exercise 
    { 
        static void Main() 
        { 
            // Initializing various variables when declaring them with the same data type 
            double value1 = 224.58, value2 = 1548.26; 
            var result = value1 * value2; 
            System.Console.Write(value1); 
            System.Console.Write(" * "); 
            System.Console.Write(value2); 
            System.Console.Write(" = "); 
            System.Console.WriteLine(result); 
            System.Console.WriteLine(); 
        } 

}     

 نتیجه

224.58 * 1548.26 = 347708.2308 
Press any key to continue... 

 به کاربردن عملگر ضرب

 برای این منظور، فایل مرتبط را به این صورت اصلاح کنید. .8

    class Order 
    { 
        static void Main() 
        { 
            const decimal priceOneShirt = 0.95M; 
            const decimal priceAPairOfPants = 2.95M; 
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            const decimal priceOneDress = 4.55M; 
            string customerName = "James Burreck", 
            homePhone = "(202) 301-7030"; 
            uint numberOfShirts = 5, 
            numberOfPants = 2, 
            numberOfDresses = 3; 
            uint totalNumberOfItems; 
            decimal subTotalShirts, subTotalPants, subTotalDresses; 
            decimal totalOrder; 
            uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
            totalNumberOfItems = numberOfShirts + numberOfPants + numberOfDresses; 
            subTotalShirts = priceOneShirt * numberOfShirts; 
            subTotalPants = priceAPairOfPants * numberOfPants; 
            subTotalDresses = numberOfDresses * priceOneDress; 
            totalOrder = subTotalShirts + subTotalPants + subTotalDresses; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("===================================="); 
            System.Console.Write("Customer:   "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Home Phone: "); 
            System.Console.WriteLine(homePhone); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.Write(numberOfShirts); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneShirt); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalShirts); 
            System.Console.Write("Pants       "); 
            System.Console.Write(numberOfPants); 
            System.Console.Write("     "); 
            System.Console.Write(priceAPairOfPants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalPants); 
            System.Console.Write("Dresses     "); 
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            System.Console.Write(numberOfDresses); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneDress); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalDresses); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Number of Items: "); 
            System.Console.WriteLine(totalNumberOfItems); 
            System.Console.Write("Total Order:     "); 
            System.Console.WriteLine(totalOrder); 
            System.Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
        } 
    } 

 . برنامه را طبق دستور العمل اجرا کرده تا نتیجه ی آن را مشاهده کنید.2

-/- Georgetown Cleaning Services -/- 
==================================== 
Customer:   James Burreck 
Home Phone: (202) 301-7030 
Order Date: 3/15/2002 
------------------------------------ 
Item Type  Qty Unit/Price Sub-Total 
------------------------------------ 
Shirts      5     0.95     4.75 
Pants       2     2.95     5.90 
Dresses     3     4.55     13.65 
------------------------------------ 
Number of Items: 10 
Total Order:     24.30 
==================================== 
 

 را بسته و به محیط برنامه نویسی خود بازگردید. DOSاکنون، پنجره ی  .2

 ضرب مرکب

دیدیم که می توان مقداری را ازمتغیر کم کرد یا مقداری به آن اضافه کرد، سپس محصول آن را به متغیر دیگری اختصاص داد. همین عملیات 

 را می توان برای ضرب هم پیاده کرد.

 مثال
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    class Exercise 
    { 
        static void Main() 
        { 
            double value = 12.75; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value = value * 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 نتیجه

Value = 12.75 
Value = 30.855 
Press any key to continue... 
 

نشان داده می شود( را در اختیار برنامه نویس قرار می دهد.  =*عملگر ضرب مرکب )که با این علامت  #Cبه منظور آسان سازی عملیات، زبان 

 به مثال زیر توجه کنید.

    class Exercise 
    { 
        static void Main() 
        { 
            double value = 12.75; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value *= 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 عملیات تفریق

از این عمل به منظور کم کردن مقداری از مقدار دیگر استفاده می شود. کم کردن متضاد عمل جمع محسوب می شود. عمل تفریق همان طور که 

 انجام می شود. توجه خود را به مثال زیر جلب کنید. (-)می دانید با عملگر 

    class Exercise 
    { 
        static void Main() 
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        { 
            // Values used in this program 
            double value1 = 224.58, value2 = 1548.26; 
            var result = value1 - value2; 
            System.Console.Write(value1); 
            System.Console.Write(" - "); 
            System.Console.Write(value2); 
            System.Console.Write(" = "); 
            System.Console.WriteLine(result); 
        } 
    } 

 نتیجه

224.58 - 1548.26 = -1323.68 
Press any key to continue... 

یکی نیست. برنامه ی زیر این حقیقت را به خوبی نشان   a –b  -cبا   c –b  -aبرخلاف عمل جمع، تفریق شرکت پذیر نیست. به عبارت دیگر، 

 می دهد.

    class Exercise 
    { 
        static void Main() 
        { 
            // This tests whether the addition is associative 
            System.Console.WriteLine(" =+= Addition =+="); 
            System.Console.Write("128 + 42 +   5 = "); 
            System.Console.WriteLine(128 + 42 + 5); 
            System.Console.Write("  5 + 42 + 128 = "); 
            System.Console.WriteLine(5 + 42 + 128); 
            System.Console.WriteLine(); 
            // This tests whether the subtraction is associative 
            System.Console.WriteLine(" =-= Subtraction =-="); 
            System.Console.Write("128 - 42 -   5 = "); 
            System.Console.WriteLine(128 - 42 - 5); 
            System.Console.Write("  5 - 42 - 128 = "); 
            System.Console.WriteLine(5 - 42 - 128); 
            System.Console.WriteLine(); 
        } 

}     

 نتیجه ی زیر به دست می آید.

=+= Addition =+= 
128 + 42 +   5 = 175 
  5 + 42 + 128 = 175 
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 =-= Subtraction =-= 
128 - 42 -   5 = 81 
  5 - 42 - 128 = -165 

 
عداد همان ترتیب را همان طور که مشاهده می کنید، هر دو عملیات یک نتیجه ی واحد و یکسان را ارائه می دهند. در بخش منها  عملیات، ا 

 دنبال می کنند، ولی نتایج متفاوتی به دست می دهند.

 به کاربردن عملگر منها

 برای انجام عمل منها، فایل را به صورت زیر تغیر دهید. 1.

 
 
  class Order 
    { 
        static void Main() 
        { 
            const decimal priceOneShirt = 0.95M; 
            const decimal priceAPairOfPants = 2.95M; 
            const decimal priceOneDress = 4.55M; 
            const decimal salestaxRate = 0.0575M; // 5.75% 
            string customerName = "James Burreck", 
            homePhone = "(202) 301-7030"; 
            uint numberOfShirts = 5, 
            numberOfPants = 2, 
            numberOfDresses = 3; 
            uint totalNumberOfItems; 
            decimal subTotalShirts, subTotalPants, subTotalDresses; 
            decimal taxAmount, totalOrder, netPrice; 
            uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
            totalNumberOfItems = numberOfShirts + numberOfPants + numberOfDresses; 
            subTotalShirts = priceOneShirt * numberOfShirts; 
            subTotalPants = priceAPairOfPants * numberOfPants; 
            subTotalDresses = numberOfDresses * priceOneDress; 
            totalOrder = subTotalShirts + subTotalPants + subTotalDresses; 
            taxAmount = totalOrder * salestaxRate; 
            netPrice = totalOrder - taxAmount; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("===================================="); 
            System.Console.Write("Customer:   "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Home Phone: "); 
            System.Console.WriteLine(homePhone); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
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            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.Write(numberOfShirts); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneShirt); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalShirts); 
            System.Console.Write("Pants       "); 
            System.Console.Write(numberOfPants); 
            System.Console.Write("     "); 
            System.Console.Write(priceAPairOfPants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalPants); 
            System.Console.Write("Dresses     "); 
            System.Console.Write(numberOfDresses); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneDress); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalDresses); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Number of Items: "); 
            System.Console.WriteLine(totalNumberOfItems); 
            System.Console.Write("Total Order:     "); 
            System.Console.WriteLine(totalOrder); 
            System.Console.Write("Tax Rate:        "); 
            System.Console.Write(salestaxRate * 100); 
            System.Console.WriteLine('%'); 
            System.Console.Write("Tax Amount:      "); 
            System.Console.WriteLine(taxAmount); 
            System.Console.Write("Net Price:       "); 
            System.Console.WriteLine(netPrice); 
            System.Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
        } 
    } 

 

 برنامه را اجرا کنید. نتیجه ی زیر به دست می آید. 2.

-/- Georgetown Cleaning Services -/- 
==================================== 
Customer:   James Burreck 
Home Phone: (202) 301-7030 
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Order Date: 3/15/2002 
------------------------------------ 
Item Type  Qty Unit/Price Sub-Total 
------------------------------------ 
Shirts      5     0.95     4.75 
Pants       2     2.95     5.90 
Dresses     3     4.55     13.65 
------------------------------------ 
Number of Items: 10 
Total Order:     24.30 
Tax Rate:        5.7500% 
Tax Amount:      1.397250 
Net Price:       22.902750 
==================================== 
 

 را بسته و به محیط برنامه نویسی بازگردید. DOSپنجره ی  3.

 کاهش دادن متغیر 

رقم از آن کسر می کنید. از این عملیات با نام کاهش مقدار  1، در واقع یک 5 ،6 ،7 ،8 زمانی که اعداد را به صورت معکوس می شمارید، مثل 

(decrementing a value) .یاد می شود 

    // This program studies value decrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value = value - 1; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 نتیجه

Techniques of decrementing a value 
Value = 12 
Value = 11 
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را ارائه می دهد. با استفاده از عملگر مذکور، عملیات فوق را می توان به این صورت  (--)، برای این منظور عملگر کاهش #Cزبان برنامه نویسی 

 اصلاح کرد.

    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value--; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

Pre-decrementing a variable 

 در این مورد نیز موقعیت عملگر )جایی که در آن قرار می گیرد( اهمیت به سزایی دارد. چنانچه مایلید متغیر را پیش از فراخوانی آن کاهش

 را سمت چپ عملوند قرار دهید. برنامه ی زیر این عملیات را به تصویر کشیده. (decrement operator)دهید، باید عملگر کاهش 

// This program studies value decrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12; 
            System.Console.WriteLine("Techniques of decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(--value); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 نتیجه

Techniques of decrementing a value 
Value = 12 
Value = 12 
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Value = 11 

 (compound subtractionتفریق مرکب )

 استفاده می شود. =-از یک متغیر، از عملگر  (constant value)به منظور کسر مقدار ثابتی 

 

 مثال

    // This program studies value incrementing and decrementing 
    public class Exercise 
    { 
        static void Main() 
        { 
            var value = 12.75; 
            System.Console.WriteLine("Techniques of incrementing and decrementing a value"); 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value -= 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 
} 

 نتیجه    

Techniques of incrementing and decrementing a value 
Value = 12.75 
Value = 10.33 

 (division operation)عملیات تقسیم 

تقسیم یک مقدار عبارتند از جداسازی آن به بخش های متعدد. برای مثال، هنگامی که سیبی را از وسط نصف می کنید، در واقع آن را به دو 

 انجام می گیرد. )/(ده اید. عمل تقسیم با عملگر بخش تقسیم کر

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            // Initializing various variables when declaring them with the same data type 



 

157 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            double value1 = 224.58, value2 = 1548.26; 
            var result = value1 / value2; 
            System.Console.Write(value1); 
            System.Console.Write(" / "); 
            System.Console.Write(value2); 
            System.Console.Write(" = "); 
            System.Console.WriteLine(result); 
            System.Console.WriteLine(); 
        } 

}     

 نتیجه ی زیر را ارائه می دهد. مثال این

224.58 / 1548.26 = 0.145053156446592 
Press any key to continue… 

 هیچ گاه چیزی را به صفر تقسیم نکنید. نکته: 

 عملگر تقسیم به کاربر بردن

 .برای این منظور، فایل را به این صورت تغییر دهید .8

class Order 
    { 
        static void Main() 
        { 
            const decimal priceOneShirt = 0.95M; 
            const decimal priceAPairOfPants = 2.95M; 
            const decimal priceOneDress = 4.55M; 
            const decimal discountRate = 0.20M; // 20% 
            const decimal taxRate = 5.75M;  // 5.75% 
            string customerName = "James Burreck", homePhone = "(202) 301-7030"; 
            uint numberOfShirts = 5, numberOfPants = 2, numberOfDresses = 3; 
            uint totalNumberOfItems; 
            decimal subTotalShirts, subTotalPants, subTotalDresses; 
            decimal DiscountAmount, totalOrder, netPrice, taxAmount, salesTotal; 
            decimal amountTended, difference; 
            uint orderMonth = 3, orderDay = 15, orderYear = 2002; 
            totalNumberOfItems = numberOfShirts + numberOfPants + numberOfDresses; 
            subTotalShirts = priceOneShirt * numberOfShirts; 
            subTotalPants = priceAPairOfPants * numberOfPants; 
            subTotalDresses = numberOfDresses * priceOneDress; 
            totalOrder = subTotalShirts + subTotalPants + subTotalDresses; 
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            DiscountAmount = totalOrder * discountRate; 
            netPrice = totalOrder - DiscountAmount; 
            taxAmount = totalOrder * taxRate / 100; 
            salesTotal = netPrice + taxAmount; 
            amountTended = 50M; 
            difference = amountTended - salesTotal; 
            System.Console.WriteLine("-/- Georgetown Cleaning Services -/-"); 
            System.Console.WriteLine("===================================="); 
            System.Console.Write("Customer:   "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Home Phone: "); 
            System.Console.WriteLine(homePhone); 
            System.Console.Write("Order Date: "); 
            System.Console.Write(orderMonth); 
            System.Console.Write('/'); 
            System.Console.Write(orderDay); 
            System.Console.Write('/'); 
            System.Console.WriteLine(orderYear); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Shirts      "); 
            System.Console.Write(numberOfShirts); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneShirt); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalShirts); 
            System.Console.Write("Pants       "); 
            System.Console.Write(numberOfPants); 
            System.Console.Write("     "); 
            System.Console.Write(priceAPairOfPants); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalPants); 
            System.Console.Write("Dresses     "); 
            System.Console.Write(numberOfDresses); 
            System.Console.Write("     "); 
            System.Console.Write(priceOneDress); 
            System.Console.Write("     "); 
            System.Console.WriteLine(subTotalDresses); 
            System.Console.WriteLine("------------------------------------"); 
            System.Console.Write("Number of Items: "); 
            System.Console.WriteLine(totalNumberOfItems); 
            System.Console.Write("Total Order:     "); 
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            System.Console.WriteLine(totalOrder); 
            System.Console.Write("Discount Rate:   "); 
            System.Console.Write(discountRate * 100); 
            System.Console.WriteLine('%'); 
            System.Console.Write("Discount Amount: "); 
            System.Console.WriteLine(DiscountAmount); 
            System.Console.Write("After Discount:  "); 
            System.Console.WriteLine(netPrice); 
            System.Console.Write("Tax Rate:        "); 
            System.Console.Write(taxRate); 
            System.Console.WriteLine('%'); 
            System.Console.Write("Tax Amount:      "); 
            System.Console.WriteLine(taxAmount); 
            System.Console.Write("Net Price:       "); 
            System.Console.WriteLine(salesTotal); 
            System.Console.WriteLine("===================================="); 
            System.Console.Write("Amount Tended:   "); 
            System.Console.WriteLine(amountTended); 
            System.Console.Write("Difference:      "); 
            System.Console.WriteLine(difference); 
            System.Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
        } 

}     

 .. برنامه را اجرا کنید. نتیجه ی زیر را به دست می دهد2

-/- Georgetown Cleaning Services -/- 
==================================== 
Customer:   James Burreck 
Home Phone: (202) 301-7030 
Order Date: 3/15/2002 
------------------------------------ 
Item Type  Qty Unit/Price Sub-Total 
------------------------------------ 
Shirts      5     0.95     4.75 
Pants       2     2.95     5.90 
Dresses     3     4.55     13.65 
------------------------------------ 
Number of Items: 10 
Total Order:     24.30 
Discount Rate:   20.00% 
Discount Amount: 4.8600 
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After Discount:  19.4400 
Tax Rate:        5.75% 
Tax Amount:      1.39725 
Net Price:       20.83725 
==================================== 
Amount Tended:   50 
Difference:      29.16275 
====================================    

 

 .را بسته و به محیط برنامه نویسی برگردید DOS. پنجره ی 1

 (Compound divisionتقسیم مرکب )

ص به خاطر دارید که می توان مقداری را به متغیری اضافه کرد، در آن ضرب کرد، یا از آن کسر کرد، سپس نتیجه ی آن را به خود متغیر اختصا

 .یاده کرد. نمونه ی آن را در زیر مشاهده می کنیدداد. این عملیات را می توان برای تقسیم نیز پ

    class Exercise 
    { 
        static void Main() 
        { 
            double value = 12.75; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value = value / 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 .نتیجه ی زیر حاصل می گردد

Value = 12.75 
Value = 5.26859504132231 
Press any key to continue... 

 .دهد. مثال زیر این عملگر را به کار می برد را ارائه می =/برای این منظور عملگر  #Cزبان 

    class Exercise 
    { 
        static void Main() 
        { 
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            double value = 12.75; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
            value /= 2.42; 
            System.Console.Write("Value = "); 
            System.Console.WriteLine(value); 
        } 

}     

 (Remainderباقی مانده )

قی به کار ببرید. گاهی اوقات به با در آن  )814عملیات تقسیم نتیجه ای با رقم اعشار در اختیار شما قرار می دهد، چنانچه عددی فرد )مثل 

بازیکن کودک در استادیوم حضور دارند، و بازی در شرف آغاز است. مطلع هستید  22مانده ی عمل تقسیم نیاز داریم. برای مثال، تصور کنید 

 بازیکن نیاز است. اگر بازی با تعداد صحیح شروع شود، چند نفر بیرون از بازی منتظر می مانند؟  88که برای هر تیم به 

نشان داده می شود، این عملیات را انجام می دهد. عملگر فوق با گرفتن   )%(که  با علامت  (remainder operation)عملگر باقی مانده 

Shift + 5.فعال می شود ، 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            var players = 18; 
            var remainder = players % 11; 
            // When the game starts، how many players will wait?. 
            System.Console.Write("Out of "); 
            System.Console.Write(players); 
            System.Console.Write(" players، "); 
            System.Console.Write(remainder); 
            System.Console.WriteLine(" players will have to wait when the game starts.\n"); 
        } 

}     

 .نتیجه ی زیر به دست می آید

Out of 18 players، 7 players will have to wait when the game starts. 
Press any key to continue... 
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 (compound remainderباقی مانده ی مرکب )

 همان طور که در عملگرهای دیگر ریاضی مشاهده کردید، می توان پس از به دست آوردن باقی مانده ی یک متغیر نتیجه ی آن را دوباره به خود

 متغیر تخصیص داد.

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            var players = 18; 
            // When the game starts، how many players will wait?. 
            System.Console.Write("Out of "); 
            System.Console.Write(players); 
            System.Console.Write(" players، "); 
            players = players % 11; 
            System.Console.Write(players); 
            System.Console.WriteLine(" players will have to wait when the game starts.\n"); 
        } 

}     

 ، فرایند را سرعت می بخشد.=%با فراهم کردن عملگر  #Cزبان 

 مثال

     
class Exercise 
    { 
        static void Main() 
        { 
            var players = 18; 
            // When the game starts، how many players will wait?. 
            System.Console.Write("Out of "); 
            System.Console.Write(players); 
            System.Console.Write(" players، "); 
            players %= 11; 
            System.Console.Write(players); 
            System.Console.WriteLine(" players will have to wait when the game starts.\n"); 
        } 

}     
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Bit Operations 

در حافظه ی خود ذخیره می  Bitوچکی به نام همان طور که در دروس پیشین ذکر کردیم، کامپیوتر اطلاعات دریافتی را در قسمت های بسیار ک

 ( دستکاری کرد. 2به  8یا  8به  2) 8و 2را با جا به جایی مقدار های  Bit. می توان 8دارد یا  2در خود یا  Bitکند. هر 

 (decimal)یا دهدهی  (hexadecimal) 82سروکار دارند. به عبارت دیگر، هر عدد مبنای  8و  2انجام می گیرد، فقط با  Bitعملیاتی که روی 

 تبدیل شود. (binary)باید ابتدا به دودویی 

 است که به آن خواهیم پرداخت. OR operationکاربرد فراوان دارد،  Microsoft Windows (Win32)عملیاتی که در برنامه نویسی 

 )" a bit ) Bit "Reversing "معکوس کردن" 

می باشد. برای  Bit. وارونه سازی )معکوس کردن( جزئی از عملیات ایجاد تغییر در 8و یا  2ربردارد : یا ، تنها یک مقدار دBitبه خاطر دارید که هر 

، این عملیات را ممکن ~با عملگر  #Cتبدیل می شود. زبان  8را دارید به  2تبدیل می شود و اگر مقدار  2را دارید، به  8مقدار  Bitمثال، اگر در یک 

 می سازد. 

به این شکل در می آید :  binary)دهدهی است( با سیستم دودویی ) decimalرا در نظر بگیرید. این رقم ) 212م برای نمونه رق

 .را به صورت زیر وارونه کرد bit. حال، می توان هر 100011110

286 1 0 0 0 1 1 1 1 0 

Not 286 0 1 1 1 0 0 0 0 1 

 

 پ مقدار قرار دهید.را در سمت چ ~، notبرای استفاده ی صحیح از عملگر 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            var number1 = 286; 
            System.Console.Write("286 = "); 
            System.Console.WriteLine(number1); 
            System.Console.Write("Not 286 = "); 
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            System.Console.WriteLine(~number1); 
        } 

}     

 .نتیجه ای که حاصل می شود

286 = 286 
Not 286 = -287 
Press any key to continue… 

 (Bitwise Conjunctionپیوستگی بیتی )

 را تعبیه کرده. &عملگر  #Cر، دیگر. برای این منظو bitبه  bitعبارت است از پیوند دادن )یا ضمیمه کردن( محتوای یک 

 تبدیل کنید. (binary)، به خاطر داشته باشید که اول باید آن ها را به سیستم دودویی bitبرای پیوند دادن محتوای دو 

 .خواهد بود 2دیگری با همین مقدار اضافه شود، نتیجه  bitبه  2ای با مقدار  bitچنانچه 

 

Bit0 0 

Bit1 0 

Bit0 And Bit1 0 

 .خواهد بود 2اضافه شود، بازهم نتیجه  2ای با مقدار  bit، به 8با مقدار  bitانچه چن

Bit0 1 

Bit1 0 

Bit0 And Bit1 0 

 .خواهد بود 2اضافه شود، نتیجه  8ای با مقدار  bit، به 2با مقدار  bitاگر 

  Bit0 0 

Bit1 1 
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Bit0 And Bit1 0 

 .خواهد شد 8ا همین مقدار اضافه شود، نتیجه دیگری ب bitبه  8ای با مقدار  bitچنانچه 

Bit0 1 

Bit1 1 

Bit0 And Bit1 1 

 

را که به سیستم دودویی تبدیل کنید، این نتیجه به دست  216اضافه کنید. رقم دهدهی  445را به  bit 286تصور کنید می خواهید عدد 

می باشد. بر اساس چهار قاعده  111111101011معادل : )که دهدهی می باشد(  4075.نسخه ی دودویی رقم 100011110می آید : 

 .ی فوق، می توان این دو رقم را به صورت زیر جمع کرد

 

286 0 0 0 1 0 0 0 1 1 1 1 0 

4075 1 1 1 1 1 1 1 0 1 0 1 1 

286 & 4075 0 0 0 1 0 0 0 0 1 0 1 0 

 

 بارا می دهد، برابر است  100001010نتیجه ی  4075 & 286بنابراین، 

  Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

  256 128 64 32 16 8 4 2 1 

286 & 4075 1 0 0 0 0 1 0 1 0 

  256 0 0 0 0 8 0 2 0 

 .کمک می گیریم &. حال به منظور اجرای عملیات پوستگی بیتی، از عملگر 266 = 2 + 16 + 256 = 4075 & 286یعنی ؛ 

    class Exercise 
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    { 
        static void Main() 
        { 
            var number1 = 286; 
            var number2 = 4075; 
            var result = number1 & number2; 
            System.Console.Write("286 & 4075 = "); 
            System.Console.WriteLine(result); 
        } 
} 

 نتیجه    

286 & 4075 = 266 
Press any key to continue... 

(، نتیجه را دوباره برای  همان متغیر به کار برد. به مثال زیر توجه bitهمچنین می توان پس از انجام عملیات بر روی متغیر )پیوست دادن دو 

 .کنید

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 286; 
            System.Console.WriteLine(number); 
            number = number & 48; 
            System.Console.WriteLine(number); 
        } 

}     

 نتیجه

286 
16 
Press any key to continue... 

 .تنها یک مرحله خلاصه کرد ، به=&می توان عملیات فوق را با به کاربردن عملگر 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 286; 
            System.Console.WriteLine(number); 
            number &= 48; 
            System.Console.WriteLine(number); 
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        } 
}     

 (Bitwise Disjunctionازی بیتی )جداس

 ، این امکان را فراهم می سازد.(|)با فراهم کردن عملگر  #Cای دیگر.  bitاز  bitعبارت است از جدا کردن یک 

 سپس (، باید ابتدا آن ها را به سیستم دودویی تبدیل کرد.bitهمان طور که به خاطر دارید برای اضافه کردن دو رقم )از طریق پیوند دادن دو 

 .می شود 2دیگری با همان مقدار اضافه شود، نتیجه  bitبه  2ای با مقدار  bitاگر 

Bit0 0 

Bit1 0 

Bit0 Or Bit1 0 

 

 .می شود 8اضافه شود، نتیجه  2دیگری با مقدار  bitبه  8ای با مقدار  bitچنانچه 

Bit0 1 

Bit1 0 

Bit0 Or Bit1 1 

 .می شود 8اضافه شود، نتیجه  8با مقدار  دیگری bitبه  2ای با مقدار  bitاگر 

Bit0 0 

Bit1 1 

Bit0 Or Bit1 1 

 .خواهد شد 8دیگری با همین مقدار اضافه شود، نتیجه  bitبه  8حال، چنانچه بیتی با مقدار 

Bit0 1 

Bit1 1 
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Bit0 Or Bit1 1 

. رقم دهدهی 100110001)رقمی دهدهی( برابر است با  305جدا کنیم. نسخه ی دودویی  2853را می خواهیم از  123به عنوان مثال، رقم 

بر مبنای چهار قاعده ی فوق، می توان این دو رقم را به صورت زیر  . 101100100101بود، در سیستم دودیی به این صورت خواهد 2853

 .جداسازی کرد

305 0 0 0 1 0 0 1 1 0 0 0 1 

2853 1 0 1 1 0 0 1 0 0 1 0 1 

305 | 2853 1 0 1 1 0 0 1 1 0 1 0 1 

 که در آخر برابر است با 101100110101نتیجه می دهد :  2853 | 305بنابراین، 

  Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

  2048 1024 512 256 128 64 32 16 8 4 2 1 

305 Or 2853 1 0 1 1 0 0 1 1 0 1 0 1 

  2048 0 512 256 0 0 32 16 0 4 0 1 

 .2869 = 1 + 4 + 16 + 32 + 256 + 512 + 2048 = 4075 | 286یعنی ؛ 

 عملیات فوق را می توان به صورت زیر نیز محاسبه کرد.

    
 
 class Exercise 
    { 
        static void Main() 
        { 
            var number1 = 305; 
            var number2 = 2853; 
            var result = number1 | number2; 
            System.Console.Write("305 Or 2853 = "); 
            System.Console.WriteLine(result); 
        } 

}     

 نتیجه
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305 Or 2853 = 2869 
Press any key to continue... 

 ازی کرد، سپس نتیجه را به همان متغیر اختصاص داد.ها را در یک متغیر جداس bitمی توان تعدادی از 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 305; 
            System.Console.WriteLine(number); 
            number = number | 22; 
            System.Console.WriteLine(number); 
        } 

}     

 نتیجه

305 
311 
Press any key to continue… 

 ، امکان پذیر می باشد.=|نسخه ی فشرده ی این عملیات با به کارگیری عملگر 

   
  class Exercise 
    { 
        static void Main() 
        { 
            var number = 305; 
            System.Console.WriteLine(number); 
            number |= 22; 
            System.Console.WriteLine(number); 
        } 

}     

Bitwise Exclusion 

 را ارائه می دهد(. ^برای این منظور عملگر  #Cبا در نظر گرفتن قوانین زیر به هم اضافه می شوند )زبان  bitفرایندی است که در آن دو 

 خواهد بود. 2دارای مقدار یکسانی باشند، نتیجه  bitه هر دو چنانچ

Bit0 0 1 



 

170 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

Bit1 0 1 

Bit0 ^ Bit1 0 0 

 

 می شود. 8مقدار متفاوتی دارند، نتیجه  bitاگر دو 

Bit0 0 1 

Bit1 1 0 

Bit0 ^ Bit1 1 1 

 

. 100111110100 : 2548. معادل دودویی 1001101010 : 618خارج کنیم. معادل دودویی  2548را از  618فرض کنید می خواهیم مقدار 

 خارج کرد. 2548را از  618های رقم  bitبر مبنای دو قاعده ی فوق، می توان 

618 0 0 1 0 0 1 1 0 1 0 1 0 

2548 1 0 0 1 1 1 1 1 0 1 0 0 

618 ^ 2548 1 0 1 1 1 0 0 1 1 1 1 0 

 

 که برابر است با 101110011110نتیجه می دهد :  2853 ^ 305بنابراین، 

  Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

  2048 1024 512 256 128 64 32 16 8 4 2 1 

618 ^ 2548 1 0 1 1 1 0 0 1 1 1 1 0 

  2048 0 512 256 128 0 0 16 8 4 2 0 

 

 .2974 = 2 + 4 + 8 + 16 + 128 + 256 + 512 + 2048 = 4075 ^ 286یعنی ؛ 

 البته، عمل فوق را به این صورت نیز می توان محاسبه کرد.
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    class Exercise 
    { 
        static void Main() 
        { 
            var number1 = 618; 
            var number2 = 2548; 
            var result = number1 ^ number2; 
            System.Console.WriteLine(result); 
        } 

}     

 نتیجه

2974 
Press any key to continue… 

 را به صورتی که گفته شد، از متغیری خارج کرد و بعد نتیجه ی حاصل را برای خود متغیر به کاربرد. bitمی توان شماری 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 618; 
            System.Console.WriteLine(number); 
            number = number ^ 38; 
            System.Console.WriteLine(number); 
        } 

}     

 نتیجه می دهد.

618 
588 
Press any key to continue... 

 به همین نتیجه دست یافت. =^همچنین می توان با استفاده از عملگر 

class Exercise 
    { 
        static void Main() 
        { 
            var number = 618; 
            System.Console.WriteLine(number); 
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            number ^= 38; 
            System.Console.WriteLine(number); 
        } 

}     

 ها از راست به چپ Bitانتقال 

ها از سمت راست به سمت چپ. در این مورد نیز، لازم است پیش از انجام عملیات عدد به معادل دودویی خود  bitعبارت است از جا به جایی 

 پشتیبانی می کند.  >>این عملیات را با عملگر  #Cتبدیل شود. 

 .که به صورت زیر نمایش داده می شود 1011100101: را در نظر بگیرید. معادل دودویی آن برابر است با  418رقم 

1 0 1 1 1 0 0 1 0 1 

 

 bit کبه منظور انجام عملیات فوق، باید تک تک مقدارها را )بسته به تعداد دفعات جا به جایی( از سمت راست به چپ جا به جا کرد. با انتقال ی

. yدیگری سمت چپ آن در موقعیت  bitقرار می گیرد و  xای در موقعیت  bitل، تغییر می کند. برای مثا bitاز چپ به راست، موقعیت تنها یک 

 .دریافت می کند 2در راست ترین موقعیت قرار داشت، مقدار  bit xدر صورتی که  می کنیم.   bit y را جایگزین مقدار bit xمقدار 

Original   1 0 1 1 1 0 0 1 0 1 

<< by 1 1 0 1 1 1 0 0 1 0 1 0 

 

 .آن به این صورت محاسبه شده (decimal)را به دست می دهد. نتیجه ی دهدهی  10111001010ه ی نتیج

  Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

  1024 512 256 128 64 32 16 8 4 2 1 

741 << 1 1 0 1 1 1 0 0 1 0 1 0 

  1024 0 256 128 64 0 0 8 0 2 0 

 

 .ین نتیجه حاصل می شودهمچنین، ا
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741 << 1 = 1024 + 256 + 128 + 64 + 8 + 2 = 1482 

 استفاده کرد. >>همان طور که از مثال بالا پیدا است، باید برای پیاده سازی این عملیات از عملگر 

 مثال

    class Exercise 
    { 
        static void Main() 
        { 
            System.Console.WriteLine(741 << 1); 
        } 

}      

 محصول فرایند

1482 
Press any key to continue... 

 ها را بیش از یک واحد به سمت چپ انتقال داد. bitبه همین ترتیب، می توان 

   
  class Exercise 
    { 
        static void Main() 
        { 
            var number = 248 << 5; 
            System.Console.WriteLine(number); 
        } 

}     

 نتیجه

7936 
Press any key to continue… 

 .را به سمت چپ )یک متغیر( جا به جا کرد، سپس نتیجه ی حاصله را برای خود متغیر اعمال کرد bitبنابراین، می توان چند 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 248; 
            System.Console.WriteLine(number); 
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            number = number << 5; 
            System.Console.WriteLine(number); 
        } 

}     

 .نتیجه ی زیر را به دست می دهد

248 
7936 
Press any key to continue... 

C#  برای کاربر بسیار آسان می کند =>>عملیات فوق را با به کاربردن عملگر. 

    class Exercise 
    { 
        static void Main() 
        { 
            var number = 248; 
            System.Console.WriteLine(number); 
            number <<= 5; 
            System.Console.WriteLine(number); 
        } 

}     

 ها به سمت راست Bitانتقال 

ها به چپ انجام می دادید را به صورت معکوس برای  bitها را در سمت راست قرار داد. برای این منظور تمام مراحلی که برای انتقال  bitمی توان 

 کان پذیر می کند.، این پروسه را ام<<با عملگر  #Cاین فرایند پیاده کنید. زبان 

 کلاس ها

یا نوع داده ی ساده و شناخته شده بهره گرفت. برای مثال، می توان برای تعریف متغیری که  varبرای تعریف متغیر، می توان از کلیدواژه ی 

 .استفاده کرد integerنشانگر تعداد اتاق خواب های یک خانه است، از 

    class Program 
    { 
        static void Main() 
        { 
            int bedrooms = 3; 
        } 
    } 
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می توان با به کاربردن چند متغیر، شی ای کامل پیچیده ساخت. در زبان های برنامه نویسی کلاس )که خود متشکل از یک گروه متغیر  #Cدر  

را تایپ  classبرای به وجود آوردن یک کلاس، ابتدا کلیدواژه ی است(، در واقع پایه ای برای ایجاد متغیری پیچیده تر می باشد. حال 

 قرار داد.  }{کرده،سپس به دنبال آن اسم و بدنه ی اصلی را داخل 

 نحوه ی وارد کردن کلاس 

8.      Microsoft Visual Studio را اجرا کنید. 

 .را انتخاب کنید File -> New Projectجدید گزینه های  appمراجعه کرده و برای ایجاد  main menuبه       .2

 کلیک کنید. Empty Projectدر فهرست میانی روی گزینه ی       .1

 تغییر دهید. DepartmentStore1اسم مورد نظر را به       .4

 را کلیک کنید. OKحال       .5

 نام گذاری کلاس

س بسیار شبیه به فرایند اسم گذاری برای متغیر است )از همان درست مثل متغیر، یک کلاس باید دارای اسم باشد. اسم گذاری برای کلا

 قوانین پیروی می کند(. البته، شما می توانید قوانین خو را به کار ببرید. در دروس ما

چنانچه اسم کلاس از تنها یک کلمه تشکیل شده، فقط حرف اول با حروف بزرگ نوشته می شود. نمونه های آن : 

Identification،Vehicle  ، Student .می باشد 

، DrivingRecordاگر اسم کلاس موردنظر از چند کلمه ساخته شده باشد، تمام حروف اول کلمات با حرف بزرگ نوشته می شوند : 

GeometricShape، SocialSecurityInformation  

 مدیریت کلاس ها

Microsoft Visual Studio ت کلاس در اختیار برنامه نویس می گذارد. همچنین فرایند نام گذاری ابزار و امکان های بصری زیادی برای مدیری

 یا تغییر اسم کلاس ها را با امکاناتی که دارد برای کاربر آسان ساخته است.

 Class Viewپنجره ی 

 است. برای دسترسی به این پنجره  Class Viewبهترین روش برای مدیریت کلاس، استفاده از پنجره ی 
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 را کلیک کنید. View -> Class Viewرا باز کرده، سپس  main menuاز قبل باز نیست، ابتدا چنانچه پنجره 

 آن کلیک کنید. tabاگر پنجره ی مذکور از قبل باز بود، تنها کافی است روی 

 solutionآن مشابه  از شش بخش مجزا تشکیل شده. همانطور که در تصویر زیر مشاهده می کنید کاربرد و نوار عنوان Class Viewپنجره ی 

explorer .می باشد 

 

 .آن می باشد  (toolbar)دومین بخش تشکیل دهنده ی نوار عنوان، نوار ابزار 

به شما اجازه می دهد فولدری جدید ایجاد کرده و به پروژه اضافه کنید. دکمه های  New Folderهمان طور که از اسم آن پیدا است گزینه ی 

Back  وForward اجازه می دهند در کلاس ها پیمایش کنید. به شما 

 و دکمه تشکیل شده که به کمک آن ها می توانید جستجو کنید. combo box، نوار دیگری وجود دارد که از یک toolbarدر زیر 

شان می دهد. حال نیز از دو بخش اصلی تشکیل شده. اولین گره ی قسمت بالایی پنجره، اسم پروژه را ن Class Viewبدنه ی اصلی پنجره ی 

 زیر گره ی پروژه، اسم کلاس ها نمایش داده شده است. قسمت پایینی پنجره نیز به اعضای کلاس ها اختصاص داده شده است.

 برای مشاهده ی اعضای کلاس ها

http://articles.tahlildadeh.com/image.axd?picture=clip_image002[4]_2.gif
http://articles.tahlildadeh.com/image.axd?picture=clip_image004_65.jpg
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 ایجاد کلاس

، فایل را ایجاد کرده، کلیدواژه ی Notepadراه های مختلفی برای ساختن کلاس وجود دارد. در صورت کار با برنامه های ویرایش متن مثل 

class  را درج کنید. {را تایپ کنید، به دنبال آن اسم کلاس مورد نظر و علامت 

 نمونه

  class House 
    { 
    } 

یل اید فاذخیره کنید. البته، نیازی نیست که اسم فایل با اسم کلاس یکی باشد. به خاطر داشته باشید که ب cs.حال، فایل خود را با پسوند 

 مزبور را در همان فولدری که فایل های دیگر پروژه در آن نگه داری می شوند، ذخیره کنید.

 ایجاد می شود. به همین خاطر هم می توانید آن را در اولین فایل پروژه ی خود ذخیره کنید. code fileکلاس در یک 

    class House 
    { 
    } 
    class Exercise 
    { 
        static void Main() 
        { 
            int bedrooms = 3; 

http://articles.tahlildadeh.com/image.axd?picture=clip_image005[4]_1.gif
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        } 
    } 

 

 Microsoft Visual C# 2010 Express  یاMicrosoft Visual Studio  8فرایند ایجاد کلاس را برای شما بسیار آسان می سازد. در درس ،

نام برده، کافی است کد مورد نیاز را برای کلاس وارد کنید. پس از  code fileایجاد کرد. پس از ساختن  code fileدیدیم که چگونه می توان 

 (، می توان نوع فایل دلخواه را انتخاب کرد از جمله فایل کلاس. main menuیا  solution explorer)در  Add New Itemانتخاب گزینه ی 

 به منظور ایجاد کلاسی جدید

 Add New Item ،Projectکلیک کنید، ) یا در لیست میانی پنجره ی محاوره  ...Project -> Add Classروی گزینه ی  main menuدر 

-> Add New Item روی گزینه ی ،class .)کلیک کنید 

 را انتخاب کنید. classقرار دهید، سپس  Add، روی اسم پروژه راست کلیک کرده، نشان گر موس را روی Solution Explorerدر 

 را انتخاب کنید. classقرار داده، و  Add، روی اسم پروژه راست کلیک کنید، نشان گر موس را روی Class Viewدر پنجره ی 

اتنخاب شده(. در صورتی  classنمایش داده می شود )که در آن گزینه ی  Add New Itemدر نتیجه ی تمام عملیات بالا، پنجره ی محاوره ی 

کلیک کنید. می توانید اسم  classانتخاب کرده اید، کافی است روی خود  Solution Explorerیا  main menuرا از  Add New Itemکه 

عوض کنید ) یا در صورت تمایل همان اسم را بپذیرید(. اکنون، فایل جدیدی با اسم انتخابی شما و  Nameپیش فرض را در کادر متن 

 به پروژه ی شما اضافه می شود. cs.پسوند 

 استفاده کرد. skeleton codeیجاد کلاس از همچنین می توان برای ا

کلیک کنید. حال،  Insert Snippetکه باید کلاس جدید را اضافه کنید، راست کلیک کرده، سپس روی  Code Editorدر آن قسمت 

Visual C#  را دو بار کلیک کنید. در لیستی که ظاهر می شود، رویclass .دو بار کلیک کنید 
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قبل نوشته اید، و اکنون می خواهید آن کد را در کلاس خود جای دهید، کافی است آن کد را انتخاب کنید. ابتدا روی آن راست چنانچه کد را از  

 را انتخاب کنید. Surround Withکلیک کرده، سپس گزینه ی 

  

http://articles.tahlildadeh.com/image.axd?picture=clip_image007[4]_1.gif
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 به وجود می آید. MyClassکلاسی با اسم پیش فرض 

 وارد کردن کلاس 

 کلیک کنید. ...Project -> Add New Itemاجعه کرده، روی مر main menuبه       .8

 کلیک کنید. Code File، روی Add New Itemدر لیست میانی       .2

 تغییر دهید.  StoreItemاسم را به       .1

  

 

 کلیک کنید. Add. روی 4

 . در فایل زیر، این عبارت را تایپ کنید.5

    class StoreItem 
    { 
    } 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002_108.jpg
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 .View -> Solution Explorerگزینه های ، main menuدر . 2

راست کلیک کرده، سپس نشانگر  DepartmentStore1روی  Solution Explorer)ای دیگر، )در  code file. حال، برای به وجود آوردن 4

 را انتخاب کنید. ...click New Itemقرار داده و گزینه ی  Addموس را روی 

 کلیک کنید. Code File، روی Add New Itemجره ی محاوره . در لیست میانی پن1

 تغییر دهید. DepartmentStore. اسم مورد نظر را به 1

 کلیک کنید. Add. روی 82

 . داخل فایل خالی عبارات زیر را تایپ کنید.88

    class DepartmentStore 
    { 
        static void Main() 
        { 
        } 
    } 

 وه ی دستیابی به کلاسنح

ر همان طور که پیشتر ذکر شد، شما می توانید هر تعداد کلاس که مایلید برای پروژه ی خود ایجاد کنید. مطابق میل می توانید هر کلاس را د 

رسی به کلاس هافایل مختص به خود آن کلاس نگه دارید یا می توانید تمام کلاس ها را در یک فایل واحد ذخیره کنید. اکنون، برای دست  

 combo boxاختصاص دارد، روی تبَی که میزبان فایل کلاس دلخواه است کلیک کنید. سپس، به  Code Editorدر قسمتی که به تب های 

 مراجعه کرده و کلاس را انتخاب کنید Code Editorسمت چپ 

است دوبار کلیک کنید. چنانچه فایل حاوی چند کلاس ، زیر اسم پروژه، روی اسم فایلی که دربردارنده ی کلاس Solution Explorerدر 

 ، کلاس دلخواه را انتخاب کنید.Code Editorسمت چپ  combo boxاست،در 

 ، زیر اسم پروژه، اسم کلاس را دوبار کلیک کنید.Class Viewدر پنجره ی 

 را انتخاب کنید. Go To Definitionی ، روی کلاس مورد نظر راست کلیک کرده، سپس گزینه Class Viewپنجره ی  combo boxدر 
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 تغییر اسم کلاس 

)یا در برنامه ی   Code Editorاگر اسم کلاسی باب میلتان نیست، می توانید آن را عوض کنید. راه اولیه ی آن پیدا کردن اسم کلاس در 

مت هایی که اسم در آن به کار رفته نیز ( و ویرایش آن است. در صورت استفاده از این روش، باید تمامی قسNotepadویرایش متن مثل 

 #Microsoft Visual Cپیدا شود. همان طور که انتظار می رود این کار بسیار دشوار بوده و احتمال خطا نیز در آن بالا است. اما برنامه های 

2010 Express  و یاMicrosoft Visual Studio قرار می دهند.  راه حل بهتری برای انجام این فرایند در اختیار شما 

 دستورات زیر را انجام دهید. #Microsoft Visual Cیا  Microsoft Visual Studioبرای تغییر دادن اسم در 

را  ...Renameقرار دهید، سپس گزینه ی  Refactor، روی اسم کلاس راست کلیک کرده، حال نشانگر موس را روی Code Editorدر 

 انتخاب کنید.

 را انتخاب کنید. ...Rename، روی اسم کلاس راست کلیک کرده و Class Viewدر پنجره ی 

مراجعه کرده و گزینه های  main menu، به منظور انتخاب کلاس موردنظر باید روی اسم آن کلیک کنید. اکنون، به Class Viewدر 

Refactor -> Rename... .را کلیک کنید 

ویرایش  New Nameرا نمایش می دهند. حال، می توانید اسم کلاس را در کادر متن  Renameکلیه ی اقدامات بالا پنجره ی محاوره ی 

ها  checkboxرا تغییر دهد یا نه، مجبورید از  stringیا  comment ، اسم به کار رفته در  Code Editorکنید. برای تنظیم اینکه آیا مایلید 

به نمایش گذاشته می شود. پنجره ی بالا بخش  Preview Changes – Rename، پنجره ی  okاستفاده کنید. پس از کلیک روی دکمه ی 

ی های مختلفی که اسم مورد نظر در آن به کار رفته را برای شما فهرست می کند. اکنون می توانید به منظور اعمال تغییرات به وجود آمده رو

Apply .کلیک کنید 

 #Cابزار جانبی زبان 

 کد نا امن

از جمله ی این ( pointer)بود. کاربرد اشاره گر  ++C/Cطراحی شد، اجتناب از کاستی ها و مشکلات زبان های  #C  یکی از دلایلی که زبان

تا حد  #Cاز اشاره گر برای ارجاع دادن به محل نگه داری مقداری در حافظه استفاده می کنند. بر خلاف این دو زبان،  ++C/Cکاستی ها بود. 

ر اجتناب می کند و مدیریت حافظه را خود به دست می گیرد ) به جای سپردن این وظیفه به برنامه نویس(. البته ممکن از به کاربردن اشاره گ

 استفاده کند.  (#Cدر صورت لزوم، برنامه نویس می تواند از اشاره گر )در 
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منظور مقدارهای برنامه ای است که از عهده دار مدیریت حافظه و مقدارهای ذخیره شده در آن است ) #Cزبان  compilerبه این خاطر که 

 حافظه استفاده می کنند(، استفاده از اشاره گر توصیه نمی شود. با این وجود، چنانچه مایل هستید از اشاره گر در برنامه ی کاربردی خود

 تایپ کنید. به مثال زیر توجه کنید.را  unsafeاستفاده کنید، باید پیش از اسم تمامی متدهایی که از کدناامن استفاده می کنند کلیدواژه ی 

  

class Exercise 
{ 
    unsafe static void Main() 
     { 
        int Length = 224; 
        int *Len = &Length; 
        System.Console.Write("Length "); 
        System.Console.WriteLine(Length); 
        System.Console.Write("Length "); 
        System.Console.WriteLine(*Len); 
        System.Console.WriteLine(); 
        Length = 804; 
        System.Console.Write("Length "); 
        System.Console.WriteLine(Length); 
        System.Console.Write("Length "); 
        System.Console.WriteLine(*Len); 
     } 
 } 

) کد ناامن( در این برنامه به کاربرده شده.  unsafe codeبرنامه ی کاربردی مورد نظر، باید حتماً اشاره شود که ( compile)پیش از ترجمه 

 استفاده می شود. unsafe/، (modifier) برای این منظور، از تعریف کننده

 نمونه

csc /unsafe Exercise.cs 

 

کلیک  ...Project -> [Project ] Propertiesرا باز کرده، روی  Microsoft Visual Studio ،main menuبرای استفاده از این امکان در 

 را فعال کنید. Allow Unsafe Code، کادر تیک Buildکنید. حال، در قسمت 
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Region Delimiters  

Microsoft Visual Studio مکانات مختلفی برای نوشتن و مدیریت بهتر کد فراهم می کند. این ویژگی ها و امکانات عبارت اند از : کلمات ا

 ، تعیین حد و مرز کدها و غیره... IntelliSense، (intuitive indentation) رنگی، توگذاری خودکار

  



 

186 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 

  

خی از خط های برنامه قرار دارند. دکمه های نام برده به شما اجازه می همان طور که در تصویر مشاهده می کنید، دکمه هایی در سمت چپ بر

کلیک کنید. علامت دکمه ی مذکور ( -)دهند آن بخشی از کد را که مورد نیاز نیست جمع کنید )ببندید(. برای این منظور، باید روی دکمه ی 

 تغییر می کند.)+( به 
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 Microsoft Visual Studioبرنامه ی  Code Editorرا باز کنید. این ویژگی یکی از امکانات به شما اجازه می دهد بخش پنهان کد + دکمه ی 

از قوانین خاصی  Code Editorاست )که البته در خیلی از محیط های برنامه نویسی دیگر نیز کاربرد دارد(. برای به وجود آوردن این بخش ها، 

 پیروی می کند. 

دلخواه خود را  (code section) ید در صورت تمایل، به جای استفاده از بخش های کد بالا، بخش های کدلازم به ذکر است که شما می توان

 ایجاد کنید. برای این منظور

، فایل Microsoft Visual C# 2010 Expressبرنامه ی  Code Editor( یا wordpadدر صورت کار با برنامه های ویرایش متن )مثل 

 ر شروع کرده.موردنظر را با عبارت زی

#region Whatever  
 و با این عبارت به پایان برسانید. 

#endregion Whatever 
 

 کار می کنید. Microsoft Visual Studioیا  Microsoft Visual C# 2010 Expressاگر با برنامه های 

از آن جا شروع شود راست  sectionی خواهید ای ایجاد کنید که حاوی بخشی تهی باشد، روی آن خطی که م sectionچنانچه مایلید  

 را انتخاب کنید، سپس  ...Insert Snippetکلیک کرده، 

 دوبار کلیک کنید. #Visual Cروی 

 

انتخاب کنید. حال، باید روی بخش  Code Editorچنانچه مایلید بخشی ایجاد کنید که حاوی کد است، کافی است کد موردنظر را در 

 را انتخاب کنید. Insert Snippetرده و گزینه ی  انتخابی راست کلیک ک
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کلیک کنید. ناحیه ای با اسم پیش فرض به  region#دوبار کلیک کنید. در لیستی که ظاهر می شود، روی گزینه ی  #Visual Cروی صفحه ی 

 صورت زیر ایجاد می شود.

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[6]_4.gif
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نیاز دارید. می توانید در سمت راست عبارت بالا هر چه مایل  region# هر زمان و جایی که می خواهید ناحیه ی جدیدی ایجاد کنید، به عبارت

)و هرچیز دیگری که دوست دارید به دنبال آن تایپ کنید( به پایان  endregion#هستید تایپ کنید. بخش به وجود آورده را با عبارت 

 برسانید. توجه خود را به مثال زیر جلب کنید.

    class Circle 
    { 
    } 
    #region This section is reserved for quadrilateral shapes 
    class Rectangle 
    { 
    } 
    class Square 
    { 
    } 
    #endregion This is the end of the quadrilateral section 
    class Line 
    { 
    } 

را در سمت چپ  -دکمه ی  Code Editorنیست. پس از ایجاد ناحیه ی مورد نظر،  endregion#نیاز به تایپ کردن هیچ چیز در سمت راست 

#region  نمایش می دهد و به دنبال آن خطی ظاهر می شود که به سمت چپ عبارت#endregion .ختم می شود 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002[6]_2.gif
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 حال، این دکمه به شما اجازه می دهد بخش مورد نظر را به دلخواه بازکرده یا ببندید.

 

چیزی بنویسید و می توانید آن را خالی بگذارید. در مثال بالا،  endregion#ر که بالا ذکر شد، نیازی نیست در سمت راست همان طو

می آید. این مستطیل رشته ای که پس از  region#مستطیلی مشاهده می کنید که با خط های خاکستری رشته را احاطه کرده و به دنبال 

#endregion شش قرار نمی دهد. به عبارت دیگر، چنانچه هیچ چیز در سمت راست می آید را تحت پو#endregion  تایپ نشود، بخش

 نیز نمایش داده نخواهد شد.  region#سمت راست خط 

http://articles.tahlildadeh.com/image.axd?picture=clip_image003[4].gif
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 مبانی نحوه ی استفاده از کلاس

 ایجاد )یک( شی

 ایند تعریف متغیر برای کلاس، به عنوان ایجاد شیبرای به کاربردن کلاس در برنامه، ابتدا لازم است برای آن یک متغیر تعریف کنید. از فر

(creating an object ) یا نمونه ای از کلاس(instance of class)  .نیز یاد می شود 

استفاده کرد. سرانجام، می توان اسم متغیر را به دنبال اسم کلاس مورد نظر  varبه منظور تعریف متغیر )یک( کلاس، می توان از کلید واژه ی 

 پ کرد. برای مثال، اگر بخواهیم متغیری برای کلاس خانه ی اول درس معرفی کنیم، به صورت زیر عمل می کنیم :تای

    class House 
    { 
    } 
 
    class Program 
    { 
        static void Main() 
    { 
        var property . . . 
    } 
    } 

 یا

    class House 
    { 
    } 
    class Program 
    { 
        static void Main() 
        { 
            House property; 
        } 
    } 
 

 (reference type( و نوع ارجاع )value typesنوع مقدار )

 compilerیه ی این متغیرها، با نحوه ی تعریف متغیر های نوع عادی آشنا شدیم. همچنین گفتیم که پس از مقداردهی اول 4و  1در درس های 

هایی که برای چنین  (data type) مقدارهای آن ها را در قسمت هایی از حافظه که از قبل به آن ها اختصاص داده ذخیره می کند. نوع داده
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بخشی در حافظه  compilerخوانده می شوند. برای ذخیره سازی مقادیر این متغیرها،  (value type) مقدارمتغیرهایی به کار می روند، نوع 

 نام دارد که به ذخیره سازی متغیر کلاس ها اختصاص می یابد : heap. بخش باقی مانده ی حافظه (stack) به وجود می آورد به نام پشته

 

ن تخصیص را به آ heapدرخواست کنید بخشی از حافظه ی  compilerپس از این که متغیری را با استفاده از کلاس تعریف کردید، باید از 

 استفاده می شود. newدهد. برای این منظور، از عملگری به نام 

 مثال

    class House 
    { 
    } 
    class Program 
    { 
        static void Main() 
        { 
            var property = new House(); 
        } 
    } 

ذکر شد، در  (value type)متغیر را با اسم کلاس معرفی کرد. همان طور که برای نوع مقدار ، varمی توان به جای استفاده از کلید واژه ی 

ملزم هستید بلافاصله حافظه به آن اختصاص دهید. اما، در صورت استفاده از اسم کلاس )برای تعریف ، varصورت استفاده از کلیدواژه ی 

 را در خط دیگری برای تخصیص حافظه به کاربرد. Newرد، سپس عملگر متغیر( ، می توان متغیر مزبور را در یک خط تعریف ک

 مثال

    class House 
    { 
    } 
    class Program 
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    { 
        static void Main() 
        { 
            House property; 
            // You can do something here 
            property = new House(); 
        } 
    } 

چنانچه کلاسی را در هریک از فایل های متعلق به یک پروژه واحد ایجاد کنید، کلاس نام برده در دسترس  #Cو  Visual Basic در برنامه های

 تمامی فایل های )دیگر( پروژه قرار می گیرد.

 تعریف متغیر نوع کلاس

 ، عبارات زیر را تایپ کنید.Mainدر بدنه ی 

    class DepartmentStore 
    { 
        static void Main() 
        { 
            StoreItem si = new StoreItem(); 
        } 
    } 

 (Null Objectایجاد شی تهی ) 

دیم که پیش از به و مقدارهایی که کلاس فراهم می کند، ملزم به تعریف متغیر هستیم. همچنین دی( behavior)برای استفاده از امکانات 

اجازه می دهد تا حافظه ی تخصیص یافته به  compilerکاربری کلاس، باید مقدارهای لازم برای فیلد های کلاس را فراهم کنید. این کار به 

 متغیر را با مقادیر دلخواه پر کند. ممکن است شما کاملاً آماده نباشید مقادیر لازم را هنگام تعریف متغیر فراهم کنید.

می خوانند. برای این منظور ( (null objectغیری که برای کلاسی تعریف شده ولی هنوز مقدار لازم برای فیلد را دریافت نکرده را، شی تهی مت

 را به آن اختصاص دهید. null)ایجاد شی تهی(، ابتدا اسم کلاس و به دنبال آن اسم متغیر را تایپ کرده، سپس کلید واژه ی 

به آن اضافه کرد. در صورت استفاده از کلاس، از  )؟(علامت سوال ( null)ی توان برای تعریف متغیری با مقدار تهی پیش تر بحث شد که م

 به اسم کلاس خودداری کنید. ؟اضافه کردن 

 مثال

      class House 
    { 
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    } 
    class Program 
    { 
        static void Main() 
        { 
            House property = null; 
        } 

}     

چنانچه متغیر کلاسی از پیش تعریف و مقدار دهی اولیه شده بود، ولی بنا به هر دلیلی مقدارهای آن پاک شد، چنین متغیری نیز شی تهی 

(null object )  .خوانده می شود 

 به اشتراک گذاری کلاس

طوری تعبیه شده که با دیگر زبان های برنامه نویسی  #Cحساب می شود، زبان  #Cنامه ی که پیشرو و والدین بر ++Cو  Cبرخلاف زبان های 

به صورت مکمل کار کند. به عبارت دیگر، می توان با کد هریک از زبان های بالا، کدهای یک برنامه  #Fو C++/CLI ، Visual Basicاز جمله 

 (public object) باید به عنوان شی عمومی #Cق بخشیدن به این امر، کلاس نوشته شده باشد را خواند. برای تحق #Cکاربردی که توسط 

 تعریف شود. 

اگر می خواهید کدهای نوشته شده توسط زبان های بالا به کلاس شما دسترسی پیدا کنند، باید هنگام ایجاد کلاس، پیش از کلید واژه ی 

class ،کلیدواژه ی public .را تایپ کنید 

 

 مثال

    public class Exercise 
    { 
        static void Main() 
        { 
            var number = 244; 
            var thing = "Vehicle"; 
            System.Console.WriteLine(number); 
            System.Console.WriteLine(thing); 
        } 
    } 
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 کلاسکاربرد : به اشتراک گذاری 

8 .main menu  را باز کرده، روی گزینه هایView -> Class View .کلیک کنید 

 دوبار کلیک کنید تا بزرگ شود. DepartmentStore1، روی Class View. در پنجره ی 2

را انتخاب  Go To Definitionراست کلیک کرده، سپس گزینه ی  StoreItem، روی Class View. در قسمت بالایی بدنه ی اصلی پنجره ی 1

 کنید.

 را فشار دهید. فایل پیش رو به صورت زیر تغییر داده می شود. spaceرا تایپ کنید و پس از آن دکمه ی  publicرا زده،  Home. کلید 4

    public class StoreItem 
    { 
    } 

 (garbage collectionزباله روبی )

را به آن اختصاص می دهید )برای آن  heapریف می کنید، در واقع دارید بخشی از حافظه ی تع newزمانی که متغیری را به کمک کلیدواژه ی 

رزرو می کنید(. زمانی که به آن متغیر دیگر نیازی نیست، مثل زمانی که برنامه بسته می شود، متغیر گفته شده پاک شده و حافظه ی 

می گویند. در  garbage collectionدیگر قرار گیرد. به این فرایند زباله روبی یا اختصاص یافته به آن باید در اختیار متغیرها یا برنامه های 

این مسئله برای برنامه نویس یک معضل بزرگ محسوب می شد، زیرا  که برنامه نویس باید خود به صورت ، ++C/Cزبان های برنامه نویسی 

 را آزاد می ساخت. ( را پاک می کرد و حافظهpointer/دستی چنین متغیرهایی )اشاره گر

 مسئله ی زوباله روبی را حل کرده و حافظه را خودکار از متغیرهای بلااستفاده رها می سازد.  NET Framework.چهارچوب کاری 

 فیلدهای کلاس

 را در نظر بگیرید. Houseکلاسی با اسم 

    public class House 
    { 
    } 

ی یک کلاس گفته می شود. در بدنه ی کلاس اجزای تشکیل دهنده ی کلاس قرار می گیرند. است، بدنه  }{به بخشی که محصور در علامت 

متغیری که در بدنه ی  #Cهای یک کلاس تعریف می شوند. در زبان  member variableاین اجزا در واقع تحت عنوان متغیرهای عضو یا 

 عمول دیگر، با یک اسم و نوع داده تعریف می شود.کلاس ایجاد می شود، فیلد اطلاق می گردد. هر فیلد مثل متغیرهای م
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برای مثال، زیر اجزای تشکیل دهنده ی یک خانه به عنوان اعضای تشکیل دهنده یک کلاس )که هریک خود به مثابه ی یک متغیر تعریف 

 شده( تعریف شده اند.

    public class House 
    { 
        string propertyNumber; 
        char propertyType; 
        byte stories; 
        uint bedrooms; 
        decimal value; 

}       

داشته باشد، کافی است علامت سوال به آن  (null value)برای این که نشان دهید متغیری )فیلدی از نوع اولیه( قادر است مقداری تهی  

 اضافه کنید.

    public class House 
    { 
        string propertyNumber; 
        char? propertyType; 
        byte? stories; 
        uint? bedrooms; 
        decimal? value; 
    } 

 ، ملزم به رعایت قوانین خاصی می شوید.؟پس از افزودن 

ده می شوند و هر متغیر عضو سرانجام یک فلید تلقی خوان (member variable)متغیرهای تعریف شده در بدنه ی یک کلاس متغیرهای عضو 

 می گردد. فیلدها ی یک کلاس ممکن از هر نوع داده که تا کنون معرفی شده تشکیل شده باشد.

 توجه 

 از این بخش به بعد، برای اشاره به فیلد متعلق به یک کلاس می نویسیم.

ClassName.FieldName 
 

 می باشد. ClassNameی است که عضو کلاس فیلد FieldNameبه عبارتی ساده تر، 

 افزودن فیلد به کلاس

 را به این ترتیب اصلاح کنید. StoreItemکلاس 
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    public class StoreItem 
    { 
        long itemNumber; 
        string itemName; 
        string size; 
        decimal unitPrice; 
    } 

  (access modifiers of a class)سسطح دسترسی اعضای کلا

 اعضای خصوصی یک کلاس

بخش های یک شئ به دو دسته ی اصلی تقسیم می شوند : آن دسته ای که به آن دسترسی دارید و آن دسته ای که دسترسی به آن ها برای 

کرد ولی موتور آن برای شما قابل رویت و شما مقدورنمی باشد. برای مثال، ماشینی که در خیابان پارک شده را می توان دید، آن را لمس 

 گفته می شود. publicدسترسی نیست. به اجزایی از کلاس که در دسترس عموم قرار دارند 

 اعضای عمومی یک کلاس 

س برخی اعضای کلاس در اختیار دیگر کلا #Cتلقی می گردد. در زبان  privateبخش هایی از کلاس که از دید و دسترسی عموم پنهان است 

ها قرار می گیرند و در عین حال برخی دیگر اعضای کلاس از دید و دسترس کلاس های دیگر پنهان می شوند. برای محدود کردن سطح 

استفاده می شود. حال، برای در دسترس  privateدسترسی به بخش یا عضوی از کلاس که باید مخفی یا خصوصی باقی بماند از کلید واژه ی 

و  publicتعریف کرد. به کلید واژه های  publicز کلاس که خصوصی محسوب نمی شود، باید متغیر را با کلید واژه ی قرار دادن آن بخش ا

private  سطح دسترسی(access level ) .نیز گفته می شود 

حسوب می شوند و م privateبه صورت پیش فرض، تمامی متغیر های عضوی که تعریف می کنید ولی سطح دسترسی آن را مشخص نمی کنید، 

بدین ترتیب برای غیراعضای یک کلاس قابل دسترسی نمی باشد.  به این خاطر چنانچه می خواهید عضوی را برای غیراعضای یک کلاس قابل 

چ می توان ترکیبی از اعضای خصوصی و عمومی در کلاس خود ایجاد کرد و هی تعریف کنید. puplicدسترس کنید، باید آن را با کلید واژه ی 

 قانون خاصی مبنی بر این که کدام اول باید فهرست شود و کدام آخر وجود ندارد.

 مثال

    public class House 
    { 
        string propertyNumber; 
        public char propertyType; 



 

198 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

        byte stories; 
        public uint bedrooms; 
        private decimal value; 
    } 

می شود. برای  privateفقط به خاطر داشته باشید که در صورت تعیین نکردن سطح دسترسی، عضو کلاس تعریف شده خودکار خصوصی یا 

 جلوگیری از بروز هر نوع خطا، حتماً توصیه می شود سطح دسترسی عضو کلاس را مشخص کنید. 

    public class House 
    { 
        public string propertyNumber; 
        public char propertyType; 
        public byte stories; 
        public uint bedrooms; 
        public decimal value; 
    } 

 تعیین سطح دسترسی به اعضای کلاس

 را به صورت زیر اصلاح کنید. storeitemsکلاس 

    public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
    } 

 اعضای داخلی کلاس

ا کنند. در به اشیإی خود برنامه و برنامه های دیگر اجازه می دهد که به عضو عمومی یک کلاس دسترسی پید publicدیدیم که کلیدواژه ی 

تنها به اعضای خود آن کلاس اجازه ی دسترسی به اعضای خصوصی را فراهم می کردیم. چنانچه مایل  privateحالی که با استفاده از کلید واژه 

لامت ع internalهستید عضوی ایجاد کنید که تنها برای اعضا و اشیإ خود آن کلاس قابل دسترسی باشد، لازم است آن را با کلید واژه ی  

 گذاری کنید. تفاوت بین این کلید واژه ها در زیر شرح داده شده.

چنانچه کلاسی با کلیدواژه های زیر علامت گذاری یا   

 تعریف شده باشد :
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  public internal private 

فقط دیگر اعضای همین کلاس می توانند به این عضو 

 دسترسی پیدا کنند

 بله بله بله

ه، حتی اعضای خارج از این کلاس، تمام اعضای این برنام

 به این عضو دسترسی دارند

 خیر بله بله

اشیا خارج از این برنامه می توانند به این عضو 

 دسترسی پیدا کنند

 خیر خیر بله

  

 مقدار دهی اولیه ی شی

 عملگر نقطه ).(

ن کلاس را تعریف کنید. اکنون، برای دسترسی به عضو به منظور دستیابی به عضوی از کلاس از طریق کلاسی دیگر، ابتدا باید متغیری از آ

 استفاده کنید. "." موردنظر از عملگر 

پس از تعریف نمونه ای از کلاس، می توان به اعضای کلاس نام برده دسترسی داشت و به آن ها مقادیر دلخواه را تخصیص داد. به مثال زیر 

 توجه کنید.

    public class House 
    { 
        internal long propertyNumber; 
        internal string propertyType; 
        internal uint bedrooms; 
        internal double value; 

}     

    public class Exercise 
    { 
        static void Main() 
        { 
            var property = new House(); 
            property.propertyNumber = 283795; 
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            property.propertyType = "Single Family"; 
            property.bedrooms = 4; 
            property.value = 652880; 
        } 
    } 
 

 ل داشته باشند.امی توانند علامت سو (primitive types)به خاطر دارید که داده های نوع اولیه  

     public class House 
    { 
        internal long? propertyNumber; 
        internal string propertyType; 
        internal uint? bedrooms; 
        internal double? value; 
    } 
    public class Exercise 
    { 
        static void Main() 
        { 
            var property = new House(); 
            property.propertyNumber = 283795; 
            property.propertyType = "Single Family"; 
            property.bedrooms = 4; 
            property.value = 652880; 
        } 
    } 
 

 به آن دسترسی پیدا کرده، سپس مقدار آن را بازیابی کرد."."  پس از مقدار دهی اولیه ی فیلد یک کلاس، می توان با به کار بردن عملگر

     public class House 
    { 
        internal long? propertyNumber; 
        internal string propertyType; 
        internal uint? bedrooms; 
        internal double? value; 
    } 
    public class Exercise 
    { 
        static void Main() 
        { 
            var property = new House(); 
            property.propertyNumber = 283795; 
            property.propertyType = "Single Family"; 
            property.bedrooms = 4; 
            property.value = 652880; 
            System.Console.WriteLine("=//= Altair Realtors =//="); 
            System.Console.WriteLine("Properties Inventory"); ; 
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            System.Console.Write("Property #:  "); 
            System.Console.WriteLine(property.propertyNumber); 
            System.Console.Write("Property Type:  "); 
            System.Console.WriteLine(property.propertyType); 
            System.Console.Write("Bedrooms:       "); 
            System.Console.WriteLine(property.bedrooms); 
            System.Console.Write("Market Value:  "); 
            System.Console.WriteLine(property.value); 
            System.Console.ReadKey(); 
        } 
    } 
 
 

 نتیجه ی زیر را به دست می دهد.

        =//= Altair Realtors =//= 
        Properties Inventory 
        Property #:  283795 
        Property Type:  Single Family 
        Bedrooms:       4 
        Market Value:  652880 
        Press any key to continue... 

 به کاربردن فیلدهای یک کلاس

 .کلیک کرده تا به فایل دسترسی پیدا کنید DepartmentStore.cs، روی Code Editor. در بالاترین قسمت 8

 .. فایل بالا را بدین ترتیب اصلاح کنید2

    class DepartmentStore 
    { 
        static void Main() 
        { 
            StoreItem si = new StoreItem(); 
            si.itemNumber = 720823; 
            si.itemName = "Cotton Seam Sheath Dress"; 
            si.size = "6"; 
            si.unitPrice = 158M; 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(si.size); 
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            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.ReadKey(); 
        } 
    } 

 . برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد.1

  

        Department Store 
        Item #:     720823 
        Item Name:  Cotton Seam Sheath Dress 
        Item Size:  6 
        Unit Price: 158 

 را ببندید. ((message box. حال، کادر پیغام 1

 به کاربردن نوع ناشناس 

تعریف کرده، سپس آن را مقدار دهی اولیه کنید. همان طور که پیش تر ذکر شد، برای به کاربردن کلاس ابتدا باید متغیری برای آن 

خوشبختانه به منظور مقدار دهی اولیه یک شی، نیازی به استفاده از کلاس نیست. می توان متغیری مشابه نمونه ی کلاس تعریف کرده، بعد 

س( یاد می شود. به منظور استفاده از آن ) یا نوع ناشنا anonymous typeآن را به صورت دلخواه مقدار دهی اولیه کرد. از این نوع با نام 

استفاده کنید. به جای استفاده  newتعریف کرده و به منظور تخصیص حافظه به آن از عملگر  varکافی است متغیر مورد نظر را با کلید واژه ی 

ک تک اعضا انتخاب کرده، گویی دارید اسمی برای ت}{  تایپ کنید. حال در را newرا درج کرده، سپس عملگر }{ از اسم کلاس، ابتدا علامت 

 ، تعریف را با}{های دلخواه مقدار دهی اولیه کنید. پس از علامت  valueاسم عضو های کلاس را تعریف می کنید، سپس هر متغیر عضو را با 

 به پایان برسانید.( ;)

 مثال

    public class Exercise 
    { 
        static void Main() 
        { 
            var BookInformation = new 
            { 
                Title = "Calculus 6e Edition", 
                Pages = 1074, 
                Cover = "Hard Back" 
            }; 
        } 
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    } 
رتیب اسم متغیر، عملگر نقطه، متغیر عضو، به تک تک اعضای آن پس از مقدار دهی اولیه ی نوع ناشناس، می توان با تایپ کردن به ت

 دسترسی پیدا کرد.

 مثال

    public class Exercise 
    { 
        static void Main() 
        { 
            var BookInformation = new 
            { 
                Title = "Calculus 6e Edition", 
                Pages = 1074, 
                Cover = "Hard Back" 
            }; 
            System.Console.WriteLine("=//= BookInformation =//="); 
            System.Console.Write("Title:         "); 
            System.Console.WriteLine(BookInformation.Title); 
            System.Console.Write("Nbr of Pages:  "); 
            System.Console.WriteLine(BookInformation.Pages); 
            System.Console.Write("Type of Cover: "); 
            System.Console.WriteLine(BookInformation.Cover); 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

         =//= BookInformation =//= 
        Title:         Calculus 6e Edition 
        Nbr of Pages:  1074 
        Type of Cover: Hard Back 
        Press any key to continue... 

 

متعدد فقط خواندن آن را سهل می کند. می توان تمامی جزئیات را در خطی یکسان قرار به خاطر داشته باشید که قرار دادن تعریف در خط های 

 داد. 

    public class Exercise 
    { 
        static void Main() 
        { 
            var book = new { Title = "Calculus 6e Edition", Pages = 1074 }; 
            System.Console.WriteLine("=//= BookInformation =//="); 
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            System.Console.Write("Title:         "); 
            System.Console.WriteLine(book.Title); 
            System.Console.Write("Nbr of Pages:  "); 
            System.Console.WriteLine(book.Pages); 
            System.Console.ReadKey(); 
        } 
    } 

 مدیریت فیلدهای کلاس 

 بهره می گیرد.  combo boxاز دو  Code Editorبرای سهولت و مدیریت بهتر فیلدهای یک کلاس، 

  

 

 Combo box  .سمت چپ، کلاس های موجود در فایل جاری را نمایش می دهندCombo box  سمت راست، اعضای انتخابی کلاس از

Combo box .سمت چپ را به نمایش می گذارد 

http://articles.tahlildadeh.com/image.axd?picture=image_1061.png
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 نحوه ی دسترسی به فیلد

 از راه های مختلفی می توان به فیلد دسترسی پیدا کرد از جمله

 فایل دربردارنده ی کلاس را باز کنید. همان طور که مشاهده می کنید، فیلد در فایل بیان شده قابل رویت می باشد

را انتخاب کنید. اسم فیلد مورد نظر را  Edit -> Quick Findمراجعه کرده، گزینه های  main menuفایل حاوی کلاس را باز کنید. به 

 کلیک کنید. لازم به ذکر است که در این روش، باید اسم دقیق فیلد مورد نظر را از قبل داشته باشید.  Find Nextتایپ کرده، روی 

آن در قسمت پایینی بدنه ی ، روی اسم کلاس حاوی فیلد کلیک کنید. لیست اعضای Class Viewدر قسمت بالایی بدنه ی پنجره ی 

 پنجره نمایان می شود. اکنون می توانید روی آن دوبار کلیک کنید.

، روی اسم فیلد راست Class View، روی اسم کلاس حامل فیلد کلیک کنید. در قسمت پایینی Class Viewدر بخش فوقانی بدنه ی 

 را کلیک کنید.  Go To Definitionکلیک کرده، سپس گزینه ی 

 یر اسم فیلد تغی

( text editing)می توان اسم فیلد را باب میل تغییر داد. کافی است فیلد را در فایل مورد نظر پیدا کرده و با دانش خود از ویرایش متن 

کلیک  Edit -> Quick Replaceروی  main menuنام فیلد را اصلاح کرد. سرانجام، می توانید پس از باز کردن فایل حاوی کلاس، در 

را انتخاب کنید. این روش برای بازدید کردن از تمام بخش هایی که فیلد  Replaceیا  Find Nextکنید، اسم فیلد را تایپ کرده، سپس 

 در آن به کار رفته بسیار کارامد است. 

http://articles.tahlildadeh.com/image.axd?picture=image_1062.png
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 برای این امر بسیار مناسب است.  visual studioمحیط برنامه نویسی 

 visual studioبه منظور تغییر اسم در محیط 

کلیک کنید. حال،  Quick Replaceروی گزینه ی  main menuرا با هم بزنید، و یا در  Ctrl + Hفایل حاوی کلاس را باز کنید. یا کلیدهای 

 را انتخاب کنید.  Replace All، اسم فیلد را وارد کرده و Find Whatدر قسمت 

را بزنید و یا  Ctrl + Hدر آن قرار داده شود. کلیدهای ( caret^ )تا علامت  فایل حامل کلاس را باز کنید. روی فیلد مورد نظر کلیک کنید

ظاهر می شود که در آن فیلد انتخابی را وارد  Find Whatای به نام  combo boxرا کلیک کنید.  main menu ،Quick Replaceدر 

 کلیک کنید.  Replace Allکرده، سپس روی دکمه ی 

، باید روی اسم کلاس کلیک کنید. در قسمت پایینی پنجره، روی فیلد راست کلیک کرده سپس Class Viewدر سمت بالایی پنجره ی 

Rename  را انتخاب کنید... حال، در کادر متنNew Name  اسم دلخواه فیلد را درج کنید. برای تنظیم و تغییر اسم در بخش

comment و  ها string ها، باید بهcheckbox از انجام دستورات بالا، روی  ها مراجعه کرد. پسok  کلیک کنید. در پنجره ی محاوره

Preview Changes – Rename فهرستی از تمامی بخش هایی که فیلد در آن به کار رفته نمایان می باشد. اکنون گزینه ،Apply  را

 انتخاب کنید. 

 مبانی متدها

توسط جنبه هایی همچون تعداد اتاق های  Houseمثال، کلاسی به نام  فیلدها در واقع وظیفه ی توصیف کلاس را بر عهده دارند. برای

 آن توصیف می شود. (value)و ارزش  (property type)، نوع ملک (bedrooms)خواب 

    public class House 
    { 
        public char propertyType; 
        public uint bedrooms; 
    } 

 methodیا  functionاند عملیاتی و یا انتسابی معین انجام دهد. عملیاتی که یک کلاس برای شما انجام می دهد، علاوه بر این، شی می تو

 خوانده می شود. متد اساساً بخشی از کد است، که در راستای قابلیت ها و کاربرد کلاس، یکی از جزئیات عملیات را ایفا می کند. 

 معرفی متدها

8 .Microsoft Visual Studio .را راه اندازی کنید 
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 انتخاب کنید. File -> New  Projectهایمراجعه کرده و گزینه  main menu. برای ایجاد برنامه ی کاربردی جدید، به 2

 را از لیست میانی انتخاب کنید. Empty Projectگزینه ی . 1

 را کلیک کنید. okتغییر داده، سپس  DepartmentStore2. اسم را به 4

 را انتخاب کنید. ...Project -> Add New Itemگزینه های  main menu. در 5

 را انتخاب کنید. Code File، گزینه ی Add New Item. در فهرست میانی پنجره ی محاوره ی 2

 را کلیک کنید. Addتغییر داده، بعد   StoreItem. اسم مورد نظر را به 4

 . در فایل پیش رو دستورات زیر را تایپ کنید.1

    public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
    } 

 راست کلیک کنید. ...DepartmentStore2 -> Add -> New Item، روی Solution Explorer، در code file. به منظور ایجاد 1

 را کلیک کنید. Add New Item ،Code File. در لیست میانی پنجره ی محاوره 82

 کلیک کنید. Addتغییر داده و روی  DepartmentStore. اسم را به 88

 . در فایل خالی که در اختیارتان قرار می گیرد، عبارات زیر را تایپ کنید.82

    public class DepartmentStore 
    { 
        static void Main() 
        { 
            StoreItem si = new StoreItem(); 
            si.itemNumber = 720823; 
            si.itemName = "Cotton Seam Sheath Dress"; 
            si.size = "6"; 
            si.unitPrice = 158M; 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
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            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(si.size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.ReadKey(); 
            System.Console.ReadKey(); 
        } 
    } 

 . برای مشاهده ی نتیجه برنامه را اجرا کنید.81 

 را بسته و به محیط برنامه نویسی بازگردید. DOS. پنجره ی 84

 ساختن متد 

برای ایجاد یک متد باید ابتدا اسم آن را مشخص کنید. فرایند تعریف اسم متد نیز از همان قوانینی که برای انتخاب اسم متغیرها تشریح 

 .. در این مبحث، همان پیشنهاداتی را که برای گزینش اسم کلاس ارائه کردیم، برای انتخاب اسم متد نیز به کار می بریمکردیم پیروی می کند

 .چنانچه اسم متد در یک کلمه خلاصه شده باشد، فقط حرف اول را با حروف بزرگ می نویسیم

 .ا حرف بزرگ نمایش داده می شوددر صورتی که اسم متد متشکل از چند کلمه باشد، حروف اول تمام کلمات ب

 به دنبال اسم متد پرانتز می آید.  به این خاطر که متد یک عملیات محسوب می شود، سرانجام باید آن را یک فعل نام گذاشت

ند. در یکی از کارهای متد تخصیص دادن یک مقدار معین در برنامه است. بدین ترتیب پس از این کار، متد می تواند مقداری را فراهم ک

که متد ارائه می دهد  (type)می گویند. نوعی  voidنتیجه، متد نتیجه را بر می گرداند. چنانچه نتیجه ای از متد نام برده حاصل نشد، به آن 

تایپ کنید. عملیات  void)یا باز می گرداند(، در سمت چپ اسم متد درج می شود. چنانچه متد نتیجه ای دربر نداشت، در سمت چپ آن 

 محصور می شود. }{صیص که متد نقل می کند، داخل تخ

 نمونه

    public class House 
    { 
        public char propertyType; 
        public uint bedrooms; 
        void Display() 
        { 
        } 
    } 

 نامیده می شود. Mainمتد  ،#Cپرکاربرد ترین متد زبان برنامه نویسی 
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 . استفاده می کنیم ClassName.MethodNameتوجه : از این بخش به بعد، برای اشاره به متدی که متعلق به یک کلاس است از  

 سطح دسترسی متد 

  privateیاگر قرار است متد تنها برای اعضای خود آن کلاس قابل دسترسی باشد، متد گفته شده را با کلید واژه درست مانند متغیر عضو 

 خاصی لحاظ نکرد(.  acces modifier /ت گذاری کنید )یا می توان هیچ گونه تنظیم کننده ی دسترسی علام

واژه  به منظور این که متد برای تمامی اعضای کلاس و دیگر بخش های همین برنامه )نه خارج از این برنامه( قابل دسترسی باشد، آن را با کلید

 تعریف کنید. internalی 

ستید متدی برای تمامی اعضای این کلاس، دیگر بخش های همین برنامه و اجزای برنامه های دیگر قابل دستیابی باشد، کافی چنانچه مایل ه

 تعریف کنید.  publicواژه ی  است متد بیان شده را با کلید

ل، می توان متغیر های عضو را داخل ( پرداخت. برای مثا}{پس از ایجاد متد، می توان به تعریف کارکرد آن )در بدنه ی متد، داخل علامت 

 .نوشت. به مثال های زیر توجه کنید ()System.Console.WriteLineیا  ()System.Console.Writeپرانتزهای 

    public class House 
    { 
        public char propertyType; 
        public uint bedrooms; 
        internal void Display() 
        { 
            System.Console.WriteLine("=//= Altair Realtors =//="); 
            System.Console.WriteLine("Properties Inventory"); ; 
            System.Console.Write("Property Type:  "); 
            System.Console.WriteLine(PropertyType); 
            System.Console.Write("Bedrooms:       "); 
            System.Console.WriteLine(Bedrooms); 
        } 
    } 

 می توانید هر تعداد متد که لازم است، به همین ترتیب ایجاد کنید. 

 فراخوانی متد 

پس از ساختن متد، می توان از داخل یا خارج کلاس به آن دسترسی پیدا کرد. فراخوانی یک متد، در واقع همان دسترسی پیدا کردن به متد 

خلاف فیلد، لازم است به دنبال اسم کلاس پرانتز گذاشته شود. نمونه ی آن را است. برای این منظور، از عملگر نقطه کمک گرفته می شود. بر 

 .در مثال زیر مشاهده می کنید
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      public class House 
    { 
        public char propertyType; 
        public uint bedrooms; 
        internal void Display() 
        { 
            System.Console.WriteLine("=//= Altair Realtors =//="); 
            System.Console.WriteLine("Properties Inventory"); ; 
            System.Console.Write("Property Type:  "); 
            System.Console.WriteLine(propertyType); 
            System.Console.Write("Bedrooms:       "); 
            System.Console.WriteLine(bedrooms); 
        } 
    } 
    public class Program 
    { 
        static void Main() 
        { 
            var property = new House(); 
            property.propertyType = 'S'; 
            property.bedrooms = 4; 
            property.Display(); 
        } 

}     

 .نتیجه ی زیر به دست می آید

        =//= Altair Realtors =//= 
        Properties Inventory 
        Property Type:  S 
        Bedrooms:       4 
        Press any key to continue... 

 

 های یک کلاسنحوه ی ایجاد متد

 را انتخاب کنید. فایل مورد نظر باز می شود. Window -> StoreItem.cs، گزینه های main menu. در 8

 . برای افزودن متد به کلاس، فایل را به صورت زیر اصلاح کنید.2

    public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
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        public string size; 
        public decimal unitPrice; 
        public void CreateItem() 
        { 
            itemNumber = 792475; 
            itemName = "Aramis Gentlemen Collection 3.4oz JHL Custom Blended Cologne Spray"; 
            size = "3.4oz"; 
            unitPrice = 48.00m; 
        } 
        public void Describe() 
        { 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(unitPrice); 
        } 

}     

1 .main menu  را باز کرده و روی گزینه هایWindow -> DepartmentStore.cs .کلیک کنید 

 . فایل مورد نظر را به صورت زیر تغییر دهید :4

    public class DepartmentStore 
    { 
        static void Main() 
        { 
            StoreItem si = new StoreItem(); 
            si.CreateItem(); 
            si.Describe(); 
            System.Console.ReadKey(); 
        } 

}     

 اکنون، برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد.

      Department Store 

        Item #:     792475 
        Item Name:  Aramis Gentlemen Collection 3.4oz JHL Custom Blended Cologne Spray 
        Item Size:  3.4oz 
        Unit Price: 48.00 
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 را بسته و به محیط برنامه نویسی بازگردید. DOS. پنجره ی 6

 متدی که مقدار باز می گرداند  

قرار دهد، در این صورت متد دیگر  پس از این که متدی مقداری را حمل کرد، باید محصول و نتیجه ی آن را در اختیار دیگر متدها و کلاس ها

یا بی مقدار باشد و سرانجام باید مقداری را بازگرداند. برای تعریف متدی که مقدار باز می گرداند، باید نوع بازگشتی  voidنمی تواند 

(return type ).را در سمت چپ اسم متد قرار داد 

 مثال

     class Exercise 

    { 
        double Operate() 
        { 
        } 
    } 

 همچنین می توانید علامت سوأل به نوع داده ی مورد نظر خود اضافه کنید. مثال زیر را در نظر بگیرید.

    class Exercise 
    { 
        double? Operate() 
        { 
        } 
    } 

د آن متد مورد استفاده قرار می گیرند. متغیری که در بدنه ی متد تعریف می در بدنه ی متد، می توان چند متغیر تعریف کرد که فقط توسط خو

شود، متغیر محلی نامیده می شود. متغیر محلی تنها از داخل متد قابل دسترسی است )نمی توان به آن خارج از کلاس دسترسی پیدا کرد(. 

ما می توانید هر کاری که مناسب می دانید با آن انجام دهید. برای پس از تعریف متغیر محلی، متد بلافصله به آن دسترسی پیدا می کند و ش

 مثال می توانید پیش از استفاده، به متغیر محلی مقدار اختصاص دهید.

به  را تایپ کرده و returnپس از این که متد وظیفه ی محوله را انجام داد، باید مقداری را ارائه دهد. برای این منظور باید ابتدا کلید واژه ی 

 رید.بگیدنبال آن مقداری را که متد باز می گرداند قرار دهید. مقدار بازگردانده شده باید با نوع بازگشتی متد یکی باشد. مثال زیر را در نظر 

    class Exercise 
    { 
        double Operate() 
        { 
            return 24.55; 
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        } 
    } 

یح است.اگر چه این نیز صح  

    class Exercise 
    { 
        double? Operate() 
        { 
            return 24.55; 
        } 
    } 

بازگرداند، البته به شرط این که عبارت بیان شده مقداری تولید کند که با نوع بازگشتی هم خوانی  (expression)متد ممکن است عبارت 

 به مثال زیر جلب کنید. داشته باشد. توجه خود را

    class Exercise 
    { 
        double? Operate() 
        { 
            return 24.55 * 4.16; 
        } 

}     

 بازگرداندن یک مقدار از متد

 کلیک کنید. Window -> StoreItem.cs. در فهرست گزینه ی اصلی، روی 8

 د.. فایل را به صورت زیر اصلاح کنی2

    public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
        public void CreateItem() 
        { 
            itemNumber = 792475; 
            itemName = "Aramis Gentlemen Collection 3.4oz JHL Custom Blended Cologne Spray"; 
            size = "3.4oz"; 
            unitPrice = 48.00m; 
        } 
        public decimal CalculateTotalValue() 
        { 
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            return unitPrice; 
        } 
        public void Describe() 
        { 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:      "); 
            System.Console.WriteLine(itemNumber); 
            System.Console.Write("Item Name:   "); 
            System.Console.WriteLine(itemName); 
            System.Console.Write("Item Size:   "); 
            System.Console.WriteLine(size); 
            System.Console.Write("Unit Price:  "); 
            System.Console.WriteLine(unitPrice); 
            System.Console.Write("Total Value: "); 
            System.Console.WriteLine(CalculateTotalValue()); 
        } 
    } 

 . برنامه را اجرا کرده تا نتیجه ی عملیات را مشاهده کنید.1

 را بسته و به محیط برنامه نویسی خود بازگردید. DOS. پنجره ی 4

 یک برنامه ی کاربردی ()Mainمقدمه ای بر تابع  

و به صورت پیش فرض  New Project)که هنگام ایجاد برنامه ی کاربردی جدید و با به کار بردن پنجره ی محاوره ی  ()Mainتاکنون با تابع 

می باشد. راه دیگری که برای پیاده سازی  voidاز نوع  ()Mainتعریف می شود( کار کردیم. در چنین پیاده سازی به صورت پیش فرض تابع 

 ()Mainاجرا است. تابع  قابل  .intهمین قانون برای تمام متدهای نوع   باشد. integer وجود دارد، این است که متد، از نوع  ()Mainتابع 

 بازگشتی معتبر باشد(. integerای بازگرداند ) البته به شرط این که  integerمی تواند هر نوع 

 مثال

    class Exercise 
    { 
        char? HaveCharacter() 
        { 
            return 'G'; 
        } 
        static int Main() 
        { 
            Exercise exo = new Exercise(); 
            System.Console.Write("Character: "); 
            System.Console.WriteLine(exo.HaveCharacter()); 
            return 244006; 
        } 
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    } 
 نتیجه ی زیر به دست می آید. 

Character: G 
Press any key to continue... 

 

، روی آن بخشی که می خواهید تابع نام برده را اضافه کنید راست کلیک کرده، skeleton codeبا استفاده از  Mainبه منظور ایجاد تابع  

 دوبار کلیک کنید. #Visual Cرا انتخاب کنید. حال، روی گزینه ی  ...Insert Snippetسپس گزینه ی 

 ("static void Main"دوبار کلیک کنید. )مخفف  svmکه مقداری باز نمی گرداند، روی  ای ایجاد کنید Mainچنانچه مایلید تابع 

 

  

 ( دوبار کلیک کنید."static int Main")مخفف simباز می گرداند، روی  integerای که  Mainبه منظور ایجاد تابع 

 ()Mainبازگرداندن مقداری از تابع  

 کرده تا به آن دسترسی پیدا کنید، سپس آن را به صورت زیر اصلاح کنید : کلیک DepartmentStore.cs. روی دکمه ی 8

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_33.gif
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    public class DepartmentStore 
    { 
        static int Main() 
        { 
            StoreItem si = new StoreItem(); 
            si.CreateItem(); 
            si.Describe(); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 . برنامه را اجرا کرده تا نتیجه ی آن را ببینید.2

 را بسته و به محیط برنامه نویسی بازگردید. DOS. پنجره ی 1

 مبانی آرگومان های متد  

تدهایی که در بخش های پیشین به کار بردیم، برای تبادل متد تکلیفی را انجام می دهد که تکمیل کننده ی عملیات یک کلاس است. م

اطلاعات بین بخش های مختلف برنامه به متغیرهای محلی تکیه می کردند. گاهی اوقات یک متد برای تکمیل عملیات کلاس به چند مقدار نیاز 

را فرا می خواند باید مقدارهای لازم آن را تامین دارد. خصوصیت برجسته ای که مقادیر ذکر شده دارند این است که، متد دیگری که این متد 

 به مقداری که متد برای تکمیل وظیفه محوله به آن نیاز دارد، آرگومان گفته می شود.  کند.

  

درست مشابه متغیر، یک آرگومان با نوع مقدارش تعریف و نمایش داده می شود. برای مثال، متدی ممکن است به کاراکتر نیاز داشته باشد، 

نیاز داشته باشد. به  (decimal number) در حالی که متدی دیگر به یک رشته نیاز دارد. حتی ممکن است متغیر دیگری به عدد اعشاری

عبارت دیگر، متد یا کلاسی که متد دیگری را فرا می خواند، مسئول تامین مقدارهای مناسب و مورد نیاز است )البته یک متد ممکن است خود 

 ی برای اعتبار سنجی چنین مقداری داشته باشد(. مکانیزم داخل

  

مقداری که برای متدی فراهم می شود، داخل پرانتزهای متد تایپ می شود. یک متد باید نوع مقداری که به آن نیاز دارد را مشخص کند، به 

 همین خاطر آرگومان مورد نظر با نوع داده ی معین و یک اسم نمایش داده می شود. 

  

 د که می خواهیم متدی تعریف کنیم که طول ضلع یک مربع را نمایش دهد. چنین متدی به صورت زیر تعریف می شود.تصور کنی

    class Exercise 
    { 
        void ShowCharacter(char c) 
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        { 
        } 
    } 

داشته  (null value)نوع داده ی مزبور می تواند مقدار تهی  در صورتی که نوع داده ی آرگومان از نوع اولیه بود، برای این که نشان دهیم

 باشد، به آن علامت سوأل اضافه می کنیم. نمونه ی آن را در زیر مشاهده می کنید :

    class Exercise 
    { 
        void ShowCharacter(char? c) 
        { 
        } 
    } 

ن را لحاظ کرد )هم چنین می توان مقدار آرگومان را در بدنه ی متد به کار نبرد(. مثال زیر مقدار می توان در بدنه ی یک متد مقدار آرگوما

 آرگومان را در بدنه ی متد نمایش می دهد.

    class Exercise 
    { 
        void ShowCharacter(char c) 
        { 
            System.Console.WriteLine(c); 
        } 
    } 

 نمونه ی زیر نیز معتبر و صحیح است.

    class Exercise 
    { 
        void ShowCharacter(char? c) 
        { 
            System.Console.WriteLine(c); 
        } 
    } 

 به همین شیوه می توان مقدار ارائه شده را به صورت دلخواه تنظیم و اداره کرد.

 رگومان می گیرد فراخوانی متدی که آ 

آرگومان در وهله ی اول برای استفاده از یک متد باید آن را فرا خواند. به منظور فراخوانی متدی که آرگومان می گیرد، ابتدا باید مقداری برای 

قرار دهیم، در غیر این دریافت می کنید. همچنین باید مقدار مناسب را در اختیار آرگومان ( error)فراهم کنید، در غیر این صورت پیغام خطا 

 صورت متد آن گونه که باید کار خود را درست انجام نمی دهد و نتیجه ی اتکاناپذیر و نامعتبر به دست می دهد. 

  

 چنانچه متد حین فراخوانی، آرگومان بگیرد، می توانید داخل پرانتز آن مقداری تایپ کنید.
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  مثال

    class Exercise 
    { 
        void ShowCharacter(char c) 
        { 
            System.Console.WriteLine(c); 
        } 
        static int Main() 
        { 
            Exercise exo = new Exercise(); 
            System.Console.Write("Character: "); 
            exo.ShowCharacter('W'); 
            return 0; 
        } 
    } 

 متدی که آرگومان می گیرد، همچنین می تواند متغیرهای محلی خود را تعریف کند. 

 ارسال آرگومان ها  

 کلیک کرده تا فایل مورد نظر باز شود، سپس آن را به صورت زیر اصلاح کنید. StoreItem.cs. روی دکمه ی 8

  public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
        public void CreateItem() 
        { 
            itemNumber = 911792; 
            itemName = "Girls Tillie Poplin Dress"; 
            size = "12"; 
            unitPrice = 110.00m; 
        } 
        public decimal CalculateTotalValue(int qty) 
        { 
            return unitPrice * qty; 
        } 
        public void Describe() 
        { 
            int quantity = 6; 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:      "); 
            System.Console.WriteLine(itemNumber); 
            System.Console.Write("Item Name:   "); 
            System.Console.WriteLine(itemName); 
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            System.Console.Write("Item Size:   "); 
            System.Console.WriteLine(size); 
            System.Console.Write("Unit Price:  "); 
            System.Console.WriteLine(unitPrice); 
            System.Console.Write("Quantity:    "); 
            System.Console.WriteLine(quantity); 
            System.Console.Write("Total Value: "); 
            System.Console.WriteLine(CalculateTotalValue(quantity)); 
        } 

}     

 

 . اکنون برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد.2 

        Department Store 
        Item #:      911792 
        Item Name:   Petite Tropical Wool Pencil Skirt 
        Item Size:   12 
        Unit Price:  110.00 
        Quantity:    6 
        Total Value: 660.00 

 را بسته و به محیط برنامه نویسی بازگردید. DOS. پنجره ی 1

 ارسال چندین آرگومان به یک متد

مان های متعدد داشته باشد. البته، برای تک تک آرگومان ها باید یک اسم و نوع داده در نظر گرفته شود. آرگومان ها یک متد می تواند آرگو

 از هم جدا می شوند. به مثال زیر توجه کنید. )،(با ویرگول 

    class Exercise 
    { 
        void ShowEmployee(long employeeNumber, string fullName, 
                      char gender, double hourlySalary) 
        { 
        } 
    } 

 در صورت الزام، به آرگومان هایی که از نوع اولیه ی داده هستند، علامت سوال اضافه می کنیم.

 توجه 

 تفاده می کنیم.از این بخش درس به بعد، به منظور اشاره به متدی که متعلق به یک کلاس هست از قرداد زیر اس
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ClassName.MethodName(Arguments) 
  

 توجه داشته باشید که آیتم داخل پرانتز به آرگومانی که متد می گیرد اشاره دارد.

 توجه 

 از این بخش درس به بعد، می نویسیم " دستور نحوی این متد هست ".

ReturnValue ClassName.MethodName(Arguments); 
  

 ، اسم مورد نظر، و تعداد آرگومان های یک متد را ارائه می دهیم. (return type)م نوع بازگشتی با این کار داری

، C ،C++، Object Pascal ،Visual Basicخاتمه می دهیم. بر خلاف زبان های  (;)در قرارداد جدید ما، دستور نحوی را با نقطه ویرگول 

ما نمی دهد که اول تابعی را تعریف کنید، سپس آن را در بخش دیگر فایل یا فایلی مجزا این اجازه را به ش Javaو  #Cزبان برنامه نویسی 

  پیاده سازی کنید. ما از نقطه ویرگول برای نشان دادن ساختار یک متد استفاده می کنیم )و نه برای خود تعریف(.

مایلید به کار ببرید. برای مثال، می توانید مقادیر آن را با کنسول یا حتی تمامی آرگومان ها را هر طور که  8، 2هنگام تعریف متغیر، می توانید  

 نشان دهید. به مثال های زیر توجه کنید.

      class Exercise 
    { 
        void ShowEmployee(long employeeNumber, string fullName,char gender, double hourlySalary) 
        { 
            System.Console.Write("Employee #:    "); 
            System.Console.WriteLine(employeeNumber); 
            System.Console.Write("Full Name:     "); 
            System.Console.WriteLine(fullName); 
            System.Console.Write("Gender:        "); 
            System.Console.WriteLine(gender); 
            System.Console.Write("Hourly Salary: "); 
            System.Console.WriteLine(hourlySalary); 
            System.Console.ReadKey(); 
        } 

}     
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راه های مختلفی برای فراخوانی متدی که آرگومان می گیرد وجود دارد. دیدیم که هنگام فراخوانی متدی که آرگومان می گیرد، می توان  

 مقداری در پرانتزهای متد تایپ کرد. به همین ترتیب هم، هنگام فراخوانی متدی که چندین آرگومان می گیرد، کافی است مقدار مربوط را در

placeholder.آن آرگومان تایپ کنید. مثال های آن را زیر مشاهده می کنید 

    class Exercise 
    { 
        void ShowEmployee(long employeeNumber, string fullName, 
                          char gender, double hourlySalary) 
        { 
            System.Console.WriteLine("Employee Record"); 
            System.Console.WriteLine("-----------------------------"); 
            System.Console.Write("Employee #:    "); 
            System.Console.WriteLine(employeeNumber); 
            System.Console.Write("Full Name:     "); 
            System.Console.WriteLine(fullName); 
            System.Console.Write("Gender:        "); 
            System.Console.WriteLine(gender); 
            System.Console.Write("Hourly Salary: "); 
            System.Console.WriteLine(hourlySalary); 
        } 
        static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.ShowEmployee(572948, "Andrew Bridges", 'M', 22.85D); 
            return 0; 
        } 
    } 

 .این نتیجه را به دست می دهد

        Employee Record 
        ----------------------------- 
        Employee #:    572948 
        Full Name:     Andrew Bridges 
        Gender:        M 
        Hourly Salary: 22.85 
        Press any key to continue... 
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 فراخوانی آرگومان با استفاده از اسم 

دقیق هر آرگومان نیست. در عوض می  placeholderن های متعددی می گیرد، نیازی به استفاده از چنانچه متدی فراخوانی کنید که آرگوما

و  ):(توان به هر آرگومان با اسم آن اشاره کرد. برای این منظور، در پرانتزهای متد، ابتدا اسم آرگومان را تایپ کنید و به دنبال آن علامت 

 مقدار مناسب را درج کنید.

، قاعدتاً باید بتوانید فهرستی از اسم های آرگومان ")" ، پس از وارد کردن اسم متد و Microsoft Visual Studioبرنامه ی  در صورت کار با

 ها را به صورت زیر مشاهده کنید.

  

 

ید. حال، فهرستی را فشار ده Ctrl + Spaceسپس، می توانید اسم آرگومان را تایپ کنید. می توانید هم به جای تایپ کردن آن، کلید های 

 ظاهر می شود. در فهرست مذکور اسم های آرگومان ها قابل مشاهده می باشد.
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و به دنبال آن " : " اکنون می توانید اسم آرگومان را از فهرست انتخاب کنید. همان طور که پیش تر ذکر شد، پس از اسم آرگومان، علامت 

ب، می توان به هر آرگومان با استفاده از اسم دسترسی پیدا کرد، سپس مقدار به آن تخصیص مقدار آرگومان را وارد می کنیم. به همین ترتی

 از هم جدا کرد. مثال :  )،(داد و آن ها را با ویرگول 

    class Exercise 
    { 
        void ShowEmployee(long employeeNumber, string fullName,char gender, double hourlySalary) 
        { 
            System.Console.WriteLine("Employee Record"); 
            System.Console.WriteLine("-----------------------------"); 
            System.Console.Write("Employee #:    "); 

http://articles.tahlildadeh.com/image.axd?picture=clip_image005_31.jpg
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            System.Console.WriteLine(employeeNumber); 
            System.Console.Write("Full Name:     "); 
            System.Console.WriteLine(fullName); 
            System.Console.Write("Gender:        "); 
            System.Console.WriteLine(gender); 
            System.Console.Write("Hourly Salary: "); 
            System.Console.WriteLine(hourlySalary); 
        } 
        static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.ShowEmployee(fullName: "Annette Greens", hourlySalary: 16.85,employeeNumber: 519427, gender: 'F'); 
            return 0; 
        } 
    } 

 نتیجه

        Employee Record 
        ----------------------------- 
        Employee #:    519427 
        Full Name:     Annette Greens 
        Gender:        F 
        Hourly Salary: 16.85 
        Press any key to continue... 

 یک کلاسارسال آرگومان ها به متد 

  روش های ارسال آرگومان 

 ارسال آرگومان با استفاده از مقدار

است  هنگام فراخوانی متدی که چندین آرگومان می گیرد، گفتیم که ابتدا باید مقدارهای مورد نیاز آرگومان ها را فراهم کنیم. این به آن خاطر

باید )هنگام فراخوانی متدی که چندین آرگومان دارد( مقداری معتبر  (calling method)که )وجود( آرگومان الزامی بوده و متد فراخوان 

 ارائه دهد. به این روش از ارائه ی مقدار برای آرگومان، روش ارسال آرگومان با استفاده از مقدار گفته می شود. 

 نحوه ی ارسال آرگومان با استفاده از مقدار

8.      Microsoft Visual Studio  .را اجرا کنید 

 را کلیک کنید. ...File -> New Projectبرای ایجاد برنامه ی کاربردی جدید، به فهرست اصلی مراجعه کرده و گزینه های       .2
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1.      Empty Project  .را از لیست میانی انتخاب کنید 

 را فشار دهید. Enter سپس کلید تغییر داده، NationalBank1اسم را به       .4

 NationalBank1 -> Add: ، راست کلیک کرده و طبق دستور زیر به پیش بروید Solution Explorerظور ایجاد فایل جدید، در به من      .5

-> New Item.... 

 کلیک کنید. Code Fileدر لیست میانی روی       .6

 تغییر دهید. Managementاسم فایل را به       .4

 کلیک کنید. Addروی گزینه ی       .1

 ، دستورات زیر وارد کنید.Management.csدر فایل خالی       .1

    public class Management 
    { 
        private void ShowAccountInformation(string acntNbr, string name, short PIN, double balance) 
        { 
            System.Console.WriteLine("=============================="); 
            System.Console.WriteLine("Account Information"); 
            System.Console.WriteLine("------------------------------"); 
            System.Console.Write("Account #:     "); 
            System.Console.WriteLine(acntNbr); 
            System.Console.Write("Customer Name: "); 
            System.Console.WriteLine(name); 
            System.Console.Write("PIN:           "); 
            System.Console.WriteLine(PIN); 
            System.Console.Write("Balanace:      "); 
            System.Console.WriteLine(balance); 
            System.Console.WriteLine("=============================="); 
        } 
        public static int Main() 
        { 
            Management man = new Management(); 
            string accountNumber = "248-050842-749"; 
            string customerName = "Ann Kelley"; 
            short pin = 8648; 
            double currentBalance = 350.00D; 
            man.ShowAccountInformation(accountNumber, customerName,pin, currentBalance); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 

 را فشار دهید. F5. برای اجرای دستورات، کلید 82
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       ============================== 
        Account Information 
        ------------------------------ 
        Account #:     248-050842-749 
        Customer Name: Ann Kelley 
        PIN:           8648 
        Balanace:      350 
        ============================== 
 

 خارج شوید. DOSاز پنجره ی  Enter. پس از مشاهده ی نتایج، با فشار دادن کلید 88

 ارسال آرگومان با استفاده از ارجاع  

 برنامه ی زیر را در نظر بگیرید.

    public class Exercise 
    { 
        void GetDeposit(decimal amount) 
        { 
            amount = 450; 
            System.Console.WriteLine("In GetDeposit()"); 
            System.Console.Write("Amouont: $"); 
            System.Console.WriteLine(amount); 
        } 
        static int Main() 
        { 
            decimal amt = 0; 
            var exo = new Exercise(); 
            System.Console.WriteLine("In Main()"); 
            System.Console.Write("Amouont: $"); 
            System.Console.WriteLine(amt); 
            System.Console.WriteLine("-------------------------"); 
            exo.GetDeposit(amt); 
            System.Console.WriteLine("-------------------------"); 
            System.Console.WriteLine("Bank in Main()"); 
            System.Console.Write("Amouont: $"); 
            System.Console.WriteLine(amt); 
            return 0; 
        } 
    } 
  

 

 نتیجه ی زیر حاصل می گردد.
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        In Main() 
        Amouont: $0 
        ------------------------- 
        In GetDeposit() 
        Amouont: $450 
        ------------------------- 
        Bank in Main() 
        Amouont: $0 
        Press any key to continue... 

  

 یکسان است و هیچ فرقی نمی کند. ()GetDepositهمان طور که مشاهده می کنید، مقدار آرگومان قبل و پس از فراخوانی متد 

مقداری حافظه به آن تخصیص می دهد. در مورد متغیر دو چیز از اهمیت  compilerهنگامی که متغیری را در برنامه ی خود تعریف می کنید، 

 رخوردار است : مقدار متغیر و محل قرار گیری آن در حافظه. به مکان یا محل قرارگیری متغیر در حافظه، آدرس متغیر می گویند.بالایی ب

 calling)تنها کپی ای از مقدار آرگومان تهیه کرده، سپس آن را به متد فراخوان  compilerاگر آرگومان را با استفاده از اسم فراخوانی کنید، 

method )برد، اما نمی  ی دهد. اگرچه متد فراخوان مقدار آرگوامان ذکر شده را دریافت می کند و می تواند آن را به هر شکل ممکن به کارم

. اگر می خواهید (modify)تواند آن را )برای همیشه( تغییر دهد. در صورت نیاز می توان با فراخوانی متد، مقدار یک آرگومان را تغییر داد 

را بازگرداند، باید ارگومان را با استفاده از  (modified)مقدار آرگومان ارائه شده را تغییر داده، سپس مقدار تغییر داده شده  متد فراخوان

 ارسال کنید.  (reference)ارجاع 

 مان تایپ کرد.پیش از نوع داده ی آرگو را refحال، برای ارسال آرگومان با استفاده از ارجاع، حین تعریف متد، باید کلیدواژه ی 

 مثال

 Exercise class public     
    { 
        void GetDeposit(ref decimal amount) 
        { 
        } 
    } 

 زرا پس ا در متد، می توانید آرگومان را به کار ببرید )یا آن را نادیده بگیرید و مورد استفاده قرار ندهید(. هنگام فراخوانی متد، اسم آرگومان

 به کار ببرید. به مثال زیر توجه کنید. refکلیدواژه ی 

    public class Exercise 
    { 
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        void GetDeposit(ref decimal amount) 
        { 
        } 
        static int Main() 
        { 
            decimal amt = 0; 
            var exo = new Exercise(); 
            System.Console.WriteLine("In Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amt); 
            exo.GetDeposit(ref amt); 
            System.Console.WriteLine("Bank in Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amt); 
            return 0; 
        } 
    } 

 نتیجه

        In Main() 
        Amount: $0 
        Bank in Main() 
        Amount: $0 
        Press any key to continue... 

 

 است مقدار دلیل اصلی ارسال آرگومان به وسیله ی ارجاع، این است که به متد اجازه ی تغییر مقدار آرگومان داده شود. برای این منظور، لازم

 آرگومان را در متد تغییر داد.

 مثال

    
 public class Exercise 
    { 
        void GetDeposit(ref decimal amount) 
        { 
            amount = 450; 
            System.Console.WriteLine("In GetDeposit()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amount); 
        } 
        static int Main() 
        { 
            decimal amt = 0; 
            var exo = new Exercise(); 
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            System.Console.WriteLine("In Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amt); 
            System.Console.WriteLine("-------------------------"); 
            exo.GetDeposit(ref amt); 
            System.Console.WriteLine("-------------------------"); 
            System.Console.WriteLine("Bank in Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amt); 
            return 0; 
        } 
    } 

 نتیجه

         In Main() 
        Amount: $0 
        ------------------------- 
        In GetDeposit() 
        Amount: $450 
        ------------------------- 
        Bank in Main() 
        Amount: $450 
        Press any key to continue... 

 

 همان طور که در مثال بالا مشاهده کردید، این بار مقدار متغیر پس از فراخوانی تابع تغییر یافته.

به عنوان ارجاع ارسال کنید. این که کدام آرگومان با مقدار ارسال شود و کدام با ارجاع بستگی به این دارد می توانید کلیه ی آرگومان ها را 

 که شما می خواهید متد فراخوانده آرگومان را تغییر دهد یا نه. 

با  (reference)وشبختانه، ارجاع وجود دارد. خ returnدیدیم که )یک( تابع می تواند تنها یک مقدار بازگرداند، زیرا تنها یک کلیدواژه ی 

 داشتن قابلیت ارسال چندین آرگومان، به متد اجازه می دهد چندین مقدار بازگرداند. 

 آرگومان با استفاده از ارجاع نحوه ی ارسال

 را به صورت زیر اصلاح کنید. Management.csفایل     .8

    public class Management 
    { 
        private void ShowAccountInformation(string acntNbr, string name, short PIN, double balance) 
        { 
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            System.Console.WriteLine("=============================="); 
            System.Console.WriteLine("Account Information"); 
            System.Console.WriteLine("------------------------------"); 
            System.Console.Write("Account #:     "); 
            System.Console.WriteLine(acntNbr); 
            System.Console.Write("Customer Name: "); 
            System.Console.WriteLine(name); 
            System.Console.Write("PIN:           "); 
            System.Console.WriteLine(PIN); 
            System.Console.Write("Balanace:      "); 
            System.Console.WriteLine(balance); 
            System.Console.WriteLine("=============================="); 
        } 
 
        private double GetDeposit(ref double amount) 
        { 
            double deposit = 225.55; 
            amount = amount + deposit; 
            return deposit; 
        } 
        private double GetWithdrawal(ref double amount) 
        { 
            double withdrawal = 265.25d; 
            amount = amount - withdrawal; 
            return withdrawal; 
        } 
        public static int Main() 
        { 
            Management man = new Management(); 
            string accountNumber = "248-050842-749"; 
            string customerName = "Ann Kelley"; 
            short pin = 8648; 
            double currentBalance = 350.00D; 
            double? depositAmount = null; 
            double? withdrawalAmount = null; 
            man.ShowAccountInformation(accountNumber, customerName,pin, currentBalance); 
            depositAmount = man.GetDeposit(ref currentBalance); 
            System.Console.WriteLine("After a new deposit"); 
            man.ShowAccountInformation(accountNumber, customerName,pin, currentBalance); 
            withdrawalAmount = man.GetWithdrawal(ref currentBalance); 
            System.Console.WriteLine("After a withdrwal"); 
            man.ShowAccountInformation(accountNumber, customerName,pin, currentBalance); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 
 

 را زده تا برنامه اجرا شود. F5کلید     .2
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       ============================== 
        Account Information 
        ------------------------------ 
        Account #:     248-050842-749 
        Customer Name: Ann Kelley 
        PIN:           8648 
        Balanace:      350 
        ============================== 
        After a new deposit 
        ============================== 
        Account Information 
        ------------------------------ 
        Account #:     248-050842-749 
        Customer Name: Ann Kelley 
        PIN:           8648 
        Balanace:      575.55 
        ============================== 
        After a withdrwal 
        ============================== 
        Account Information 
        ------------------------------ 
        Account #:     248-050842-749 
        Customer Name: Ann Kelley 
        PIN:           8648 
        Balanace:      310.3 
        ============================== 

  

1.    Enter  را زده تا پنجره یDOS  شود.بسته 

 outارسال آرگومان  

، داخل پرانتز متد پیش از نوع داده ی outمی باشد. به منظور ارسال آرگومان  outروش دیگر ارسال آرگومان با استفاده از کلیدواژه ی 

 را تایپ می کنیم. outآرگومان کلیدواژه ی 

 مثال

    public class Exercise 
    { 
        void GetWithdrawal(out decimal amount) 
        { 
        } 
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    } 
آرگومان باید حتماً داخل خود متد  ،outاین است که در صورت ارسال آرگومان با کلید واژه ی  outو  refتفاوت اصلی بین کلید واژه های  

 مقداردهی اولیه شود.

 مثال

    public class Exercise 
    { 
        void GetWithdrawal(out decimal amount) 
        { 
            amount = 265.00m; 
        } 
    } 

 را پیش از آرگومان استفاده کنید. به مثال زیر توجه کنید. outمی گیرد، باید کلید واژه ی  outهنگام فراخوانی متدی که آرگومان 

public class Exercise 
    { 
        void GetDeposit(ref decimal amount) 
        { 
            amount = 450.00M; 
            System.Console.WriteLine("In GetDeposit()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amount); 
        } 
        void GetWithdrawal(out decimal amount) 
        { 
            amount = 265.00m; 
            System.Console.WriteLine("In GetWithdrawal()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(amount); 
        } 
        static int Main() 
        { 
            decimal depositAmount = 0M; 
            decimal withdrawalAmount = 0M; 
            var exo = new Exercise(); 
            System.Console.WriteLine("In Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(depositAmount); 
            System.Console.WriteLine("-------------------------"); 
            exo.GetDeposit(ref depositAmount); 
            System.Console.WriteLine("-------------------------"); 
            System.Console.WriteLine("Bank in Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(depositAmount); 
            System.Console.WriteLine("-------------------------"); 
            exo.GetWithdrawal(out withdrawalAmount); 



 

233 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            System.Console.WriteLine("-------------------------"); 
            System.Console.WriteLine("Bank in Main()"); 
            System.Console.Write("Amount: $"); 
            System.Console.WriteLine(withdrawalAmount); 
            return 0; 
        } 
    } 

 ارسال کنید، تمام تغییرات وارد آمده بر آرگومان حتی پس از اتمام متد، نگه داشته می شوند. outچنانچه آرگومانی را با کلید واژه ی 

       In Main() 
        Amount: $0 
        ------------------------- 
        In GetDeposit() 
        Amount: $450.00 
        ------------------------- 
        Bank in Main() 
        Amount: $450.00 
        ------------------------- 
        In GetWithdrawal() 
        Amount: $265.00 
        ------------------------- 
        Bank in Main() 
        Amount: $265.00 
        Press any key to continue... 

 (method overloadingمتد )سربارگذاری 

 را در نظر بگیرید. CalculateAreaتابع زیر به نام 

    public class Geometry 
    { 
        double CalculateArea() 
        { 
            return 0D; 
        } 
    } 

 virtual tableلیستی از آن متدها تهیه می کند. به لیست مزبور  compilerد کرده و پروژه ای می سازید، هنگامی که متدی در کلاس ایجا

 )جدول مجازی( می گویند. در جدول بیان شده، متد با استفاده از اسمش کد گذاری می شود.

Method Name Encoding 
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CalculateArea Calculate@None 

  

داشت، جدول بالا نوع داده ی آرگومان را نمایش می دهد. نوع بازگشتی متد و اسم های آرگومان ها هیچ کدام در صورتی که متد آرگومانی 

مهم نیستند. در صورتی که کلاس دربردارنده ی متدهایی با اسامی متفاوتی بود، متدها به راحتی از هم قابل تشخیص خواهند بود. گاهی 

شید که همگی یک کار مشابه را انجام می دهند ولی با تفاوت های جزئی )این دیگر بستگی به شما اوقات لازم است متدهای مختلفی داشته با

 دارد که این تفاوت ها چه باشند(. یکی از گزینه های پیش رو این است که اسم متدها را یکی انتخاب کنید. به قابلیت داشتن چندین متد با

 گویند.  می  method overloadingاسم مشابه در یک کلاس 

 در لیست نام برده باید منحصر به فرد باشند. (entry)، تک تک درایه ها virtual table، هنگام ایجاد method overloadingبرای اجرای 

همان طور که پیش تر ذکر شد، نوع بازگشتی متد داخل جدول قرار داده نمی شود، در نتیجه نمی توان تفاوت ها را بر آن اساس پایه گذاری 

کرد. اگر سعی کنید دو متد ایجاد کنید که هیچ یک آرگومان نمی گیرند، طبیعتاً تشخیص آن دو متد از یک دیگر ممکن نخواهد بود. راه حل 

 مسئله فوق این است که حداقل یکی از آن دو متد آرگومان بگیرند. به مثال زیر توجه کنید.

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
    } 

  

Method Name Argument(s) Encoding 

CalculateArea   Calculate@None 

CalculateArea Double Calculate@Double 
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 جداگانه ای )متفاوتی( دارد. مثال زیر کد بالا را به کار می برد. (encoding) همان طور که انتظار می رفت، این بار هر متد رمزگذاری

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Geometry geo = new Geometry(); 
            System.Console.WriteLine("Geometric Shapes"); 
            System.Console.WriteLine("Calculation of Areas"); 
            System.Console.Write("Square: "); 
            System.Console.WriteLine(geo.CalculateArea(26.38)); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید.

       Geometric Shapes 
        Calculation of Areas 
        Square: 695.9044 
        Press any key to continue... 

  

نمی توان دو  محسوب نمی شود. بنابراین، virtual tableآن در  (encoding)به خاطر داشته باشید که اسم یک آرگومان بخشی از رمزگذاری 

 متد به کاربرد که هر دو یک آرگومان یکسان داشته باشد. کد زیر را در نظر بگیرید.

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
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        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
        // Circle 
        public double CalculateArea(double radius) 
        { 
            return radius * radius * 3.14159; 
        } 
    } 

 را به دست می دهد.عملیات بالا نتیجه ی زیر 

 Method Name Argument(s) Encoding 

CalculateArea   Calculate@None 

CalculateArea Double Calculate@Double 

CalculateArea Double Calculate@Double 

  

 پیغام خطای زیر را تولید می کند. compilerدر نتیجه، زمانی که پروژه را به وجود می آورید، 

        Error 1 Type 'Geometry' already defines a member called 'CalculateArea'  
        with the same parameter types 
        C:\Exercise1\Exercise.cs   16   19   Overloading 

 

 از نوع مختلف داشته باشد. به مثال زیر توجه کنید. یکی از قواعد اضافه بار گذاری متد این است که متد گفته شده می تواند آرگومان هایی

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
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        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
        // Circle 
        public double CalculateArea(double radius) 
        { 
            return radius * radius * 3.14159; 
        } 
    } 

 virtualدیگر( ارسال کنید. گفتیم که نوع داده ی آرگومان در داخل در بیشتر موارد، شما به دلایلی نمی خواهید آرگومان متفاوتی )از نوع 

table .قرار می گیرد. اما اگر هر متد ، شمار متفاوتی آرگومان بگیرد چه می شود؟ مثال زیر را در نظر بگیرید 

   
 
  public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
        // Rectangle 
        public double CalculateArea(double length, double height) 
        { 
            return length * height; 
        } 
    } 

 نتیجه ی زیر را به دست می دهد.

 Method Name Argument(s) Encoding 

CalculateArea   Calculate@None 

CalculateArea double Calculate@Double 
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CalculateArea double، 

double 

Calculate@Double@Double 

  

دوم و سوم متفاوت هستند. نمونه ای از فراخوانی متدها را در  متد( encoding) همان طور که در جدول بالا مشاهده می کنید، رمزگذاری

 مثال زیر مشاهده می کنید.

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
        // Rectangle 
        public double CalculateArea(double length, double height) 
        { 
            return length * height; 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var geo = new Geometry(); 
            System.Console.WriteLine("Geometric Shapes"); 
            System.Console.WriteLine("Calculation of Areas"); 
            System.Console.Write("Square:    "); 
            System.Console.WriteLine(geo.CalculateArea(26.38)); 
            System.Console.Write("Rectangle: "); 
            System.Console.WriteLine(geo.CalculateArea(39.17, 26.38)); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه 

      eometric Shapes 
        alculation of Areas 
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        quare:    695.9044 
        ectangle: 1033.3046 
        ress any key to continue... 
 

از هر نوعی باشد. این برای متد سوم استفاده کردیم، آرگومان می تواند  (double argument)اگرچه در مثال بالا از دو آرگومان نوع دابل 

متد ایجاب می کند هر متد آرگومان های متفاوتی سربارگذاری تصمیم دیگر با شما است که چی متد را به وجود آورد. بنابراین، قاعده ی دیگر 

 داشته باشد. 

، Pascalمثل :   یگر زبان هاو د#C، C++ ،Java،  Cیکی از خصوصیات بیشتر زبان های برنامه نویسی کامپیوتر از جمله زبان های مبنای 

Visual Basic  ًاین است که برنامه نویس نیازی به استفاده از آرگومان داخل متد ندارد. از این امکان می توان برای ایجاد دو نسخه ی کاملا

ده مورد استفاده قرار نمی مشابه دارند : می توان آرگومانی ارسال کرد که در آین (behavior)متفاوت متد استفاده کرد که هر دو عملکرد 

 می شود. کد زیر را در نظر بگیرید. virtual tableگیرد ولی منجر به ایجاد درایه ی جدید و متمایز در 

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
        } 
        // Rectangle 
        public double CalculateArea(double length, double height) 
        { 
            return length * height; 
        } 
        // Circle 
        public double CalculateArea(double radius, int unused) 
        { 
            return radius * radius * 3.14159; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد. 

 Method Name Argument(s) Encoding 
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CalculateArea   Calculate@None 

CalculateArea double Calculate@Double 

CalculateArea double، 

double 

Calculate@Double@Double 

CalculateArea double، 

double 

Calculate@Double@Integer 

  

 مشاهده می کنید رمز گذاری ها متمایز هستند.همان طور که 

وجه تمایز قائل  /نیاز دارید. به منظور تمیز دادن ( value) به خاطر دارید که برای محاسبه ی محیط های یک مربع یا دایره، به تنها یک مقدار

 "unused"دیم. ما در مثال خود آرگومان را  شدن بین محاسبات این دو محیط در کد، آرگومانی متفاوت )دومی( به محیط دایره ارسال می کر

این است که در  #Cو  ++Cنامیدیم، ولی شما می توانید هر اسمی که دوست دارید برای آن انتخاب کنید )یکی از تفاوت های بین زبان های 

C++  می توان اسم آرگومان را حذف کرد. بنابراین، اگر کد فوق را با زبانC++ به نام گذاری آرگومان وجود نداشت(. می نوشتیم دیگر نیازی 

 دهنگام فراخوانی متدی که دو آرگومان می گیرد، توجه داشته باشید که حتماً باید مقداری به آرگومان دومی ارسال شود. به این خاطر که مت

وع متد هم خوانی و مطابقت داشته آرگومان گفته شده را به کار نمی برد، فرقی نمی کند چه مقداری به آن ارسال کنید، مادام این که با ن

 باشد.

 مثال

    public class Geometry 
    { 
        // Unknown Shape 
        public double CalculateArea() 
        { 
            return 0D; 
        } 
        // Square 
        public double CalculateArea(double side) 
        { 
            return side * side; 
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        } 
        // Rectangle 
        public double CalculateArea(double length, double height) 
        { 
            return length * height; 
        } 
        // Circle 
        public double CalculateArea(double radius, int unused) 
        { 
            return radius * radius * 3.14159; 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var geo = new Geometry(); 
            System.Console.WriteLine("Geometric Shapes"); 
            System.Console.WriteLine("Calculation of Areas"); 
            System.Console.Write("Square:    "); 
            System.Console.WriteLine(geo.CalculateArea(26.38)); 
            System.Console.Write("Rectangle: "); 
            System.Console.WriteLine(geo.CalculateArea(39.17, 26.38)); 
            System.Console.Write("Circle:    "); 
            System.Console.WriteLine(geo.CalculateArea(26.38, 0)); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

        Geometric Shapes 
        Calculation of Areas 
        Square:    695.9044 
        Rectangle: 1033.3046 
        Circle:    2186.246303996 
        Press any key to continue... 
 

لازم است قواعد آن را هنگام استفاده از این برنامه به خاطر داشته  کاربرد فراوانی دارد. بنابراین، NET Framework. متد درسربارگذاری 

تعداد مختلفی آرگومان داشته باشند و یا آرگومان های آن / باشید. خوشبختانه این قواعد بسیار ساده هستند : متدها یا باید شمار متفاوت 

 متمایز باشند(. ها از نوع متفاوت باشند )نوع آرگومان های ارسال شده به آن ها از هم 

نشانگر تعداد نسخه های متد می  xنمایش می دهد.  xاز  8برچسبی  code editor ،IntelliSenseمی شود، در  overloadهنگامی که متدی 

 را نمایش می دهد. 1از  IntelliSense 8مشاهده می کنید که سه نسخه ی مجزا دارد، بنابراین ( function)باشد. در زیر تابعی 
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را فشار داد یا مقدار آرگومان مورد نظر را تایپ کرده تا  (down arrow key)برای انتخاب یکی از ورژن ها، می توان کلید پیکان جهت پایین  

 برنامه، نسخه ی مورد نظر را نمایش دهد. 

http://articles.tahlildadeh.com/image.axd?picture=image_1063.png
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 آرگومان های اختیاری

 آرگومانی با مقدار اختیاری

گام فراخوانی آن آرگومان، لازم است مقداری برای آرگومان نام برده فراهم کرد. البته، گفته شد در صورتی که متدی آرگومان گرفت، هن

استثنایی برای قاعده ی مذکور وجود دارد. چنانچه متدی دارید که آرگومان آن معمولاً مقداری یکسان دریافت می کند، می توانید مقداری 

 پیش فرض به آرگومان مزبور اختصاص دهید.

 نظر بگیرید.کد زیر را در 

    public class Exercise 
    { 
        double? CalculateNetPrice(double? discountRate) 
        { 
            double? origPrice = 125.55; 
            return origPrice - (origPrice * discountRate / 100); 
        } 
        static int Main() 
        { 
            var exo = new Exercise(); 
            double? finalPrice = null; 
            double? discount = 15; // That is 25% = 25 
            finalPrice = exo.CalculateNetPrice(discount); 
            System.Console.WriteLine("After applying the discount"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

        After applying the discount 
        Final Price = 106.7175 
        Press any key to continue... 

 

 برای نشان دادن این که آرگومانی مقدار پیش فرض دارد، مقدار پیش فرض را داخل پرانتز متد، پس از اسم آرگومان قرار دهید.

 مثال
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    public class Exercise 
    { 
        double? CalculateNetPrice(double? discountRate = 25) 
        { 
            double? origPrice = 125.55; 
            return origPrice - (origPrice * discountRate / 100); 
        } 
    } 

د. چنانچه می خواهید مقدار پیش فرض را به کارببرید، دیگر نیازی به ارسال می توان هنگام فراخوانی متد، یک مقدار به آرگومان ارسال کر

 آرگومان نیست.

 مثال

    public class Exercise 
    { 
        double? CalculateNetPrice(double? discountRate = 25) 
        { 
            double? origPrice = 125.55; 
            return origPrice - (origPrice * discountRate / 100); 
        } 
        static int Main() 
        { 
            var exo = new Exercise(); 
            double? finalPrice = null; 
            finalPrice = exo.CalculateNetPrice(); 
            System.Console.WriteLine("After applying the discount"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 توجه داشته باشید که پرانتزهای متد خالی هستند، به این معنی که آرگومانی ارسال نشده است. نتیجه ی زیر به دست می آید.

        After applying the discount 
        Final Price = 94.1625 
        Press any key to continue... 

  

د که آرگومان های متعددی می گیرد. حال، کلیه ی آرگومان های مزبور )یا برخی از آن ها( می توانند به همین ترتیب، می توان متدی ایجاد کر

 مقدارهای پیش فرض داشته باشند. 
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در صورتی که متدی چند آرگومان )بیش از یک آرگومان( گرفت، می توان آرگومانی پیش فرض برای هر یک فراهم کرد، سپس انتخاب کرد 

ان ها مقدار پیش فرض دریافت کنند. اگر می خواهید کلیه ی آرگومان ها مقدار پیش فرض داشته باشند، حین تعریف متد کدام یک از آرگوم

 و مقدار دلخواه را تایپ کنید. توجه خود را به مثال زیر جلب کنید. " = "مورد نظر، به دنبال هر اسم علامت مساوی 

    public class Exercise 
    { 
        double? CalculateNetPrice(double? tax = 5.75, double? discount = 25,double? origPrice = 245.55) 
        { 
            double? discountValue = origPrice * discount / 100; 
            double? taxValue = tax / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            System.Console.Write("Original Price: $"); 
            System.Console.WriteLine(origPrice); 
            System.Console.Write("Discount Rate: "); 
            System.Console.Write(discount); 
            System.Console.WriteLine("%"); 
            System.Console.Write("Tax Amount: $"); 
            System.Console.WriteLine(tax); 
            return netPrice; 
        } 
        static int Main() 
        { 
            var exo = new Exercise(); 
            double? finalPrice = null; 
            finalPrice = exo.CalculateNetPrice(); 
            System.Console.WriteLine("After applying the discount"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

        Original Price: $245.55 
        Discount Rate: 25% 
        Tax Amount: $5.75 
        After applying the discount 
        Final Price = 184.22 
        Press any key to continue... 

 

آرگومان )بیش از یک آرگومان( گرفت، و شما خواستید مقدارهای پیش فرضی برای آن پارامترها فراهم کنید، ترتیب قرار چنانچه متدی چند 

 گیری آرگومان ها از اهمیت خاصی برخوردار خواهد بود. 
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ض برای تنها یکی از اگر متد دو آرگومان داشت، می توان آن را با مقادیر پیش فرض تعریف کرد. چنانچه می خواهید مقداری پیش فر

آرگومان ها ارائه دهید، آن مقدار پیش فرض فقط به آرگومان دومی تعلق می گیرد. هنگام فراخوانی چنین تابعی، چنانچه تنها یک 

مقدار آن را به اولین پارامتر در لیست تخصیص می دهد و هیچ مقداری به دومین پارامتر اختصاص  compilerآرگومان فراهم کنید، 

 هد.نمی د

     public class Exercise 
    { 
        double? CalculateNetPrice(double? taxRate, double? discountRate = 25) 
        { 
            double? origPrice = 185.95; 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
        static int Main() 
        { 
            double? finalPrice; 
            double? taxRate = 5.50; // = 5.50% 
            Exercise exo = new Exercise(); 
            finalPrice = exo.CalculateNetPrice(taxRate); 
            System.Console.WriteLine("After applying a 25% discount and a 5.50% tax rate"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 مثال

        After applying a 25% discount and a 5.50% tax rate 
        Final Price = 139.5175 
        Press any key to continue... 
 

یف تابع و تخصیص مقدار پیش فرض به اولین آرگومان، تنها یک آرگومان هنگام فراخوانی تابع فراهم کنید، با پیغام خطا چنانچه پس از تعر

 مواجه می شوید. کد زیر را در نظر بگیرید.

     public class Exercise 
    { 
        double? CalculateNetPrice(double? discountRate = 25, double? taxRate) 
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        { 
            double? origPrice = 185.95; 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
        static int Main() 
        { 
            double? finalPrice; 
            double? taxRate = 5.50; // = 5.50% 
            Exercise exo = new Exercise(); 
            finalPrice = exo.CalculateNetPrice(taxRate); 
            System.Console.WriteLine("After applying a 25% discount and a 5.50% tax rate"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 م خطای زیر صادر می شوند.دو پیغا

        Error 1 Optional parameters must appear after all required parameters 
        C:\Exercises\Bank\Exercise.cs  3    70   Bank 
 

آرگومان ها مقدار پیش فرض داشته  حال، چنانچه متد چندین آرگومان )بیش از دو آرگومان( دریافت کرد و می خواهید که تنها تعدادی از آن 

باشند، به خاطر داشته باشید که آرگومان های با مقدار پیش فرض باید انتهای لیست قرار بگیرند. صرف نظر از این که چه تعداد آرگومان 

ن هایی آغاز کنید که مقدار پیش فرض دریافت می کنند )و چه تعداد مقدار پیش فرض دریافت نمی کنند(، همیشه لیست خود را با آرگوما

 مقدار پیش فرض به کار نمی گیرند.

 مثال

    public class Exercise 
    { 
        double? CalculateNetPrice(double? origPrice,double? taxRate = 5.75,double? discountRate = 25) 
        { 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
    } 

ض ندارند می توان مقدار ارائه داد.در هنگام فراخوانی متد، به یاد داشته باشید که تنها برای آرگومان هایی که مقدار پیش فر  
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    public class Exercise 
    { 
        double? CalculateNetPrice(double? origPrice,double? taxRate = 5.75,double? discountRate = 25) 
        { 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
        static int Main() 
        { 
            double? originalPrice = 375.95; 
            double? finalPrice; 
            Exercise exo = new Exercise(); 
            finalPrice = exo.CalculateNetPrice(originalPrice); 
            System.Console.WriteLine("After applying a 25% discount and a 5.75% tax rate"); 
            System.Console.Write("Final Price = "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 مثال 

        After applying a 25% discount and a 5.75% tax rate 
        Final Price = 282.02 
        Press any key to continue... 

  

 راخوانی آرگومان با )استفاده از( اسمف

، برای تخصیص مقدار به دومین آرگومان اختیاری، ابتدا باید مقداری برای ++Cتصور کنید متدی دارید که چندین آرگومان اختیاری می گیرد. در 

رید، باید آن را ارسال کنید. به مثال زیر اولین آرگومان اختیاری ارسال کنید. حتی اگر هم بخواهید مقدار پیش فرض آرگومان اولی را به کاربب

 .توجه کنید

    public class Exercise 
    { 
        double? CalculateNetPrice(double? origPrice,double? taxRate = 5.75,double? discountRate = 25) 
        { 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
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        static int Main() 
        { 
            double? finalPrice; 
            Exercise exo = new Exercise(); 
            finalPrice = exo.CalculateNetPrice(375.95, 5.75, 40); 
            System.Console.WriteLine("Original Price: 375.95"); 
            System.Console.WriteLine("Tax Rate:       5.75%"); 
            System.Console.WriteLine("Discount Rate:  40%"); 
            System.Console.Write("Final Price:    "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر حاصل می گردد

        Original Price: 375.95 
        Tax Rate:       5.75% 
        Discount Rate:  40% 
        Final Price:    225.6275 
        Press any key to continue... 

  

 یتصور کنید می خواهید یک آرگومان اختیاری را نادیده گرفته تا از مقدار پیش فرض آن استفاده کنید، ولی برای آرگومان های دوم، سوم.. م

و مقدار  ):(خواهید مقدار ارسال کنید. برای این منظور، در پرانتز متدی که فرا می خوانید، اسم آرگومان مورد نظر و به دنبال آن دو نقطه 

 دلخواه را تایپ کنید ) که در واقع با پروسه ی فراخوانی متد با استفاده از اسم یکی است(.

 مثال

    public class Exercise 
    { 
        double? CalculateNetPrice(double? origPrice,double? taxRate = 5.75,double? discountRate = 25) 
        { 
            double? discountValue = origPrice * discountRate / 100; 
            double? taxValue = taxRate / 100; 
            double? netPrice = origPrice - discountValue + taxValue; 
            return netPrice; 
        } 
        static int Main() 
        { 
            double? finalPrice; 
            Exercise exo = new Exercise(); 
            finalPrice = exo.CalculateNetPrice(discountRate: 40, origPrice: 375.95); 
            System.Console.WriteLine("Original Price: 375.95"); 
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            System.Console.WriteLine("Tax Rate:       5.75%"); 
            System.Console.WriteLine("Discount Rate:  40%"); 
            System.Console.Write("Final Price:    "); 
            System.Console.WriteLine(finalPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 با استفاده از این روش، می توان آرگومان های اختیاری را که حاضر نیستید مقداری برای آن ها فراهم کنید نادیده گرفت. 

 مبانی سازنده ها

 توصیف

 .کلاس زیر را در نظر بگیرید

    public class BankAccount 
    { 
        private string customerName; 
        private decimal originalDeposit; 

}     

به هر یک از اعضای کلاس به اندازه ی کافی حافظه اختصاص  compilerپس از تعریف متغیر یک کلاس در برنامه، زمانی که برنامه بالا می آید، 

 می دهد. فضای ای که به هر متغیر عضو تخصیص داده می شود با توجه به نوع آن متغیر مقداردهی اولیه می شود. 

پر می شود. برای شئ  2، فضای حافظه با integer، فضای مزبور خالی نگه داشته می شود. برای نوع string (string object)ی شی از نوع برا

 ای از این نوع، بهتر است مقداری فراهم شود که متغیرهای عضو را با مقدارهای دلخواه شما مقداردهی اولیه می کند. 

باشد زیرا هدف   void)اولیه( می کند، ممکن است هر مقداری برگرداند، اما بهتر است مقدار بازگشتی از نوع متدی که شی ای را مقداردهی 

اصلی آن تنظیم دوباره ی مقادیر است. به این خاطر که متد، مقداری اولیه به تک تک متغیرهای عضو می دهد )متغیرهایی که طبیعتاً باید 

 گومانی معادل برای هر یک از متغیرهایی که مقداردهی اولیه می کند داشته باشد.مقداردهی اولیه شوند(، لازم است آر

    public class BankAccount 
    { 
        private string customerName; 
        private decimal originalDeposit; 
        public void Initialize(string name, decimal deposit) 
        { 
        } 
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}     

)  دمتدی که کلاسی را مقداردهی اولیه می کند، لزومی ندارد حتماً تمامی اعضای یک کلاس را مقداردهی )اولیه( کند. به منظور پیاده سازی مت

 توجه کنید.  منظور متدی است که مقداردهی اولیه می کند(، کافی است آرگومان متد را به متغیر مربوط اختصاص دهید. به مثال های ذیل

    public class BankAccount 
    { 
        private string customerName; 
        private decimal originalDeposit; 
        public void Initialize(string name, decimal deposit) 
        { 
            customerName = name; 
            originalDeposit = deposit; 
        } 

}     

 بدهد. سپس می توانید متد را پس از تعریف نمونه ای از کلاس، فراخوانی کنید تا مقادیر اولیه را به فیلدهای کلاس

 مثال 

    public class BankAccount 
    { 
        private string customerName; 
        private decimal originalDeposit; 
        public void Initialize(string name, decimal deposit) 
        { 
            customerName = name; 
            originalDeposit = deposit; 
        } 
        public void Show() 
        { 
            System.Console.WriteLine("Customer Account Information"); 
            System.Console.Write("Customer Name:    "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Original Deposit: "); 
            System.Console.WriteLine(originalDeposit); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            BankAccount account = new BankAccount(); 
            account.Initialize("Paul Motto", 450.00M); 
            account.Show(); 
            return 0; 
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        } 
}     

 نتیجه

Customer Account Information 
Customer Name: Paul Motto 
Original Deposit: 450.00 
Press any key to continue... 

 معرفی سازنده ها

8.    Microsoft Visual Studio .را اجرا کنید 

 یک کنید.را کل File -> New Projectبه منظور ایجاد برنامه ی جدید، فهرست گزینه ی اصلی برنامه را باز کرده، سپس گزینه های     .2

 را از لیست میانی انتخاب کنید. Empty Projectگزینه ی     .1

 کلیک کنید. okتغییر داده، روی  DepartmentStore3اسم را به     .4

 راست کلیک کرده، سپس طبق دستور زیر عمل کنید. Solution Explorerدر پنجره ی     .5

6.    DeparmentStore3 ->Add ->New Item. 

 را کلیک کنید. Add New Item ،Code Fileدر لیست میانی پنجره ی محاوره ی      .4

 را کلیک کنید. Addتغییر داده و سپس  StoreItemحال، اسم را به     .1

 در فایل دستورات زیر را وارد کنید.    .1

    public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 

}     

 ( پیش فرضconstructorسازنده ی )

ساخته می شود. متد و کلاس هر دو یک اسم دارند. لازم  (object)سازنده متدی خاص است که هنگام به وجود آمدن شی جدید 

ان به وجود آمدن آن مقداردهی اولیه می کند. هنگامی که کلاسی می سازید، چنانچه سازنده به ذکر است متد، شی را درست در زم

به صورت خودکار یک سازنده برای شما ایجاد می کند؛ این کار باعث می شود که کلیه ی شی  compilerای برای آن معرفی نکنید، 
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ایجاد می شود، سازنده ی پیش فرض نیز می گویند.  compilerهای کلاس از وجود شی جدید آگاه شوند. به سازنده ای که توسط 

 متدی معرفی کنید که با کلاس هم نام است.البته شما می توانید سازنده ی خود را ایجاد کنید. برای این منظور 

کنید.حال، در لیستی را دوبار کلیک  #Visual Cرا انتخاب کنید، سپس  ...Insert Snippetداخل کلاس موردنظر راست کلیک کرده         

 دوبار کلیک کنید. ctorکه ظاهر می شود روی 

 
  

Code Editor برای ایجاد متد جدید از اسم کلاس استفاده می کند 

 به خاطر داشته باشید که متد فوق نباید هیچ مقداری بازگرداند. 

 مثال

    public class BankAccount 
    { 
        public BankAccount() 
        { 
        } 

}     

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_86.gif
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زمانی که نمونه ای از کلاس تعریف می کنید، )چه از آن شی استفاده بکنید چه نکنید(، سازنده ای برای شی ایجاد می شود. پس از این که 

ه بگیرید(. مثال نمونه ای از کلاس تعریف شد، سازنده ی پیش فرض فراخوانده می شود ) چه شی نام برده را به کار ببرید و چه آن را نادید

  زیر به زیبایی عملیات ذکر شده را تشریح می کند.

  

    public class BankAccount 
    { 
        public BankAccount() 
        { 
            System.Console.WriteLine("New Bank Account"); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            BankAccount account = new BankAccount(); 
            return 0; 
        } 

}     

 نتیجه

New Bank Account 
Press any key to continue... 
 

 به تنهایی وجود شی جدید را نشان داد. همان طور که در مثال فوق مشاهده کردید، اگرچه شی مذکور مورد استفاده قرار نگرفت، تعریف آن 

 به کاربردن سازنده ی پیش فرض

 ...DepartmentStore3 ->Add ->New Item ، راست کلیک کرده، سپس Solution Explorerدر پنجره ی   .8

تغییر داده و  DepartmentStoreکلیک کنید. حال، اسم را به  Code File، روی Add New Itemدر لیست میانی پنجره ی محاوره ی   .2

Add را کلیک کنید 

 فایل را به صورت زیر اصلاح کنید.  .1

    public class DepartmentStore 
    { 
        static int Main() 
        { 
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            StoreItem si = new StoreItem(); 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(si.size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.ReadKey(); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 برنامه را اجرا کنید. این نتیجه را به دست می دهد. 

Department Store 
Item #:    0 
Item Name: 
Item Size: 
Unit Price: 0 

 را بسته و به محیط برنامه نویسی باز گردید. DOS. پنجره ی 5

 سازنده ای که مقداردهی اولیه می کند

یه ی فیلدهای یک کلاس نیز استفاده کرد. به همین دلیل، می تواند جایگزین برای مقداردهی اول (constructor)می توان از سازنده 

مناسبی برای متدی باشد که مقداردهی اولیه می کند. برای استفاده از سازنده به منظور مقداردهی اولیه ی فیلدهای یک کلاس، 

نید. نیازی نیست تمامی متغیرهای عضو را تعریف متغیرهایی را که می خواهید مقداردهی اولیه کنید را به عنوان آرگومان تعریف ک

کنید، بلکه تنها آن دسته متغیرهایی که ملزوم به مقداردهی اولیه هستید کفایت می کند. در حقیقت، تنها باید آن عضوهایی را 

به عبارت روشن تر، مقداردهی )اولیه( کنید که مطمئن هستید، دیگر شی ها به هنگام استفاده از این شئ به آن ها نیاز دارند. 

object  شما فیلدهایی دارد که اشیا خارجی(external objects)  نیاز ندارند تغییر دهند ) یا به آن ها دسترسی پیدا کنند( یا

 متغیرهای عضو بعده ها هنگامی که از شئ مورد نیاز فراخوانده می شوند، مقداردهی اولیه می شوند. 
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، می توانید فقط فیلدهای دلخواه کلاس را مقداردهی اولیه کنید. برای متغیری از نوع عددی، به منظور ایجاد سازنده ی پیش فرض

به آن   (’)کافی است ثابت دلخواه را به هر متغیر عضو اختصاص دهید. در صورتی که متغیر یک کاراکتر بود، فقط یک تک کوتیشن

 دابل کوتیشن به متغیر اختصاص داد.  )"(با  اضافه می کنیم. حال، چنانچه متغیر یک رشته بود، باید مقداری

   public class BankAccount 
    { 
        private string customerName; 
        private decimal originalDeposit; 
        public BankAccount() 
        { 
            customerName = "John Doe"; 
            originalDeposit = 0M; 
        } 
        public void Show() 
        { 
            System.Console.WriteLine("Customer Account Information"); 
            System.Console.Write("Customer Name:    "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Original Deposit: "); 
            System.Console.WriteLine(originalDeposit); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            BankAccount account = new BankAccount(); 
            account.Show(); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

Customer Account Information 
Customer Name:   John Doe 
Original Deposit: 0 
Press any key to continue... 

 دستورالعمل ایجاد سازنده ای که مقداردهی )اولیه( می کند

 کلیک کنید. Window ->StoreItem.csی اصلی را باز کرده، روی گزینه ی  فهرست گزینه    .8
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 فایل را به صورت زیر اصلاح کنید.    .2

       public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
        public StoreItem() 
        { 
            itemNumber = 0; 
            itemName = "Unknown"; 
            size = "0"; 
            unitPrice = 0.00M; 
        } 
    }  

 . برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد.1

Department Store 
Item #:    0 
Item Name: Unknown 
Item Size: 0 
Unit Price: 0.00 

 را بسته و به محیط برنامه نویسی بازگردید. DOS. پنجره ی 4

 (constructor overloadingسربارگذاری سازنده )

س، رض به اعضای کلامناسب ترین مکان برای تعریف اولیه ی متغیر ها درون سازنده می باشد )مناسب ترین جا برای تخصیص مقادیر پیش ف

سازنده ی پیش فرض می باشد(. علاوه بر سازنده ی پیش فرض، می توانید هر تعداد سازنده که ملزوم می دانید اضافه کنید. این جنبه به 

 ن دارد.شد overloadشما اجازه می دهد برای اهداف مختلف، سازنده های متفاوت تولید کنید. بنابراین، یک سازنده نیز )مثل متد( امکان 

متد قبلاً مفصل بحث کردیم. ابتدایی ترین سازنده ای که ایجاد می کنید، قابلیت استفاده از یک آرگومان سربارگذاری در مورد کلیه ی قواعد 

ت دارد، و را دارد. هنگام ایجاد سازنده ای که تنها یک آرگومان می گیرد، باید آن عضوی را مقداردهی اولیه کنید که با آرگومان مذکور مطابق

 دیگر اعضا را با مقادیر پیش فرض مقداردهی کنید. به مثال زیر توجه کنید.

    public class BankAccount 
    { 
        private string accountNumber; 
        private string customerName; 



 

258 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

        private decimal originalDeposit; 
        public BankAccount(string number) 
        { 
            accountNumber = number; 
            customerName = "John Doe"; 
            originalDeposit = 0M; 
        } 
        public void Show() 
        { 
            System.Console.WriteLine("Customer Account Information"); 
            System.Console.Write("Account N#:       "); 
            System.Console.WriteLine(accountNumber); 
            System.Console.Write("Customer Name:    "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Original Deposit: "); 
            System.Console.WriteLine(originalDeposit); 
            System.Console.ReadKey(); 
        } 

    } 

در صورتی که کلاسی با تنها یک سازنده ایجاد کردید )مانند مثال فوق(، باید هنگام معرفی نمونه ای از کلاس، سازنده ی نام برده 

: توجه داشته باشید که نمی توان از سازنده ی پیش فرض ای که آرگومان نمی گیرد استفاده کرد. هنگام تعریف را به کار ببرید

 متغیر، آن را با سازنده مقداردهی اولیه کنید، سپس مقادیر را داخل پرانتز سازنده قرار دهید.

    public class BankAccount 
    { 
        private string accountNumber; 
        private string customerName; 
        private decimal originalDeposit; 
        public BankAccount(string number) 
        { 
            accountNumber = number; 
            customerName = "John Doe"; 
            originalDeposit = 0M; 
        } 
        public void Show() 
        { 
            System.Console.WriteLine("Customer Account Information"); 
            System.Console.Write("Account #:        "); 
            System.Console.WriteLine(accountNumber); 
            System.Console.Write("Customer Name:    "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Original Deposit: "); 
            System.Console.WriteLine(originalDeposit); 
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        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            BankAccount account = new BankAccount("27-940025-17"); 
            account.Show(); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 حاصل می گردد. ریزنتیجه ی    

Customer Account Information 
Account #:       27-940025-17 
Customer Name:   John Doe 
Original Deposit: 0 
Press any key to continue... 
 

امکان وجود ندارد که برای هر متغیر  به همین ترتیب، می توان برای مقداردهی های اولیه ی متفاوت، سازنده های متفاوت ایجاد کرد، البته این

ی اسازنده ای متفاوت ایجاد کرد. چنانچه سازنده ای متفاوت با آرگومان های مختلف )برای مقداردهی اولیه( ایجاد کنید، هنگام تعریف متغیره

 ایراد می گیرد.  compilerکلاس، دقت کنید که هر نمونه را با تعداد صحیح آرگومان مقداردهی اولیه کنید، در غیر این صورت، 

چنانچه کلاسی با تنها یک سازنده ایجاد کنید، و آن سازنده نیز حداقل یک آرگومان داشته باشد، سازنده ی پیش فرض دیگر قابل استفاده و 

 در دسترس نخواهد بود. برای دسترسی به سازنده ی پیش فرض یک شی، دو گزینه پیش رو دارید.

 در کلاس ایجاد نکنید، سازنده ی پیش فرض همیشه هنگام فراخوانی کلاس آماده هست.در صورتی که هیچ سازنده ای  ·

اگر حداقل یک سازنده برای کلاس ایجاد کنید و حداقل یک آرگومان برای سازنده ی مزبور فراهم کنید، باید خودتان )صراحتا( یک  ·

 سازنده ی پیش فرض برای کلاس ایجاد کنید.

 سربارگذاری سازنده 

 کلیک کنید. Window ->StoreItem.csه فهرست گزینه ی اصلی مراجعه کرده، روی گزینه های ب    .8

 فایل را به صورت زیر اصلاح کنید.    .2
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public class StoreItem 
    { 
        public long itemNumber; 
        public string itemName; 
        public string size; 
        public decimal unitPrice; 
        public StoreItem() 
        { 
            itemNumber = 0; 
            itemName = "Unknown"; 
            size = "0"; 
            unitPrice = 0.00M; 
        } 
        public StoreItem(long number) 
        { 
            itemNumber = number; 
            itemName = "Unknown"; 
            size = "0"; 
            unitPrice = 0.00M; 
        } 
        public StoreItem(long number, string name, string itemSize, decimal price) 
        { 
            itemNumber = number; 
            itemName = name; 
            size = itemSize; 
            unitPrice = price; 
        } 
    } 

 دسترسی پیدا کرده، سپس آن را به صورت زیر تغییر دهید. DepartmentStore.csبه فایل     .1

public class DepartmentStore 
    { 
        static int Main() 
        { 
            // Using the default contructor to create an unknown object 
            StoreItem unknown = new StoreItem(); 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(unknown.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(unknown.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(unknown.size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(unknown.unitPrice); 
            System.Console.WriteLine("=-------------------------------------------="); 



 

261 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            // Using the contructor that takes one argument create an object 
            // whose only known information is the item number 
            StoreItem knownNumber = new StoreItem(227174); 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(knownNumber.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(knownNumber.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(knownNumber.size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(knownNumber.unitPrice); 
            System.Console.WriteLine("=-------------------------------------------="); 
            // Using the contructor that has all the information 
            // necessary to create an object 
            StoreItem complete = new StoreItem(180318, "V-Neck Cardigan with Ruffle Trim", "M", 74); 
            System.Console.WriteLine("Department Store"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(complete.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(complete.itemName); 
            System.Console.Write("Item Size:  "); 
            System.Console.WriteLine(complete.size); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(complete.unitPrice); 
            System.Console.WriteLine("=-------------------------------------------="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 برنامه را اجرا کنید. نتیجه ی زیر به دست می آید.    .4

Department Store 
Item #:    0 
Item Name: Unknown 
Item Size: 0 
Unit Price: 0.00 
=-------------------------------------------= 
Department Store 
Item #:    227174 
Item Name: Unknown 
Item Size: 0 
Unit Price: 0.00 
=-------------------------------------------= 
Department Store 
Item #:    180318 
Item Name: V-Neck Cardigan with Ruffle Trim 
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Item Size: M 
Unit Price: 74 
=-------------------------------------------= 
 

 ید.را بسته و به محیط برنامه نویسی بازگرد DOSپنجره ی     .5

 سازنده ای با مقادیر پیش فرض

 هبه این خاطر که یک سازنده پیش از هر چیز یک متد است و می تواند آرگومان بگیرد،متعاقباً آرگومان های آن می توانند مقادیر پیش فرض ب

 کارببرند. 

 ه آرگومان اختصاص دهید.به منظور تخصیص مقدار پیش فرض به آرگومان یک سازنده، مقدار مناسب را هنگام ایجاد سازنده ب

 مثال 

    public class Rectangle 
    { 
        private double len; 
        private double hgt; 
        public Rectangle(double side = 10.00D) 
        { 
        } 
    } 

 رد.می توان از سازنده برای مقداردهی اولیه ی فیلدهای یک کلاس استفاده ک

اگر سازنده ای ایجاد کنید که یک آرگومان می گیرد، هنگام ایجاد نمونه ای از کلاس، آن تک سازنده هم به عنوان یک سازنده ی پیش فرض 

 هعمل می کند، هم به عنوان سازنده ای که یک آرگومان می گیرد. به این معنا که شما می توانید متغیری تعریف کرده و از سازنده ای استفاد

  ید که پرانتزهای آن خالی است. به مثال زیر توجه کنید.کن

public class Rectangle 
    { 
        private double len; 
        private double hgt; 
        // Length = Height: Square 
        public Rectangle(double side = 10.00D) 
        { 
            len = side; 
            hgt = side; 
        } 
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        public void Describe() 
        { 
            System.Console.WriteLine("Square Characteristics"); 
            System.Console.Write("Side: "); 
            System.Console.WriteLine(len); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Rectangle rect = new Rectangle(); 
            rect.Describe(); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید.   

Square Characteristics 
Side: 10 
Press any key to continue... 
 

 به همین ترتیب می توانید سازنده های مختلفی ایجاد کنید که آرگومان های متفاوتی می گیرند، و برخی از آرگومان های ذکر شده می توانند

ناگون می توانند آرگومان های از نوع متفاوت )مختلفی( داشته باشند، برخی آرگومان ها می مقادیر پیش فرض داشته باشند. سازنده های گو

توانند مقادیر پیش فرض داشته باشند، در حالی که برخی دیگر )از این آرگومان ها( مقادیر پیش فرض نداشته باشند. هنگام ایجاد شی، 

 . مثال زیر را در نظر بگیرید.لازم است به نوع سازنده ای که به کار می برید دقت کنید

public class Rectangle 
    { 
        private double len; 
        private double hgt; 
        /* If the constructor is called with only one argument,  
         * we are dealing with a square. 
         * If the constructor is called with two arguments, 
         * then we have a rectangle */ 
        public Rectangle(double length, double height = 10.00D) 
        { 
            len = length; 
            hgt = height; 
        } 
        /* If the constructor is called with only one argument,  
         * we are dealing with a square.*/ 
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        public void Describe() 
        { 
            System.Console.WriteLine("Square Characteristics"); 
            System.Console.Write("Side: "); 
            System.Console.WriteLine(len); 
        } 
        /* If the constructor is called with two arguments, 
         * then we have a rectangle */ 
        public void Describe(int rect) 
        { 
            System.Console.WriteLine("Rectangle Characteristics"); 
            System.Console.Write("Length: "); 
            System.Console.WriteLine(len); 
            System.Console.Write("Height: "); 
            System.Console.WriteLine(hgt); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Rectangle rect = null; 
            rect = new Rectangle(24.72); 
            rect.Describe(); 
            rect = new Rectangle(24.72, 20.64); 
            rect.Describe(1000); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می شود.

Square Characteristics 
Side: 24.72 
Rectangle Characteristics 
Length: 24.72 
Height: 20.64 
Press any key to continue...  

 استفاده از سازنده های یک کلاس

 (class destructorمخرب های کلاس )

مام شده و نیازی به آن ندارد. مخرب فرایند درست برخلاف سازنده ها، یک مخرب زمانی فراخوانده می شود که برنامه دیگر کارش با شی ت

خود  compilerپاک سازی را پشته صحنه انجام می دهد. درست مثل سازنده ی پیش فرض، در صورتی که مخربی برای کلاس تعریف نکنید، 



 

265 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

دیگر، شما نمی توانید کرد. به عبارت  (overload)یک مخرب پیش فرض ایجاد می کند. برخلاف سازنده، مخرب را نمی توان سربارگذاری 

 آغاز می شود.  "~"بیش از یک مخرب داشته باشید. اما درست مثل سازنده، مخرب با کلاس هم اسم است. این بار اسم مخرب با علامت 

 و به دنبال آن اسم کلاس را تایپ کنید. ~برای ایجاد مخرب، علامت 

 مثال 

    public class BankAccount 
    { 
        private string accountNumber; 
        private string customerName; 
        private decimal originalDeposit; 
        public BankAccount(string number) 
        { 
            accountNumber = number; 
            customerName = "John Doe"; 
            originalDeposit = 0M; 
        } 
        public void Show() 
        { 
            System.Console.WriteLine("Customer Account Information"); 
            System.Console.Write("Account #:        "); 
            System.Console.WriteLine(accountNumber); 
            System.Console.Write("Customer Name:    "); 
            System.Console.WriteLine(customerName); 
            System.Console.Write("Original Deposit: "); 
            System.Console.WriteLine(originalDeposit); 
        } 
        ~BankAccount() 
        { 
        } 

}     

 (read-only variablesتغیرهای خواندنی )م

هنگام ایجاد متغیر عضو کلاس، یکی از تصمیماتی که اتخاذ می کنید این است که فیلد کلاس چگونه مقدارش را دریافت کند. گاهی اوقات به 

شود. گاهی اوقات هم شما می  که از کلاس استفاده می کنند، اجازه ی تغییر مقادیر فیلدها داده می (clients of a class)آن اعضایی 

ی دهد که خواهید فیلد، فقط مقدار مزبور را نگه دارد یا ارائه بدهد، ولی در عین حال نتواند آن را تغییر دهد. این کار باز هم به اعضا اجازه م

 به فیلد دسترسی پیدا کنند ولی تنها در حد خواندن آن. 
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را تایپ کرد. به مثال زیر توجه  readonlyان خواند، پیش از نوع داده ی آن باید کلیدواژه ی به منظور ایجاد فیلدی که مقدار آن را فقط بتو

 کنید.

public readonly double PI; 

ه یپس از تعریف متغیر، لازم است آن را مقداردهی اولیه کنید. دو گزینه اصلی پیش رو دارید، می توانید فیلد را هنگام تعریف مقداردهی اول

 کنید.

 لمثا

    public class Circle 
    { 
        public double radius; 
        public Circle(double rad) 
        { 
            radius = rad; 
        } 
        public readonly double PI = 3.14159; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var circ = new Circle(24.72); 
            System.Console.WriteLine("Circle Characteristics"); 
            System.Console.Write("Radius: "); 
            System.Console.WriteLine(circ.radius); 
            System.Console.Write("PI:     "); 
            System.Console.WriteLine(circ.PI); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 نتیجه ی زیر را به دست می دهد.

Circle Characteristics 
Radius: 24.72 
PI:    3.14159 
Press any key to continue... 
 

 گزینه ی دوم این است که فیلد را داخل سازنده ی یک کلاس مقداردهی اولیه کنید. این کار به صورت زیر انجام می پذیرد.
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    public class Circle 
    { 
        public double radius; 
        public Circle(double rad) 
        { 
            radius = rad; 
            PI = 3.14159; 
        } 
        public readonly double PI; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var circ = new Circle(24.72); 
            System.Console.WriteLine("Circle Characteristics"); 
            System.Console.Write("Radius: "); 
            System.Console.WriteLine(circ.radius); 
            System.Console.Write("PI:     "); 
            System.Console.WriteLine(circ.PI); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

از یک عبارت گرفته شده باشد، فیلد نام برده باید در سازنده و با عبارت دلخواه  (read-only field)چنانچه مقدار یک فیلد خواندنی 

 نمی شود. (compile)کد زیر ترجمه مقداردهی اولیه شود. بر این اساس، 

    public class Circle 
    { 
        public double radius; 
        public Circle(double rad) 
        { 
            radius = rad; 
            PI = 3.14159; 
        } 
        public readonly double PI; 
        public readonly double Diameter = radius * 2; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var circ = new Circle(24.72); 
            System.Console.WriteLine("Circle Characteristics"); 
            System.Console.Write("Radius:   "); 
            System.Console.WriteLine(circ.radius); 
            System.Console.Write("PI:       "); 
            System.Console.WriteLine(circ.PI); 
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            System.Console.Write("Diameter: "); 
            System.Console.WriteLine(circ.Diameter); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید.

Error 1 A field initializer cannot reference the non-static  
field، method، or property 'Circle.radius'  
C:\Exercise1\Exercise.cs 12 39 Bank 
 

در کلاس تعریف کرده، سپس آن  (read-only)ی رفع خطای فوق، این است که فیلد مزبور را به عنوان متغیری فقط خواندنی یکی از راه حل ها

 را در سازنده و با عبارت موردنظر مقداردهی اولیه کنید . نمونه های آن را زیر مشاهده می کنید.

    public class Circle 
    { 
        public double radius; 
        public Circle(double rad) 
        { 
            radius = rad; 
            Diameter = radius * 2; 
            Circumference = Diameter * PI; 
            Area = radius * radius * PI; 
        } 
        public readonly double PI = 3.14159; 
        public readonly double Diameter; 
        public readonly double Circumference; 
        public readonly double Area; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Circle circ = new Circle(24.72); 
            System.Console.WriteLine("Circle Characteristics"); 
            System.Console.Write("Radius:        "); 
            System.Console.WriteLine(circ.radius); 
            System.Console.Write("Diameter:      "); 
            System.Console.WriteLine(circ.Diameter); 
            System.Console.Write("Circumference: "); 
            System.Console.WriteLine(circ.Circumference); 
            System.Console.Write("Area:          "); 
            System.Console.WriteLine(circ.Area); 
            System.Console.ReadKey(); 
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            return 0; 
        } 
    } 

 نتیجه ی زیر را به دست می دهد.

Circle Characteristics 
Radius:       24.72 
Diameter:     49.44 
Circumference: 155.3202096 
Area:         1919.757790656 
Press any key to continue... 
 

باید به محض ایجاد کردن، مقداردهی کرد. لازم به ذکر است که متغیر )فقط( را  constant variable))می دانیم که یک متغیر ثابت 

ن ا ایخواندنی از این قاعده پیروی نمی کند. به خاطر داشته باشید که نیازی نیست متغیر خواندنی را هنگام ایجاد آن مقداردهی اولیه کرد، زیر

شدن را دارد، می تواند مقادیر متفاوتی  overloadکه سازنده قابلیت  کار داخل سازنده ی کلاس صورت می گیرد. هم چنین به دلیل این

سر اداشته باشد، اما مقدار متغیر ثابت هیچ گاه تغییر نمی کند : یک بار در کلاس )یا متد( مقداردهی می شود و آن مقدار را برای همیشه سرت

 ستفاده می کند(. کلاس )یا متد( نگه می دارد )در تمام بخش های کلاس از همان مقدار ا

  (Namespace) معرفی فضاهای نام

فضای نام بخشی از یک کد است، که با نام به خصوصی شناسایی می شود. آن نام می تواند هر اسمی از جمله اسم یک شخص، شرکت یا شهر 

 باشد.

 مقدمه

 را اجرا کنید. Microsoft Visual Studioابتدا برنامه ی       .8

 .کلیک کنید File -> New Projectایجاد پروژه ی جدید، به فهرست گزینه ی اصلی مراجعه کرده، سپس روی گزینه های به منظور       .2

 .را انتخاب کنید Windowsدر فهرست سمت چپ،       .1

 .در لیست سمت راست کلیک کنید Empty Projectحال، روی       .4

 .یدتغییر ده DepartmentStore4اسم را به        .5

 .را کلیک کنید okاکنون،       .6

 .کلیک کنید ...Project -> Add New Itemبرای ایجاد فایل جدید، فهرست گزینه ی اصلی را باز کرده، روی گزینه های       .4
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 .را از لیست سمت چپ انتخاب کنید Codeگزینه ی       .1

 .کلیک کنید Code Fileدر لیست سمت راست، روی       .1

 .را کلیک کنید Addتغییر دهید،  DepartmentStoreاسم را به  .82

 .. در فایل خالی دستورات زیر را تایپ کنید88

    public class DepartmentStore 
    { 
        static int Main() 
        { 
            return 0; 
        } 
    } 

 ایجاد فضای نام به صورت دستی

 نام برای ایجاد فضای

 .آغاز کرده و به دنبال آن اسم بخش موردنظر را تایپ کنید namespaceکد را با کلیدواژه ی 

 .دوبار کلیک کنید ...Insert Snippetروی بخشی که می خواهید فضای نام در آنجا ایجاد شود راست کلیک کرده، حال روی  

 ختم می شود. "{"آغاز شده و به  "}"درست مثل یک کلاس، بخشی که متعلق به فضای نام است با علامت 

 مثال

    namespace Business 
    { 

}     

می توان هر چه مربوط به فضای نام است قرار داد. برای مثال، می توان داخل فضای نامی یک کلاس ایجاد کنید. به مثال زیر توجه }{ داخل 

 .کنید

    namespace Business 
    { 
        class House 
        { 
        } 
    } 
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 نحوه ی ایجاد فضای نام

 .برای این منظور، فایل را به صورت زیر تغییر دهید

    public class DepartmentStore 
    { 
        static int Main() 
        { 
            return 0; 
        } 
    } 
    namespace Store 
    { 
        public class StoreItem 
        { 
            public int itemNumber; 
            public string itemName; 
            public decimal unitPrice; 
        } 
    } 

 فضای نامی که به صورت اتوماتیک ایجاد شده

 .کلیک کنید ...Project -> Add Classبه فهرست گزینه ی اصلی مراجعه کرده، روی  برای ایجاد کلاسی جدید

 ....project -> Add -> click Class، روی اسم پروژه ی موردنظر راست کلیک کرده سپس : Solution Explorerدر پنجره ی 

 ...Project -> Add -> Class، روی اسم پروژه راست کلیک کرده سپس : Class Viewدر پنجره ی 

فضای نامی با  Microsoft Visual Studioیا  Microsoft Visual C# 2010 Expressنامه ی در صورت استفاده از هریک روش های بالا، بر

 اسم پروژه ایجاد کرده، سپس کلاس جدید را به آن اضافه می کند.

 دسترسی به اعضای فضای نام

  

فضای نام دسترسی پیدا کنید. برای این به آیتم موردنظر در ).(  پس از ایجاد اعضای یک فضای نامی، می توانید با استفاده از عملگر نقطه

 و عضو موردنظر فضای نام را تایپ کنید.).( منظور، اسم فضای نام و به دنبال آن عملگر نقطه 

 مثال

    namespace Business 
    { 
        public class House 
        { 
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            public string propertyNumber; 
            public decimal price; 
        } 
    } 
    public class Exercise 
    { 
        static void Main() 
        { 
            Business.House property = new Business.House(); 
            property.propertyNumber = "D294FF"; 
            property.Price = 425880; 
        } 
    } 

 دسترسی به اعضای فضای نام

 برای دسترسی به محتوای فضای نام، فایل را به صورت زیر اصلاح کنید.      .8

    public class DepartmentStore 
    { 
        static int Main() 
        { 
            Store.StoreItem si = new Store.StoreItem(); 
            si.itemNumber = 613508; 
            si.itemName = "Merino Crew Neck Cardigan"; 
            si.unitPrice = 80.00M; 
            System.Console.WriteLine("Store Inventory"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 
    namespace Store 
    { 
        public class StoreItem 
        { 
            public int itemNumber; 
            public string itemName; 
            public decimal unitPrice; 
        } 
    } 

 . برنامه را اجرا کنید.2
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       Store Inventory 
        Item #:     613508 
        Item Name:  Merino Crew Neck Cardigan 
        Unit Price: 80.00 

 را زده تا به محیط برنامه نویسی باز گردید. Enter. کلید 1

 

 استفاده از چندین فضای نام

 مقدمه

ی توانید فضاهای نامی متعددی در فایل ایجاد کنید، البته به شرط اینکه بدنه در مثال بالا، تنها یک فضای نام ایجاد کردیم. به همین شکل، م

 شده باشد. (delimit)ی تمامی آن ها به درستی مرتب 

 مثال

    namespace RealEstate 
    { 
        public class House 
        { 
            public string propertyNumber; 
            public decimal price; 
        } 
    } 
    namespace Dealership 
    { 
        public class Car 
        { 
        } 
    } 

همچنین می توان فضاهای نامی متعدد در چندین فایل ساخت. پس از ایجاد فایل ها، برای دسترسی به محتوای فضای نام، لازم است اسم  

 کلاس را تعریف کنید. 

 جاد چندین فضای نامای 

 .کلیک کنید ...Project -> Add New Itemبرای ایجاد فایل جدید، فهرست اصلی را باز کرده، روی       .8

 .کلیک کنید Code Fileکلیک کنید. حال، در لیست سمت راست روی  Codeدر صورت نیاز، در لیست سمت چپ روی       .2
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 .را کلیک کنید Addسپس  تغییر داده، Recordsاسم را به       .1

 .فایل را به این شکل زیر تغییر دهید      .4

  

    namespace Store 
    { 
        public class StoreItem 
        { 
            public int itemNumber; 
            public string itemName; 
            public decimal unitPrice; 
        } 
    } 

 ...Project -> Add New Itemبرای ایجاد فایل جدید، فهرست اصلی را باز کرده سپس :       .5

 .کلیک کنید Code Fileرا از لیست سمت چپ انتخاب کنید. اکنون، در لیست سمت راست روی  Codeدر صورت لزوم، گزینه ی       .6

 .کلیک کنید Addتغییر داده، سپس روی  Suppliersاسم را به       .4

 .فایل را به صورت زیر اصلاح کنید      .1

  

    namespace Supply 
    { 
        public class Manufacturer 
        { 
            public string companyName; 
            public string contactName; 
            public string contactPhone; 
        } 
    } 

 .کلیک کنید  DepartmentStore.csبرای دستیابی به فایل دیگر، روی برچسب       .1

 .برای به کار بردن فضاهای نامی، فایل را به صورت زیر اصلاح کنید    . 82

    public class DepartmentStore 
    { 
        static int Main() 
        { 
            Supply.Manufacturer dealer = new Supply.Manufacturer(); 
            dealer.companyName = "Peel Corp"; 
            dealer.contactName = "Sylvain Yobo"; 
            dealer.contactPhone = "(602) 791-8074"; 
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            Store.StoreItem si = new Store.StoreItem(); 
            si.itemNumber = 613508; 
            si.itemName = "Merino Crew Neck Cardigan"; 
            si.unitPrice = 80.00M; 
            System.Console.WriteLine("Store Inventory"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 استفاده از )یک( فضای نام

تعریف کنید. برای ).(  دیدیم که به منظور فراخوانی شی یا متدی که بخشی از فضای نام می باشد، باید شی مورد نظر را با عملگر نقطه

استفاده کنید  usingای که قبلاً در فایل دیگری ایجاد شده و مورد استفاده قرار گرفته، لازم است از کلیدواژه ی  namespaceاستفاده از 

 )با این کار نشان می دهید که فضای نامی که اکنون دارید به کار می برید، قبلاً در جای دیگری تعریف شده(. برای انجام این کار، ابتدا

 و به دنبال آن اسم فضای نامی را تایپ کنید. usingکلیدواژه ی  

 توان هر تعداد فضای نام خارجی که لازم است دخیل کرد. می  usingلازم به ذکر است که با استفاده از کلیدواژه ی 

 استفاده می کنید، باز هم باید اسم کلاس را کامل تعریف کنید.  usingدر صورت بروز تداخل اسم، حتی اگر هم از کلیدواژه ی 

 به کار بردن فضاهای نام 

 .ر دهیدفایل را به صورت زیر تغیی، usingبرای استفاده از کلیدواژه ی       .8

    public class DepartmentStore 
    { 
        static int Main() 
        { 
            Manufacturer dealer = new Manufacturer(); 
            dealer.companyName = "Peel Corp"; 
            dealer.contactName = "Sylvain Yobo"; 
            dealer.contactPhone = "(602) 791-8074"; 
            StoreItem si = new StoreItem(); 
            si.itemNumber = 613508; 
            si.itemName = "Merino Crew Neck Cardigan"; 
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            si.unitPrice = 80.00M; 
            System.Console.WriteLine("Manufacturer Information"); 
            System.Console.Write("Company Name:  "); 
            System.Console.WriteLine(dealer.companyName); 
            System.Console.Write("Contact Name:  "); 
            System.Console.WriteLine(dealer.contactName); 
            System.Console.Write("Contact Phone: "); 
            System.Console.WriteLine(dealer.contactPhone); 
            System.Console.WriteLine("---------------------------------------"); 
            System.Console.WriteLine("Store Inventory"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.WriteLine("=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-="); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 .برنامه را اجرا کنید، نتیجه ی زیر به دست می آید      .2

  

        Manufacturer Information 
        Company Name:  Peel Corp 
        Contact Name:  Sylvain Yobo 
        Contact Phone: (602) 791-8074 
        --------------------------------------- 
        Store Inventory 
        Item #:     613508 
        Item Name:  Merino Crew Neck Cardigan 
        Unit Price: 80.00 
        =-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

 

1.      Enter را زده و به محیط برنامه نویسی باز گردید. 

 گنجاندن یک فضای نامی در دل فضای نامی دیگر 

یا تودرتو کردن فضای نام می گویند.  nesting a namespaceبه چنین فرایندی  می توان یک فضای نام را داخل فضای نام دیگر قرار داد.

 .برای ایجاد فضای نام داخل فضای نام دیگر، از همان شیوه ای که برای ایجاد فضای نام ساده استفاده می کنید پیروی کنید
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    namespace Business 
    { 
        public class House 
        { 
            public string propertyNumber; 
            public decimal price; 
        } 
        namespace Dealership 
        { 
        } 
    } 

گنجانده شده. پس از ایجاد فضاهای نام دلخواه، می توان به ساخت کلاس  Businessداخل فضای نام  Dealershipدر مثال بالا، فضای نام 

 فضای نام ذکر شده پرداخت.  های مورد نیاز داخل

 زبه منظور دستیابی به اعضای فضای نام، پیش از فراخوانی عضو مورد نظر فضای نام )یا فضای نامی که در دل فضای نام دیگر گنجانده شده( ا

 استفاده می کنیم. ).(عملگر نقطه 

 مثال

    namespace Business 
    { 
        public class House 
        { 
            public string propertyNumber; 
            public decimal price; 
        } 
        namespace Dealership 
        { 
            public class Car 
            { 
                public decimal price; 
            } 
        } 
    } 
    public class Exercise 
    { 
        static void Main() 
        { 
            Business.House property = new Business.House(); 
            property.propertyNumber = "D294FF"; 
            property.price = 425880; 
            Business.Dealership.Car vehicle = new Business.Dealership.Car(); 
            vehicle.price = 38425.50M; 
        } 
    } 
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 به همین ترتیب می توان هر تعداد فضای نام که لازم می دانید داخل فضای نام دیگر قرار دهید. 

م جدید بپردازید. پس از اسم شیوه ی دیگری که با آن می توان فضای نامی را در فضای نام دیگر دخیل کرد، این است که به ایجاد فضای نا

 فضای نام، عملگر نقطه و به دنبال آن اسم فضای نام دوم )فضای نامی که داخل فضای نام دیگر قرار می گیرد( را تایپ کنید.

    namespace Geometry.Quadrilaterals 
    { 
    } 

 ام به محتوای آن دسترسی داشته باشید.پس از ایجاد فضای نام مورد نظر، شما می توانید با تعریف کردن فضای ن 

 مثال

    namespace Geometry.Quadrilaterals 
    { 
        public class Square 
        { 
            public double side; 
        } 
    } 
    public class Exercise 
    { 
        public static void Main() 
        { 
            Geometry.Quadrilaterals.Square sqr = new Geometry.Quadrilaterals.Square(); 
            sqr.side = 25.85; 
        } 
    } 

 مانند زیر بگنجانید:  NameSpaceرا داخل  یک  NameSpaceبه همین صورت شما می توانید چند 

    namespace Geometry.Quadrilaterals 
    { 
    } 
 
    namespace Geometry.Rounds 
    { 

}     

به همین ترتیب، می توان هر تعداد فضای نام که مورد نیاز است داخل فضای نام دیگر ایجاد کرد. پس از گنجاندن فضای نام )در فضای نام 

 دیگر( برای دسترسی داشتن به محتوای آن، می توانید اسم انتخابی آن را تعریف کنید.

 مثال
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    namespace Geometry.Quadrilaterals 
    { 
        public class Square 
        { 
            public double side; 
        } 
    } 
    namespace Geometry.Volumes.Elliptic 
    { 
        public class Cylinder 
        { 
            public double radius; 
        } 
    } 
    public class Exercise 
    { 
        public static void Main() 
        { 
            Geometry.Quadrilaterals.Square sqr = new Geometry.Quadrilaterals.Square(); 
            Geometry.Volumes.Elliptic.Cylinder cyl = new Geometry.Volumes.Elliptic.Cylinder(); 
            sqr.side = 25.85; 
            cyl.radius = 36.85; 
        } 
    } 

 گنجاندن فضای نام

 کلیک کنید تا به فایل آن دست پیدا کرده و آن را به صورت زیر تغییر دهید. Records.csروی )لیبل(     .8

namespace Store 
    { 
        namespace Inventory 
        { 
            public class StoreItem 
            { 
                public int itemNumber; 
                public string itemName; 
                public decimal unitPrice; 
            } 
        } 
        namespace Personel 
        { 
            namespace PayrollRecords 
            { 
                public class Employee 
                { 
                    public string firstName; 
                    public string lastName; 
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                    public decimal HourlySalary; 
                } 
                public class Contractors 
                { 
                    public string FullName; 
                    public int ContractStatus; 
                } 
            } 
        } 
    } 

 ح کنید.را باز کرده و آن را به ترتیب زیر اصلا DepartmentStore.csحال فایل     .2 

  using Supply; 
    using Store.Inventory; 
    public class DepartmentStore 
    { 
        static int Main() 
        { 
             . . . No Change 
            return 0; 
        } 
    } 

 کلاس امری امکان ناپذیر سربارگذاری 

به عبارت دیگر، نمی توان دو کلاس هم نام در  کرد. ( overload) سربارگذاری ان اسم کلاس را داخل فایل برخلاف متدهای کلاس، نمی تو 

 ایجاد کرد. یکی از گزینه های پیش رو این است که هر فضای نامی را داخل کلاس خودش قرار دهید. (scope)یک محدوده 

 مثال

 

 

    namespace Arithmetic 
    { 
        public class Numbers 
        { 
            public int value; 
        } 
    } 
    namespace Algebra 
    { 
        public class Numbers 
        { 
            public int value; 
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        } 
    }  

مختصر، می توان در یک فضای نام، دو کلاس داشت که یکی مطرح می گردد. به عبارتی  genericsگزینه ی دیگری نیز وجود دارد که در مبحث 

 نباشد. genericباشد و دیگری  (generic)عمومی 

 مثال

    namespace Arithmetic 
    { 
        public class Numbers 
        { 
            public int value; 
        } 
        public class Numbers<T> 
        { 
            public int value; 
        } 
    } 

 استفاده از کلاس نام گذاری شده

 .را بازکنید، سپس آن را به صورت زیر اصلاح کنید Suppliers.csابتدا، فایل     .8

    namespace Supply 
    { 
        public class SalesPerson 
        { 
            public string fullName; 
            public string expertise; 
            public string phoneNumber; 
        } 
    } 
    namespace Manufacturers.Domestic 
    { 
        public class Manufacturer 
        { 
            public string companyName; 
            public string contactName; 
            public string contactPhone; 
        } 
    } 
    namespace Manufacturers.Foreign.Asia 
    { 
        public class Manufacturer 
        { 
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            public string country; 
            public string companyName; 
            public string contactName; 
            public string contactPhone; 
            public string webSite; 
        } 
    } 

 .مراجعه کرده و آن را به صورت زیر تغییر دهید DepartmentStore.csحال، به فایل     .2

    using Supply; 
    using Manufacturers.Foreign.Asia; 
    using Store.Inventory; 
    public class DepartmentStore 
    { 
        static int Main() 
        { 
             . . . No Change 
            return 0; 
        } 

}     

 فضای نام (alias) اسم مستعار

شوار و زمان بر است. برای حل این مسئله، دسترسی به فضای نامی که آن فضای نام خود در دل فضای نام های دیگر گنجانده شده بسیار د

می توان از نام مستعار یک فضای نام بهره جست ) که در واقع میانبری برای دست یافتن به فضای نامی است که در دل فضای نامی دیگر جای 

 را تایپ کنید.  namespaceو =، و به دنبال آن اسم دلخواه، علامت  usingگرفته(. برای ایجاد نام مستعار، کلیدواژه ی 

 نحوه ی ایجاد و استفاده از فضای نام

 ، آن را به صورت زیر اصلاح کنید.DepartmentStore.cs فایلپس از باز کردن     .8

    using Supply; 
    using Asian = Manufacturers.Foreign.Asia; 
    using Store.Inventory; 
    public class DepartmentStore 
    { 
        static int Main() 
        { 
            Asian.Manufacturer dealer = new Asian.Manufacturer(); 
            dealer.companyName = "Peel Corp"; 
            dealer.contactName = "Sylvain Yobo"; 
            dealer.contactPhone = "(602) 791-8074"; 
            StoreItem si = new StoreItem(); 
            si.itemNumber = 613508; 
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            si.itemName = "Merino Crew Neck Cardigan"; 
            si.unitPrice = 80.00M; 
            System.Console.WriteLine("Manufacturer Information"); 
            System.Console.Write("Company Name:  "); 
            System.Console.WriteLine(dealer.companyName); 
            System.Console.Write("Contact Name:  "); 
            System.Console.WriteLine(dealer.contactName); 
            System.Console.Write("Contact Phone: "); 
            System.Console.WriteLine(dealer.contactPhone); 
            System.Console.WriteLine("---------------------------------------"); 
            System.Console.WriteLine("Store Inventory"); 
            System.Console.Write("Item #:     "); 
            System.Console.WriteLine(si.itemNumber); 
            System.Console.Write("Item Name:  "); 
            System.Console.WriteLine(si.itemName); 
            System.Console.Write("Unit Price: "); 
            System.Console.WriteLine(si.unitPrice); 
            System.Console.WriteLine("=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 برنامه را اجرا کنید.     .2

 را بسته و به محیط برنامه نویسی برگردید. DOSپنجره ی     .1

 مدیرت فضای نام

 درج کردن فضای نام

 چنانچه کدی از قبل آماده دارید و می خواهید آن را داخل یک فضای نام قرار دهید.

را درج کنید. اکنون به انتهای بخش کد  {م و علامت و به دنبال آن یک اس namespaceروی بالاترین قسمت کد نویسی کلیک کرده، 

 را تایپ کنید. }نویسی مراجعه کرده و کاراکتر 

را انتخاب  ...Surround Withکدی را که می خواهید در فضای نام دخیل کنید انتخاب کرده، روی گزینه ی انتخابی کلیک کنید. سپس 

 کلیک کنید.  namespaceکرده و در لیستی که ظاهر می شود دوبار روی 
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 تغییر اسم فضای نام 

فرایند تغییر اسم فضای نام، از همان منطقی که برای تغییر اسم متغیرها،کلاس ها، و متدها تعریف کردیم پیروی می کند. اگر نمی خواهید 

 استفاده کنید. برای این منظور Code Editorخود به صورت دستی اسم را تغییر دهید، می توانید از 

، ابتدا اسم فضای نام مورد نظر را پیدا کنید. سپس روی پیکان تگَ فضای نام مذکور کلیک کرده و یک گزینه را از Code Editorدر 

 فهرست آن انتخاب کنید.

 

  

 را انتخاب کنید. ...Renameروی اسم راست کلیک کرده، سپس گزینه ی 

 (built-in namespacesمعرفی فضای نام توکار )

  Object Browser  پنجره ی

کتابخانه ای بسیار غنی و گسترده است. مزیت برجسته ی آن، مجموعه ی بزرگ و گسترده ی کلاس های آن  NET Frameworkبرنامه ی.

فضاهای نامی متعددی ایجاد کرده و به کار می برد. از هر فضای نامی به  NET Frameworkاست. برای سازمان دهی این کلاس ها، برنامه ی.

 مده به منظور ایجاد یک مجموعه کلاس )های( منحصر به فرد استفاده می شود. وجود آ

 Microsoft Visual Studio  پنجره یObject Browser را برای بررسی و پویش فضاهای نامی برنامه ی.NET Framework  .ارائه می دهد

 برای دسترسی به آن

http://articles.tahlildadeh.com/image.axd?picture=image_1239.png
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 .مراجعه کنید View -> Object Browserفهرست گزینه ی اصلی را باز کرده، به 

 .کلیک کنید Object Browserروی دکمه ی  Standard toolbarدر 

 .را فشار دهید F2اکنون، کلید 

Object Browser خود از سه پنجره تشکیل شده 

 

http://articles.tahlildadeh.com/image.axd?picture=image_1240.png
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از گره ها  پنجره ی سمت چپ فهرستی از کتابخانه های موجود را نمایش می دهد. همان طور که در تصویر فوق مشاهده می کنید برخی 

(nodes)  دارند. این اعداد نشانگر نسخه ی []اعدادی داخل علامت.NET Framework  هستند. چنانچه گره های مختلف ولی هم نام دارای

 4.0.0.0ایجاد و به روز رسانی شده. برای مثال،  NET Framework.بودند، بدانید که کتابخانه ی مورد نظر در نسخه های متفاوت []

 است.  Microsoft.NET Framework 4.0رژن نشانگر و

می باشد. برای باز کردن گره، کافی است  +به این خاطر که اغلب کتابخانه های مذکور فضاهای نام متعددی دارند، هر گره مجهز به دکمه ی 

شوند. به دلیل این که اکثر فضاهای کلیک کنید. پس از باز کردن کتابخانه مورد نظر، فضاهای نامی داخل آن به صورت گره پدیدار می  +روی 

می باشد. همان طور که پیش تر ذکر شد برای باز کردن + نام حاوی چندین )بیش از یک کلاس( کلاس هستند، هر فضای نام مجهز به دکمه ی 

ی اعضای یک کلاس )در کلیک کنید. پس از باز کردن فضای نام دلخواه، فهرست کلاس های آن ظاهر می شود. برای مشاهده  +آن، باید روی 

 پنجره ی سمت چپ( روی اسم کلاس مورد نظر کلیک کنید.
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برای مشاهده ی توصیفی از یک عضو کلاس )در پنجره ی بالایی سمت راست(، روی آن عضو کلیک کنید. حال، پنجره ی پایینی سمت راست  

 اطلاعاتی در رابطه با آیتم انتخابی شما ارائه می دهد.

 System معرفی فضای نام 

باید آن را داخل یک متد تایپ  Systemنام دارد. برای استفاده از فضای نام  NET Framework ،System.پرکاربرد ترین فضای نام در 

 کنید.

 مثال

    public class Exercise 

http://articles.tahlildadeh.com/image.axd?picture=image_1241.png
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    { 
        static int Main() 
        { 
            System.Console.WriteLine("The wonderful world of C# programming"); 
            return 0; 
        } 
    } 

 را به کار برد. ::و عملگر  globalکلید واژه ی  ،Systemهمچنین می توان پیش از  

    public class Exercise 
    { 
        static int Main() 
        { 
            global::System.Console.WriteLine("The wonderful world of C# programming"); 
            return 0; 
        } 
    } 

استفاده می شود. از همین روش برای اشاره و دسترسی به فضای  usingپیش تر ذکر شد که برای دستیابی به یک فضای نام، از کلید واژه ی  

 نیز استفاده می شود. Systemنامی 

 مثال

 using System;   
  public class Exercise 
    { 
        static int Main() 
        { 
            System.Console.WriteLine("The wonderful world of C# programming"); 
            return 0; 
        } 
    } 

 .به کار ببرید Systemرا پیش از کلیدواژه ی  ::globalاین بار نیز می توانید 

 using global::System    
 public class Exercise 
    { 
        static int Main() 
        { 
            System.Console.WriteLine("The wonderful world of C# programming"); 
            return 0; 
        } 
    } 
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حذف ( function)را در بدنه ی تابع  Systemه کار بردید، می توانید کلید واژه ی را ب global::Systemیا  using Systemپس ازاین که 

 کنید.

 مثال

using System;      
 public class Exercise 
    { 
        static int Main() 
        { 
            Console.WriteLine("The wonderful world of C# programming"); 
            return 0; 
        } 
    } 

 معرفی دیگر فضاهای نامی

.NET Framework  لیست بلند بالایی از فضاهای نام فراهم می کند. در این مبحث به همگی آن ها نمی پردازیم، ولی در جایی که باید از

 کلاس ها استفاده کنیم، خواهیم گفت هر کلاس در کدام فضای نام قرار می گیرد.

، کلاسی جدید ایجاد Class Viewیا  Solution Explorerاز فهرست گزینه ی اصلی پنجره ی  Add New Classخاب گزینه ی می توان با انت

فضاهای نام دیگری نیز اضافه می کند. در حال حاضر، کد را همان گونه هست )بدون  visual studioکرد. در صورت استفاده از روش بالا 

 ایجاد تغییر( استفاده می کنیم.

  

  NET.نوع داده های

در قالب )توسط( کلاس ها نشان داده می شوند. به عبارت دیگر،  NET Framework.تمامی نوع داده هایی که تا کنون به کار برده ایم در 

نام برده تعریف می شوند. کلاس های نوع داده های  Systemنوع داده های مذکور خود مجهز به متد هستند. کلاس های مزبور در فضای نام 

 بدین ترتیب تعریف می شوند.
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C# Data Type 

)نوع داده ی 

C#) 

Equivalent.NET Class 

 (NET.)کلاس معادل در

C# Data Type Equivalent.NET Class 

bool Boolean char Char 

byte Byte sbyte SByte 

short Int16 ushort UInt16 

int Int32 uint UInt32 

long Int64 ulong UInt64 

float Single double Double 

decimal Decimal     

  

به عبارت دیگر، چنانچه تمایلی به استفاده از نوع داده هایی که تا کنون معرفی کرده ایم ندارید، می توانید از کلاسی که در فضای نام 

System است اسم آن را تایپ کنید. تعریف شده استفاده کنید. به منظور استفاده از کلاس های گفته شده، کافی 

 

 مثال

    class Operations 
    { 
        public double Addition() 
        { 
            Double a; 
            Double b; 
            Double c; 
            a = 128.76; 
            b = 5044.52; 
            c = a + b; 
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            return c; 
        } 
    } 

به دلیل این که نوع داده ها به عنوان )در قالب( کلاس تعریف می شوند، خود مجهز به متد هستند. یکی از متدهایی که همگی آن ها دارند  

ToString نامیده می شود. همان طور که از اسم آن پیدا است، این متد به منظور تبدیل یک مقدار به رشته به کار می رود. 

 مقدمه ای بر کتابخانه های سفارشی

.NET Framework .درباره ی  کتابخانه ای عظیم متشکل از کلاس های گوناگون و مختلف هست که هر یک برای منظور خاصی به کار می رود

د نیاز را فراهم نکرد، قابلیت مور NET Framework.برخی از کلاس های نام برده در مباحث پیش رو بحث خواهیم کرد. با این وجود، چنانچه 

نبه ی ه جشما می توانید کتابخانه ی دلخواه خود را ایجاد کرده و آن را در چندین برنامه به کار ببرید. همچنین می توانید کتابخانه ای بسازید ک

تابخانه گنجاند و در دسترس تجاری داشته، و بتوان آن را توزیع کرده و به فروش رساند. برای مثال، می توان چندین کلاس آماده داخل یک ک

 دیگران قرار داد. 

یا دیگر منابع مورد نیاز برنامه های دیگر. به منظور طراحی و ایجاد برنامه ی مزبور از همان روشی / کتابخانه برنامه ای است شامل کلاس ها  

جاد کردیم( به کار بردیم. به این خاطر که کتابخانه استفاده می کنیم که برای برنامه های دیگر )برنامه هایی که تاکنون و در دروس پیشین ای

را به همراه  dll.ندارد. لازم به ذکر است که کتابخانه به طور معمول پسوند  ()Mainیک فایل یا برنامه ی اجرایی نیست، نیازی هم به تابع  

 می باشد(.  lib.وند آن ها وجود دارد که پس Microsoft Windowsدارد )البته کتابخانه هایی از نوع دیگر نیز در 

 ایجاد کتابخانه ی سفارشی

 را اجرا کنید. #Microsoft Visual Cبرنامه ی       .8

 .را انتخاب کنید ...File -> New Projectبرای ایجاد برنامه ی جدید، فهرست اصلی را باز کرده،       .2

 .را از لیست سمت چپ انتخاب کنید Windowsگزینه ی       .1

 .کلیک کنید Empty Projectحال در لیست سمت راست روی       .4

 کلیک کنید. OKتغییر داده، سپس روی گزینه ی  SaleRecordاسم را به       .5

 کلیک کنید.  Save All کرده، اکنون روی دکمه ی  مراجعه Standard toolbarبه منظور ذخیره ی پروژه مورد نظر، به       .6

پذیرفتن فولدر پیشنهادی )در مکانی که کامپیوتر توصیه می کند(، محل ذخیره سازی آن را به خاطر بسپرید. در غیر این در صورت       .4

 صورت، مسیر دلخواه خود را وارد کنید و آن را به یاد بسپارید.

http://articles.tahlildadeh.com/image.axd?picture=clip_image002[4]_20.jpg
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 را کلیک کنید. Saveگزینه ی       .1

 نحوه ی ایجاد کتابخانه

ل تشکیل شده باشد یا از چندین فایل متعدد )هر تعداد که لازم است(. فایلی که عضوی از یک کتابخانه کتابخانه ممکن است از تنها یک فای

هست می تواند یک یا چند کلاس دربرداشته باشد. هر کلاس باید کارکردی را پیاده و فراهم کند که سرانجام برای تمامی کلاس ها مفید 

 های یک کتابخانه درست مثل کلاس های دیگر برنامه ها ایجاد می شوند. واقع شده و در دسترس آن ها قرار گیرد. کلاس 

کلیک کنید.  ..File -> New Projectرا باز کرده، روی گزینه های  Microsoft Visual Studioبرای ایجاد کتابخانه، فهرست گزینه ی اصلی 

 کلیک کنید. حال، اسمی برای آن انتخاب کنید. Class Libraryیا گزینه ی  Empty Projectدر لیست میانی، می توانید روی 

 

 Outputرا باز کرده، سپس در  Propertiesباید پنجره ی ، New Projectدر پنجره ی محاوره ی  Empty Projectدر صورت انتخاب گزینه ی 

Type combo box  گزینه یClass Library .را انتخاب کنید 

 ختیار شما قرار می گیرد که می توانید باب میلتان به کارببرید.ای در ا skeleton codeدر هر دو صورت،  

http://articles.tahlildadeh.com/image.axd?picture=clip_image004[4]_4.jpg
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 مثال

 

    public class Algebra 
    { 
        public double Addition(double x = 0, double y = 0) 
        { 
            return x + y; 
        } 
        public double Subtraction(double x = 0, double y = 0) 
        { 
            return x - y; 
        } 
        public double Multiplication(double x = 0, double y = 0) 
        { 
            return x * y; 
        } 
        public double Division(double x = 0, double y = 1) 
        { 
            return x / y; 
        } 
    } 
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 راه اندازی کتابخانه

 .کلیک کنید ...Project -> SaleRecord Propertiesمراجعه کرده، روی ( main menu)به فهرست گزینه ی اصلی       .8

 را انتخاب کنید. Class Libraryگزینه ی  Output Type combo boxدر       .2

  

 

 کلیک کنید. ...Project -> Add New Itemی گزینه های برای ایجاد فایل جدید، در فهرست گزینه ی اصلی، رو      .1

 را کلیک کنید. Codeدر لیست سمت چپ،       .4

 را انتخاب کنید. Code Fileدر لیست سمت راست،       .5

 کلیک کنید. Addتغییر داده، سپس روی  StoreItemاسم را به       .6

 فایل را به صورت زیر اصلاح کنید.      .4

    public class StoreItem 
    { 
        public int itemNumber; 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002[6]_11.jpg
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        public string itemName; 
        public string size; 
        public decimal unitPrice; 
    } 

 ذخیره کنید. Save allتمامی تغییرات وارد آمده را با کلیک روی دکمه ی       .1 

 ساختن کتابخانه

 آن (compile) فایل اجرایی، برای ترجمه /طر که فایل انتخابی کتابخانه هست نه یک برنامه به این خا

 .کلیک کنید Build -> Build ProjectNameدر فهرست اصلی، می توانید روی 

 .کنیدرا انتخاب  Build، ابتدا روی اسم پروژه ی مورد نظر راست کلیک کرده، سپس گزینه ی Solution Explorerدر پنجره ی 

 .را انتخاب کنید Build، روی اسم پروژه راست کلیک کرده، Class Viewدر پنجره ی 

 .دستور زیر را تایپ کنید(، Command Prompt)کتابخانه در پنجره ی فرمان ( compile)برای ترجمه ی 

csc /target:library NameOfFile.cs 

 .را بزنید Enterاکنون کلید  

 نامهایجاد کتاب خانه در بر

 .کلیک کنید Build -> Build Solutionبرای ایجاد کتابخانه، در فهرست اصلی روی گزینه های 

 (custom libraryبه کاربردن کتابخانه ی سفارشی )

ر پروژه ای پس از ایجاد پروژه می توانید آن )پروژه ی ایجاد شده( را در همان پروژه ای که کتابخانه در آن ساخته شده به کارببرید یا آن را د

، کار خود را با ایجاد پروژه ی جدید آغاز کنید، به منظور Microsoft Visual Studioدیگر مورد استفاده ی خود قرار دهید، در صورت کار با  

 دهید، برای این منظور( reference)استفاده از کتابخانه، در وهله ی اول باید به آن ارجاع 

 .کلیک کنید ...Project -> Add Referenceده، روی به فهرست گزینه ی اصلی مراجعه کر

 .را انتخاب کنید ...Add Reference، گزینه ی References، پس از راست کلیک روی Solution Explorerدر پنجره ی 
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در صورت انجام هر یک از دستورات بالا، پنجره ی محاوره    Add Reference ی تَبِ پدیدار می گردد، حال می توانید  رو  Browse کلیک کرده،  

 پس از پیدا کردن فولدری که کتابخانه در آن قرار دارد، روی فولدر بیان شده کلیک کنید.

 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_35.gif
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را کلیک کنید، اکنون می توانید متدها و کلاس های کتابخانه را )به همان ترتیبی که از متدها و کلاس  OKپس از انتخاب کتابخانه مورد نظر، 

 استفاده می کردید( به کار ببرید. NET Frameworkهای کتابخانه ی،

 مثال

    using System; 
    public class Exercise 
    { 
        static void Main() 
        { 
            Algebra alg = new Algebra(); 
            double number1 = 244.58; 
            double number2 = 5082.88; 
            double result = alg.Addition(number1, number2); 
            Console.Write(number1); 
            Console.Write(" + "); 
            Console.Write(number2); 
            Console.Write(" = "); 
            Console.WriteLine(result); 
            System.Console.ReadKey(); 
        } 
    } 

 کنید، دستوری مشابه به دستور زیر را تایپ کنید. (compile) ترجمه( Command Prompt)اگر می خواهید پروژه را در پنجره ی فرمان  

csc /target:library /out:DesiredNameOfLibrary.dll NameOfFile.cs 

 نتیجه ی زیر را به دست می دهد. 

     244.58 + 5082.88 = 5327.46     
        Press any key to continue... 

 استفاده از کتابخانه ی سفارشی

 کلیک کنید. ...File -> New Projectبرای راه اندازی پروژه ی جدید، در فهرست اصلی روی       .8       

 را انتخاب کنید. Empty Projectدر لیست میانی، گزینه ی       .2

 را کلیک کنید. Addتغییر داده، سپس  DepartmentStore5اسم را به       .1
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 Addراست کلیک کرده، سپس گزینه ی  References، روی DepartmentStore5پایین ، Solution Explorerدر پنجره ی       .4

Reference... .را از لیست انتخاب کنید 

 مراجعه کنید. Browseاکنون به تَبِ        .5

 در آن ایجاد شده، پیدا کنید.فولدری را که کتابخانه       .6

 را انتخاب کنید. SaleRecord.dllفایل       .4

1.      OK .را کلیک کنید 

 DepartmentStore5 -> Add -> Newراست کلیک کرده، سپس  DepartmentStore5روی ، Solution Explorerدر پنجره ی       .1

Item... 

 .کلیک کنید Code File. در لیست میانی روی 82

 را انتخاب کنید. Addتغییر داده، سپس گزینه ی  DepartmentStore. اسم را به 88

 . فایل را به صورت زیر اصلاح کنید.82

    using System; 
    public class Program 
    { 
        static int Main() 
        { 
            StoreItem si = new StoreItem(); 
            si.itemNumber = 660284; 
            si.itemName = "Tropical Wool Neutral Jacket"; 
            si.unitPrice = 200.00M; 
            Console.WriteLine("Store Inventory"); 
            Console.Write("Item #:     "); 
            Console.WriteLine(si.itemNumber); 
            Console.Write("Item Name:  "); 
            Console.WriteLine(si.itemName); 
            Console.Write("Unit Price: "); 
            Console.WriteLine(si.unitPrice); 
            Console.WriteLine("=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

. حال برنامه را اجرا کنید.81  

       Store Inventory 
        Item #:     660284 
        Item Name:  Tropical Wool Neutral Jacket 
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        Unit Price: 200.00 
        =-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
        Press any key to continue... 

. به محیط برنامه نویسی باز گردید.84   

 مقدمه ای بر کتابخانه های توکار

 #Cمقدمه ای بر کتابخانه ی 

کار )متعلق به خود( فاقد کتابخانه ی تو #Cزبان ، Pascal (Delphi) (Object)یا  ++Cبرخلاف خیلی از زبان های برنامه نویسی دیگر مثل : 

به دلیل همین انعطاف  #Cنیست. بلکه زبان  #Cمی باشد. لازم به ذکر است که این فقدان به معنای کارایی و قابلیت کمتر و ضعف برنامه 

 پذیری بالایی که دارد، می تواند از کتابخانه های دیگر زبان های برنامه نویسی نهایت استفاده را ببرد.

ک کتابخانه ی کوچک دارد متشکل از تنها چند کلاس ناچیز که اغلب به کار نمی اید. اسم این کتابخانه فقط ی #Cدر حقیقت 

Microsoft.CSharp.dll  می باشد. البته در نسخه ی تازه منتشر شده یC# (C# 4.0،)  کتابخانه به روزرسانی شده و نوع داده ی جدیدی

 به آن اضافه شده که کاربرد فراوان دارد.

به صورت خودکار کتابخانه ی  Microsoft Visual Studioایجاد کنید، ( console application)برنامه ی کاربردی کنسول اگر 

Microsoft.CSharp.dll  را به برنامه ی شما اضافه می کند. حال اگر پروژه ی خالی ایجاد کرده اید ولی در هر صورت می خواهید از این

 ، کتابخانه ی بیان شده را به پروژه ی خود اضافه کنید.Add Referenceاست با مراجعه به پنجره ی محاوره  کتابخانه استفاده کنید، کافی

 ( dynamic data typeنوع داده ی پویا )

خابی آشنا شدیم. گفته شد که نوع داده ی انت stringو  short، int، float، double، decimalدر دروس پیشین، با نوع داده های مختلفی از 

( نشانگر موس را روی نوع Code Editorخبر می دهد چه مقدار حافظه برای متغیر مورد نظر تخصیص یابد. در واقع، چنانچه )در compilerبه 

 ای نمایان می شود که مقدار حافظه ی اشغال شده توسط متغیر را نشان می دهد. (tool tip)داده مورد نظر قرار دهید، راهنمای ابزار 
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استفاده کنید اما باید  varهم گفته شد که اگر تمایل ندارید نوع داده ای، هنگام تعریف متغیر، مشخص کنید می توانید ازکلیدواژه ی این 

بر مبنای برآوردش از مقداری که به متغیر  compilerمتغیر را پیش از به کاربردن مقداردهی اولیه کنید. پس از مقداردهی اولیه ی متغیر، 

نوع داده ای که  Code Editorاده اید، حافظه رزرو می کند. هنگام استفاده از متغیر، چنانچه نشانگر موس را روی آن قرار دهید، اختصاص د

 .به آن تخصیص داده اید را نشان می دهد

 

  

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[4]_6.gif
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اده نکرده اید( مطلع نیستید. به عبارت در برخی حالات، شما از مقدار فضای موردنیاز متغیر )تا زمانی که به آن نیاز پیدا نکرده و از آن استف

را با مسائلی همچون تدارکات متغیر )مثل اینکه به چه قدر حافظه نیاز دارد( درگیر نمی کنیم تا زمانی که عملیاتی که به  compilerدیگر، 

 می شود.متغیر نیاز دارد به آن )متغیر( دسترسی پیدا کند.  به چنین متغیری، متغیر پویا یا داینامیک گفته 

 استفاده می کنیم. dynamicواژه ی  برای تعریف متغیر پویا، از کلید

 مثال

    public class Exercise 
    { 
        static int Main() 
        { 
            dynamic value; 
            return 0; 
        } 
    } 

، لازم نیست متغیر پویا را حین تعریف )آن( مقداردهی اولیه کنید. به هر حال، باید تعریف می شود varبرخلاف متغیری که با کلیدواژه ی 

بررسی  compilerمقداری به آن اختصاص دهید )ترجیحاً پیش از به کار بردن آن(. هنگامی که مقداری به متغیر پویا اختصاص می دهید، 

تنها نوع متغیر  Code Editorچنانچه نشانگر موس را روی متغیر قرار دهید،  نمی کند چه مقدار حافظه مناسب یا مورد نیاز متغیر مزبور است.

 )پویا( را به شما نشان می دهد :

  

http://articles.tahlildadeh.com/image.axd?picture=clip_image003_14.gif
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خارجی دارد و از مقادیر ( application)متغیر پویا اغلب زمانی استفاده می شود که پروژه ی شما نیاز به برقراری ارتباط با برنامه ی کاربردی 

 #Cاست که توسط زبان  Microsoft Excelیا صفحه گسترده ی  Microsoft Word documentی کند. نمونه ی آن آن برنامه استفاده م

 طراحی شده، و کتابخانه ی خارجی وارد می کنند.

 به کاربردن متغیر پویا

 کلیک کنید. ...File -> New Project برای ایجاد پروژه ی جدید، در فهرست اصلی روی     .8

 کلیک کنید. Empty Project انی، رویدر لیست می     .2

 کلیک کنید. Add تغییر داده، سپس روی DepartmentStore7 اسم آن را به     .1

 <- DepartmentStore7 -> Addراست کلیک کرده سپس  DepartmentStore7 روی ،Solution Explorerدر پنجره ی .4

New Item... .را کلیک کنید 

 انی انتخاب کنید.را از لیست می Code File گزینه ی .5

 کلیک کنید. Add تغییر داده و روی PayrollProcessing اسم را به .6

 را انتخاب کنید. ...Project -> Add Reference به فهرست گزینه ی اصلی مراجعه کرده و گزینه های     .4

 کلیک کنید. NET. حال روی تبَِ      .1

 .را انتخاب کنیدMicrosoft. CSharp در لیست موردنظر،     .1

http://articles.tahlildadeh.com/image.axd?picture=clip_image004_17.gif
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82.  OK .را کلیک کنید 

 فایل را به صورت زیر اصلاح کنید. .88

 
    using System; 
    public class Payroll 
    { 
        static int Main() 
        { 
            dynamic employeeName; 
            dynamic hourlySalary, weeklyTime, weeklySalary; 
            employeeName = "Patricia Katts"; 
            hourlySalary = 22.75; 
            weeklyTime = 38.50; 
            weeklySalary = hourlySalary * weeklyTime; 
            Console.WriteLine("=============================="); 
            Console.WriteLine("Payroll Summary"); 
            Console.WriteLine("------------------------------"); 
            Console.Write("Employee Name: "); 
            Console.WriteLine(employeeName); 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001[6]_5.gif
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            Console.Write("Hourly Salary: "); 
            Console.WriteLine(hourlySalary); 
            Console.Write("Weekly Time:   "); 
            Console.WriteLine(weeklyTime); 
            Console.Write("Weekly Salary: "); 
            Console.WriteLine(weeklySalary); 
            Console.WriteLine("=============================="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
} 

 .برنامه را اجرا کنید. نتیجه ی زیر حاصل می گردد  .82

============================== 
Payroll Summary 
------------------------------ 
Employee Name: Patricia Katts 
Hourly Salary: 22.75 
Weekly Time:   38.5 
Weekly Salary: 875.875 
============================== 

 

 .را بسته و به محیط برنامه نویسی بازگردید DOS ه یپنجر  .81

 قابلیت همکاری

 دنبال می شود، فراهم کردن امکان همکاری بین زبان های مختلف است  NET.از اهداف اصلی که در ییک 

 )مانند به اشتراک گذاری کد(. یکی از روش هایی که این امر را امکان پذیر می کند، توانایی استفاده از 

 .است ت های یک زبان در برنامه ای است که توسط زبان برنامه نویسی دیگر نوشته شدهقابلی

 بهره جست.  #Cدر یک برنامه ی کاربردی  Visual Basicبه طور مثال، می توان از )کتابخانه ی غنی( توابع  

 کنید که در خود به این خاطر که هیچ کتابخانه ای صد در صد کامل نیست، ممکن است به قابلیتی نیاز پیدا 

 زبان انتخابی )زبانی که هم اکنون برای برنامه نویسی به کار می برید( موجود نباشد. 

 همچنین ممکن است با تیم برنامه نویسی همکاری داشته باشید که از زبان های برنامه نویسی مختلفی 

 استفاده در برنامه ی خود استفاده کرده و توابع یا عملیات پیچیده ای نوشته باشند که شما مجبور به 

 هستید. 
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   win32کتابخانه ی 

 (. Javaو #C++ ،Cنوشته شده است )زبان والدِ  Cاصل سیستم عامل مایکروسافت ویندوز در محیط زبان 

  Win32برای ایجاد امکان برنامه نویسی )ایجاد برنامه های کاربردی(، مایکروسافت کتابخانه ای به نام 

 ابخانه ی نام برده متشکل از یک سری تابع و کلاس هست که از قبل استفاده می کردید. را منتشر کرد. کت

 نیستید. Win32امروزه، شما دیگر برای ایجاد برنامه ی کاربردی ویندوز ملزوم به استفاده از 

 تید با این وجود، هنوز شمار زیادی از عملیاتی که ملزم با انجام آن ها در برنامه کاربردی ویندوز هس 

 دشوار  #Cموجود هستند. خوشبختانه، به کاربردن تعداد زیادی از این توابع در زبان  Win32تنها در 

 نیست و تنها قوانینی دارد که باید رعایت کرد.

 مثال

    using System; 
    using System.Runtime.InteropServices; 
    class Program 
    { 
        [DllImport("Kernel32.dll")] 
        public static extern bool SetConsoleTitle(string strMessage); 
        static void Main() 
        { 
            SetConsoleTitle("C# Programming"); 
        } 

}     

 Visual C++/ CLIکتابخانه ی 

اکنون  ++Microsoft Visual C( کار بسیار دشواری بود. خوشبختانه، برنامه ی  ++Cدر زمان های قبل ایجاد یک کتابخانه )به خصوص در

را باز کنید. پس از  New Projectی اایجاد کتابخانه را به فرایندی فوق العاده ساده تبدیل کرده. برای این منظور، ابتدا باید پنجره ی محاوره 

کلیک کرده و اسم آن را مشخص کنید. حال می توانید در بدنه ی فایل،  Class Library، در لیست میانی، روی گزینه ی ++Visual Cانتخاب 

 توابع دلخواه را ایجاد کنید./ کلاس ها 

 مثال

 
 
 // Business.h 
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#pragma once 
using namespace System; 
public ref class Finance 
{ 
public: 
    double CalculateDiscount(double MarkedPrice, 
                     double DiscountRate) 
    { 
return MarkedPrice * DiscountRate / 100; 
    } 
}; 

فایلی با  compiler(. در نتیجه،  Build -> Build Businessپس از آماده شدن پروژه، باید به ساختن آن پرداخت )فهرست گزینه ی اصلی، 

 .ایجاد می کند dll.پسوند 

 

 ردن کتابخانه به کارب 

بسیار آسان است. برای استفاده از آن، قواعدی هست که باید رعایت شود. در وهله ی اول، باید مطمئن شوید  ++Cایجاد کتابخانه در محیط 

در فولدر  و جای گذاری آن dllکه پروژه ی شما می تواند کتابخانه ی موردنظر را پیدا کند. آسان ترین روش برای این منظور، کپی کردن فایل 

( با وارد Microsoft Visual Studioپروژه است. این کار را می توان به طور مستقیم )از طریق ( executable)دربردارنده ی  فایل اجرایی 

 کردن فایل کتابخانه نیز انجام داد. 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_36.gif
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کتابخانه )پیش از را در پروژه ی خود دخیل کنید. پیش از  System.Runtime.InteropServicesلازم است فضای نام  

("Business.dll")،)  صفت مشخصه یDllImport  را وارد کنید. این ویژگی(Attribute)  اسم کتابخانه را که در قالب رشته(string) 

 به عنوان آرگومان می گیرد./ ارسال شده، به جای 

 مثال

    using System; 
    using System.Runtime.InteropServices; 
    using Business; 
    class Exercise 
    { 
        [DllImport("Business.dll")] 
        public static extern double CalculateDiscount(double price, double discount); 
        static int Main() 
        { 
            Finance fin = new Finance(); 
            double markedPrice = 275.50; 
            double discountRate = 25.00; // % 
            double discountAmount = fin.CalculateDiscount(markedPrice,discountDate); 
            double netPrice = markedPrice - discountAmount); 
            Console.Write("Marked Price:    "); 
            Console.WriteLine("markedPrice"); 
            Console.Write("Discount Rate:   "); 
            Console.WriteLine("discountRate / 100"); 
            Console.Write("Discount Amount: "); 
            Console.WriteLine("discountAmount"); 
            Console.Write("Net Price:       "); 
            Console.WriteLine("netPrice"); 
            return 0; 
        } 
    } 

 استاتیک

، باید در وهله ی اول متغیر آن را تعریف  ()Mainدر متد Book. برای دسترسی به کلاس Bookتصور کنید کلاسی به وجود آورده اید به نام 

لاس ککنید. متغیر تعریف شده ی کلاس، نمونه ای از آن کلاس نیز اطلاق می گردد. به همین شکل می توان هر تعداد نمونه که مورد نیاز است از 

 .)واحد( تعریف کرد

    public class Book 
    { 
        public string title; 
        public string author; 
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        public short yearPublished; 
        public int numberOfPages; 
        public char coverType; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var written = new Book(); 
            var bought = new Book(); 
            return 0; 
        } 
    } 

دارهای خاص هر یک از نمونه های گفته شده، دسترسی به عضوهای کلاس مربوط را فراهم می کند. ولی باید در نظر داشت که هر نمونه تنها مق

 اعضای نمونه ی مختص به خود را نگه می دارد. توجه خود را به مثال زیر جلب کنید.

public class Exercise 
    { 
        static int Main() 
        { 
            var first = new Book(); 
            first.title = "Psychology and Human Evolution"; 
            first.author = "Jeannot Lamm"; 
            first.yearPublished = 1996; 
            first.numberOfPages = 872; 
            first.coverType = 'H'; 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(first.title); 
            Console.Write("Author: "); 
            Console.WriteLine(first.author); 
            Console.Write("Year:   "); 
            Console.WriteLine(first.yearPublished); 
            Console.Write("Pages:  "); 
            Console.WriteLine(first.numberOfPages); 
            Console.Write("Cover:  "); 
            Console.WriteLine(first.coverType); 
            var second = new Book(); 
            second.title = "C# First Step"; 
            second.author = "Alexandra Nyango"; 
            second.yearPublished = 2004; 
            second.numberOfPages = 604; 
            second.coverType = 'P'; 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(second.title); 
            Console.Write("Author: "); 
            Console.WriteLine(second.author); 
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            Console.Write("Year:   "); 
            Console.WriteLine(second.yearPublished); 
            Console.Write("Pages:  "); 
            Console.WriteLine(second.numberOfPages); 
            Console.Write("Cover:  "); 
            Console.WriteLine(second.coverType); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

 نتیجه ی زیر حاصل می گردد. 

      Book Characteristics 
        Title:  Psychology and Human Evolution  
        Author: Jeannot Lamm  
        Year:   1996  
        Pages:  872  
        Cover:  H  
        Book Characteristics  
        Title:  C# First Step  
        Author: Alexandra Nyango  
        Year:   2004  
        Pages:  604  
        Cover:  P 
 

تعریف می شوند زیرا، به  instance variableکلیه ی متغیرهای عضو و متدهای کلاس که تاکنون به کار برده ایم تحت عنوان متغیر نمونه یا 

تعریف نمونه ی کلاس در کلاسی دیگر هستید )منظور کلاسی است که می خواهید در آن به متغیر نمونه منظور دسترسی به آن ها ملزوم به 

 دست پیدا کنید(.

به  و می توانید متغیری در برنامه ی کاربردی خود، صرفنظر از اینکه کدام نمونه از )یک( شی را برای این منظور استفاده می کنید، تعریف کرده

 یا ایستا تلقی می گردد. Staticمتغیری  آن ارجاع دهید. چنین

  تعریف متغیر ایستا

 را در سمت چپ آن تایپ کنید. به مثال زیر توجه کنید. staticبرای تعریف متغیر )عضو یک( کلاس به عنوان ایستا، باید کلید واژه ی 

    public class Book 
    { 
        static string title; 
    } 
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ی توانید هر تعداد متغیر ایستا که لازم می دانید معرفی کنید. همان طور که در مباحث پیشین تشریح شد، برای کنترل سطح به همین ترتیب م

، می توانید modifier)تنظیم کننده های سطح دسترسی( استفاده می شود. در صورت استفاده از  modifierدسترسی به فیلد های کلاس از 

 یا پس از آن به کار ببردید )البته مادام اینکه قبل از نوع داده استفاده شود(.را پیش  staticکلیدواژه ی 

 مثال

    public class Book 
    { 
        public static string title; 
        static public string author; 
    } 

کنید ) این که کجا می خواهید از آن استفاده کنید(. این کار مستلزم برای دسترسی به متغیر ایستا، باید ابتدا مکان به کار گیری آن را تعریف 

 تعیین )کردن( کلاس متغیر ایستا است.

 مثال

  
    public class Book 
    { 
        public static string title; 
        static public string author; 
        public short yearPublished; 
        public int pages; 
        public char coverType; 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var first = new Book(); 
            Book.title = "Psychology and Human Evolution"; 
            Book.author = "Jeannot Lamm"; 
            first.yearPublished = 1996; 
            first.pages = 872; 
            first.coverType = 'H'; 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(Book.title); 
            Console.Write("Author: "); 
            Console.WriteLine(Book.author); 
            Console.Write("Year:   "); 
            Console.WriteLine(first.yearPublished); 
            Console.Write("Pages:  "); 
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            Console.WriteLine(first.Pages); 
            Console.Write("Cover:  "); 
            Console.WriteLine(first.coverType); 
            var second = new Book(); 
            Book.title = "C# First Step"; 
            Book.author = "Alexandra Nyango"; 
            second.yearPublished = 2004; 
            second.pages = 604; 
            second.coverType = 'P'; 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(Book.title); 
            Console.Write("Author: "); 
            Console.WriteLine(Book.author); 
            Console.Write("Year:   "); 
            Console.WriteLine(second.yearPublished); 
            Console.Write("Pages:  "); 
            Console.WriteLine(second.Pages); 
            Console.Write("Cover:  "); 
            Console.WriteLine(second.coverType); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

ه س برای دسترسی بهمان طور که در مثال بالا مشاهده می کنید زمانی که متغیری به عنوان ایستا تعریف می شود، دیگر نیازی به نمونه ی کلا

آن متغیر )عضو( از بیرون کلاس نیست. بر این اساس چنانچه همه ی اعضای کلاس را به عنوان ایستا معرفی کنید، دیگر لازم نیست برای 

ی  ( بدون استفاده از نمونهBook)از کلاس  Titleو  Authorدسترسی به آن ها متغیری از کلاسشان تعریف کنید. در مثال ذیل، فلیدهای 

 قابل دسترسی می باشد. Exercise، برای کلاس Bookکلاس 

using System; 
    using System; 
    public class Book 
    { 
        public static string title; 
        static public string author; 
    } 
    public class Exercise 
    { 
        static void Main() 
        { 
            Book.title = "Psychology and Human Evolution"; 
            Book.author = "Jeannot Lamm"; 
            Console.WriteLine("Book Characteristics"); 
            Console.WriteLine("Title:  "); 
            Console.WriteLine(Book.title); 
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            Console.WriteLine("Author: "); 
            Console.WriteLine(Book.author); 
            Book.title = "C# First Step"; 
            Book.author = "Alexandra Miles"; 
            Console.WriteLine("Book Characteristics"); 
            Console.WriteLine("Title:  "); 
            Console.WriteLine(Book.title); 
            Console.WriteLine("Author: "); 
            Console.WriteLine(Book.author); 
            Console.ReadKey(); 
        } 
    } 

ریف کرد. فقط به خاطر داشته باشید که برای دسترسی به متغیر به طور مشابه، می توان ترکیبی از متغیرهای ایستا و غیر ایستا برای کلاس تع

س ایستا، شما ملزم به تعریف یا ایجاد نمونه ای از کلاس نیستید. در حالی که به منظور دسترسی به متغیر غیر ایستا، باید متغیری برای کلا

 مورد نظر معرفی کنید.

 متدهای ایستا  

لاس را به عنوان ایستا معرفی کرد. متد مذکور قابلیت دسترسی به تمامی اعضای کلاس را دارد )البته درست مشابه متغیر عضو، می توان متد ک
سطح دسترسی متد به اعضای کلاس بستگی به این دارد که متغیر عضو چگونه تعریف شده باشد(. به یاد داشته باشید که اعضای کلاس می 

 توانند ایستا یا غیر ایستا باشند. 

 یستاایجاد متد ا

 را سمت چپ آن تایپ کنید. staticبرای تعریف متدی به عنوان ایستا، کافی است کلیدواژه ی 

 مثال

    public class Book 
    { 
        static void CreateBook() 
        { 
        } 
    } 

را پیش یا  staticرا دارد. می توان کلیدواژه ی ( access modifier)متد ایستا همچنین اجازه ی استفاده از تنظیم کننده ی سطح دسترسی 
 پس از تنظیم کننده ی سطح دسترسی قرار دهید.

 مثال

    using System; 
    public class Book 
    { 
        private static string title; 
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        static private string author; 
        private static int pages; 
        static private double price; 
        static public void CreateBook() 
        { 
            title = "Psychology and Human Evolution"; 
            author = "Jeannot Lamm"; 
            pages = 472; 
            price = 24.95; 
        } 
        internal static void ShowBook() 
        { 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(Book.title); 
            Console.Write("Author: "); 
            Console.WriteLine(Book.author); 
            Console.Write("Pages:  "); 
            Console.WriteLine(pages); 
            Console.Write("Price:  "); 
            Console.WriteLine(price); 
            Console.ReadKey(); 
        } 
        public static int Main() 
        { 
            return 0; 
        } 
    } 
 

ذکر شد، استفاده از متد ایستا نیز بستگی به مکان دسترسی آن دارد )منظور جایی است که متد  (static field) همان طور که برای فیلد ایستا
فاده ستایستا در آن قابل دسترس است(. به منظور دستیابی به عضو ایستا از طریق متد ایستای همان کلاس، می توان از اسم عضو ایستا ا

 کرد.

   مثال

    using System; 
    public class Book 
    { 
        static string title; 
        static string author; 
        static int pages; 
        static double price; 
        static void CreateBook() 
        { 
            title = "Psychology and Human Evolution"; 
            author = "Jeannot Lamm"; 
            pages = 472; 
            price = 24.95; 
        } 
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        static void ShowBook() 
        { 
            Console.WriteLine("Book Characteristics"); 
            Console.Write("Title:  "); 
            Console.WriteLine(Book.title); 
            Console.Write("Author: "); 
            Console.WriteLine(Book.author); 
            Console.Write("Pages:  "); 
            Console.WriteLine(pages); 
            Console.Write("Price:  "); 
            Console.WriteLine(price); 
            Console.ReadKey(); 
        } 
        public static int Main() 
        { 
            CreateBook(); 
            ShowBook(); 
            return 0; 
        } 
    } 

 

 .نتیجه ی زیر را به دست می دهد

Book Characteristics 
Title:  Psychology and Human Evolution 
Author: Jeannot Lamm 
Pages:  472 
Price:  24.95 
 

 .همچنین می توان ابتدا اسم کلاس و به دنبال آن نقطه، عضو مورد نظر را را تایپ کرد. به مثال های زیر توجه کنید

   using System; 
    public class Book 
    { 
         . . . No Change 
        static void CreateBook() 
        { 
              . . . No Change 
        } 
        static void ShowBook() 
        { 
              . . . No Change 
        } 
        public static int Main() 
        { 
            Book.CreateBook(); 
            Book.ShowBook(); 
            return 0; 
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        } 
    } 
 

ای هبه منظور دسترسی به عضوی ایستا از بیرون کلاس، ابتدا اسم کلاس، به دنبال آن نقطه و عضو موردنظر را تایپ کنید. نظر خود را به مثال  
 .زیر جلب کنید

using System; 
    public class Book 
    { 
        . . . No Change 
        static public void CreateBook() 
        { 
             . . . No Change 
        } 
        internal static void ShowBook() 
        { 
             . . . No Change 
        } 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            Book.CreateBook(); 
            Book.ShowBook(); 
            return 0; 
        } 
    } 

 کلاس های ایستا

کلاسی هست که برای دسترسی به اعضای آن به هیچ وجه نیازی به  کلاس هم می تواند درست مثل متد و متغیر ایستا باشد. کلاس ایستا
به عبارتی روشن تر، دسترسی به اعضای کلاس ایستا فقط و فقط با استفاده از اسم کلاس )مستقیم از خود کلاس( و نمونه ی کلاس نیست. 

 عملگر نقطه امکان پذیر می باشد. 

به ( non-static)کلاسی هست که اعضای آن باید ایستا باشند )در قالب ایستا ایجاد شوند(. به عبارت دیگر، نمی توان عضوی غیر ایستا 
 کلاسی ایستا افزود: کلیه ی اعضا به استثنای ثابت ها، باید ایستا باشند.  

 ایجاد کلاس ایستا

 به کار ببرید. classرا پیش از کلیدواژه ی  staticبرای ایجاد کلاسی ایستا، کلیدواژه ی 

 مثال

using System; 
    public static class Square 
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    { 
        public static double side; 
        public static double Perimeter() 
        { 
            return side * 4; 
        } 
        public static double Area() 
        { 
            return side * side; 
        } 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            Square.Side = 36.84; 
            Console.WriteLine("Square Characteristics"); 
            Console.Write("Side:      "); 
            Console.WriteLine(Square.side); 
            Console.Write("Perimeter: "); 
            Console.WriteLine(Square.Perimeter()); 
            Console.Write("Area:      "); 
            Console.WriteLine(Square.Area()); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر را به دست می دهد

 
Square Characteristics 
Side:      36.84 
Perimeter: 147.36 
Area:      1357.1856 
Press any key to continue . . . 

 Staticتوابع سازنده ی 

تعریف کرد. برای این منظور قوانینی وجود دارد که می بایست از آن ها  C# ،Staticرا مانند دیگر توابع معمول در  constructorمی توان 

تعریف شده )برای استفاده از آن خارج از کلاس خودش نیازی به ساختن نمونه یا شی  staticه پیروی کنید. برای استفاده از تابع سازنده ای ک

 از آن کلاس نیست(، بایستی آن را به طور صریح ایجاد نمایید )کامپایلر خودکار آن را برای شما ایجاد نمی کند(.

ای تعریف  constructorقرار گیرد، به عبارتی روشن تر باید پیش فرض مورد استفاده  constructorباید به عنوان  staticتابع سازنده ی 

 کنید که آرگومان نمی گیرد. مثال:
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    public class Person 
    { 
        public string firstName; 
        static Person() 
        { 
        } 
    } 
 

 کلاس مورد نظر وجود ندارد: staticان استفاده از فیلدها یا اعضای غیر ایجاد کنید، آن وقت دیگر امک staticتابع سازنده ی اگر یک 

 

 با این حال، شما این اجازه را دارید که به فیلدهای کلاس دسترسی داشته باشید. مثال:

    
 using System; 
    public class Person 
    { 
        public string firstName; 
        static Person() 
        { 
        } 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            Person pers = new Person(); 
            pers.firstName = "Gertrude"; 
            Console.WriteLine("Personal Identification"); 
            Console.Write("Name: "); 
            Console.WriteLine(pers.firstName); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 
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ر تابع می باشد، چند گزینه پیشرو دارید. برای مقداردهی اولیه ی متغیر عضوی د staticای که دارای خاصیت  constructorبرای استفاده از 

 ، ابتدا لازم است یک متغیر برای آن کلاس اعلان کرده، سپس به آن متغیر عضو دسترسی پیدا کنید. مثال:staticسازنده ی 

    public class Person 
    { 
        public string firstName; 
        static Person() 
        { 
            Person pers = new Person(); 
            pers.firstName = "Gertrude"; 
        } 
    } 

کلاس و یا انجام عملیاتی است که بین تمامی  static، مقداردهی اولیه ی فیلدهای staticدر واقع، یکی از دلایل استفاده از تابع سازنده ی 

آن  staticع سازنده، مقداردهی اولیه ی متغیرهای عضو نمونه های کلاس به اشتراک گذاشته می شود. بنابراین، دیگر مورد استفاده ی تاب

که در تابع سازنده مقداردهی اولیه شدند، می بینید که آن فیلدها مقادیر   staticکلاس می باشد. حال، در زمان دسترسی به فیلدهای 

 تخصیص یافته را درخود ذخیره کرده و آماده ی استفاده دارند. 

    using System; 
    public class Person 
    { 
        public static string firstName; 
        static Person() 
        { 
            firstName = "Gertrude"; 
        } 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            Console.WriteLine("Personal Identification"); 
            Console.Write("Name: "); 
            Console.WriteLine(Person.firstName); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر را به دنبال دارد:   

Personal Identification 
Name: Gertrude 
Press any key to continue . . . 

 می باشد، دسترسی به آن از طریق اعلان متغیر برای کلاس مورد نظر امکان پذیر نمی باشد. staticاز آنجایی که تابع سازنده 
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ح دسترسی باید رعایت کرد این است که نباید تحت هیچ شرایطی به آن تنظیم کننده ی سط staticقانون دیگری که در کار با تابع سازنده ی 

(access modifier:اضافه کرد. کد زیر با خطا مواجه می شود )  

    public class Person 
    { 
        public static Person() 
        { 
        } 
    } 

 می باشد. مثال: staticغیر  constructorو یک یا چند تابع  staticمی توانید یک کلاس تعریف کنید که ترکیبی از تابع سازنده ی 

    public class Person 
    { 
        public string firstName; 
        public string lastName; 
        static Person() 
        { 
        } 
        public Person(string first, string last) 
        { 
            firstName = first; 
            lastName = last; 
        } 
    } 
 

پیش فرضی برای آن وجود نداشته یا در حال حاضر دسترس پذیر  constructorاگر چنین کلاسی تعریف کرده و متغیری برای آن اعلان کنید، 

می گیرد )آن متغیر را به عنوان که دو پارامتر ورودی  constructorنمی باشد. اگر هم می خواهید متغیری برای آن تعریف کنید، بایستی از یک 

 آرگومان می پذیرد(، استفاده نمایید.  مثال:

    using System; 
    public class Person 
    { 
        public string firstName; 
        public string lastName; 
        static Person() 
        { 
        } 
        public Person(string first, string last) 
        { 
            firstName = first; 
            lastName = last; 
        } 
    } 
    public class Exercise 
    { 



 

320 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

        public static int Main() 
        { 
            Person pers = new Person("Gertrude", "Monay"); 
            Console.WriteLine("Personal Identification"); 
            Console.Write("First Name: "); 
            Console.WriteLine(pers.firstName); 
            Console.Write("Last Name:  "); 
            Console.WriteLine(pers.lastName); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 خروجی:

Personal Identification 
First Name: Gertrude 
Last Name:  Monay 
Press any key to continue . . . 
 

 هستید که دلیل خوبی برای ایجاد آن داشته باشید.  constructorبا توجه به آنچه گفته شد، تنها زمانی مجاز به تعریف 

 طول عمر یک متغیر محدوده و

 نمونه های زیادی از تعریف متغیرهای محلی را مشاهده کردیم.

 مثال

   using System; 

    public class Exercise 
    { 
        public static int Main() 
        { 
            int number; 
            return 0; 
        } 

}     
 

ست متغیری نیاز داشته باشید که توسط متدهای مختلف یک کلاس قابل دسترسی و اصلاح باشند. برای این منظور، می در برخی موارد، ممکن ا
 می گویند. ( global variable) توانید متغیر مورد نظر را بیرون از محدوده ی )تمامی( متدها تعریف کنید. به چنین متغیری، متغیر سراسری

 اسریایجاد و استفاده از متغیر سر

 همان طور که پیش تر ذکر شد، برای ایجاد متغیر سراسری، باید آن را )در( بیرون متدها ولی در محدوده ی کلاس تعریف کرد.
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 مثال

    using System; 
    public class Exercise 
    { 
        int number; 
        public static int Main() 
        { 
            return 0; 
        } 
    } 
 
 پس از تعریف متغیر، می توان از هر متدی داخل کلاس برای دسترسی به آن استفاده کرد، از قبیل اصلاح مقدار آن. مثال های زیر را در نظر

 .بگیرید

    using System; 
    public class Exercise 
    { 
        int number; 
        public void Modify() 
        { 
            number = 28; 
        } 
        public void Change() 
        { 
            number = 405; 
        } 
        public static int Main() 
        { 
            Exercise exo = new Exercise(); 
            Console.Write("Number: "); 
            Console.WriteLine(exo.number); 
            exo.Modify(); 
            Console.Write("Number: "); 
            Console.WriteLine(exo.number); 
            exo.Change(); 
            Console.Write("Number: "); 
            Console.WriteLine(exo.number); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر به دست می آید

Number: 0 
Number: 28 
Number: 405 
Press any key to continue... 
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 .همچنین می توان از متد برای نشان دادن مقدار متغیر سراسری بهره گرفت

    using System; 
    public class Exercise 
    { 
        int number; 
        public void Modify() 
        { 
            number = 28; 
        } 
        public void Change() 
        { 
            number = 405; 
        } 
        public void Show() 
        { 
            Console.Write("Number: "); 
            Console.WriteLine(number); 
            Console.ReadKey(); 
        } 
        public static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.Show(); 
            exo.Modify(); 
            exo.Show(); 
            exo.Change(); 
            exo.Show(); 
            return 0; 
        } 
    } 

 متغیرهای ایستا و سراسری

راه حل آن تعریف متغیر خارج از محدوده ی متد است، سپس  امکان تعریف متغیر ایستا درون متد وجود ندارد.#C) در( ،++Cدرست برخلاف 
 ه به آن نیاز دارد دست پیدا کرد.می توان به متغیر مورد نظر از هر متدی ک

 مثال

  using System; 
    public class Exercise 
    { 
        static int number; 
        public void Modify() 
        { 
            number = 28; 
        } 
        public void Change() 
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        { 
            number = 405; 
        } 
        public void Show() 
        { 
            Console.Write("Number: "); 
            Console.WriteLine(number); 
            Console.ReadKey(); 
        } 
        public static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.Show(); 
            exo.Modify(); 
            exo.Show(); 
            exo.Change(); 
            exo.Show(); 
            return 0; 
        } 
    } 

 خصوصیات اعضای ایستا

 ثابت ها

بحث کردیم  1کلاس وجود دارد. همان طور که در درس  در( constant variable)امکان ایجاد متغیر ثابت  ،#Cدر  ،++C/Cبرخلاف زبان های 
را در سمت چپ متغیر مربوطه تایپ کنید. توجه داشته باشید که هنگام تعریف یک   constبرای تعریف متغیر ثابت، کافی است کلید واژه ی 

 ثابت، باید آن را با مقدار مناسب و مقتضی مقداردهی اولیه کرد. 

 thisنمونه ی 

ی حاوی فیلد و متد باشد، عضوهای فیلد )غیر ایستا( خودکار در دسترس متدهای کلاس مورد نظر قرار می گیرند، حتی آن دسته چنانچه کلاس
هستند. هنگام دسترسی به فیلد یا متدی از متد دیگر )همان( کلاس، برای این که نشان دهیم عضوی که  (private)فیلدهایی که خصوصی 

و به دنبال آن عملگر نقطه پیش از متد یا فیلد مورد نظر  thisمتعلق به همین کلاس است، از شی ای به نام   خواهان دسترسی به آن هستیم
 در واقع ارجاع به کلاس جاری می باشد(. thisاستفاده می کنیم )نمونه ی 

 مثال

   
  
    public class House 
    { 
        internal char propertyType; 
        internal uint bedrooms; 
        internal void Display() 
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        { 
            Console.WriteLine("=//= Altair Realtors =//="); 
            Console.WriteLine("Properties Inventory"); ; 
            Console.Write("Property Type:  "); 
            Console.WriteLine(this.propertyType); 
            Console.Write("Bedrooms:       "); 
            Console.WriteLine(this.bedrooms); 
            Console.ReadKey(); 
        } 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            House h = new House(); 
            h.Display(); 
            return 0; 
        } 
    } 
 

هیچگاه تعریف نمی شود، بلکه هنگام ایجاد کلاس خودکار به  thisپیروی از قوانین زیر الزامی می باشد.شی  thisهنگام بکارگیری کلید واژه ی  

 آن اشاره می شود.

 کمک گرفت. Bده کرد، سپس از آن برای دسترسی پیدا کردن به عضوی از کلاس استفا Aنمی توان در کلاس  thisاز 

 استفاده کرد. staticدر متد  thisبه هیچ وجه نمی توان از شی 

 بررسی اجمالی اعداد

رای ریاضی ، از ریاضی پشتیبانی نمی کند )امکان پشتیبانی توکار بJavaو  C ،C++ ،Pascal، Visual Basic، برخلاف زبان های #Cزبان 

 ندارد( و مجبور است این قابلیت را از کتابخانه ها یا زبان های دیگر وام بگیرد. 

استفاده کنید. همچنین می  Math.NET Frameworkمی توانید از متدهای کلاس  ،#Cبرای انجام ساده ترین عملیات جبری و هندسی در 

این منظور کمک گرفت. کتابخانه ی بالا یکی از گسترده ترین مجموعه توابع حوضه  برای  visual basicبسیار غنی توابع  توان از کتابخانه ی

 های مختلف ریاضی تجاری را در بر دارد. 

 راه های مختلفی برای تعریف متغیر )از( نوع عددی وجود دارد که نمونه های آن را زیر مشاهده می کنید.

    using System; 
    class Program 
    { 
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        static int Main() 
        { 
            short sNumber; 
            int iNumber; 
            double dNumber; 
            decimal mNumber; 
            return 0; 
        } 
    } 

 علامت اعداد

ز به کار بردن آن، متغیر باید مقداردهی اولیه شده باشد. نمونه این است که پس از تعریف متغیر و پیش ا #Cیکی از قوانین پایه و اولیه ی 

 .های مقداردهی اولیه متغیر در مثال به نمایش گذاشته شده است

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            short sNumber = 225; 
            int iNumber = -847779; 
            double dNumber = 9710.275D; 
            decimal mNumber = 35292742.884295M; 
            Console.WriteLine("Short Integer:      {0}", sNumber); 
            Console.WriteLine("Integral Number:    {0}", iNumber); 
            Console.WriteLine("Double-Precision:   {0}", dNumber); 
            Console.WriteLine("Extended Precision: {0}", mNumber); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر را به دست می دهد

Short Integer:      225 
Integral Number:    -847779 
Double-Precision:   9710.275 
Extended Precision: 35292742.884295 
Press any key to continue... 

 

که سرانجام  2در واقع مشخص می کنید که متغیر نام برده مثبت باشد یا منفی و یا (، constant)هنگام مقداردهی اولیه متغیر با یک ثابت 

در صورتی که مقدار متغیر را از راه دیگری به دست آورید، ممکن است علامت آن مشخص نشود. اگر چه  علامت آن متغیر محسوب می شود.
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متدی در اختیار شما math  کلاس  علامت متغیر )مثبت یا منفی بودن عدد( را به دست آورد، اما های مقایسه می توان با استفاده از عملگر

 می دهد.  قرار می دهد که این کار را برای شما انجام

آن ها به شکل زیر  (syntax)را فراخواند. البته متد مذکور در نسخه های مختلف که دستور نحوی  ()Math.Signبرای این منظور باید متد 

 است اضافه بارگذاری شده.

public static int Sign(sbyte   value); 
public static int Sign(short   value); 
public static int Sign(int     value); 
public static int Sign(long    value); 
public static int Sign(sbyte   value); 
public static int Sign(double  value); 
public static int Sign(decimal value); 

 نتایج زیر را بر می گرداند. هنگام فراخوانی این متد، متغیر یا مقدار دلخواه را به عنوان آرگومان ارسال کنید. متد 

 .چنانچه آرگومان منفی بود -8

 .بود 2چنانچه آرگومان  2

 .چنانچه آرگومان مثبت بود 8

 مثال های فراخوانی متد

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            short sNumber = 225; 
            int iNumber = -847779; 
            double dNumber = 9710.275D; 
            decimal mNumber = 35292742.884295M; 
            Console.WriteLine("Number: {0} => Sign: {1}",sNumber, Math.Sign(sNumber)); 
            Console.WriteLine("Number: {0} => Sign: {1}",iNumber, Math.Sign(iNumber)); 
            Console.WriteLine("Number: {0} => Sign: {1}",dNumber, Math.Sign(dNumber)); 
            Console.WriteLine("Number: {0} => Sign: {1}\n",mNumber, Math.Sign(mNumber)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه
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Number: 225 => Sign: 1 
umber: -847779 => Sign: -1 
umber: 9710.275 => Sign: 1 
umber: 35292742.884295 => Sign: 1 
ress any key to continue... 

 بخش صحیح عدد ممیز شناور 

یل شده، یک بخش عدد صحیح و یک بخش اعشار و این دو تشریح کردیم، عدد ممیز شناور از دو بخش اصلی تشک 1همان طور که در درس 

از هم جدا می شوند. در برخی موارد )عملیات( لازم است بخش عدد صحیح یک مقدار را بدست آورید. ". " بخش مذکور توسط نقطه ی اعشار 

 در این زمینه کمک شایانی به شما می کند. Mathکلاس 

این امکان را برای شما فراهم می کند. متد بالا در  ()Trancateبا متد  Mathکلاس  دهدهی،برای به دست آوردن بخش عدد صحیح یک رقم 

 .دو نسخه ی زیر اضافه بار گذاری شده و دستور نحوی آن به شرح زیر است

 
public static double Truncate(double d); 
public static double Truncate(double d); 

 

یک عدد یا متغیر از نوع شناور، دابل و دهدهی به آن ارسال کنید. متد نام برده بخش عدد صحیح یک مقدار را باز  هنگام فراخوانی این متد،

 می گرداند.

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            float number = 225.75f; 
            Console.WriteLine("The integral part of {0} is {1}\n",number, Math.Truncate(number)); 
            Console.ReadKey(); 
            return 0; 
        } 

}      

 .نتیجه ی زیر به دست می آید
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The integral part of 225.75 is 225 
Press any key to continue... 

  کمینه ی دو مقدار

متد . Minمجهز به متدی است به نام  Mathمی توان کمینه ی دو مقدار را بدون نیاز به نوشتن کد )خود( بدست آورد. برای این منظور کلاس 

تطبیق داده شده است. دستورهای  floating-pointیا  integralمزبور در ورژن های متفاوت اضافه بارگذاری شده که هر نسخه با نوع داده ی 

 .آن ها به شرح زیر استنحوی 

public static byte    Min(byte    val1, byte    val2); 
public static sbyte   Min(sbyte   val1, sbyte   val2); 
public static short   Min(short   val1, short   val2); 
public static ushort  Min(ushort  val1, ushort  val2); 
public static int     Min(int     val1, int     val2); 
public static uint    Min(uint    val1, uint    val2); 
public static float   Min(float   val1, float   val2); 
public static long    Min(long    val1, long    val2); 
public static ulong   Min(ulong   val1, ulong   val2); 
public static double  Min(double  val1, double  val2); 
public static decimal Min(decimal val1, decimal val2); 

  مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int number1 = 8025; 
            int number2 = 73; 
            Console.WriteLine("The minimum of {0} and {1} is {2}", number1, number2, Math.Min(number1, number2)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

The minimum of 8025 and 73 is 73 
 Press any key to continue... 

 

 برای تعریف متغیرهای مورد نظر استفاده کرد : dynamicو  varبه خاطر داشته باشید که می توان از کلیدواژه های 



 

329 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            var number1 = 8025; 
            dynamic number2 = 73; 
            Console.WriteLine("The minimum of {0} and {1} is {2}",number1, number2, Math.Min(number1, number2)); 
            Console.ReadKey(); 
            return 0; 
        } 

}      

 یک سری integerبیشینه ی مقدار 

 .( فراخواند. دستور نحوی این متد به ترتیب زیر استMathرا )از کلاس  ()Max عدد، می توان متد برای بدست آوردن بیشینه ی دو

public static byte    Max(byte    val1, byte    val2); 
public static sbyte   Max(sbyte   val1, sbyte   val2); 
public static short   Max(short   val1, short   val2); 
public static ushort  Max(ushort  val1, ushort  val2); 
public static int     Max(int     val1, int     val2); 
public static uint    Max(uint    val1, uint    val2); 
public static float   Max(float   val1, float   val2); 
public static long    Max(long    val1, long    val2); 
public static ulong   Max(ulong   val1, ulong   val2); 
public static double  Max(double  val1, double  val2); 
public static decimal Max(decimal val1, decimal val2); 

 مثال فراخوانی متد بالا

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int number1 = 8025; 
            int number2 = 73; 
            Console.WriteLine("The maximum of {0} and {1} is {2}",number1, number2, Math.Max(number1, number2)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 



 

330 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 نتیجه

The maximum of 8025 and 73 is 8025 
Press any key to continue... 

 تبدیل مقادیر

 تبدیل ضمنی

آشنا شدیم. طریقه ی مقداردهی اولیه ی آن ها نیز تشریح شد. در صورت ( integral)با نحوه ی تعریف نوع های رشته، ممیز شناور و صحیح 

 8یرهای مختلفی در آن به کار گرفته شده، می توان مقدار یک متغیر را به )مقدار( متغیر دیگری تبدیل کرد. در درس داشتن برنامه ای که متغ

 با مقدار حافظه ی مورد نیاز برای ذخیره سازی متغیر هر نوع داده آشنا شدیم.

 Data Type Name Memory Size 

byte Byte 8 bits 

sbyte Signed Byte ( تبایت با علام )  8 bits 

char Character 16 bits 

short Small Integer (عدد صحیح کوچک)  16 bits 

ushort Unsigned Small Integer 16 bits 

int Signed Integer(عدد صحیح علامت دار)  32 bits 

uint Unsigned Integer(عدد صحیح بدون علامت)  32 bits 

float Single-Precision Floating-Point Number ( عدد با ممیز

 (شناور با تنها یک رقم اعشار

32 bits 
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double Double-Precision Floating-Point Number ( عدد با

 (ممیز شناور با دو رقم اعشار

64 bits 

long Signed Long Integer (عدد صحیح بزرگ علامت دار)  64 bits 

ulong Unsigned Long Integer 64 bits 

decimal Extended Precision Floating-Point Number( عدد(

  (ممیز اعشار با رقم اعشار طولانی

128 bits 

 

جای گیرد و  intمی تواند در مقدار حافظه ی تخصیص یافته برای متغیر  Byteهمان طور که در جدول بالا مشاهده می کنید، مقدار یک متغیر  

اختصاص  intرا به متغیر  Byteقابلیت ذخیره شدن را دارد. بر این اساس، می توان مقدار یک  longخود در متغیر  intسرانجام مقدار متغیر 

بیشتر از مقدار حافظه ی تخصیص یافته به  int. همچنین به این خاطر که حافظه ی رزرو شده برای متغیر longرا به متغیر  intداد و یا متغیر 

 .لی را به متغیر دومی اختصاص داد. مثال زیر را در نظر بگیریدمی باشد، می توان متغیر او doubleمتغیر 

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int iNumber = 2445; 
            double dNumber = iNumber; 
            Console.WriteLine("Number = {0}", iNumber); 
            Console.WriteLine("Number = {0}\n", dNumber); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

Number = 2445 
Number = 2445 
Press any key to continue... 

 از این ویژگی با عنوان تبدیل ضمنی یاد می شود.
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 تبدیل صریح

به دلیل مقررات و الزامات حافظه، عکس فرایند تبدیل ضمنی امکان پذیر نمی باشد. به این خاطر که حافظه ی تخصیص یافته برای متغیر 

short  کمتر از مقدار حافظه است که برای متغیرint  رزرو شده، نمی توان مقدار متغیرint  را بهshort  اختصاص داد. برنامه ی زیر را در نظر

 د.بگیری

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int iNumber = 168; 
            short sNumber = iNumber; 
            Console.WriteLine("Number = {0}", iNumber); 
            Console.WriteLine("Number = {0}\n", sNumber); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 با اخطار زیر مواجه می شوید.

Cannot implicitly convert type 'int' to 'short'. 

 

و می خواهیم آن مقدار مورد داریم  integerتبدیل )نوع( مقدار عبارتند از تبدیل یک مقدار به مقداری با نوع متفاوت. برای مثال، مقداری 

 می طلبد داشته باشیم. از این فرایند با عنوان تبدیل صریح نیز یاد می شود. shortنظر را در عبارتی که مقدار 

 به منظور تبدیل یک مقدار یا متغیر، نوع داده ی دلخواه را پیش از مقدار مورد نظر داخل پرانتز تایپ می کنید.

 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int iNumber = 168; 
            short sNumber = (short)iNumber; 
            Console.WriteLine("Number = {0}", iNumber); 



 

333 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            Console.WriteLine("Number = {0}\n", sNumber); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

Number = 168 
Number = 168 
Press any key to continue... 

 

است. اگر می  هنگام اجرای تبدیل صریح، توجه دقیق به نوع تبدیلی )نوعی که می خواهید تبدیل کنید( از اهمیت بسیار بالایی برخوردار

بیت جای گیرد، به این معنا که باید در محدوده )طیف(  16تخصیص یابد، مقدار مورد نظر باید در  shortبه متغیر  integerخواهید مقدار 

 قرار گیرد. هر مقدار دیگری فراتر از این رنج نتیجه ی غیرقابل پیش بینی بدست خواهد داد. 12424تا  32768-عددی 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int iNumber = 680044; 
            short sNumber = (short)iNumber; 
            Console.WriteLine("Number = {0}", iNumber); 
            Console.WriteLine("Number = {0}\n", sNumber); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .حاصل زیر به دست می آید

Number = 680044 
Number = 24684 
Press any key to continue...  

 همان طور که مشاهده می کنید نتیجه ی نادرست حاصل شده.
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  Convertکلاس 

اقتباس شده، مجهز به متد  NET Framework.، که خود از ساختار#Cخواهد شد که هر نوع داده ی زبان  توضیح داده  12و  81در درس 

ToString()  است که قابلیت تبدیل مقدار نوع داده به نوعString  را فراهم می کند. البته به امکان تبدیل مقداری از یک نوع اولیه

(primitive type )نشد. برای پشتیبانی از این امکان )تبدیل مقداری از یک نوع به نوع دیگر(  به نوع اولیه ی دیگر پرداخته.NET 

Framework  کلاسی به نامConvert  را ارائه می دهد. کلاس مذکور مجهز به چندین متد ایستا است که در این مبحث امکان تشریح همه ی

 آن ها وجود ندارد. 

 برگرفته شده است. NET Framework.از #Cی  به خاطر داشته باشید که هر نوع داده ی اولیه

 

C# Data Type Name .NET Framework Structure 

bool Bollean Boolean 

byte Byte Byte 

sbyte Signed Byte SByte 

char Character Char 

short Small Integer Int16 

ushort Unsigned Small Integer UInt16 

int Integer Int32 

uint Unsigned Integer UInt32 

long Long Integer Int64 

ulong Unsigned Long Integer UInt64 
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float Single-Precision Floating-Point Single 

double Double-Precision Floating-Point Double 

decimal Extended Precision Floating-

Point Number 

Decimal 

No Explicit 

Type 

Date/Time Value DateTime 

string String String 

  

 NET.آغاز شده و با اسم Toکلاس مزبور مجهز به متد ایستایی است که نام آن با  ، #Cبه نوع داده های Convert برای تطبیق دادن کلاس 

Framework ل شود. بر این اساس، به منظور تبدیل عدد ساختارش پایان می یابد و به عنوان آرگومان، آن نوعی را می گیرد که باید تبدی

را به عنوان آرگومان ارسال  doubleرا فراخواند سپس متغیر  ()ToInt32، می توان متد intبه عددی از نوع  doubleدهدهی از نوع 

 کرد. دستور نحوی آن به صورت زیر است.

public static int ToInt32(double value); 

 مثال

     using System; 
    class Program 
    { 
        static int Main() 
        { 
            double dNumber = 34987.68D; 
            int iNumber = Convert.ToInt32(dNumber); 
            Console.WriteLine("Number: {0}", dNumber); 
            Console.WriteLine("Number: {0}", iNumber); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

 (Arithmetic) حساب
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 مقادیر مطلق

از منفی بی نهایت آغاز شده و به مثبت بی نهایت ختم می شود. به عبارت دیگر، بسته به موقعیت آن ها ( decimal)سیستم عدد اعشاری 

که خنثی تلقی می گردد. در برخی عملیات  2ند یا قبل آن( اعداد یا منفی هستند یا مثبت. البته به جز عدد )این که بعد از صفر قرار می گیر

است، البته در صورتی که عدد مورد نظر مثبت  xهمان  xعدد حتماً باید مثبت باشد، حتی اگر در قالب منفی ارائه شده باشد. مقدار مطلق عدد 

هست، این در  82همان  82دار مطلق آن معادل مثبت آن عدد محسوب می شود. برای مثال، مقدار مطلق باشد. چنانچه عددی منفی بود، مق

 است. 82،  -82حالی است که مقدار مطلق 

، که در نسخه های متعدد اضافه بار گذاری Absمجهز به متدی است به نام  Mathبرای به دست آوردن مقدار مطلق یک عدد، کلاس 

(overload )ت. دستور زبان شده اس(syntax ).آن ها به شرح زیر است 

public static sbyte   Abs(sbyte   value); 
public static short   Abs(short   value); 
public static int     Abs(int     value); 
public static float   Abs(float   value); 
public static double  Abs(double  value); 
public static long    Abs(long    value); 
public static decimal Abs(decimal value); 

 متد فوق آرگومانی می گیرد که باید مقدار مطلق آن را به دست آورد : 

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int number = -6844; 
            Console.WriteLine("Original Value = {0}", number); 
            Console.WriteLine("Absolute Value = {0}\n", Math.Abs(number)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر را بدست می دهد

Original Value = -6844 
bsolute Value = 6844 
ress any key to continue... 
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 سقف )بیشترین مقدار( یک عدد

 .قرار دارد integer 13و  integer 12را در نظر بگیرید. این عدد بین  82.855عددی با ممیز اعشار مثل 

 

بزرگ تر  -24قرار می گیرد. لازم به ذکر نیست که  -25 و -24را در نظر بگیرید که منفی بوده و بین اعداد  24.06-به همین نحو، عددی مثل 

 است.

، عدد 82.855هست که از عدد مورد نظر بزرگ تر باشد. در مثال اول سقف ( integer)در علم حساب سقف یک عدد، نزدیک ترین عدد صحیح 

 می باشد. -24، 24.06-ف عدد می باشد. حال سق 82.855نزدیک ترین عدد صحیح بزرگتر از )یا برابر با(  81است زیرا  81

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_37.gif
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که در دو نسخه اضافه بارگذاری شده است. دستور  Ceilingمجهز به متدی است به نام  Mathبرای به دست آوردن سقف یک عدد، کلاس 

 نحوی این دو نسخه به صورت زیر می باشد.

public static double Ceiling(double a); 
public static decimal Ceiling(decimal d); 

 متد بالا به عنوان آرگومان یک متغیر عدد با ممیز اعشار می گیرد که سقف آن را باید به دست آورد.

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double value1 = 155.55; double value2 = -24.06; 
            Console.WriteLine("The ceiling of {0} is {1}",value1, Math.Ceiling(value1)); 
            Console.WriteLine("The ceiling of {0} is {1}\n",value2, Math.Ceiling(value2)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

The ceiling of 155.55 is 156 
he ceiling of -24.06 is -24 
ress any key to continue... 
 

 پیاده سازی خودش از متد نام برده را با دستور نحوی زیر ارائه می دهد. Double، ساختار Mathجدا از کلاس 

public static decimal Ceiling(decimal d); 

 کف )کمترین مقدار( یک عدد

-عدد کوچکتر محسوب می شود.  821قرار دارد که  129و  128بین دو عدد  128.44را در نظر بگیرید.  36.72-و  128.44 دو عدد اعشاری 

عدد کوچکتر محسوب می شود. کمترین یا پایین ترین ولی در عین حال نزدیک ترین مقدار  37-قرار گرفته که  36-و  37-بین دو عدد  36.72

integer ی گویند.یک عدد را کف آن عدد م 

را ارائه می دهد. این متد در دو نسخه ی زیر اضافه بارگذاری می  ()Floor، متد Mathبرای بدست آوردن کمترین مقدار یک عدد کلاس 

 .شود
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public static double Floor(double d); 
public static decimal Floor(decimal d); 

را برمی گرداند که کوچکتر از )یا برابر با( آرگومان نام برده  (integer)رفته و عدد صحیحی مقدار مربوط را به عنوان آرگومان گ ()Floorمتد 

 باشد.

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double value1 = 1540.25; 
            double value2 = -360.04; 
            Console.WriteLine("The floor of {0} is {1}",value1, Math.Floor(value1)); 
            Console.WriteLine("The floor of {0} is {1}\n",value2, Math.Floor(value2)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .ددنتیجه ی زیر حاصل می گر

The floor of 1540.25 is 1540 
he floor of -360.04 is -361 
ress any key to continue... 

 

را به کار برد که متدی ویژه ی بدست آوردن کم ترین مقدار )کف( عدد اعشاری  Double، می توان ساختار Mathبه جای استفاده از کلاس 

 دارد. دستور نحوی آن به شکل زیر است :

public static decimal Ceiling(decimal d); 

 توان یک عدد

 توان با فرمول زیر انجام می شود : #C در

    ReturnValue = X y 

 را در اختیار شما قرار می دهد که دستور نحوی آن به شکل زیر است : Powبرای انجام عملیات توان، متد  Mathکلاس 

    public static double Pow(double x, double y); 
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را  x، که توان نامیده می شود، آرگومان y، عدد پایه است که باید ارزیابی شود. آرگومان دوم، xاین متد دو آرگومان می گیرد. آرگومان اول، 

 می برد.  yبه توان آرگومان

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            const double source = 25.38; 
            const double exp = 3.12; 
            double result = Math.Pow(source, exp); 
            Console.WriteLine("Pow({0}, {1}) = {2}\n",source, exp, result); 
            Console.ReadKey(); 
            return 0; 
        } 
    }  

 نتیجه

Pow(25.38، 3.12) = 24099.8226934415 
Press any key to continue... 

 (the Exponentionalمقدار نمایی )

را برای این منظور در نظر گرفته است. دستور نحوی آن به شکل زیر )( Exp، متد Mathمی توان مقدار نمایی یک عدد را محاسبه کرد. کلاس 

 .می باشد

public static double Exp (double d); 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            Console.WriteLine("The exponential of {0} is {1}",709.78222656, Math.Exp(709.78222656)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 
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 نتیجه ی زیر به دست می آید :

The exponential of 709.78222656 is 1.79681906923757E+308 
 Press any key to continue... 

 

رخ می  (underflow)کوچکتر بود، مقدار صفر برگردانده می شود و وضعیت پاریز  708.395996093-از عدد )تقریبی(  xچنانچه مقدار 

 رخ می دهد.  (overflow)بود، )نتیجه( وضعیت سرریز  709.78222656بزرگتر از عدد )تقریبی(  xدهد. در صورتی که مقدار آرگومان 

 لگاریتم طبیعی

وی یکی از را فراخواند. متد مزبور به دو صورت زیر ارائه می شود. دستور نح)(Math.Logبرای محاسبه لگاریتم طبیعی یک عدد، می توان متد 

 آن دو

public static double Log(double d); 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double log = 12.48D; 
            Console.WriteLine("Log of {0} is {1}", log, Math.Log(log)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر حاصل می شود

Log of 12.48 is 2.52412736294128 
Press any key to continue... 

 82لگاریتم پایه ی 

 است.یک عدد را محاسبه می کند. دستور نحوی متد نام برده به صورت زیر  82لگاریتم پایه ی )( Math.Log10متد 

public static double Log10(double d); 

 



 

342 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 .بر می گرداند 82عددی که ارزیابی می شود به عنوان آرگومان ارسال می گردد. متد، لگاریتم مورد نظر را با فرمول زیر بر مبنای 

y = log10x   
 که معادل

x = 10y 
 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double log10 = 12.48D; 
            Console.WriteLine("Log of {0} is {1}", log10, Math.Log10(log10)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر حاصل می گردد

Log of 12.48 is 1.09621458534641 
Press any key to continue... 

 لگاریتم به هر مبنایی

 .نسخه ی دیگری فراهم می کند که دستور نحوی آن بدین صورت است )(Math.Logمتد 

public static double Log(double a, double newBase); 

 

د ارسال می گردد. آرگومان دوم به شما اجازه می دهد مبنای متغیری که مقدار لگاریتمی آن محاسبه می شود، به عنوان اولین آرگومان به مت

 .)لگاریتم( دلخواه خود را تعیین کنید. چنین متدی از فرمول زیر استفاده می کند

Y = logNewBasex   
 .که با فرمول زیر یکی است

 yx = NewBase 
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 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double logN = 12.48D; 
            Console.WriteLine("Log of {0} is {1}", logN, Math.Log(logN, 4)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

Log of 12.48 is 1.82077301454376 
Press any key to continue... 

 ریشه ی دوم / جذر

که دستور  Sqrtمجهز به متدی است به نام  Mathمی توان ریشه ی مربع یک عدد مثبت اعشاری را به دست آورد. برای این منظور، کلاس 

 .نحوی آن به شکل زیر می باشد

public static double Sqrt(double d); 

 

 را برمی گرداند. xور مثبت می گیرد. پس از محاسبه، متد ریشه ی مربع )جذر( متد بالا یک آرگومان به عنوان عدد با ممیز شنا

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double sqrt = 8025.73D; 
            Console.WriteLine("The square root of {0} is {1}", sqrt, Math.Sqrt(sqrt)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه
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The square root of 8025.73 is 89.5864387058666 
Press any key to continue… 

 مثلثات

 

  

خطی مستقیم (r) ن صفحه، مقدار ثابتی باشد. شعاع شان از نقطه ی ثابتی واقع در آ دایره )مکان هندسی(، نقاطی از صفحه است که فاصله

شان از نقطه ی ثابتی واقع در آن  را به نقطه ای از محیط دایره وصل می کند. خطی که نقاطی از صفحه که فاصله(C) است که مرکز دایره 

از محیط دایره تا مرکز آن قطر دایره نامیده صفحه، مقدار ثابتی باشد را به هم وصل کند محیط دایره خوانده می شود. فاصله ی بین دو نقطه 

 می شود، به عبارت دیگر، قطر دایره دو برابر شعاع دایره می باشد. 

بخش تقسیم می شود. هر یک از بخش های بیان شده یک درجه  162به منظور مدیریت اندازه گیری و دیگر عملیات مرتبط، محیط دایره به 

محیط دایره  Dو  Aاندازه گیری دو نقطه ی ".  ˚" آن درجه می باشد که با این علامت نشان داده می شود : اطلاق می گردد. واحد اندازه گیری 

 نمایش داده می شود.  ˚15بخش می شود. در این مثال، اندازه گیری مورد نظر به صورت  85شامل 

محیط  Bو  Aشود. زاویه نسبت فصله ی بین دو نقطه  خوانده می (arc)شکلی گرد است که در هندسه کمان  Bو  Aفاصله ی بین دو نقطه ی 

از برخورد دو نیم خط زاویه تشکیل می شود(. تعریف فوق را می توان به تقسیم شده ) به عبارت دیگر  (r)دایره است که توسط شعاع دایره 

 صورت فرمول زیر درآورد :

http://articles.tahlildadeh.com/image.axd?picture=image_1242.png
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طر که زاویه یک نسبت است نه اندازه گیری هندسی )به عبارت روشن تر بنابراین، زاویه نسبت کمان بر شعاع دایره می باشد. به این خا

زاویه یک بعد نیست(، کاملاً مستقل از اندازه ی یک دایره محسوب می شود. بدیهی است که این زاویه نشانگر تعداد بخش هایی می باشد 

 می باشد.  (radian)یری و سنجش زاویه رادیان که توسط سه نقطه ی اشغال شده. واحد دیگر )یا شاید بگیم بهتر( برای اندازه گ

 

  

واحد اندازه گیری چرخش، گِردِ یک دایره است. به این خاطر که چرخش لزوماً کامل صورت نمی گیرد، بسته به شرایط، سنجش  (cycle)دَوَران 

شی از یک دایره را طی کند که در آن صورت بر اساس زاویه ای انجام می شود که در گردش طی شده. برای مثال ممکن است دَورَان تنها بخ

 . 2. دوََران برابر است با رادیان تقسیم بر (˚360)چرخش کامل نخواهد بود. همچنین ممکن است دوران، کل مساحت یک دایره را طی کند 

  PIثابت 

یاضی به کار می رود. مقدار تقریبی آن نیز نوشته می شود، عدد ثابتی است که در محسابات گوناگون در علم ر Pi، که به صورت пکلمه ی 

می باشد. ماشین حساب سیستم عامل ویندوز آن را بدین صورت نمایش می دهد :  3.1415926535897932معادل 

3.1415926535897932384626433832795  

 باشد. می PI مجهز به ثابتی به نام  Math، کلاس Piبرای پشتیبانی از قابلیت عدد 

http://articles.tahlildadeh.com/image.axd?picture=image_1243.png
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 2قطر به صورت  ++C. در زبان برنامه نویسی 2Rدوبرابر شعاع دایره است. در علم هندسه، بدین صورت نوشته می شود : یک قطر در واقع 

* R  یاR * 2  نمایش داده می شود )به این خاطر که ضرب متقارن و برابر است(. محیط یک دایره از ضرب )کردن( قطر آن در ثابتPi  به دست

 نوشته می شود. می آید که به صورت های زیر

2Rп 2، یا * R * п  2و یا * R * Pi 

 . Pi rad * 2یا  2пبه دست می آید که برابر است با  2Rп/R radیا  2Rп/Rیک رادیان از فرمول 

 برای انجام عملیات تبدیل بین درجه و رادیان )تبدیل درجه به رادیان(، می توان از فرمول زیر استفاده کرد :

 360˚ = 2п rad 1رابر است با که ب rad = 360˚ / 2п = 57.3˚ . 

 کسینوس یک مقدار

 شکل هندسی زیر را در نظر بگیرید.

 

 Aطول نقطه ی  ACیاد می شود. همچنین تصور کنید ( hypotenuse)در نظر بگیرید که از آن به عنوان وتر  Bتا  Aرا، طول نقطه ی  ABحال  

می باشد. به عبارت  AC/ABنسبت  Aنیز خوانده می شود. کسینوس زاویه ی نقطه ی  Aنقطه ی ( Adjacent)است که ضلع مجاور  Cتا 

 ABوَتر،  بر ACدیگر، نسبت ضلع مجاور، 

 می باشد. 8و  1-حاصل تقسیم، عددی با دو رقم اعشار بین  مقدار باز گردانده شده

 ور نحوی آن به شکل زیر است.را به کار می برد. دست ()Cosمتد  Mathبرای محاسبه ی کسینوس یک زاویه، کلاس 

public static double Cos(double d); 

 مثال

http://articles.tahlildadeh.com/image.axd?picture=image_1244.png


 

347 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            int number = 82; 
            Console.WriteLine("The cosine of {0} is {1}", number, Math.Cos(number)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

The cosine of 82 is 0.949677697882543 
Press any key to continue... 

 سینوس یک مقدار

AB  را طول نقطه یA  تاB  در نظر بگیرید که همان وتر نام دارد. همچنینCB قطه ی را در نظر بگیرید، طول نC  تا نقطه یB ، که ضلع مقابل

 .ABبر وتر  CB؛ به عبارت دیگر، نسبت ضلع مقابل، CB/ABنامیده می شود. سینوس یک مقدار عبارتند از نسبت 

 فراخواند. دستور نحوی آن Mathرا از کلاس  ()Sinبرای محاسبه ی سینوس یک مقدار، می توان متد 

public static double Sin(double a); 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            double number = 82.55; 
            Console.WriteLine("The sine of {0} is {1}", number, Math.Sin(number)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

The sine of 82.55 is 0.763419622322519 
Press any key to continue... 
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 تانژانت

AC  را طول نقطه یA  تاC  وBC  را طول نقطه یB  تاC  در نظر بگیرید. تانژانت نتیجه یBC/AC  هست؛ به عبارت روشن تر، نسبتBC  بر

ACدد، کلاس . برای کمک در محاسبه ی تانژانت یک عMath  مجهز به متدی است به نامTan که دستور نحوی آن به شکل زیر می باشد. 

public static double Tan(double a); 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            uint number = 225; 
            Console.WriteLine("The tangent of {0} is {1}", number, Math.Tan(number)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 نتیجه

The tangent of 225 is -2.53211499233434 
Press any key to continue... 

Arc Tangent  

BC  را طول نقطه یB  تاC  وAC  را طولA  تا نقطه یB  .در نظر بگیریدarc tangent  نسبتBC/AC  است. به منظور محاسبه یarc 

tangent  یک مقدار، می توان متدMath.Atan() را مورد استفاده قرار داد. دستور نحوی 

public static double Atan(double d); 

 مثال

    using System; 
    class Program 
    { 
        static int Main() 
        { 
            short number = 225; 
            Console.WriteLine("The arc tangent of {0} is {1}",number, Math.Atan(number)); 
            Console.ReadKey(); 
            return 0; 
        } 
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    } 
 نتیجه

The arc tangent of 225 is 1.56635191161394 
Press any key to continue... 
 

 

 

 خواندن وقالب بندی داده ها

 درخواست )دریافت( مقدار رشته

تساوی نیز می گویند و با علامت = نشان داده می شود و کار آن کپی مقدار در متغیر  /assignmentکه به آن دستور در اغلب انتساب های )  

خبر نداریم. به منظور درخواست دریافت مقدار رشته )یا  (string value) از مقدار رشته ربردی( کدنویسی، هنگام نوشتن برنامه ی کا است

را فراخوانده، سپس تابع ()Console.ReadLine یا ()Console.Read هر متغیر دیگری که در این مبحث به آن می پردازیم(، باید توابع 

 زیابی کنید، اختصاص دهید.مذکور را به اسم متغیری که می خواهید مقدار آن را با

 مثال

 .را اجرا کنید Microsoft Visual Studioبرنامه ی      .8

 .را انتخاب کنید File -> New Projectبرای راه اندازی پروژه ی جدید به فهرست گزینه ی اصلی برنامه مراجعه کرده، گزینه ی      .2

 .کلیک کنید  Empty Projectدر لیست میانی روی     .1

 .تغییر دهیدgdcs5  اسم پروژه را به     .4

 .را کلیک کنید okحال،      .5

 ...gdcs5 -> Add -> New Itemراست کلیک کرده، سپس :  gdcs5، روی Solution Explorerدر پنجره ی      .6

 .را از لیست میانی آن انتخاب کنید Code Fileگزینه ی      .4

 .را بزنید Enterداده و کلید  تغییرClearningOrder اسم مورد نظر را به      .1

 .اکنون، به منظور درخواست رشته ها از کاربر، فایل مورد نظر را به صورت زیر اصلاح کنید     .1
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using System; 
public class CleaningOrder 
{ 
    public static int Main() 
    { 
        string customerName, homePhone; 
        Console.Title = "Georgetown Dry Cleaning Services"; 
        Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
        // Request customer information from the user 
        Console.Write("Enter Customer Name:  "); 
        customerName = Console.ReadLine(); 
        Console.Write("Enter Customer Phone: "); 
        homePhone = Console.ReadLine(); 
        Console.Clear(); 
        // Display the receipt 
        Console.WriteLine("===================================="); 
        Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
        Console.WriteLine("===================================="); 
        Console.Write("Customer:   "); 
        Console.WriteLine(customerName); 
        Console.Write("Home Phone: "); 
        Console.WriteLine(homePhone); 
        Console.WriteLine("====================================\n"); 
        System.Console.ReadKey(); 
        return 0; 
    } 
} 

 

 James Watsonبرنامه را اجرا کنید. هنگامی که از شما نام مشتری درخواست می شود، اسم مورد نظر را وارد کنید مثلاً  .82 

 .را بزنید Enter. کلید 88

 . 2005-493 (410). حال، شماره ی تلفن همراه مورد نظر را وارد می کنیم مثلاً 82

-/- Georgetown Dry Cleaning Services -/- 
Enter Customer Name:  James Watson 
Enter Customer Phone: (410) 493-2005 

 .را فشار دهید Enter. کلید 81

==================================== 
/- Georgetown Dry Cleaning Services -/- 
=================================== 
ustomer:   James Watson 
ome Phone: (410) 493-2005 
=================================== 
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 .یدرا بسته و به محیط برنامه نویسی بازگرد DOS. اکنون پنجره ی 84

 درخواست عدد

درخواست نکنید، رشته های مزبور تحلیل و  compilerهر آنچه تایپ می کنید، یک رشته محسوب می شود و تا زمانی که شما از  #Cدر زبان 

 پردازش نمی شوند. بنابراین، برای دریافت عدد مورد نظر از کاربر، ابتدا باید رشته را درخواست کنید.

 مثال

using System; 
public class Exercise 
{ 
    public static void Main() 
    { 
        int number; 
        string strNumber; 
        strNumber = Console.ReadLine(); 
    } 
} 
 

را Parse می به نام مکانیس NET Frameworkپس از دریافت رشته، باید آن را به عدد تبدیل کرد. برای این منظور هر یک از نوع داده های.

، رشته ای را که از parseهای  و پرانتز را تایپ کنید. در پرانتز "."نوع داده و به دنبال آن عملگر نقطه ، ()Parseدارند. برای به کار بردن تابع 

 کاربر درخواست کرده بودید، وارد کنید.

 مثال

    using System; 
    public class Exercise 
    { 
        public static void Main() 
        { 
            int number; 
            string strNumber; 
            strNumber = Console.ReadLine(); 
            number = int.Parse(strNumber); 
        } 
    }  
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است که همان نتیجه را به دست می  Parseر پرانتزهای تابع د()Console.ReadLine روشی پیچیده ولی سریع تر، تایپ کردن دستور  

 .دهد

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            int number; 
            number = int.Parse(Console.ReadLine()); 
            return 0; 
        } 
    } 

 خواندن مقادیر عددی

 .برای دریافت اعداد مورد نظر از کاربر، فایل را به صورت زیر تغییر دهید      .8

using System; 
    public class CleaningOrder 
    { 
        public static int Main() 
        { 
            // Price of items 
            const double PriceOneShirt = 0.95; 
            const double PriceAPairOfPants = 2.95; 
            const double PriceOneDress = 4.55; 
            const double TaxRate = 0.0575;  // 5.75% 
            // Customer personal infoirmation 
            string customerName, homePhone; 
            // Unsigned numbers to represent cleaning items 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            // Each of these sub totals will be used for cleaning items 
            double subTotalShirts, subTotalPants, subTotalDresses; 
            // Values used to process an order 
            double totalOrder, taxAmount, salesTotal; 
            double amountTended, moneyChange; 
            Console.Title = "Georgetown Dry Cleaning Services"; 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            // Request customer information from the user 
            Console.Write("Enter Customer Name:  "); 
            customerName = Console.ReadLine(); 
            Console.Write("Enter Customer Phone: "); 
            homePhone = Console.ReadLine(); 
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            // Request the quantity of each category of items 
            Console.Write("Number of Shirts:  "); 
            string strShirts = Console.ReadLine(); 
            numberOfShirts = uint.Parse(strShirts); 
            Console.Write("Number of Pants:   "); 
            string strPants = Console.ReadLine(); 
            numberOfPants = uint.Parse(strPants); 
            Console.Write("Number of Dresses: "); 
            string strDresses = Console.ReadLine(); 
            numberOfDresses = uint.Parse(strDresses); 
            // Perform the necessary calculations 
            subTotalShirts = numberOfShirts * PriceOneShirt; 
            subTotalPants = numberOfPants * PriceAPairOfPants; 
            subTotalDresses = numberOfDresses * PriceOneDress; 
            // Calculate the "temporary" total of the order 
            totalOrder = subTotalShirts + subTotalPants +subTotalDresses; 
            // Calculate the tax amount using a constant rate 
            taxAmount = totalOrder * TaxRate; 
            // Add the tax amount to the total order 
            salesTotal = totalOrder + taxAmount; 
            // Communicate the total to the user... 
            Console.Write("\nThe Total order is: "); 
            Console.WriteLine(salesTotal); 
            // and request money for the order 
            Console.Write("Amount Tended? "); 
            amountTended = double.Parse(Console.ReadLine()); 
            // Calculate the difference owed to the customer 
            // or that the customer still owes to the store 
            moneyChange = amountTended - salesTotal; 
            Console.Clear(); 
            // Display the receipt 
            Console.WriteLine("===================================="); 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            Console.WriteLine("===================================="); 
            Console.Write("Customer:   "); 
            Console.WriteLine(customerName); 
            Console.Write("Home Phone: "); 
            Console.WriteLine(homePhone); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Shirts      "); 
            Console.Write(numberOfShirts); 
            Console.Write("     "); 
            Console.Write(PriceOneShirt); 
            Console.Write("     "); 
            Console.WriteLine(subTotalShirts); 
            Console.Write("Pants       "); 
            Console.Write(numberOfPants); 
            Console.Write("     "); 
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            Console.Write(PriceAPairOfPants); 
            Console.Write("     "); 
            Console.WriteLine(subTotalPants); 
            Console.Write("Dresses     "); 
            Console.Write(numberOfDresses); 
            Console.Write("     "); 
            Console.Write(PriceOneDress); 
            Console.Write("     "); 
            Console.WriteLine(subTotalDresses); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Total Order:     "); 
            Console.WriteLine(totalOrder); 
            Console.Write("Tax Rate:        "); 
            Console.Write(TaxRate * 100); 
            Console.WriteLine('%'); 
            Console.Write("Tax Amount:      "); 
            Console.WriteLine(taxAmount); 
            Console.Write("Net Price:       "); 
            Console.WriteLine(salesTotal); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Amount Tended:   "); 
            Console.WriteLine(amountTended); 
            Console.Write("Difference:      "); 
            Console.WriteLine(moneyChange); 
            Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
} 

 . برنامه را اجرا کنید.2 

 مثال

 -/- Georgetown Dry Cleaning Services -/- 
        Enter Customer Name:  Genevieve Alton 
        Enter Customer Phone: (202) 974-8244 
        Number of Shirts:  8 
        Number of Pants:   2 
        Number of Dresses: 3  
        The Total order is: 28.711125 
        Amount Tended? 30 

 .را بزنید Enter. حال، کلید 1

=============================== 
        -/- Georgetown Dry Cleaning Services -/- 
        ==================================== 
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        Customer:   Genevieve Alton 
        Home Phone: (202) 974-8244 
        ------------------------------------ 
        Item Type  Qty Unit/Price Sub-Total 
        ------------------------------------ 
        Shirts      8     0.95     7.60 
        Pants       2     2.95     5.90 
        Dresses     3     4.55     13.65 
        ------------------------------------ 
        Total Order:     27.15 
        Tax Rate:        5.7500% 
        Tax Amount:      1.561125 
        Net Price:       28.711125 
        ------------------------------------ 
        Amount Tended:   30 
        Difference:      1.288875 
        ==================================== 
 

 .را ببندید DOS. پنجره ی 4

 درخواست تاریخ و زمان  

 ن فرایندی که برای دریافت هر رقم دیگری انجام می شود، می توان برای درخواست مقدار تاریخ پیاده کرد. برای این منظور ابتدا لازم استهما

 .رشته را از کاربر درخواست کنید

 using System; 
    namespace ValueRequests 
    { 
        class Exercise 
        { 
            static void Main() 
            { 
                string strDateHired; 
                strDateHired = Console.ReadLine(); 
            } 
        } 
    } 

دیگری که از کاربر تبدیل کنید. درست مثل هر مقدار DateTime پس از اینکه کاربر رشته ی مربوطه را وارد کرد، می توانید آن را به مقدار  

 درخواست می کنید، مقدار تاریخ یا زمان وارد شده باید معتبر و صحیح باشد، در غیر این صورت برنامه پیغام خطا می دهد. به این خاطر که

ه را با فرمت لازم و دارند، باید سعی کنید به کاربر بفهمانید که مقادیر نام برد (format)مقادیر تاریخ و زمان قوانین خاصی برای قالب بندی 

 .مناسب وارد کنند



 

356 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 compilerبه صورت پیش فرض، چنانچه از کاربر تنها مقدار تاریخی )معتبر( را تقاضا کنید، )پس از اینکه کاربر تاریخ مورد نظر را تایپ کرد( 

تاریخ جاری را به  Compilerواست کنید، را اضافه می کند. در صورتی که از کاربر فقط مقدار زمانی )معتبر( را درخ midnightبه آن مقدار 

 مقدار فوق اضافه می کند.

 درخواست مقادیر تاریخ و زمان

 .به منظور درج تاریخ و مقدار جدید، برنامه را به صورت زیر اصلاح کنید    .8

using System; 
    public class OrderProcessing 
    { 
        public static int Main() 
        { 
            // Price of items 
            const double PriceOneShirt = 0.95; 
            const double PriceAPairOfPants = 2.95; 
            const double PriceOneDress = 4.55; 
            const double TaxRate = 0.0575;  // 5.75% 
            // Basic information about an order 
            string customerName, homePhone; 
            DateTime orderDate; 
            // Unsigned numbers to represent cleaning items 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            // Each of these sub totals will be used for cleaning items 
            double subTotalShirts, subTotalPants, subTotalDresses; 
            // Values used to process an order 
            double totalOrder, taxAmount, salesTotal; 
            double amountTended, moneyChange; 
            Console.Title = "Georgetown Dry Cleaning Services"; 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            // Request order information from the user 
            Console.Write("Enter Customer Name:  "); 
            customerName = Console.ReadLine(); 
            Console.Write("Enter Customer Phone: "); 
            homePhone = Console.ReadLine(); 
            Console.WriteLine("Enter the order date and " + "time (mm/dd/yyyy hh:mm AM/PM)"); 
            orderDate = DateTime.Parse(Console.ReadLine()); 
            // Request the quantity of each category of items 
            Console.Write("Number of Shirts:  "); 
            string strShirts = Console.ReadLine(); 
            numberOfShirts = uint.Parse(strShirts); 
            Console.Write("Number of Pants:   "); 
            string strPants = Console.ReadLine(); 
            numberOfPants = uint.Parse(strPants); 
            Console.Write("Number of Dresses: "); 
            string strDresses = Console.ReadLine(); 
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            numberOfDresses = uint.Parse(strDresses); 
            // Perform the necessary calculations 
            subTotalShirts = numberOfShirts * PriceOneShirt; 
            subTotalPants = numberOfPants * PriceAPairOfPants; 
            subTotalDresses = numberOfDresses * PriceOneDress; 
            // Calculate the "temporary" total of the order 
            totalOrder = subTotalShirts +subTotalPants + subTotalDresses; 
            // Calculate the tax amount using a constant rate 
            taxAmount = totalOrder * TaxRate; 
            // Add the tax amount to the total order 
            salesTotal = totalOrder + taxAmount; 
            // Communicate the total to the user... 
            Console.Write("\nThe Total order is: "); 
            Console.WriteLine(salesTotal); 
            // and request money for the order 
            Console.Write("Amount Tended? "); 
            amountTended = double.Parse(Console.ReadLine()); 
            // Calculate the difference owed to the customer 
            // or that the customer still owes to the store 
            moneyChange = amountTended - salesTotal; 
            Console.Clear(); 
            // Display the receipt 
            Console.WriteLine("===================================="); 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            Console.WriteLine("===================================="); 
            Console.Write("Customer:    "); 
            Console.WriteLine(customerName); 
            Console.Write("Home Phone:  "); 
            Console.WriteLine(homePhone); 
            Console.Write("Date & Time: "); 
            Console.WriteLine(orderDate); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Shirts      "); 
            Console.Write(numberOfShirts); 
            Console.Write("     "); 
            Console.Write(PriceOneShirt); 
            Console.Write("     "); 
            Console.WriteLine(subTotalShirts); 
            Console.Write("Pants       "); 
            Console.Write(numberOfPants); 
            Console.Write("     "); 
            Console.Write(PriceAPairOfPants); 
            Console.Write("     "); 
            Console.WriteLine(subTotalPants); 
            Console.Write("Dresses     "); 
            Console.Write(numberOfDresses); 
            Console.Write("     "); 
            Console.Write(PriceOneDress); 
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            Console.Write("     "); 
            Console.WriteLine(subTotalDresses); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Total Order:     "); 
            Console.WriteLine(totalOrder); 
            Console.Write("Tax Rate:        "); 
            Console.Write(TaxRate * 100); 
            Console.WriteLine('%'); 
            Console.Write("Tax Amount:      "); 
            Console.WriteLine(taxAmount); 
            Console.Write("Net Price:       "); 
            Console.WriteLine(salesTotal); 
            Console.WriteLine("------------------------------------"); 
            Console.Write("Amount Tended:   "); 
            Console.WriteLine(amountTended); 
            Console.Write("Difference:      "); 
            Console.WriteLine(moneyChange); 
            Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 

 حال برنامه را اجرا کنید . نتیجه ی زیر به دست می آید.    .2 

-/- Georgetown Dry Cleaning Services -/- 
        Enter Customer Name:  Alexander Pappas 
        Enter Customer Phone: (301) 397-9764 
        Enter the order date and time (mm/dd/yyyyhh:mm AM/PM) 
        06/22/98 08:26 AM 
        Number of Shirts:  2 
        Number of Pants:   6 
        Number of Dresses: 0 
        The Total order is: 20.727000 
        Amount Tended? 50 

 .را فشار دهید Enterکلید     .1

==================================== 
-/- Georgetown Dry Cleaning Services -/- 
==================================== 
Customer:    Alexander Pappas Home Phone:  (301) 397-9764 
 Date & Time: 6/22/1998 8:26:00 AM 
 ------------------------------------ 
 Item Type  Qty Unit/Price Sub-Total 
 ------------------------------------ 
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 Shirts      2     0.95     1.90 
 Pants       6     2.95     17.70 
 Dresses     0     4.55     0 
 ------------------------------------ 
 Total Order:     19.60 
 Tax Rate:        5.7500% 
 Tax Amount:      1.127000 
 Net Price:       20.727000 
 ------------------------------------ 
 Amount Tended:   50 
 Difference:      29.273000 
 ==================================== 

. به محیط برنامه نویسی برگردید.4  

  placeholder نمایش داده ها با

 .برای این منظور فایل مورد نظر را به صورت زیر اصلاح کنید    .8

using System; 
    public class OrderProcessing 
    { 
        public static int Main() 
        { 
            // Price of items 
            const double PriceOneShirt = 0.95; 
            const double PriceAPairOfPants = 2.95; 
            const double PriceOneDress = 4.55; 
            const double TaxRate = 0.0575;  // 5.75% 
            double Difference; 
            // Basic information about an order 
            string customerName, homePhone; 
            DateTime orderDate; 
            // Unsigned numbers to represent cleaning items 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            // Each of these sub totals will be used for cleaning items 
            double subTotalShirts, subTotalPants, subTotalDresses; 
            // Values used to process an order 
            double totalOrder, taxAmount, salesTotal; 
            double amountTended, moneyChange; 
            Console.Title = "Georgetown Dry Cleaning Services"; 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            // Request order information from the user 
            Console.Write("Enter Customer Name:  "); 
            customerName = Console.ReadLine(); 
            Console.Write("Enter Customer Phone: "); 
            homePhone = Console.ReadLine(); 
            Console.WriteLine("Enter the order date and " +"time (mm/dd/yyyy hh:mm AM/PM)"); 
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            orderDate = DateTime.Parse(Console.ReadLine()); 
            // Request the quantity of each category of items 
            Console.Write("Number of Shirts:  "); 
            numberOfShirts = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Pants:   "); 
            numberOfPants = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Dresses: "); 
            numberOfDresses = uint.Parse(Console.ReadLine()); 
            // Perform the necessary calculations 
            subTotalShirts = numberOfShirts * PriceOneShirt; 
            subTotalPants = numberOfPants * PriceAPairOfPants; 
            subTotalDresses = numberOfDresses * PriceOneDress; 
            // Calculate the "temporary" total of the order 
            totalOrder = subTotalShirts +subTotalPants + subTotalDresses; 
            // Calculate the tax amount using a constant rate 
            taxAmount = totalOrder * TaxRate; 
            // Add the tax amount to the total order 
            salesTotal = totalOrder + taxAmount; 
            // Communicate the total to the user... 
            Console.Write("\nThe Total order is: "); 
            Console.WriteLine(salesTotal); 
            // and request money for the order 
            Console.Write("Amount Tended? "); 
            amountTended = double.Parse(Console.ReadLine()); 
            // Calculate the difference owed to the customer 
            // or that the customer still owes to the store 
            Difference = amountTended - salesTotal; 
            Console.Clear(); 
            // Display the receipt 
            Console.WriteLine("===================================="); 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            Console.WriteLine("===================================="); 
            Console.WriteLine("Customer:    {0}", customerName); 
            Console.WriteLine("Home Phone:  {0}", homePhone); 
            Console.WriteLine("Date & Time: {0}", orderDate); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Shirts      {0}     {1}     {2}",numberOfShirts,PriceOneShirt, subTotalShirts); 
            Console.WriteLine("Pants       {0}     {1}     {2}", numberOfPants,PriceAPairOfPants, subTotalPants); 
            Console.WriteLine("Dresses     {0}     {1}     {2}",numberOfDresses, PriceOneDress, subTotalDresses); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Total Order:     {0}", totalOrder); 
            Console.WriteLine("Tax Rate:        {0}%", TaxRate * 100); 
            Console.WriteLine("Tax Amount:      {0}", taxAmount); 
            Console.WriteLine("Net Price:       {0}", salesTotal); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Amount Tended:   {0}", amountTended); 
            Console.WriteLine("Difference:      {0}", Difference); 
            Console.WriteLine("===================================="); 
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            System.Console.ReadKey(); 
            return 0; 
        } 
    } 
} 

 .برنامه را اجرا کرده تا نتیجه ی آن را مشاهده کنید    .2

 را ببندید DOSاکنون پنجره ی .1

 دیل به رشتهتب

با صفحه کلید تایپ می شود عمدتاً رشته است و تبدیل آن به نوع مورد نیاز، دیگر وظیفه ی برنامه  #Cپیش تر ذکر شد که هر آنچه در محیط 

نویس می باشد و برعکس، چنانچه مقداری داشته باشید که )در قالب( رشته نبود می توان به راحتی آن را به رشته تبدیل کرد. برای 

 #Cرا ارائه می دهند. در زبان  ToStringمکانیسمی به نام  NET Frameworkپشتیبانی از چنین امکان و قابلیتی، تمامی نوع داده های.

انجام می شود. با این وجود، در برخی موارد شما خود مجبور به انجام فرایند compiler پروسه ی تبدیل معمولاً به صورت اتوماتیک توسط 

 .تبدیل هستید

را تایپ کنید. توجه خود  ()ToString    به رشته، اسم متغیر و به دنبال آن عملگر نقطه و تابع  به منظور تبدیل مقداری از داده های نوع اولیه

 .را به مثال زیر جلب کنید

using System; 
public class Exercise 
{ 
    public static void Main() 
    { 
        var fullName = "Anselme Bogos"; 
        var age = 15; 
        var hSalary = 22.74; 
        Console.WriteLine("Full Name: {0}", fullName); 
        Console.WriteLine("Age: {0}", age.ToString()); 
        Console.WriteLine("Distance: {0}", hSalary.ToString()); 
        Console.WriteLine(); 
    } 
} 

 قرار داد. ()ToStringدر برخی حالات می  توان داده داخل پرانتز تابع  

 قالب بندی نمایش داده ها

 برای این منظور، فایل را به ترتیب زیر تغییر دهید.    .8
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    using System; 
    public class OrderProcessing 
    { 
        public static int Main() 
        { 
            // Price of items 
            const double PriceOneShirt = 0.95; 
            const double PriceAPairOfPants = 2.95; 
            const double PriceOneDress = 4.55; 
            const double TaxRate = 0.0575;  // 5.75% 
            // Basic information about an order 
            string customerName, homePhone; 
            DateTime orderDate; 
            // Unsigned numbers to represent cleaning items 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            // Each of these sub totals will be used for cleaning items 
            double subTotalShirts, subTotalPants, subTotalDresses; 
            // Values used to process an order 
            double totalOrder, taxAmount, salesTotal; 
            double amountTended,Difference, moneyChange; 
            Console.Title = "Georgetown Dry Cleaning Services"; 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            // Request order information from the user 
            Console.Write("Enter Customer Name:  "); 
            customerName = Console.ReadLine(); 
            Console.Write("Enter Customer Phone: "); 
            homePhone = Console.ReadLine(); 
            Console.WriteLine("Enter the order date and " +"time (mm/dd/yyyy hh:mm AM/PM)"); 
            orderDate = DateTime.Parse(Console.ReadLine()); 
            // Request the quantity of each category of items 
            Console.Write("Number of Shirts:  "); 
            numberOfShirts = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Pants:   "); 
            numberOfPants = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Dresses: "); 
            numberOfDresses = uint.Parse(Console.ReadLine()); 
            // Perform the necessary calculations 
            subTotalShirts = numberOfShirts * PriceOneShirt; 
            subTotalPants = numberOfPants * PriceAPairOfPants; 
            subTotalDresses = numberOfDresses * PriceOneDress; 
            // Calculate the "temporary" total of the order 
            totalOrder = subTotalShirts + subTotalPants + subTotalDresses; 
            // Calculate the tax amount using a constant rate 
            taxAmount = totalOrder * TaxRate; 
            // Add the tax amount to the total order 
            salesTotal = totalOrder + taxAmount; 
            // Communicate the total to the user... 
            Console.Write("\nThe Total order is: "); 
            Console.WriteLine(salesTotal); 
            // and request money for the order 
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            Console.Write("Amount Tended? "); 
            amountTended = double.Parse(Console.ReadLine()); 
            // Calculate the difference owed to the customer 
            // or that the customer still owes to the store 
            Difference = amountTended - salesTotal; 
            Console.Clear(); 
            // Display the receipt 
            Console.WriteLine("===================================="); 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            Console.WriteLine("===================================="); 
            Console.WriteLine("Customer:    {0}", customerName); 
            Console.WriteLine("Home Phone:  {0}", homePhone); 
            Console.WriteLine("Date & Time: {0}", orderDate); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Shirts      {0}     {1:C}     {2}",numberOfShirts.ToString(), 
            PriceOneShirt,subTotalShirts.ToString("C")); 
            Console.WriteLine("Pants       {0}     {1:C}     {2:C}", numberOfPants, PriceAPairOfPants,subTotalPants); 
            Console.WriteLine("Dresses     {0}     {1:C}     {2:C}", numberOfDresses, PriceOneDress,subTotalDresses); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Total Order:     {0:C}", totalOrder); 
            Console.WriteLine("Tax Rate:        {0:P}", TaxRate); 
            Console.WriteLine("Tax Amount:      {0}",taxAmount.ToString("C")); 
            Console.WriteLine("Net Price:       {0:F}", salesTotal); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Amount Tended:   {0:C}", amountTended); 
            Console.WriteLine("Difference:      {0:C}", Difference); 
            Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
            return 0; 
        } 

}     

 برنامه را اجرا کنید.. 2 

-/- Georgetown Dry Cleaning Services -/- 
Enter Customer Name:  Gretchen McCormack 
Enter Customer Phone: (410) 739-2884 
Enter the order date and time (mm/dd/yyyyhh:mm AM/PM) 
04/09/2001 10:25 AM 
Number of Shirts:  5 
Number of Pants:   12 
Number of Dresses: 8 
The Total order is: 80.951625 
Amount Tended? 100 

 .را بزنید Enterحال     .1 

==================================== 
-/- Georgetown Dry Cleaning Services -/- 
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==================================== 
Customer:    Gretchen McCormack 
Home Phone:  (410) 739-2884 
Date & Time: 4/9/2001 10:25:00 AM 
------------------------------------ 
Item Type  Qty Unit/Price Sub-Total 
------------------------------------ 
Shirts      5     $0.95     $4.75 
Pants       12     $2.95     $35.40 
Dresses     8     $4.55     $36.40 
------------------------------------ 
Total Order:     $76.55 
Tax Rate:        5.75 % 
Tax Amount:      $4.40 
Net Price:       80.95 
------------------------------------ 
Amount Tended:   $100.00 
Difference:      $19.05 
==================================== 

 .را ببندید DOSپنجره ی . 4 

 قالب بندی خط

استفاده می کردیم. برای قرار دادن متنی با طول  ()WriteLineیا  ()Writeدر برنامه های فوق به منظور نمایش خطی از یک متن، از توابع 

یم. چنین تکنیکی تاحدی غیر حرفه ای و متفاوت بالای متن دیگری، با استفاده ی بیش از حد از فضاهای خالی، یک رشته را خراب می کرد

نامطمئن تلقی می شود. خوشبختانه، قالب بندی خط و متن، همچنین نحوه ی نمایش آن ها را می توان تاحدی زیادی مدیریت کرد. همان طور 

حوه ی قرار گیری رشته ی به منظور تنظیم مقدار فضای مورد نیاز برای نمایش رشته ای از متن و ن  NET Framework.،که انتظار می رفت

 مزبور در خط مربوط به آن مکانیسم های ویژه ای در اختیار کاربر قرار می دهد. 

استفاده کرد.  ()WriteLine   یا ()Write  داخل پرانتز placeholderبه منظور تعیین مقدار فضای مورد نیاز برای نمایش رشته، می توان از 

را به همراه کاراکتر قالب بندی آن  (incrementing number) تصاعدییا تعدادی عدد  placeholder ،2برای این منظور، داخل 

(formatting character)  برابر  /تایپ کنید. سپس، ویرگول و به دنبال آن تعداد کاراکترهایی که با فضای )پهنا( دلخواه همخوانی دارد

 است را وارد کنید.

 مثال

    using System; 
    public class Exercise 
    { 
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        public static void Main() 
        { 
            var fullName = "Anselme Bogos"; 
            var age = 15; 
            var hSalary = 22.74; 
            Console.WriteLine("Full Name: {0,20}", fullName); 
            Console.WriteLine("Age:{0,14}", age.ToString()); 
            Console.WriteLine("Distance: {0:C,8}", hSalary.ToString()); 
            Console.WriteLine(); 
        } 
    } 

 نتیجه

Full Name:        Anselme Bogos 
Age:            15 
Distance: 22.74 

 

 alignmentدر نظر می گیرید بسیار مهم است. اگر مثبت بود، خط متن در سمت راست قرار می گیرد که باید  ( width)علامتی که برای پهنا 

 مرجع، به خصوص برای مقادیر عددی باشد. حال چنانچه علامتی که ارائه می دهید منفی باشد، متن در سمت چپ قرار می گیرد. 

  قالب بندی تاریخ و زمان 

خود یک بخش زمان به مقدار  compilerوارد می کند،  DateTimeذکر شد، هنگامی که کاربر مقدار زمان برای متغیر همان طور که پیش تر 

مشخص کنید. برای این  compilerمذکور اضافه می کند. اگر بخواهید تنها بخش زمان یا بخش تاریخ بررسی شود، لازم است این امر را برای 

سری حروف در نظر گرفته است که با استفاده از آن می توان نحوه ی نمایش مقدار )نوع قالب بندی آن( یک  DateTimeمنظور، نوع داده ی 

 incremental)یا مقدار عددی افزایشی  2پس از  DateTimeمتغیر  placeholderبرای کاربر را تعیین کرد. کاراکتر مورد نظر داخل 

numeric value)  .باید تایپ شود 

 تاریخ / زمان مدیریت قالب بندی

 .برای تنظیم قالب بندی زمان و تاریخ، فایل را به صورت زیر اصلاح کنید  .7
using System; 
    public class OrderProccessing 
    { 
        public static int Main() 
        { 
            //Price of items 
            const double PriceOneShirt = 0.95; 
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            const double PriceAPairOfPants = 2.95; 
            const double PriceOneDress = 4.55; 
            const double TaxRate = 0.0575;  //5.75% 
            //Basic information about an order 
            string customerName, homephone; 
            DateTime orderDate, orderTime; 
            //Unsigned numbers to represent cleaning items 
            uint numberOfShirts, numberOfPants, numberOfDresses; 
            //Each of these sub totals will be used for cleaning items 
            double subTotalShirts, subTotalPants, subTotalDresses; 
            //Values used to process an order 
            double totalOrder, taxAmount, salesTotal; 
            double amountTended, moneyChange; 
            Console.Title = "Georgetown Dry Cleaning Services"; 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            //Request order information from the user 
            Console.Write("Enter Customer Name:   "); 
            customerName = Console.ReadKey().ToString(); 
            Console.Write("Enter Customer Phone:  "); 
            homephone = Console.ReadLine(); 
            Console.Write("Enter the order date(mm/dd/yyyy):  "); 
            orderDate = DateTime.Parse(Console.ReadLine()); 
            Console.Write("Enter the order time(hh:mm AM/PM): "); 
            orderTime = DateTime.Parse(Console.ReadLine()); 
            //Request the quantity of each category of items 
            Console.Write("Number of Shirts:  "); 
            numberOfShirts = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Pants:   "); 
            numberOfPants = uint.Parse(Console.ReadLine()); 
            Console.Write("Number of Dresses: "); 
            numberOfDresses = uint.Parse(Console.ReadLine()); 
            //Perform the necessary calculations 
            subTotalShirts = numberOfShirts * PriceOneShirt; 
            subTotalPants = numberOfPants * PriceAPairOfPants; 
            subTotalDresses = numberOfDresses * PriceOneDress; 
            //Calculate the "temporary" total of the order 
            totalOrder = subTotalShirts + subTotalPants +subTotalDresses; 
            //Calculate the tax amount using a constant rate 
            taxAmount = totalOrder * TaxRate; 
            //Add the tax amount to the total order 
            salesTotal = totalOrder + taxAmount; 
            //Communicate the total to the user... 
            Console.WriteLine("\nThe Total order is: {0:C}", salesTotal); 
            //and request money for the order 
            Console.Write("Amount Tended? "); 
            amountTended = double.Parse(Console.ReadLine()); 
            //Calculate the difference owed to the customer 
            //or that the customer still owes to the store 
            moneyChange = amountTended - salesTotal; 
            Console.Clear(); 
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            //Display the receipt 
            Console.WriteLine("===================================="); 
            Console.WriteLine("-/- Georgetown Dry Cleaning Services -/-"); 
            Console.WriteLine("===================================="); 
            Console.WriteLine("Customer:    {0}", customerName); 
            Console.WriteLine("Home Phone:  {0}", homephone); 
            Console.WriteLine("Order Date:  {0:D}", orderDate); 
            Console.WriteLine("Order Time:  {0:t}", orderTime); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Item Type  Qty Unit/Price Sub-Total"); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Shirts     {0}   {1}       {2}",numberOfShirts.ToString(),PriceOneShirt.ToString("C"), subTotalShirts.ToString("C")); 
            Console.WriteLine("Pants      {0}   {1}        {2}",numberOfPants.ToString(),PriceAPairOfPants.ToString("C"),subTotalPants.ToString("C")); 
            Console.WriteLine("Dresses    {0}   {1}        {2}", numberOfDresses.ToString(),PriceOneDress.ToString("C"),subTotalDresses.ToString("C")); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Total Order:   {0}",totalOrder.ToString("C")); 
            Console.WriteLine("Tax Rate:      {0}",TaxRate.ToString("P")); 
            Console.WriteLine("Tax Amount:    {0}", taxAmount.ToString("C")); 
            Console.WriteLine("Net Price:     {0}",  salesTotal.ToString("C")); 
            Console.WriteLine("------------------------------------"); 
            Console.WriteLine("Amount Tended: {0}", amountTended.ToString("C")); 
            Console.WriteLine("Difference:    {0}",moneyChange.ToString("C")); 
            Console.WriteLine("===================================="); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

} 

برنامه را اجرا کنید   .2 . 

-/- Georgetown Dry Cleaning Services -/- 
Enter Customer Name:  Antoinette Calhoun 
Enter Customer Phone: (703) 797-1135 
Enter the order date(mm/dd/yyyy):  04/12/2002 
Enter the order time(hh:mm AM/PM): 2:12 PM 
Number of Shirts:  5 
Number of Pants:   2 
Number of Dresses: 1 
The Total order is: $16.07 
Amount Tended? 20 

 .را فشار دهید Enterاکنون کلید    .1 

==================================== 
/- Georgetown Dry Cleaning Services -/- 
=================================== 
ustomer:    Antoinette Calhoun 
ome Phone:  (703) 797-1135 
rder Date:  Friday، April 12، 2002 
rder Time:  2:12 PM 
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----------------------------------- 
tem Type  Qty Unit/Price Sub-Total 
----------------------------------- 
hirts     5   $0.95       $4.75 
ants      2   $2.95        $5.90 
Dresses    1   $4.55        $4.55 
------------------------------------ 
Total Order:   $15.20 
Tax Rate:      5.75 % 
Tax Amount:    $0.87 
Net Price:     $16.07 
------------------------------------ 
Amount Tended: $20.00 
Difference:    $3.93 
==================================== 

  .را بسته و به محیط برنامه نویسی برگردید DOSپنجره ی    .4
 .را کلیک کنید File -> Close Solutionاصلی مراجعه کرده، گزینه ی  به فهرست   .5
 .کلیک کنید noکنید یا نه روی  Saveزمانی که از شما درخواست شد می خواهید    .6

 ترکیبات کلاس ها

 (class nestingتودرتو کردن کلاس ها )

یا تودرتو می گویند. برای این  nestedدیگر ایجاد می شود، کلاس  می توان کلاسی را در دل کلاسی دیگر گنجاند. به کلاسی که داخل کلاسی

 منظور

را }{ ، سپس یک اسم و کاراکتر classداخل کلاس موجود کلیک کرده و کد مورد نیاز را برای کلاس جدید وارد کنید، ابتدا کلید واژه ی 

 تایپ کنید. 

را انتخاب کنید. در لیستی که ظاهر می  ...Surround Withو گزینه ی حال، کل کلاس را انتخاب کنید. روی انتخاب راست کلیک کرده 

 دوبار کلیک کنید. classشود روی 

 قرار گرفته  Outsideداخل کلاس دیگری به نام  Insideدر مثال زیر کلاسی به نام 

 
    public class Outside 
    { 
        public class Inside 
        { 
        } 
    } 
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طبق دستور بالا می توان هر تعداد کلاس که لازم است در کلاس های دیگر جای گذاری کرد. طریقه ی مدیریت و کنترل کلاس تودرتو هیچ 

مورد نیاز را داخل کلاس تودرتو یا  propertiesتفاوتی با )مدیریت( یک کلاس عادی ندارد. برای مثال، می توان تمامی فیلدها، متدها و 

)کلاس تودرتو( تعریف کرد. هنگامی که کلاسی را در کلاس دیگر جای گذاری می کنید، هیچ گونه ارتباط )برنامه ای( خاصی بین کلاس میزبان 

یا کلاس گنجانده شده(  nested classدو کلاس به وجود نمی آید : یعنی تنها به صرف قرار گرفتن یک کلاس در کلاس دیگر، کلاس تودرتو )

 دسترسی فوری پیدا نخواهد کرد. در حقیقت، این دو کلاس از هم مجزا هستند.( nesting class) به اعضای کلاس میزبان

اسم کلاس تودرتو )کلاس گنجانده شده( بیرون از کلاس میزبان قابل رویت نیست. برای دسترسی به کلاس تودرتو بیرون از کلاس میزبان، 

را جایی درون برنامه ولی  Insideن استفاده کنید، تعریف کنید. اگر می خواهید متغیر باید اسم کلاس تودرتو را هر جایی که می خواهید از آ

 تعریف کنید، لازم است اسم آن را تعریف کنید. Outsideبیرون از 

 مثال

    using System; 
    public class Outside 
    { 
        public class Inside 
        { 
            public Inside() 
            { 
                Console.WriteLine(" -= Inside =-"); 
            } 
        } 
        public Outside() 
        { 
            Console.WriteLine(" =- Outside -="); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Outside recto = new Outside(); 
            Outside.Inside ins = new Outside.Inside(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر را به دست می دهد. 

=- Outside -= 
 -= Inside =- 



 

370 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

 
ه شده و کلاس میزبان )دربردارنده( وجود ندارد، برای دسترسی به کلاس گنجانده به این خاطر که هیچ گونه ارتباط خاصی بین کلاس گنجاند

آن استفاده کرد. به عبارت دیگر، می توانید همه ی اعضای کلاس گنجانده ( static members)شده در کلاس میزبان، باید از اعضای ایستا 

 ان ایستا تعریف کنید. به مثال زیر توجه کنید.شده را که می خواهید در کلاس میزبان دسترسی داشته باشید به عنو

    using System; 
    public class Outside 
    { 
        public class Inside 
        { 
            public static string InMessage; 
            public Inside() 
            { 
                Console.WriteLine(" -= Insider =-"); 
                InMessage = "Sitting inside while it's raining"; 
            } 
            public static void Show() 
            { 
                Console.WriteLine("Show me the wonderful world of C# Programming"); 
            } 
        } 
        public Outside() 
        { 
            Console.WriteLine(" =- The Parent -="); 
        } 
        public void Display() 
        { 
            Console.WriteLine(Inside.InMessage); 
            Inside.Show(); 
        } 
    } 
    class Exercise 
    { 
        static int Main() 
        { 
            Outside recto = new Outside(); 
            Outside.Inside ins = new Outside.Inside(); 
            recto.Display(); 
            return 0; 
        } 
    } 

می توان از اعضای ایستا کلاس میزبان استفاده کرد ) کلیه ی اعضای  به همین نحو، برای دسترسی به کلاس میزبان در کلاس گنجانده شده،

 کلاس میزبان را که می خواهید در کلاس گنجانده شده دسترسی داشته باشید به عنوان ایستا تعریف کنید(.

 مثال
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using System; 
    public class Outside 
    { 
        public class Inside 
        { 
            public static string InMessage; 
            public Inside() 
            { 
                Console.WriteLine(" -= Insider =-"); 
                InMessage = "Sitting inside while it's raining"; 
            } 
            public static void Show() 
            { 
                Console.WriteLine("Show me the wonderful world of C# Programming"); 
            } 
            public void FieldFromOutside() 
            { 
                Console.WriteLine(Outside.OutMessage); 
            } 
        } 
        private static string OutMessage; 
        public Outside() 
        { 
            Console.WriteLine(" =- The Parent -="); 
            OutMessage = "Standing outside! It's cold and raining!!"; 
        } 
        public void Display() 
        { 
            Console.WriteLine(Inside.InMessage); 
            Inside.Show(); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Outside recto = new Outside(); 
            Outside.Inside Ins = new Outside.Inside(); 
            recto.Display(); 
            Console.WriteLine(); 
            Ins.FieldFromOutside(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید.

 =- The Parent -= 

 -= Insider =- 
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Sitting inside while it's raining 

Show me the wonderful world of C# Programming 

 Standing outside! It's cold and raining!! 

  

همچنین می توان به جای اعضای ایستا، اگر می خواهید به اعضای کلاس گنجانده شده در کلاس میزبان دسترسی داشته باشید، متغیر کلاس 

کلاس میزبان در کلاس گنجانده شده  گنجانده شده را در کلاس میزبان تعریف کنید و بر عکس )عکس این قضیه را برای دسترسی به اعضای

 پیاده کنید(.

 مثال

using System; 
    public class Outside 
    { 
        // A member of the nesting class 
        private string OutMessage; 
        // The nested class 
        public class Inside 
        { 
            // A field in the nested class 
            public string InMessage; 
            // A constructor of the nested class 
            public Inside() 
            { 
                Console.WriteLine(" -= Insider =-"); 
                this.InMessage = "Sitting inside while it's raining"; 
            } 
            // A method of the nested class 
            public void Show() 
            { 
                // Declare a variable to access the nesting class 
                Outside outsider = new Outside(); 
                Console.WriteLine(outsider.OutMessage); 
            } 
        } // End of the nested class 
        // A constructor of the nesting class 
        public Outside() 
        { 
            this.OutMessage = "Standing outside! It's cold and raining!!"; 
            Console.WriteLine(" =- The Parent -="); 
        } 
        // A method of the nesting class 
        public void Display() 
        { 



 

373 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            Console.WriteLine(insider.InMessage); 
        } 
        // Declare a variable to access the nested class 
        Inside insider = new Inside(); 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            Outside recto = new Outside(); 
            Outside.Inside Ins = new Outside.Inside(); 
            Ins.Show(); 
            recto.Display(); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید. 

-= Insider =- 
 =- The Parent -= 
 -= Insider =- 
 -= Insider =- 
 =- The Parent -= 
Standing outside! It's cold and raining!! 
Sitting inside while it's raining 

 کلاسی به عنوان فیلد

 ثل تمامی متغیرهایی که تاکنون به کار برده ایم، می توان یک کلاس یا ساختار را متغیر عضو کلاسی دیگر کرد. برای این که بتوانید کلاسم

دیگری را در کلاس خود به کار ببرید، در وهله ی اول لازم است آن کلاس را در دسترس داشته باشید. هم می توانید از کلاس های آماده ی 

C# ی این منظور استفاده کنید، هم می توانید کلاس خود را ایجاد کنید.برا 

 مثال

    public class Point 
    { 
        internal short x; 
        internal short y; 
    } 

تفاده از یک کلاس به از کلاس دیگری ساخته می شود. برای اس (primitive type)فیلد در حقیقت متغیر عضوی است که به جای نوع اولیه 

 عنوان متغیر عضو کلاسی دیگر، کافی است متغیر آن را تعریف کنید. به مثال زیر توجه کنید.
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    public class Point 
    { 
        internal short x; 
        internal short y; 
    } 
    public class CoordinateSystem 
    { 
        public Point start; 
    } 
 

 کپس از تعریف کلاسی به عنوان عضو متغیر کلاس دیگر، می توان از متغیر مزبور به طور منظم استفاده کرد. به این خاطر که عضو مورد نظر ی 

 معرفی شده، قوانینی وجود دارد که هنگام استفاده از آن باید رعایت کرد. پس از( reference)کلاس است، که به عنوان )یک( ارجاع 

تعریف متغیر عضو، باید مطمئن شوید که حافظه ی کافی به آن تخصیص داده شده است. همچنین لازم است متغیر مذکور صحیح و به طور 

 مواجه می شوید.  errorبرنامه با ( compile)مقتضی مقداردهی )اولیه( شده باشد. در غیر این صورت، هنگام ترجمه ی 

 استفاده از کلاس به عنوان فیلد 

 .را راه اندازی کنید #Microsoft Visual Cبرنامه ی     .8

 .کلیک کنید ...File -> New Projectبرای ایجاد برنامه ی جدید، در فهرست اصلی برنامه روی     .2

 .کلیک کنید ...Empty Projectدر لیست میانی، روی گزینه ی     .1

 .را فشار دهید Enterحال کلید تغییر داده،  ElectonicStore1اسم پروژه را به     .4

، روی اسم پروژه راست کلیک کرده، اکنون نشانگر موس را روی Solution Explorerبه منظور ایجاد کلاس جدید، در پنجره ی     .5

Add  قرار دهید و گزینه یclass را انتخاب کنید. 

 .کنید کلیک Addانتخاب کنید، سپس روی گزینه ی  StoreItemاسم کلاس را     .6

 .فایل را به صورت زیر تکمیل کنید    .4

 using System; 
    using System.Collections.Generic; 
    using System.Linq; 
    using System.Text; 
    namespace ElectronicStore1 
    { 
        public class StoreItem 
        { 
            private long nbr; 
            private char cat; 
            private string mk; 
            private string mdl; 
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            private double price; 
            public long GetItemNumber() 
            { 
                return nbr; 
            } 
            public void SetItemNumber(long number = 0) 
            { 
                this.nbr = number; 
            } 
            public char GetCategory() 
            { 
                return cat; 
            } 
            public void SetCategory(char category = 'A') 
            { 
                this.cat = category; 
            } 
            public string GetMake() 
            { 
                return mk; 
            } 
            public void SetMake(string make = "Unknown") 
            { 
                this.mk = make; 
            } 
            public string GetModel() 
            { 
                return mdl; 
            } 
            public void SetModel(string model = "Unknown") 
            { 
                this.mdl = model; 
            } 
            public double GetUnitPrice() 
            { 
                return price; 
            } 
            public void SetUnitPrice(double unitPrice = 0.00D) 
            { 
                this.price = unitPrice; 
            } 
        } 
    } 

 را انتخاب کنید. ...Project -> Add New Item، برای ایجاد فایل جدید، فهرست گزینه ی اصلی را باز کرده    .1 

 را از لیست میانی انتخاب کنید. Code Fileگزینه ی     .1

 را فشار دهید. Enterتغییر داده و کلید  OrderProcessing. اسم را به 82
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 . فایل را به ترتیب زیر اصلاح کنید.88

  using System; 
    namespace ElectronicStore1 
    { 
        public class OrderProcessing 
        { 
            public static int Main() 
            { 
                string strTitle1 = "=-= Nearson Electonics =-=\n"; 
                string strTitle2 = "******* Store Items ******"; 
                System.Console.ReadKey(); 
                return 0; 
            } 
        } 
    } 

 کلاس به عنوان یک نوع

 از متد بازگرداندن شی

 سپس کلاس را به عنوان نوع بازگشتی ،ابتدا متد را تعریف کرده ،برای این منظور .می توان مقدار یک کلاس را از متد یک کلاس بازگرداند

(return type )خص می کنیدمش. 

 مثال

    public class Point 
    { 
        internal short x; 
        internal short y; 
    } 
    public class CoordinateSystem 
    { 
        private Point start; 
        private Point end; 
        public Point GetThePoint() 
        { 
        } 
    } 

 / در غیر این صورت حین ترجمه ،باید مقداری بازگردانید که با کلاس همخوانی داشته باشد ،متد( implementing)پس از پیاده سازی 

در این خلال متغیر را مقداردهی  ،ابتدا متغیر کلاس را در بدنه ی متد تعریف می کنید ،بنابراین .مواجه می شوید errorکامپایل برنامه با 

 .سپس آن را باز می گردانید ،ه می کنیداولی
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 مثال

    public class Point 
    { 
        internal short x; 
        internal short y; 
    } 
    public class CoordinateSystem 
    { 
        private Point start; 
        private Point end; 
        public Point GetThePoint() 
        { 
            Point pt = new Point(); 
            Console.Write("Enter the x coordinate of the point: "); 
            pt.x = short.Parse(Console.ReadLine()); 
            Console.Write("Enter the y coordinate of the point: "); 
            pt.y = short.Parse(Console.ReadLine()); 
            return pt; 
        } 
    } 

  .می توانید آن را طبق نیاز خود مورد استفاده قرار دهید ،پس از این که متد مقدار کلاس را بازگرداند

 ارسال کلاس به عنوان آرگومان

می توان متغیر آن را به عنوان آرگومان به متد کلاس  ،برای مثال .ردمی توان آن را مثل هر متغیر دیگری به کار ب ،پس از ایجاد کلاس

کلاس در اختیار متدی که از آن ( public members)اعضای عمومی  ،زمانی که کلاسی به عنوان آرگومان ارسال می شود .دیگری ارسال کرد

 .نوان آرگومان به یک متد ارسال کردهمچنین می توان چندین )بیش از یک( کلاس به ع .استفاده می کند قرار می گیرد

 مثال

using System; 
    namespace Geometry 
    { 
        public class Point 
        { 
            internal short x; 
            internal short y; 
        } 
        public class CoordinateSystem 
        { 
            public Point start; 
            public Point end; 
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            public Point GetThePoint() 
            { 
                Point pt = new Point(); 
                Console.Write("Enter the x coordinate of the point: "); 
                pt.x = short.Parse(Console.ReadLine()); 
                Console.Write("Enter the y coordinate of the point: "); 
                pt.y = short.Parse(Console.ReadLine()); 
                return pt; 
            } 
            public double DistanceFromOrigin(Point pt) 
            { 
                double sqr1 = Math.Pow(pt.x, 2); 
                double sqr2 = Math.Pow(pt.y, 2); 
                double distance = Math.Sqrt(sqr1 + sqr2); 
                return distance; 
            } 
            public double DistanceBetween2Points(Point pt1, Point pt2) 
            { 
                double sqr1 = Math.Pow(pt2.x - pt1.x, 2); 
                double sqr2 = Math.Pow(pt2.y - pt1.y, 2); 
                double distance = Math.Sqrt(sqr1 + sqr2); 
                return distance; 
            } 
        } 
        public class Program 
        { 
            private static CoordinateSystem IdentifyCoordinates() 
            { 
                CoordinateSystem coord = new CoordinateSystem(); 
                Console.WriteLine("Start Point"); 
                coord.start = coord.GetThePoint(); 
                Console.WriteLine("End Point"); 
                coord.end = coord.GetThePoint(); 
                return coord; 
            } 
            private static void Show(CoordinateSystem c) 
            { 
                Console.WriteLine("Coordinate System"); 
                Console.WriteLine("Starting Point: P({0}, {1})", c.start.x, c.start.y); 
                Console.WriteLine("Ending Point:   Q({0}, {1})", c.end.x, c.end.y); 
                Console.WriteLine("Distance Between Both Points: {0:F}",c.DistanceBetween2Points(c.start, c.end)); 
            } 
            static int Main() 
            { 
                CoordinateSystem coord = IdentifyCoordinates(); 
                Console.WriteLine(); 
                Show(coord); 
                return 0; 
            } 
        } 
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    } 

 .زیر نمونه ای از )اجرای( برنامه مورد نظر را مشاهده می کنید

Start Point 
Enter the x coordinate of the point: -2 
Enter the y coordinate of the point: 2 
End Point 
Enter the x coordinate of the point: 3 
Enter the y coordinate of the point: -6       
Coordinate System 
Starting Point: P(-2، 2) 
Ending Point:   Q(3، -6) 
Distance Between Both Points: 9.43 
Press any key to continue... 
  

کلاس  ،هنگام ارسال کلاس به عنوان آرگومان ،ستفاده قرار می گیرندمورد ا( reference)به این خاطر که کلاس ها همیشه به عنوان ارجاع 

 مت چپ آرگومان تایپ کنید.را در س refبرای این منظور می توانید کلیدواژه ی  .نام برده )به صورت ضمنی( با ارجاع فرستاده می شود

 مثال

    using System; 
    namespace ConsoleApplication1 
    { 
        public class Point 
        { 
            internal short x; 
            internal short y; 
        } 
        public class CoordinateSystem 
        { 
            public Point start; 
            public Point end; 
            public Point GetThePoint() 
            { 
                Point pt = new Point(); 
                Console.Write("Enter the x coordinate of the point: "); 
                pt.x = short.Parse(Console.ReadLine()); 
                Console.Write("Enter the y coordinate of the point: "); 
                pt.y = short.Parse(Console.ReadLine()); 
                return pt; 
            } 
            public double DistanceFromOrigin(ref Point pt) 
            { 
                double sqr1 = Math.Pow(pt.x, 2); 
                double sqr2 = Math.Pow(pt.y, 2); 
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                double distance = Math.Sqrt(sqr1 + sqr2); 
                return distance; 
            } 
            public double DistanceBetween2Points(ref Point pt1, ref Point pt2) 
            { 
                double sqr1 = Math.Pow(pt2.x - pt1.x, 2); 
                double sqr2 = Math.Pow(pt2.y - pt1.y, 2); 
                double distance = Math.Sqrt(sqr1 + sqr2); 
                return distance; 
            } 
        } 
        public class Program 
        { 
            private static CoordinateSystem IdentifyCoordinates() 
            { 
                CoordinateSystem coord = new CoordinateSystem(); 
                Console.WriteLine("Start Point"); 
                coord.start = coord.GetThePoint(); 
                Console.WriteLine("End Point"); 
                coord.end = coord.GetThePoint(); 
                return coord; 
            } 
            private static void Show(CoordinateSystem c) 
            { 
                Console.WriteLine("Coordinate System"); 
                Console.WriteLine("Starting Point: P({0}, {1})", c.start.x, c.start.y); 
                Console.WriteLine("Ending Point:   Q({0}, {1})", c.end.x, c.end.y); 
                Console.WriteLine("Distance Between Both Points: {0:F}", c.DistanceBetween2Points(ref c.start, ref c.end)); 
            } 
            static int Main() 
            { 
                CoordinateSystem coord = IdentifyCoordinates(); 
                Console.WriteLine(); 
                Show(coord); 
                return 0; 
            } 
        } 
    } 

 شی یا ارسال آن به عنوان آرگومانبازگرداندن یک 

 .را به صورت زیر اصلاح کنید OrderProcessing.csبرای بازگرداندن کلاس یا ارسال آن به عنوان آرگومان، فایل     .8

using System; 
    namespace ElectronicStore1 
    { 
        public class SaleItem 
        { 
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            double DiscountAmount; 
            double NetPrice; 
            int Quantity; 
            double SaleTotal; 
            public double GetDiscountRate() 
            { 
                Console.Write("Discount Applied (Enter 0 to 100, 0 if no discount): "); 
                double discount = double.Parse(Console.ReadLine()); 
                return discount; 
            } 
            public int GetQuantity() 
            { 
                Console.Write("Enter Quantity: "); 
                int q = int.Parse(Console.ReadLine()); 
                return q; 
            } 
            public StoreItem Create() 
            { 
                long itemNumber; 
                char category; 
                string make; 
                string model; 
                //double discount; 
                double price; 
                StoreItem saleItem = new StoreItem(); 
                Console.Write("Enter the Item #: "); 
                itemNumber = long.Parse(Console.ReadLine()); 
                Console.WriteLine("Category"); 
                Console.WriteLine("A - Audio Cables"); 
                Console.WriteLine("B - Instructional and Tutorials (Books)"); 
                Console.WriteLine("C - Cell Phones and Accessories"); 
                Console.WriteLine("D - Bags and Cases"); 
                Console.WriteLine("E - Headphones"); 
                Console.WriteLine("F - Instructional and Tutorials (VHS & DVD)"); 
                Console.WriteLine("G - Digital Cameras"); 
                Console.WriteLine("H - Cables and Connectors"); 
                Console.WriteLine("I - PDAs and Accessories"); 
                Console.WriteLine("J - Telephones and Accessories"); 
                Console.WriteLine("K - Surge Protector"); 
                Console.WriteLine("L - TVs and Videos"); 
                Console.WriteLine("U - Unknown"); 
                Console.Write("Your Choice? "); 
                category = char.Parse(Console.ReadLine()); 
                Console.Write("Make:        "); 
                make = Console.ReadLine(); 
                Console.Write("Model:       "); 
                model = Console.ReadLine(); 
                Console.Write("Unit Price:  "); 
                price = double.Parse(Console.ReadLine()); 
                saleItem.SetItemNumber(itemNumber); 
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                saleItem.SetCategory(category); 
                saleItem.SetMake(make); 
                saleItem.SetModel(model); 
                saleItem.SetUnitPrice(price); 
                return saleItem; 
            } 
            public void ShowSaleItem(StoreItem item) 
            { 
                double discountRate = GetDiscountRate(); 
                int quantity = GetQuantity(); 
                DiscountAmount = item.GetUnitPrice() * discountRate / 100; 
                NetPrice = item.GetUnitPrice() - DiscountAmount; 
                SaleTotal = NetPrice * quantity; 
                Console.WriteLine("\nStore Item Description"); 
                Console.WriteLine("Item Number:     {0}", item.GetItemNumber()); 
                Console.WriteLine("Category:        {0}", item.GetCategory()); 
                Console.WriteLine("Make             {0}", item.GetMake()); 
                Console.WriteLine("Model:           {0}", item.GetModel()); 
                Console.WriteLine("Unit Price:      {0:C}", item.GetUnitPrice()); 
                Console.WriteLine("Discount Rate:   {0:P}", discountRate / 100); 
                Console.WriteLine("Discount Amount: {0:C}", DiscountAmount); 
                Console.WriteLine("Price/Item:      {0:C}", NetPrice); 
                Console.WriteLine("Quantity:        {0}", quantity); 
                Console.WriteLine("Sale Total:      {0:C}", SaleTotal); 
            } 
        } 
        public class OrderProcessing 
        { 
            public static int Main() 
            { 
                StoreItem item = new StoreItem(); 
                SaleItem sale = new SaleItem(); 
                string strTitle1 = "=-= Nearson Electonics =-=\n"; 
                string strTitle2 = "******* Store Items ******"; 
                Console.Title = "Electronic Super Store"; 
                Console.WriteLine(strTitle1); 
                Console.WriteLine(strTitle2); 
                Console.Clear(); 
                item = sale.Create(); 
                sale.ShowSaleItem(item); 
                System.Console.ReadKey(); 
                return 0; 
            } 
        } 
    } 

 .برنامه را اجرا کنید    .2 

 .را بزنید Enterکلید     .1
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 =-= Nearson Electonics =-= 
******* Store Items ****** 
Enter the Item #: 927374 
Category 
A - Audio Cables 
B - Instructional and Tutorials (Books) 
C - Cell Phones and Accessories 
D - Bags and Cases 
E - Headphones 
F - Instructional and Tutorials (VHS & DVD) 
G - Digital Cameras 
H - Cables and Connectors 
I - PDAs and Accessories 
J - Telephones and Accessories 
K - Surge Protector 
L - TVs and Videos 
U - Unknown 
Your Choice? L 
Make:        NEC 
Model:       VT48 Video Projector 
Unit Price:  705.95 
Discount Applied (Enter 0 to 100، 0 if no discount): 15 
Enter Quantity: 1 

 .را فشار دهید Enter. کلید 4

Store Item Description 
Category:        L 
Make:             NEC 
Model:           VT48 Video Projector 
Unit Price:      $705.95 
Discount Rate:   15.00 % 
Discount Amount: $105.89 
Price/Item:      $600.06 
Quantity:        1 
Sale Total:      $600.06 

 .از برنامه خارج شده و به محیط برنامه نویسی بازگردید Enter. با زدن 5

 ل یک کلاس به عنوان آرگومان خود آن کلاسارسا

می توان نمونه ای از یک کلاس را به عنوان آرگومان به یکی از متدهای خود آن کلاس فرستاد. برای این منظور، آرگومان را مثل هر کلاس  

 دیگری ارسال می کنید.

 مثال

    public class Point 
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    { 
        internal int x; 
        internal int y; 
        public void Equivalent(Point Same) 
        { 
        } 
    } 

ت حال، می توانید هر کاری که می خواهید در بدنه ی متد انجام دهید. همچنین، می توانید آرگومان را مورد استفاده قرار دهید. حال در صور

ته باشید، همگی )دیگر( اعضای کلاس از طریق آرگومان قابل دسترسی هستند. ساده استفاده از آرگومان گفته شده، لازم است به خاطر داش

 ترین روش استفاده از آرگومان، تخصیص )هر یک از( مقادیر آن به عضو های معادل و مربوط در کلاس است.

 مثال

    public class Point 
    { 
        internal int x; 
        internal int y; 
        public void Equivalent(Point Same) 
        { 
            this.x = Same.x; 
            this.y = Same.y; 
        } 
    } 

را هنگام فراخوانی متد، لازم است نمونه ای از کلاس به آن ارسال کنید. در وهله ی اول کلاس مورد نظر را ایجاد و تعریف می کنیم، بعد آن 

 کنیم. ارسال می

 مثال

    using System; 
    public class Point 
    { 
        internal int x; 
        internal int y; 
        public void Equivalent(Point Same) 
        { 
            this.x = Same.x; 
            this.y = Same.y; 
        } 
    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
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            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
            Point One = new Point(); 
            One.Equivalent(pt); 
            ShowPoint(One); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

Point Coordinates: A(4، 6) 
Point Coordinates: A(4، 6) 
Press any key to continue... 

 

 calling) به جای اینکه اول کلاس را تعریف و مقداردهی اولیه کنید، می توانید نمونه ای از کلاس مورد نظر را داخل پرانتز های متد فراخوان

method) به سازنده ای ایجاد کنید. البته برای این منظور نیاز (constructor)   دارید که مقادیر فیلد های کلاس مربوط را مشخص کرده تا

 آرگومان به تناسب )با مقدار مناسب( مقداردهی اولیه شود.

 مثال

    using System; 
    public class Point 
    { 
        internal int x; 
        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public void Equivalent(Point Same) 
        { 
            this.x = Same.x; 
            this.y = Same.y; 
        } 
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    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
            Point One = new Point(); 
            One.Equivalent(new Point(-3, 2)); 
            ShowPoint(One); 
            return 0; 
        } 
    } 

 

می توان سازنده ای از کلاس را برای ارسال نمونه ای از همان کلاس به کار برد. حال می توانید در  ،(formal method)به جای متد رسمی 

 سازنده، آرگومان را بر اساس نیازتان به کار ببرید )نظر به اینکه تمامی اعضای کلاس در دسترس هستند(.

 مثال

    public class Point 
    { 
        internal int x; 
        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public Point(Point Same) 
        { 
            this.x = Same.x; 
            this.y = Same.y; 
        } 

}     
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با استفاده  ،NET Framework.در حقیقت  #C هدف ما از ارسال یک کلاس به متدهای خود همان کلاس پیدا کردن معادل آن نیست. زبان

هد. در عوض، می توان متدی ایجاد کرد که نمونه ای از همان کلاس را می گیرد ولی نمونه ی ترتیب فرایند بالا را می د ()Equals از متد توکار

 Point جدیدی ایجاد کنیم که به اندازه ی یک واحد از شی Point، pointنام برده را اصلاح می کند. برای مثال، شاید بخواهیم برای کلاس 

 .موجود فاصله داشته باشد

    using System; 
    public class Point 
    { 
        internal int x; 
        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public void Equivalent(Point Same) 
        { 
            this.x = Same.x; 
            this.y = Same.y; 
        } 
        public void CreatePointOneUnitAway(Point AddUnit) 
        { 
            this.x = AddUnit.x + 1; 
            this.y = AddUnit.y + 1; 
        } 
    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
            Point One = new Point(); 
            One.CreatePointOneUnitAway(pt); 
            ShowPoint(One); 
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            One.CreatePointOneUnitAway(new Point(-8, -3)); 
            ShowPoint(One); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر به دست می آید

Point Coordinates: A(4، 6) 
Point Coordinates: A(5، 7) 
Point Coordinates: A(-7، -2) 
Press any key to continue...  

 ز متد همان کلاسبازگرداندن کلاسی ا

 ردمی توانید متدی در کلاس ایجاد کنید که نمونه ای از همان کلاس را بر می گرداند. برای شروع کار، اسم کلاس مربوط را در سمت چپ متد وا

 کنید.

 مثال

    public class Point 
    { 
        public Point MethodName() 
        { 
        } 
    } 

رهای متفاوتی با متد موردنظر انجام دهید. اگر می خواهید مقدار جدیدی از کلاس باز گردانید، می توانید نمونه ای از کلاس را می توانید کا

 .تعریف و مقداردهی اولیه کرده، سپس آن را برگردانید. به مثال زیر توجه کنید

  using System; 
    public class Point 
    { 
        internal int x; 
        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public Point(Point Same) 
        { 
            this.x = Same.x; 



 

389 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            this.x = Same.x; 
        } 
        public Point AdvanceBy5() 
        { 
            Point Some = new Point(); 
            Some.x = 5; 
            Some.y = 5; 
            return Some; 
        } 
    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
            Point Away5 = pt.AdvanceBy5(); 
            ShowPoint(Away5); 
            return 0; 
        } 
    } 

 

 نتیجه

Point Coordinates: A(4، 6) 
Point Coordinates: A(5، 5) 
Press any key to continue... 

 

 دستمی توانید نمونه ای از کلاس را تعریف کرده، مقادیر جاری کلاس را همراه با مقدارهای نمونه ی کلاس به کار ببرید تا مقادیر جدیدی به 

 آورید، سپس نمونه ی مذکور را برگردانید.

 مثال

    using System; 
    public class Point 
    { 
        internal int x; 
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        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public Point(Point Same) 
        { 
            this.x = Same.x; 
            this.x = Same.x; 
        } 
        public Point AdvanceBy5() 
        { 
            Point Some = new Point(); 
            Some.x = this.x + 5; 
            Some.y = this.y + 5; 
            return Some; 
        } 
    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
            Point Away5 = pt.AdvanceBy5(); 
            ShowPoint(Away5); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر را به دست می دهد

Point Coordinates: A(4، 6) 
Point Coordinates: A(9، 11) 
Press any key to continue... 
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ریف تعبه یاد داشته باشید که برای فراخوانی متد، چنانچه متد ایستا نبود، لازم است نمونه ی کلاس را از آن جایی که متد را فرا می خوانید، 

ای است که متد را فرا می خواند. برای مثال، می توانید مقادیری به فیلدهای آن  کنید. نوع دیگر پیاده سازی ) روش دوم آن( اصلاح نمونه

 پیاده کنید. (calling instance) اضافه کنید، یا هر عملیات دیگری که نیاز دارید روی اعضای نمونه ی فراخوان

 مثال

    using System; 
    public class Point 
    { 
        internal int x; 
        internal int y; 
        public Point() 
        { 
        } 
        public Point(int XCoord, int YCoord) 
        { 
            this.x = XCoord; 
            this.y = YCoord; 
        } 
        public Point(Point Same) 
        { 
            this.x = Same.x; 
            this.x = Same.x; 
        } 
        // This method adds 1 to each field of the class 
        // to get a new point away North-East of the current point 
        public Point CreatePointOneUnitAway() 
        { 
            this.x = this.x + 1; 
            this.y = this.y + 1; 
            return this; 
        } 
    } 
    public class Program 
    { 
        private static void ShowPoint(Point pt) 
        { 
            Console.Write("Point Coordinates: "); 
            Console.WriteLine("A({0}, {1})", pt.x, pt.y); 
        } 
        static int Main(string[] args) 
        { 
            Point pt = new Point(); 
            pt.x = 4; 
            pt.y = 6; 
            ShowPoint(pt); 
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            Point One = new Point(-8, 5); 
            Point Another = One.CreatePointOneUnitAway(); 
            ShowPoint(Another); 
            return 0; 
        } 
    } 

 .نتیجه ی زیر حاصل می گردد

Point Coordinates: A(4، 6) 
Point Coordinates: A(-7، 6) 
Press any key to continue... 

 

بر گرفتن آرگومان با کلاس والد خود هم نوع باشد. در متد، می توان به تمامی اعضای  شایان توجه است که می توان متدی ساخت که علاوه

 کلاس دسترسی داشت که از جمله ی آن فراخواندن دیگر متدهای کلاس مربوط می باشد.

 مقدمه ای بر شرطی ها

 Boolean  متغیر های

در حال اجرا عرضه کند که برخی از این مقادیر معتبر هستند ولی برخی هنگام تعامل با کامپیوتر، کاربر ممکن است مقادیری را به برنامه ی 

ر یک بادیگر نیاز به اصلاحاتی دارند یا توسط رایانه رد می شوند. برای جلوگیری از این رخداد مقادیر باید مرتب مورد بررسی قرار بگیرند. اعت

 اند درست باشد یا یک عدد مساوی عدد دیگری باشد.مقدار در رابطه با نوعش بررسی می شود. برای مثال، یک شرط می تو

 یاد می شود.  Booleanعرضه می کند که از آن ها به عنوان عملگرهای  یک سری نشانه #Cبرای اعتبار سنجی مقادیر، زبان 

 Booleanتعریف متغیرهای 

8.      Microsoft Visual Studio .را اجرا کنید 

 کلیک کنید. ...File -> New Project، به فهرست اصلی مراجعه کرده، روی برای ایجاد برنامه ی جدید      .2

 کلیک کنید. Empty Projectدر فهرست میانی روی گزینه ی       .1

 تغییر دهید. NationalBank2اسم مورد نظررا به       .4

 ...NationalBank2 -> Add -> New Itemس ، راست کلیک کرده سپSolution Explorerبرای ایجاد فایل جدید، در پنجره ی       .5

 را از لیست میانی انتخاب کنید. Code Fileگزینه ی       .6
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 تغییر دهید. Employeeاسم فایل را به       .4

1.      Add .را کلیک کنید 

 را به شکل زیر اصلاح کنید. Employee.csفایل       .1

    public class Employee 
    { 
        public string EmployeeNumber; 
        public string FirstName; 
        public string LastName; 
        public double HourlySalary; 
        public Employee(string emplNbr = "00-000", string fName = "John", 
                        string lName = "Doe", double salary = 0.00) 
        { 
            EmployeeNumber = emplNbr; 
            FirstName = fName; 
            LastName = lName; 
            HourlySalary = salary; 
        } 
    } 

 ....NationalBank2 -> Add -> New Item، راست کلیک کرده سپس : Solution Explorer. برای ایجاد فایل جدید، در پنجره ی 82

تغییر دهید و کلید  Managementانتخاب شده باشد. اسم آن را به  Code File. توجه داشته باشید که در لیست میانی گزینه ی 88

Enter .را بزنید 

 . فایل را به صورت زیر اصلاح کنید.82

    using System; 
    public class Management 
    { 
        private static Employee HireEmployee() 
        { 
            Employee empl = new Employee(); 
            Console.Title = "National Bank"; 
            Console.WriteLine("======================="); 
            Console.WriteLine("==-= National Bank =-=="); 
            Console.WriteLine("To hire a new employee, enter the following information"); 
            Console.WriteLine("-----------------------"); 
            Console.Write("Employee #:    "); 
            empl.EmployeeNumber = Console.ReadLine(); 
            Console.Write("First Name:    "); 
            empl.FirstName = Console.ReadLine(); 
            Console.Write("Last Name:     "); 
            empl.LastName = Console.ReadLine(); 
            Console.Write("Hourly Salary: "); 
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            empl.HourlySalary = double.Parse(Console.ReadLine()); 
            Console.WriteLine("======================="); 
            return empl; 
        } 
        private static void ShowEmployeeRecord(Employee empl) 
        { 
            Console.Title = "National Bank"; 
            Console.WriteLine("======================="); 
            Console.WriteLine("==-= National Bank =-=="); 
            Console.WriteLine("    Employee Record"); 
            Console.WriteLine("-----------------------"); 
            Console.WriteLine("Employee #:    {0}", empl.EmployeeNumber); 
            Console.WriteLine("First Name:    {0}", empl.FirstName); 
            Console.WriteLine("Last Name:     {0}", empl.LastName); 
            Console.WriteLine("Hourly Salary: {0}", empl.HourlySalary); 
            Console.WriteLine("======================="); 
        } 
        public static int Main() 
        { 
            Employee clerk = null; 
            clerk = HireEmployee(); 
            Console.Clear(); 
            ShowEmployeeRecord(clerk); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 کلیک کنید. Debug -> Start Debugging. برای اجرای برنامه، به فهرست اصلی مراجعه کرده، سپس روی 81 

 . اطلاعات لازم را به صورت زیر اصلاح کنید.84

Employee # 88-602 

First Name Joan 

Last Name Gergman 

Hourly Salary 16.85 

 

 را فشار دهید. Enter. کلید 85
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======================= 
==-= National Bank =-== 
Employee Record 
----------------------- 
Employee #:    88-602 
First Name:    Joan 
 Last Name:     Bergman 
 Hourly Salary: 16.85 
 ======================= 

 بسته شود. DOSرا زده تا پنجره ی  Enter. حال 86

 Booleanتعریف متغیر 

، می توان هر یک از دو Booleanخارج نباشد. برای تعریف متغیر  falseیا  trueگفته می شود که مقدار آن از دو حالت  Booleanبه متغیری 

 را به کار برد. به مثال زیر توجه کنید. boolیا  varکلیدواژه ی 

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            bool drinkingUnderAge; 
            return 0; 
        } 
    } 

 می باشد. Systemنام  بخشی از فضای  Booleanنوع داده ی  استفاده کرد. Booleanبرای تعریف متغیر  Booleanمی توان از نوع داده ی 

 مثال

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            bool drinkingUnderAge; 
            Boolean theFloorIsCoveredWithCarpet; 
            return 0; 
        } 
    } 

تعریف  varمقداردهی اولیه کرد. در حقیقت، چنانچه متغیر نام برده را به عنوان  falseیا  trueد آن را با )مقدار( پس از تعریف متغیر، بای

 کنید، چاره ای جز مقداردهی اولیه ی آن ندارید. توجه خود را به مثال زیر جلب کنید.
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    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var drinkingUnderAge = true; 
            return 0; 
        } 
    } 

تایپ  console کلاس ()WriteLineیا  ()Writeدر کنسول، می توانید اسم آن را در پرانتزهای متد  Booleanبه منظور نمایش مقدار متغیر 

 کنید. مثال زیر را در نظر بگیرید.

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var drinkingUnderAge = true; 
            Console.WriteLine("Drinking Under Age: {0}", drinkingUnderAge); 
            return 0; 
        } 
    } 

 نتیجه

Drinking Under Age: True 
Press any key to continue… 

 مثالتغییر دهید.  falseیا  trueرا با تخصیص مقادیر  Booleanمی توانید هر زمان که لازم می دانید، مقدار متغیر 

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var drinkingUnderAge = true; 
            Console.WriteLine("Drinking Under Age: {0}", drinkingUnderAge); 
            drinkingUnderAge = false; 
            Console.WriteLine("Drinking Under Age: {0}", drinkingUnderAge); 
            return 0; 
        } 
    } 

 .حاصل می گرددنتیجه ی زیر 
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Drinking Under Age: True 
Drinking Under Age: False 
Press any key to continue... 

  Booleanبازیابی مقدار متغیر 

( را تایپ false)یا  Falseیا  (true)یا  Trueرا از کاربر در خواست کرد. در این مورد، لازم است کاربر  Booleanمی توان مقدار یک متغیر 

 کمک گرفت. Consoleکلاس  ()ReadLineیا  ()Readبرای بازیابی آن باید از متدهای  کند.

 مثال

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var drivingUnderAge = false; 
            Console.WriteLine("Were you driving under age?"); 
            Console.Write("If Yes, enter True. Otherwise enter False: "); 
            drivingUnderAge = bool.Parse(Console.ReadLine()); 
            Console.WriteLine("\nWas Driving Under Age: {0}\n", drivingUnderAge); 
            return 0; 
        } 
    } 

 مثال 

Were you driving under age? 
If Yes، enter True. Otherwise enter False: true       
 as Driving Under Age: True 
 ress any key to continue... 

  Booleanایجاد فیلد 

را به فیلد یک کلاس تبدیل کرد. متغیر  Booleanتغیر مثل دیگر نوع متغیر هایی که در مباحث پیشین با آن برخورد داشتیم، می توان م

 تعریف می کنید. Booleanیا نوع داده ی   boolمذکور را مثل هر نوع متغیر دیگر، البته با کلید واژه ی 

 مثال

    public class House 
    { 
        char typeOfHome; 
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        int beds; 
        float baths; 
        byte stories; 
        bool hasCarGarage; 
        int yearBuilt; 
        double value; 
    } 

به متغیر مربوط اختصاص  falseیا  trueیک عضو آن محسوب می شود، کافی است  Booleanهنگام مقداردهی اولیه ی شی ای که متغیر 

ا با دسترسی به آن بازیابی یا چک کنید. نمونه های آن را در زیر مشاهده می ر Booleanدهید. به همین نحو، می توانید مقدار متغیر عضو 

 کنید.

    using System; 
    public class House 
    { 
        public char typeOfHome; 
        public int beds; 
        public float baths; 
        public byte stories; 
        public bool hasCarGarage; 
        public int yearBuilt; 
        public double value; 
    } 
    public class Program 
    { 
        static int Main() 
        { 
            var Condominium = new 
            { 
                hasCarGarage = false, 
                yearBuilt = 2002, 
                baths = 1.5F, 
                stories = 18, 
                value = 155825, 
                beds = 2, 
                typeOfHome = 'C' 
            }; 
            Console.WriteLine("=//= Altair Realtors =//="); 
            Console.WriteLine("=== Property Listing ==="); 
            Console.WriteLine("Type of Home:        {0}", Condominium.typeOfHome); 
            Console.WriteLine("Number of Bedrooms:  {0}", Condominium.beds); 
            Console.WriteLine("Number of Bathrooms: {0}", Condominium.baths); 
            Console.WriteLine("Number of Stories:   {0}", Condominium.stories); 
            Console.WriteLine("Year Built:          {0}", Condominium.yearBuilt); 
            Console.WriteLine("Has Car Garage:      {0}", Condominium.hasCarGarage); 
            Console.WriteLine("Monetary Value:      {0}\n", Condominium.value); 
            return 0; 
        } 
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    } 

 نتیجه ی زیر به دست می آید.

=//= Altair Realtors =//= 
 === Property Listing === 
 Type of Home:        C 
 Number of Bedrooms:  2 
 Number of Bathrooms: 1.5 
 Number of Stories:   18 
 Year Built:          2002 
 Has Car Garage:      False 
 Monetary Value:      155825 
 Press any key to continue... 

  Booleanآرگومان های 

به متد ارسال کرد. چنین آرگومانی می تواند تنها دو مقدار  Booleanیا  boolدرست مثل پارامترهای انواع دیگر، می توان آرگومان )از( نوع 

true  یاfalse .را داشته باشد 

enumeration  

ا ر تصور کنید، هنگام برنامه نویسی برای شرکتی که معاملات املاک انجام می دهد، می خواهید برنامه ای که نوشته اید از مشتری نوع خانه ای

 را دارند بپرسد. که قصد خرید آن

 مثال

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            int typeOfHouse = 0; 
            int typeOfGarage = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1 - Single Family"); 
            Console.WriteLine("2 - Townhouse"); 
            Console.WriteLine("3 - Condominium"); 
            Console.Write("Your Choice: "); 
            typeOfHouse = int.Parse(Console.ReadLine()); 
            Console.WriteLine("Enter the type of garage you want"); 
            Console.WriteLine("0 - Doesn't matter"); 
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            Console.WriteLine("1 - Interior"); 
            Console.WriteLine("2 - Exterior"); 
            Console.Write("Your Choice: "); 
            typeOfGarage = int.Parse(Console.ReadLine()); 
            Console.Clear(); 
            Console.WriteLine("\nHouse Type: {0}", typeOfHouse); 
            Console.WriteLine("Garage Type:  {0}", typeOfGarage); 
            return 0; 
        } 
    } 

 ی از اجرای برنامهمثال

Enter the type of house you want to purchase 
 1 - Single Family 
 2 - Townhouse 
 3 - Condominium 
 Your Choice: 3 
Enter the type of garage you want 
0 - Doesn't matter 
1 - Interior 
2 - Exterior 
Your Choice: 1 
--------------------------------------------------- 
House Type:  3 
Garage Type: 1 
Press any key to continue... 

  

، رقمی کلی است ولی در برنامه ی مورد نظر ممکن است نشانگر خانه ای با 8برای چنین برنامه ای، ارقام ممکن است گنگ یا مبهم باشد. عدد 

در راه های معنی دار مختلفی بهره می برد. برای ایجاد امکان دادن بیش  8ل برنامه ی نام برده از ثابت ظرفیت گنجایش تنها یک خانوار باشد. حا

به شما  #Cاز یک معنی یا کاربرد به یک عدد ثابت، به خصوص هنگامی که قرار است عدد مربوطه جزئی از یک سری باشد، زبان برنامه نویسی 

 اجازه می دهد یک نوع لیست ایجاد کنید.

enumeration  در واقع یک سری عدد صحیح ثابت(constant integer)  است که هر یک موقعیت خاصی در لیست دارد و با اسم مشخصی

نشانگر تک خانوار است، می توان لیستی ایجاد کرد که نمونه ی خانه  8شناسایی می شود. بر این اساس، به جای به خاطر داشتن این که ثابت 

انتخاب کرد. در نتیجه، در هر لیست ، اگرچه  ، می توان اسم برای آن8می شود. در لیست دیگر، به جای استفاده ی دوباره از ی مزبور را شامل 

 باز هم در نظر گرفته می شود، حداقل معنای آن دقیق خواهد بود.  8ثابت 
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  enumerationایجاد 

و همچنین اسمی مختص هر یک از آیتم های لیست را تایپ کنید. اسم  enumerationو به دنبال آن اسم  enum برای این منظور، کلیدواژه ی

و همچنین اسم تک تک آیتم های لیست از همان قوانینی که برای انتخاب اسم )ها( نام بردیم پیروی می کند.  (enumerator)شمارنده 

 به شرح زیر است. enumerationفرمول ایجاد 

enum Enumeration_Name {Item1، Item2، Item_n}; 

، روی بخش مورد نظر راست کلیک code snippet، می توانید کد را به صورت دستی وارد کنید. برای استفاده از enumerationبرای ایجاد 

دوبار  enumدوبار کلیک کنید. در لیستی که نمایان می شود، روی  #Visual Cرا انتخاب کنید. اکنون روی  ...Insert Snippetکرده، سپس 

 کلیک کنید.

 

 مثال

    using System; 
    public class Exercise 
    { 

http://articles.tahlildadeh.com/image.axd?picture=clip_image001_39.gif
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        enum HouseType { Unknown, SingleFamily, TownHouse, Condominium } 
        static int Main() 
        { 
            return 0; 
        } 
    } 

  enumerationتعریف متغیر 

 خواهند داشت.25 ،12، 4 ،0، هر یک از اعضای آن، مقدار عدد طبیعی مثل  enumerationد پس از ایجا

 ، حتی می توان از آن متغیر تعریف کرد. به مثال زیر توجه کنید.enumerationپس از ایجاد 

    using System; 
    public class Exercise 
    { 
        enum HouseType { Unknown, SingleFamily, TownHouse, Condominium } 
        static int Main() 
        { 
            HouseType propType; 
            return 0; 
        } 
    } 

 

 نیز تعریف کرد.   varیرا با کلید واژه  enumerationلازم به ذکر است که می توان متغیر )از( نوع 

  enumerationمقداردهی اولیه ی متغیر 

به متغیر اختصاص  enumeration، به منظور مقداردهی اولیه ی آن، مشخص کنید کدام عضو enumerationپس از تعریف متغیر برای نوع 

باید به متغیر تخصیص یابد. برای این منظور، در سمت راست عملگر  enumerationداده شود. شایان توجه است که تنها عضو شناس 

 و به دنبال آن عملگر نقطه، عضوی که می خواهید مقدار آن را اختصاص دهید، تایپ کنید. enumerationجایگزین، اسم 

 مثال

    using System; 
    public class Exercise 
    { 
        enum HouseType { Unknown, SingleFamily, TownHouse, Condominium } 
        static int Main() 
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        { 
            var propType = HouseType.SingleFamily; 
            return 0; 
        } 
    } 

همچنین می توان مقداری را که متغیر تعریف شده در حال حاضر دارد، به دست آورد. برای مثال، می توان آن را در کنسول و با استفاده از 

 ثال زیر توجه کنید.نمایش داد. به م ()WriteLineو   ()Writeمتدهای

    using System; 
    public class Exercise 
    { 
        enum HouseType { Unknown, SingleFamily, TownHouse, Condominium } 
        static int Main() 
        { 
            var propType = HouseType.SingleFamily; 
            Console.WriteLine("House Type:  {0}", propType); 
            return 0; 
        } 
    } 

 نتیجه ی زیر را به دست می دهد.

House Type:  SingleFamily 
Press any key to continue… 
 

enumeration ین آیتم لیست در واقع لیستی از اعداد است که هر یک توسط اسم معینی شناسایی می شود. به صورت پیش فرض، اول

را دارد، در حالی که عضو  2مقدار  enumeration HouseType ،Unknownو غیره... برای مثال، در  8را دارد، دومی مقدار  2مقدار 

Townhouse  مقادیر گفته شده پیش فرض هستند. چنانچه، با مقادیر بالا موافق نیستید می توانید مقدار هر یک از اعضای لیست 2مقدار .

" = " داشته باشد، کافی است عملگر جایگزین  5فوق مقدار  enumerationدر  Unknownود تعیین کنید. برای مثال، اگر بخواهیم عضو را خ

 .را به کار ببرید. شمارنده به این ترتیب خواهد بود

    using System; 
    public class Exercise 
    { 
        enum HouseType { Unknown = 5, SingleFamily, TownHouse, Condominium } 
        static int Main() 
        { 
            return 0; 
        } 
    } 
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 8، به این خاطر که پس از عضوی قرار گرفته که مقدار آن 6مقدار  SingleFamilyرا خواهد داشت،  5، مقدار Unknownدر این مورد عضو 

را خواهد داشت. همچنین می توان مقداری را به  1مقدار  Condominiumو  4مقدار  Townhouse(. عضو 6 = 1 + 5می باشد )بنابراین 

 اختصاص داد. enumerationچندین عضو 

 مثال

    using System; 
    public class Exercise 
    { 
        enum HouseType { Unknown = 3, SingleFamily = 12, TownHouse, Condominium = 8 } 
        static int Main() 
        { 
            return 0; 
        } 
    } 

 می باشد.  82قرار گرفته که مقدار آن  SingleFamilyرا خواهد داشت زیرا پس از عضو  81مقدار  Townhouseدر این مثال، 

  enumerationقابلیت رویت، دسترسی به 

 enumeration، دسترسی به آن تنها از طریق پروژه ای امکان پذیر می باشد که در آن، enumerationایجاد به صورت پیش فرض، پس از 

را بیرون از پروژه اش مدیرت و تنظیم کرد. به  enumerationایجاد شده است. درست مثل کلاس، می توان )سطح دسترسی(  دسترسی به 

یا برعکس بیرون از پروژه اش آن را قابل رویت ساخت. برای این منظور، می توانید  را پنهان کرد enumerationعبارت دیگر، می توان 

 قرار دهید. نظر خود را به مثال زیر جلب کنید. enumerationرا پیش از  publicو  privateکلیدواژه ی های 

    using System; 
    public class Exercise 
    { 
        public enum HouseType 
        { 
            Unknown, 
            SingleFamily, 
            TownHouse, 
            Condominium 
        } 
        static int Main() 
        { 
            HouseType propType = HouseType.SingleFamily; 
            Console.WriteLine("House Type:  {0}", propType); 
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            return 0; 
        } 
    } 

enumeration به عنوان متغیر عضو 

، می توان از آن به عنوان یک نوع داده برای تعریف متغیر استفاده کرد. برای ایجاد فیلد )از( نوع enumerationپس از ایجاد 

enumeration رعایت می کردیم پیاده کنیم : اسم ، باید همان قوانینی را که برای داده های نوع اولیهenumeration به دنبال آن اسم ،

 . به مثال زیر توجه کنید :" ;" متغیر و نقطه ویرگول 

    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class House 
    { 
        HouseType propertyType; 
    } 

به همین ترتیب، می توان هر تعداد متغیر عضو که لازم است ایجاد کرد. پس از تعریف متغیر، برای مقداردهی اولیه ی آن، عضو دلخواه  

enumeration (enumeration member) .را به متغیر اختصاص دهید 

 مثال

    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class House 
    { 
        HouseType propertyType; 
        public House() 
        { 
            propertyType = HouseType.Unknown; 
        } 
    } 
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ولیه متغیر عضو، می توانید آن را هر طور که مایلید مورد استفاده قرار دهید. برای مثال، به منظور نمایش مقدار متغیر پس از مقداردهی ا

 ارسال کرد. به مثال زیر توجه کنید. ()Writelineیا  ()Writeعضو می توان آن را به متدهای 

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class House 
    { 
        public HouseType propertyType; 
        public House() 
        { 
            propertyType = HouseType.Unknown; 
        } 
        public void Display() 
        { 
            Console.WriteLine("Property Type: {0}", propertyType); 
        } 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var propType = new House(); 
            propType.Display(); 
            Console.WriteLine(); 
            propType.propertyType = HouseType.SingleFamily; 
            propType.Display(); 
            Console.WriteLine(); 
            return 0; 
        } 
    } 

نتیجه ی زیر حاصل می شود.   

Property Type: Unknown 
Property Type: SingleFamily 
Press any key to continue... 

 

بازمی گرداند. همچنین می توانید  enumerationچنانچه از آن به عنوان یک نوع داده ی ساده استفاده کنید، می توانید متدی ایجاد کنید که 

enumeration .را به عنوان یک آرگومان به متد ارسال کنید 
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 به عنوان آرگومان enumerationارسال 

ایجاد می شود، دیگر یک نوع تلقی می گردد. می توان آن را به عنوان آرگومان  enumerationر که پیش تر ذکر شد، پس از این که همان طو

 ارسال کرد یا آن را از یک متد بازگرداند. 

Enumeration .به همان شکلی که یک نوع داده ی معمولی فرستاده می شود، باید به عنوان آرگومان ارسال گردد 

 مثال

    public class Exercise 
    { 
        private static void ShowHouse(HouseType propType) 
        { 
        } 
    } 

به ( procedure)را در بدنه ی رویه   enumerationبه همین ترتیب، می توان هر تعداد نوع شمارشی که لازم است ارسال کرد. می توان  

 استفاده قرار داد یا آن را نادیده گرفت. هنگام فراخوانی رویه، آرگومانی را ارسال کنید که نوع مقدارش از نوع شمارشی باشد.کاربرد و مورد 

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown = 2, 
        SingleFamily = 4, 
        TownHouse = 6, 
        Condominium = 8, 
    } 
    public class Exercise 
    { 
        private static void ShowHouse(HouseType propType) 
        { 
            Console.WriteLine("Type of house: {0}", propType); 
        } 
        public static int Main() 
        { 
            HouseType ht; 
            ht = HouseType.SingleFamily; 
            ShowHouse(ht); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 
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 نتیجه

Type of house: SingleFamily 
 Press any key to continue... 

د، برای این که نشان دهیم آرگومان مقدار پیش فرض دارد و عضو دلخواه را به آن ارسال آرگومان می تواند اختیاری باشد. هنگام ایجاد مت

استفاده می کنیم. هنگام فراخوانی متد، می توان مقدار برای آرگومان گفته شده ارسال کرد یا از " = " اختصاص دهیم از عملگر جایگزین 

 ارسال آن صرف نظر کرد.

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown = 2, 
        SingleFamily = 4, 
        TownHouse = 6, 
        Condominium = 8, 
    } 
    public class Exercise 
    { 
        private static void ShowHouse(HouseType propType = HouseType.Unknown) 
        { 
            Console.WriteLine("Type of house: {0}", propType); 
        } 
        public static int Main() 
        { 
            HouseType ht; 
            ht = HouseType.SingleFamily; 
            ShowHouse(); 
            return 0; 
        } 
    } 

 

 ید.نتیجه ی زیر به دست می آ 

Type of house: Unknown 
  Press any key to continue... 

 enumتعریف و استفاده از نوع داده ای 

 را باز کنید.   Employee.csفایل  .8
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 ، فایل مذکور را به صورت زیر ویرایش نمایید:enumeration. برای ایجاد تعدادی 2

  public enum EmploymentStatus 
    { 
        FullTime, 
        PartTime, 
        Internship, 
        Unknown 
    } 
    public class Employee 
    { 
        public string EmployeeNumber; 
        public string FirstName; 
        public string LastName; 
        public string Title; 
        public double HourlySalary; 
        public EmploymentStatus Status; 
        public Employee(string emplNbr = "00-000", string fName = "John", 
                        string lName = "Doe", string function = "Temporary", 
                        double salary = 0.00, 
                        EmploymentStatus emplStatus = EmploymentStatus.Unknown) 
        { 
            EmployeeNumber = emplNbr; 
            FirstName = fName; 
            LastName = lName; 
            Title = function; 
            HourlySalary = salary; 
            Status = emplStatus; 
        } 
    } 

 را باز نمایید.  Management.cs. حال فایل 1

 ، فایل را  به صورت زیر ویرایش کنید:enumeration. برای استفاده از 4

  using System; 
    public class Management 
    { 
        private static Employee HireEmployee() 
        { 
            int? status = null; 
            Employee empl = new Employee(); 
 
            Console.Title = "National Bank"; 
            Console.WriteLine("======================================="); 
            Console.WriteLine("==-= National Bank =-=="); 
            Console.WriteLine("To hire a new employee, enter the following information"); 
            Console.WriteLine("---------------------------------------"); 
            Console.Write("Employee #:    "); 
            empl.EmployeeNumber = Console.ReadLine(); 
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            Console.Write("First Name:    "); 
            empl.FirstName = Console.ReadLine(); 
            Console.Write("Last Name:     "); 
            empl.LastName = Console.ReadLine(); 
            Console.Write("Title:         "); 
            empl.Title = Console.ReadLine(); 
            Console.Write("Hourly Salary: "); 
            empl.HourlySalary = double.Parse(Console.ReadLine()); 
            Console.WriteLine("Employment Status"); 
            Console.WriteLine("1. Full-Time"); 
            Console.WriteLine("2. Part-Time"); 
            Console.WriteLine("3. Intern"); 
            Console.Write("Your Choice? "); 
            Status = int.Parse(Console.ReadLine()); 
            empl.status = (EmploymentStatus)(status - 1); 
            Console.WriteLine("======================================="); 
            return empl; 
        } 
 
        private static void ShowEmployeeRecord(Employee empl) 
        { 
            Console.Title = "National Bank"; 
            Console.WriteLine("======================================="); 
            Console.WriteLine("==-= National Bank =-=="); 
            Console.WriteLine("    Employee Record"); 
            Console.WriteLine("---------------------------------------"); 
            Console.WriteLine("Employee #:        {0}", empl.EmployeeNumber); 
            Console.WriteLine("First Name:        {0}", empl.FirstName); 
            Console.WriteLine("Last Name:         {0}", empl.LastName); 
            Console.WriteLine("Employee Title:    {0}", empl.Title); 
            Console.WriteLine("Hourly Salary:     {0}", empl.HourlySalary); 
            Console.WriteLine("Employment Status: {0}", empl.Status); 
            Console.WriteLine("======================================="); 
        } 
        public static int Main() 
        { 
            Employee clerk = null; 
            clerk = HireEmployee(); 
            Console.Clear(); 
            ShowEmployeeRecord(clerk); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 را فشار دهید. F5. برای اجرای برنامه، کلید 5

 عات زیر را وارد نمایید:. اطلا6
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Employee # 42-855 
First Name Paula 
Last Name Meyer 
Title Cashier 
Hourly Salary 18.25 
Employment Status 2 

 

======================================= 
==-= National Bank =-== 
To hire a new employee, enter the following information 
--------------------------------------- 
Employee #:    42-855 
First Name:    Paula 
Last Name:     Meyer 
Title:         Cashier 
Hourly Salary: 18.25 
Employment Status 
1. Full-Time 
2. Part-Time 
3. Intern 
Your Choice? 2 

 را بزنید.  Enter. اکنون کلید 4

======================================= 
==-= National Bank =-== 
    Employee Record 
--------------------------------------- 
Employee #:        42-855 
First Name:        Paula 
Last Name:         Meyer 
Employee Title:    Cashier 
Hourly Salary:     18.25 
Employment Status: PartTime 
======================================= 

 خارج شوید و به محیط ویژوال برگردید. Dosرا زده تا از محیط  Enter. کلید 1
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 از متد enumerationبرگرداندن  

. در بدنه ی مشخص کنید enumerationباز می گرداند، نوع بازگشتی آن را به عنوان اسم  enumerationبرای ایجاد متدی که 

enumeration هر کاری که لازم است انجام دهید. پیش از خروج از متد، مطمئن شوید مقداری که بازمی گردانید از نوع شمارشی ،

(enumeration type) باشد. مثال زیر را در نظر بگیرید. 

    public class Exercise 
    { 
        private HouseType SpecifyPropertyType() 
        { 
            HouseType pt; 
            pt = HouseType.TownHouse; 
            return pt; 
        } 
    } 

 اد.می توان متدی را که نوع شمارشی بازمی گرداند با اسم آن فراخواند. می توان مقدار بازگشتی آن را برای این منظور مورد استفاده قرار د

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown = 2, 
        SingleFamily = 4, 
        TownHouse = 6, 
        Condominium = 8, 
    } 
    public class Exercise 
    { 
        private static void ShowHouse(HouseType propType = HouseType.Unknown) 
        { 
            Console.WriteLine("Type of house: {0}", propType); 
        } 
        private static HouseType SpecifyPropertyType() 
        { 
            HouseType pt; 
            pt = HouseType.TownHouse; 
            return pt; 
        } 
        public static int Main() 
        { 
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            HouseType ht; 
            ht = SpecifyPropertyType(); 
            ShowHouse(ht); 
            return 0; 
        } 
    } 
 

 .نتیجه ی زیر حاصل می گردد 

Type of house: TownHouse 
Press any key to continue... 

 طقیعملگرهای من

 مقدمه

درخواست می کند شرایط را بسنجد و بر اساس آن شرایط عمل کند. برای  compilerبرنامه در واقع مجموعه ای از دستور ها است که از 

عملیات  بررسی چنین شرایطی، کامپیوتر بخش عظیمی از زمان خود را صرف مقایسه ی مقادیر مختلف می کند. فرایند مقایسه در حقیقت همان

Boolean است که بسته به مقادیری که مقایسه بر پایه ی آن انجام شده نتیجه ی صحیح (true)  یا غلط(false)  .می دهد 

ر، مقایسه بین دو مقدار هم نوع صورت می گیرد ؛ برای مثال، می توان دو عدد، دو کاراکتر، اسامی دو شهر را با هم مقایسه کرد. از سوی دیگ

اوت )از نوع مختلف( کاملاً بی معنا می باشد. برای مثال، نمی توان یک شماره تلفن را با سن کسی مقایسه کرد یا مقایسه ی بین دو مقدار متف

، عملیات مقایسه بر اساس دو مقدار (binary)یک نوع موسیقی را با فاصله ی بین دو نقطه قیاس کرد. مشابه عملیات حسابی دودویی 

که نتایج حاصله آن متنوع و متفاوت هستند، نتیجه ی فرایند مقایسه از دو حالت خارج نیست به صورت می گیرد. بر خلاف عملیات حسابی 

 8 است. در صورتی که مقایسه صحیح باشد، مقدار توکار (logical false)یا منطقی ناصحیح  (logical true)طوری که نتیجه یا منطقی صحیح 

تلقی می  falseنباشد، غلط یا  trueبزرگتر باشد. چنانچه مقایسه صحیح یا  2است که از  یا مثبت را به دست می دهد، که منظور همان مقداری

 خواهد بود.  2گردد و مقدار آن 

مجهز به عملگرهای گوناگونی است که به کمک آن ها می توان هر قسم مقاسیه ای بین مقادیر هم نوع انجام داد. مقادیر نام برده  #Cزبان 

یا  operator overloadingع رشته و یا اشیاء باشند )عملیاتی که بر روی اشیا صورت می گیرد در فرایندی به نام می توانند عددی، از نو

 اضافه بارگذاری عملگر، اختصاصی تنظیم می شوند. 

 .هنگام نوشتن دستورات شرطی )دستوراتی که در شرطی ها به کار می روند( یک سری ملزومات اولیه هست که باید رعایت کرد
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سادگی و وضوح : یک دستور باید کاملاً واضح و تا حد ممکن ساده ولی در عین حال کامل باشد. زمانی که دستوری طولانی می گردد، ممکن 

 است به بخش های کوتاه مختلفی تقسیم شود که وضوح دستور را مختل کرده و منجر به بروز مسائل و مشکلات متعددی می شود.

باید به عنوان یک حقیقت عرضه شود و نه یک نظر یا عقیده، به این معنا که لزومی ندارد شما آن دستور را دوست  واقعی : دستور مورد نظر

بپذیرید. در حقیقت، نیازی نیست که دستور به خودی خود  (false)یا غلط ( true)داشته باشید بلکه باید مثل اکثریت آن را به عنوان صحیح 

دقیقه هست " لزومی ندارد با نظر  45ه عنوان صحیح پذیرفت. بر این اساس، دستوری مثل اینکه " یک ساعت درست باشد بلکه باید آن را ب

شما همخوانی داشته باشد بلکه باید یا به عنوان صحیح یا غلط پذیرفته شود. دستوری مثل " این متقاضی شغل گزینه ی مناسبی است " یک 

 ایی ندارد. نظر می باشد، بنابراین در دستورات شرطی ج

درستی ضمنی و وابسته به موقعیت : زمانی که دستوری نوشته یا ایجاد می شود باید به عنوان صحیح یا غلط پذیرفته شود، اگرچه ممکن 

روز خواهد  21است بعده ها تغییر کند. برای مثال، تصور کنید در سال مشخصی دستوری به این صورت نوشته شود " امسال ماه فبریه 

 اگرچه استفاده از آن مجاز می باشد، باید تا حد ممکن از به کاربردن آن خودداری کرد، مگر در شرایط اضطراری.  داشت ".

معکوس : باید این امکان وجود داشته باشد که یک دستور عکس خود را پیدا کند. به عبارت روشن تر، زمانی که دستوری نوشته و به عنوان 

ستور ضد یا مغایری باید وجود داشته باشد که آن را عکس کند )از غلط به صحیح و بالعکس(. برای مثال، صحیح یا غلط پذیرفته می شود، د

ساله  81سال سن دارد " باید این امکان وجود داشته باشد که بگویید " این متقاضی کار  81چنانچه دستوری دارید مانند " این متقاضی کار  

 سال به نظر می رسد ".  81از نیست " یا " این متقاضی کار جوان تر 

 سعی کنید تا حد ممکن دستورات خود را دقیق و واضح بیان و تنظیم کنید. با این کار برنامه های شما خوانا می شوند و عیب زدایی آن آسان

 می گردد. 

 عملگر تساوی ==

 باشد.را به کار می برد. فرمول آن به شرح زیر می == عملگر  #Cبرای مقایسه ی دو متغیر، 

value1 == Value2  

رند اعملیات تساوی به منظور کشف برابری بین دو متغیر )یا یک متغیر و یک ثابت( بکار می رود؛ به عبارت دیگر، ایا دو متغیر مقدار یکسانی د

با هم یکسان یا  valueدو را با هم مقایسه می کند. چنانچه مقدار این  value2و  value1از طریق دستور نحوی، مقدار  compilerیا نه. 

را به دست می دهد، اما در صورتی که دو متغیر فوق با هم متفاوت باشند )مقدار آن ها  trueبرابر بود، عملیات مقایسه نتیجه ی صحیح یا 

 را ارائه می دهد.  falseباهم برابر نباشد(، مقایسه نتیجه ی غلط یا 
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یرد، برای دستورات شرطی به کار گرفته می شود. نتیجه ی پروسه ی مقایسه را می توان به صورت می گ #Cاغلب مقایسه هایی که در زبان 

 یک متغیر نیز اختصاص داد. برای ذخیره ی نتیجه ی مقایسه، لازم است عملیات مقایسه را داخل پرانتز قرار دهید.

 مثال

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var value1 = 15; 
            var value2 = 24; 
            Console.Write("Value 1 = "); 
            Console.WriteLine(value1); 
            Console.Write("Value 2 = "); 
            Console.WriteLine(value2); 
            Console.Write("Comparison of value1 == 15 produces "); 
            Console.WriteLine(value1 == 15); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

Value 1 = 15 
Value 2 = 24 
Comparison of value1 == 15 produces True 
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تفاوت قائل شد. عملگر جایگزین برای دادن مقداری جدید به متغیر به کار " == " و عملگر منطقی تساوی = " " لازم است بین عملگر جایگزین 

قرار می گیرد باید همیشه یک متغیر باشد و " = " که در سمت چپ  (operand). به یاد داشته باشید که عملوندی 244 =می رود مانند عدد 

مواجه می  errorی تخصیص دادن مقدار به کار نمی رود، و در صورت استفاده از آن برای این منظور با هیچگاه برا" == " نه یک ثابت. عملگر 

تنها برای مقایسه ی دو مقدار به کار می رود. عملوندی که در سمت چپ عملگر مزبور قرار می گیرد می تواند متغیر، ثابت " == " شوید. عملگر 

برنامه با  (compile)نانچه از یک عملگر به طور اشتباه به جای دیگری استفاده کنید هنگام ترجمه ی و یا یکی متغیر و دیگری ثابت باشد. چ

error  .مواجه می شوید 

 Notعملگر منطقی 

)یا  پس از تعریف و مقداردهی متغیر )این کار از طریق مقداردهی اولیه یا تغییر مقدار انجام می شود(، در واقع متغیر مذکور در برنامه زنده

حساب تمامی متغیرهای موجود در برنامه )و متغیرهایی  compilerایجاد( می شود. حال متغیر می تواند در عملیات لازم شرکت داشته باشد. 

که در حال پردازش هستند( را دارد. )چنانچه متغیری مورد استفاده قرار نگیرد یا برای پردازش در دسترس نباشد که در برنامه نویسی 

 #Cبه متغیر( کرد.  null)تخصیص مقدار  nullifyیرفعال تلقی می گردد( برای غیرفعال کردن متغیر )به طور موقت(، باید مقدار آن را غ مجازی

در نظر می گیرد. به منظور غیر فعال کردن )غیر قابل استفاده و از دسترس خارج ساختن آن(  sternباشد ( Null)متغیری را که مقدار آن تهی 

 را اعمال کنید. ترکیب نحوی آن به صورت زیر می باشد. " !"  Notین توسعه و شکل گیری برنامه، عملگر منطقی متغیر، ح

!Value 

دو گزینه ی اصلی پیش رو دارید. یکی از معمول ترین روش های استفاده از آن، بررسی وضعیت متغیر  Notبرای استفاده از عملگر منطقی 

 است. 

 را سمت چپ متغیر قرار دهید. مانند مثال زیر"  !" ، کافی است علامت تعجب  به متغیر nullبرای تخصیص مقدار   

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            bool hasAirCondition = true; 
            bool doesIt; 
            Console.Write("hasAirCondition = "); 
            Console.WriteLine(hasAirCondition); 
            doesIt = !hasAirCondition; 
            Console.Write("doesIt          = "); 
            Console.WriteLine(doesIt); 
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            return 0; 
        } 
    } 

 ی گردد.این نتیجه حاصل م

hasAirCondition = True 
doesIt= False 

را به آن تخصیص "  Not" یا فعال تلقی می شود. برای از دسترس خارج ساختن متغیر می توان عملگر " زنده " زمانی که متغیری مقداری دارد، 

یا  falseبود، حال به  8یا همان  trueمنطقی متغیر به متغیر، مقدار منطقی آن تغییر می یابد. اگر مقدار ( null)داد. پس از تخصیص مقدار تهی 

 تبدیل می شود. به این ترتیب می توان مقدار منطقی متغیر را معکوس کرد. 2

  > کوچکتر از : 

 را به کار ببرید. ترکیب نحوی عملگر نام برده به این شکل است. >برای کوچکتر نشان دادن مقداری از مقدار دیگر، عملگر 

Value1 < Value2 

 

  =>مساوی : یا  کوچکتر

ا دار بدو عملیات پیشین را می توان با هم ترکیب کرد و با استفاده از آن دو مقدار را با هم مقایسه کرد. با این کار متوجه می شوید که دو مق

 نحوی آن به ترتیب زیر می باشد.و دستور  =>هم برابرند یا مقدار اولی از مقدار دومی کوچک تر است. عملگر گفته شده به این شکل است : 

Value1 <= Value2 

http://articles.tahlildadeh.com/image.axd?picture=clip_image002_26.gif
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برابر باشد، نتیجه صحیح یا  value2و  value1درست مثل دو عمگلر پیشین، عملیات مقایسه انجام می دهد. در صورتی که مقدار  =>عملگر 

ه باشد که از مقدار عملوند دیگر، است، مقداری داشت value1مثبت به دست می آید. چنانچه عملوند طرف چپ، که در این مورد منظور 

value2 کمتر یا کوچکتر باشد نتیجه باز هم صحیح ،(true/positive) .خواهد بود 

 

  <بزرگتر از: 

 مورد استفاده قرار می گیرد. فرمول آن به صورت زیر است. <برای بزرگتر نشان دادن مقداری از مقدار دیگر، عملگر 

Value1 > Value2  

، می توانند متغیر باشند، یا عملگر سمت چپ متغیر و دیگری ثابت باشد. چنانچه مقدار واقع در value2و  value1گر، در این مثال هر دو عمل

سمت چپ عملگر بزرگتر از مقدار طرف راست آن بود، مقایسه نتیجه ی صحیح یا مثبت را به دست می دهد. در غیر این صورت، مقایسه نتیجه 

 ارائه می دهد. ( null)ی غلط یا تهی 

http://articles.tahlildadeh.com/image.axd?picture=clip_image003_15.gif
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  =<یا مساوی  بزرگتر 

. به این عملگر " بزرگتر از یا مساوی " می گویند. دستور =<دو عملگر بزرگتر از و تساوی با هم ترکیب شده و عملگر رو به رو را تولید می کند : 

 نحوی آن به صورت زیر است.

Value1 >= Value2 

اجرا می شود. چنانچه مقدار هر دو عملوند برابر باشد، مقایسه نتیجه ی صحیح یا  value2و  value1 عملیات مقایسه روی هر دو عملوند 

خواهد شد. حال اگر مقدار  (true)مثبت می دهد. در صورتی که مقدار عملوند چپ از مقدار عملوند راست بزرگتر باشد، باز هم نتیجه صحیح 

 خواهد شد.( null)ود، نتیجه ی فرایند غلط یا تهی عملوند سمت چپ از مقدار عملوند سمت راست کوچکتر ب
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 جدول زیر چکیده ی عملگرهای منطقی نام برده را فهرست می کند.

Operator Meaning Example Opposite  

== Equality to a == b != 

!= Not equal to 12 != 7 == 

<  Less than 25 < 84 >= 

<= Less than or equal 

to 

Cab <= Tab >  

>  Greater than 248 > 55 <= 

>= Greater than or 

equal to 

Val1 >= 

Val2 

<  

  

 دستورات شرطی

  چنانچه شرطی درست بود

لازم، عملگرهای  (expression) بدهد. به منظور ایجاد عبارت  (false)یا غلط  (true)دستور شرطی، عبارتی است که نتیجه ی صحیح 

Boolean ریم. در مبحث پیشین، با نحوه ی اجرإ عملیات و دریافت نتایج و به کاربردن آن ها آشنا شدیم. برای استفاده از را به کار می ب

 های شرطی خود را ارائه می دهد.  عملگر #C، زبان برنامه نویسی Booleanعملیات 

 عبارت های شرطی

8.      Microsoft Visual Studio .را راه اندازی کنید 

 کلیک کنید. ...File -> New Projectایجاد برنامه ی جدید، به فهرست گزینه ی اصلی مراجعه کرده، روی  برای      .2

 کلیک کنید. Empty Projectدر لیست میانی روی       .1
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 تغییر دهید. ElectronicStore2اسم پروژه را به       .4

 را بزنید. Enterکلید       .5

 ...ElectronicStore2 -> Add -> Classراست کلیک کرده سپس :  Class Viewجدید، در پنجره ی به منظور ایجاد کلاس       .6

 را کلیک کنید. Addانتخاب کرده، سپس  StoreItemاسم کلاس را       .4

 را به صورت زیر اصلاح کنید. StoreItem.csفایل       .1

    using System; 
    using System.Collections.Generic; 
    using System.Linq; 
    using System.Text; 
    namespace ElectronicStore2 
    { 
        public enum ItemsCategories 
        { 
            Unknown, 
            CablesAndConnectors, 
            CellPhonesAndAccessories, 
            Headphones, 
            DigitalCameras, 
            PDAsAndAccessories, 
            TelephonesAndAccessories, 
            TVsAndVideos, 
            SurgeProtectors, 
            Instructional 
        } 
        public class StoreItem 
        { 
            public long itemNumber; 
            public string name; 
            public ItemsCategories category; 
            public string manufacturer; 
            public string model; 
            public decimal unitPrice; 
            public StoreItem(long itmNbr = 0, string itemName = "N/A", 
                             ItemsCategories kind = ItemsCategories.Unknown, 
                             string make = "Unknown", string mdl = "Unspecified", 
                             decimal price = 0.00M) 
            { 
                itemNumber = itmNbr; 
                name = itemName; 
                category = kind; 
                manufacturer = make; 
                model = mdl; 
                unitPrice = price; 
            } 
        } 
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    } 
 
 

 

 

 ifایجاد شرط 

 برنامه زیر را در نظر بگیرید:

 
using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            return 0; 
        } 
    } 

 نتیجه

Enter the type of house you want to purchase 
1. Single Family 
2. TownHouse 
3. Condominium 
You Choice? 3          
Desired House Type: Unknown 
Press any key to continue... 
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به کار برده می شود. فرمول آن به  ifآن، عملگر  Booleanاست یا نه( و استفاده از نتیجه ی  true/به منظور بررسی عبارت )اینکه آیا صحیح 

 شرح زیر است.

if(Condition) Statement; 
Condition .می تواند از همان نوع عملیات بولی باشد که در درس پیش با آن شنا شدیم، به عبارت دیگر می تواند فرمول زیر را داشته باشد 

Operand1 BooleanOperator Operand2 
 

جرا می کند. اگر دستور مربوطه )دستوری که باید اجرا شود( را ا Statementنتیجه ی صحیح تولید کند، برنامه ی مفسر،  Conditionچنانچه 

 کوتاه بود، می توان آن را در خطی که شرط در آن بررسی می شود جای داد.

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) type = HouseType.SingleFamily; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            return 0; 
        } 
} 

 نتیجه
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Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
          
Desired House Type: SingleFamily 
Press any key to continue... 

 
 مثالنوشت یا جای گذاری کرد.  ifطولانی بود، باید آن را در خطی مجزا از عبارت شرط   Statementدر صورتی که 

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
            type = HouseType.SingleFamily; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            return 0; 
        } 
    } 

در تنها یک خط جا  ifا شرط  را در خطی مجزا از عبارت شرط قرار داد حتی اگر دستور مربوط آنقدر کوتاه باشد که ب Statementهمچنین می توان  

 شود. 

اغلب برای بررسی تنها یک شرط به کار می رود، می توان از آن برای اجرای چندین دستور وابسته و تابع استفاده  ifچه دستور )ساده ی(  اگر

 .مثال زیر توجه کنیدمحصور کنید. به  "{"و بسته ی  "}"کرد. برای بررسی چندین دستور، مجموعه دستورات را داخل کاراکتر باز 
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using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        TownHouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
            { 
                type = HouseType.SingleFamily; 
                Console.WriteLine("\nDesired House Type: {0}", type); 
            } 
            return 0; 
        } 
    } 

را حذف کنید، فقط دستوری که بلافاصله پس از شرط قرار گرفته اجرا می شود. همچنین می توان برای ایجاد دستور شرطی }{  چنانچه کاراکتر

if ،گزینه ی ، روی بخش مورد نظر )بخشی که مایلید کد در آن اضافه شود( راست کلیک کردهCode Snippet...  را انتخاب کنید. حال، روی

Visual C#  دوبار کلیک کنید. در لیست مورد نظر، رویif .کلیک کنید 

 ایجاد کرد. به مثال های زیر توجه کنید. ifهمچنین می توان چندین شرط  

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
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            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            return 0; 
        } 
    } 

 نمونه ای از برنامه

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 3   
 Desired House Type: Condominium 
 Press any key to continue... 

 ifبه کاربردن شرط ساده ی 

 کلیک کنید. ...Project -> Add New Itemبرای ایجاد فایل جدید، فهرست گزینه ی اصلی را باز کرده، روی       .8

 را انتخاب کنید. Code Fileدر لیست میانی، گزینه ی       .2

 را بزنید. Enterداده، کلید را تغییر  ElectronicStoreاسم فایل را به       .1

 در فایل خالی که در اختیار شما قرار می گیرد، دستورات زیر را وارد کنید.      .4

using System; 
    using ElectronicStore2; 
    public class Store 
    { 
        StoreItem CreateStoreItem() 
        { 
            int? category = null; 
            StoreItem sItem = new StoreItem(); 
            Console.Title = "Electronic Super Store"; 
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            Console.WriteLine("=-= Nearson Electonics =-="); 
            Console.WriteLine("******* Store Items ******"); 
            Console.WriteLine( 
            "To create a store item, enter its information"); 
            Console.Write("Item Number: "); 
            sItem.itemNumber = long.Parse(Console.ReadLine()); 
            Console.WriteLine("Category"); 
            Console.WriteLine("1.  Unknown/Miscellaneous"); 
            Console.WriteLine("2.  Cables and Connectors"); 
            Console.WriteLine("3.  Cell Phones and Accessories"); 
            Console.WriteLine("4.  Headphones"); 
            Console.WriteLine("5.  Digital Cameras"); 
            Console.WriteLine("6.  PDAs and Accessories"); 
            Console.WriteLine("7.  Telephones and Accessories"); 
            Console.WriteLine("8.  TVs and Videos - Plasma / LCD"); 
            Console.WriteLine("9.  Surge Protector"); 
            Console.WriteLine("10. Instructional and Tutorials (VHS & DVD)TVs and Videos"); 
            Console.Write("Your Choice? "); 
            category = int.Parse(Console.ReadLine()); 
            if (category == 1) 
                sItem.category = ItemsCategories.Unknown; 
            if (category == 2) 
                sItem.category = ItemsCategories.CablesAndConnectors; 
            if (category == 3) 
                sItem.category = ItemsCategories.CellPhonesAndAccessories; 
            if (category == 4) 
                sItem.category = ItemsCategories.Headphones; 
            if (category == 5) 
                sItem.category = ItemsCategories.DigitalCameras; 
            if (category == 6) 
                sItem.category = ItemsCategories.PDAsAndAccessories; 
            if (category == 7) 
                sItem.category = ItemsCategories.TelephonesAndAccessories; 
            if (category == 8) 
                sItem.category = ItemsCategories.TVsAndVideos; 
            if (category == 9) 
                sItem.category = ItemsCategories.SurgeProtectors; 
            if (category == 10) 
                sItem.category = ItemsCategories.Instructional; 
            Console.Write("Make:        "); 
            sItem.manufacturer = Console.ReadLine(); 
            Console.Write("Model:       "); 
            sItem.model = Console.ReadLine(); 
            Console.Write("Unit Price:  "); 
            sItem.unitPrice = decimal.Parse(Console.ReadLine()); 
            return sItem; 
        } 
        void DescribeStoreItem(StoreItem item) 
        { 
            Console.Title = "Electronic Super Store"; 
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            Console.WriteLine("=-= Nearson Electonics =-="); 
            Console.WriteLine("******* Store Items ******"); 
            Console.WriteLine("Store Item Description"); 
            Console.WriteLine("Item Number:   {0}", item.itemNumber); 
            Console.WriteLine("Category:      {0}", item.category); 
            Console.WriteLine("Make:          {0}", item.manufacturer); 
            Console.WriteLine("Model:         {0}", item.model); 
            Console.WriteLine("Unit Price:    {0:C}", item.unitPrice); 
        } 
        public static int Main() 
        { 
            Store st = new Store(); 
            StoreItem saleItem = st.CreateStoreItem(); 
            Console.Clear(); 
            st.DescribeStoreItem(saleItem); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 .کلیک کنید Debug -> Start Debuggingبه منظور اجرای برنامه، در فهرست گزینه ی اصلی، روی       .5

 .نیدرا بز Enterرا وارد کنید سپس  Item Number ،972485برای       .6

 .را وارد کنید 5عدد  your choiceبرای گزینه ی       .4

 .را بزنید Enterرا وارد کنید، سپس کلید  Canon)ساخت(،  makeبرای آیتم       .1

 .را بزنید Enterرا تایپ کرده و  model ،PowerShot SX20ISبرای آیتم       .1

 .را بزنید Enterتایپ کرده، اکنون  369.00 )قیمت محصول انتخابی(، unit price. برای گزینه ی 82

=-= Nearson Electonics =-= 
******* Store Items ****** 
To create a store item، enter its information 
Item Number: 972485 
Category 
1.  Unknown/Miscellaneous 
2.  Cables and Connectors 
3.  Cell Phones and Accessories 
4.  Headphones 
5.  Digital Cameras 
6.  PDAs and Accessories 
7.  Telephones and Accessories 
8.  TVs and Videos - Plasma / LCD 
9.  Surge Protector 
10. Instructional and Tutorials (VHS & DVD)TVs and Videos 
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Your Choice? 5 
Make:        Canon 
Model:       PowerShot SX20IS 
Unit Price:  369.00 

 

 .را بزنید Enter. کلید 88

=-= Nearson Electonics =-= 
  ******* Store Items ****** 
  Store Item Description 
  Item Number:   972485 
  Category:      DigitalCameras 
  Make:          Canon 
  Model:         PowerShot SX20IS 
  Unit Price:    $369.00 
  Press any key to continue... 

if...else 

 :زیر نمونه ای از آنچه در بخش پیشین آموختیم تشریح شده استدر 

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
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                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            if (type == HouseType.SingleFamily) 
                Console.WriteLine("\nDesired House Matched"); 
            return 0; 
        } 
    } 

های پیشین می توان دستور مربوطه  درآید، با توجه به گفته( true)استفاده بکنید ونتیجه ی آن صحیح  ifچنانچه برای اجرای عملیات از شرط   

 ifرا اجرا کرد. همان طور که در بخش پیشین به آن پرداختیم، هر نتیجه ی دیگری نادیده گرفته می شود. به عنوان یک جایگزین برای شرط  

 :ه ترتیب زیر استشود(. فرمول آن باجرا می  elseاجرا نشد  ifاستفاده می شود )به این معنا که اگر  elseچنین مواقعی از  در

if(Condition) 

            Statement1; 

        else 

            Statement2; 

باشد، مشابه آنچه در مبحث پیشین به آن پرداختیم. در  Booleanمی تواند یک عملیات  Conditionبه خاطر داشته باشید این بار هم 

را  Statement2بود، کامپایلر ( false)غلط  Conditionرا اجرا می کند. چنانچه  Statement1درست بود، کامپایلر  Conditionصورتی که 

 اجرا می کند.

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Program 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
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            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            if (type == HouseType.SingleFamily) 
                Console.WriteLine("Desired House Matched"); 
            else 
                Console.WriteLine("No House Desired"); 
            return 0; 
        } 
    } 

 برنامه نتیجه اجرای نمونه ای از

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 1 
 Desired House Type: SingleFamily 
 Desired House Matched 
 Press any key to continue... 

 

 نمونه ای دیگر

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 2 
 Desired House Type: Townhouse 
 No House Desired 
 Press any key to continue... 

 

 if...elseاستفاده از شرط 

 .را به ترتیب زیر اصلاح کنید ElectronicStore.csفایل  if...elseبه منظور استفاده از شرط     .8
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    using System; 
    using ElectronicStore2; 
    public class Store 
    { 
        StoreItem CreateStoreItem() 
        { 
            int? category = null; 
            decimal itemPrice = 0m; 
            StoreItem sItem = new StoreItem(); 
            Console.Title = "Electronic Super Store"; 
            Console.WriteLine("=-= Nearson Electonics =-="); 
            Console.WriteLine("******* Store Items ******"); 
            Console.WriteLine( 
            "To create a store item, enter its information"); 
            Console.Write("Item Number: "); 
            sItem.itemNumber = long.Parse(Console.ReadLine()); 
            Console.WriteLine("Category"); 
            Console.WriteLine("1.  Unknown/Miscellaneous"); 
            Console.WriteLine("2.  Cables and Connectors"); 
            Console.WriteLine("3.  Cell Phones and Accessories"); 
            Console.WriteLine("4.  Headphones"); 
            Console.WriteLine("5.  Digital Cameras"); 
            Console.WriteLine("6.  PDAs and Accessories"); 
            Console.WriteLine("7.  Telephones and Accessories"); 
            Console.WriteLine("8.  TVs and Videos - Plasma / LCD"); 
            Console.WriteLine("9.  Surge Protector"); 
            Console.WriteLine("10. Instructional and Tutorials (VHS & DVD)TVs and Videos"); 
            Console.Write("Your Choice? "); 
            category = int.Parse(Console.ReadLine()); 
            if (category == 1) 
                sItem.category = ItemsCategories.Unknown; 
            if (category == 2) 
                sItem.category = ItemsCategories.CablesAndConnectors; 
            if (category == 3) 
                sItem.category = ItemsCategories.CellPhonesAndAccessories; 
            if (category == 4) 
                sItem.category = ItemsCategories.Headphones; 
            if (category == 5) 
                sItem.category = ItemsCategories.DigitalCameras; 
            if (category == 6) 
                sItem.category = ItemsCategories.PDAsAndAccessories; 
            if (category == 7) 
                sItem.category = ItemsCategories.TelephonesAndAccessories; 
            if (category == 8) 
                sItem.category = ItemsCategories.TVsAndVideos; 
            if (category == 9) 
                sItem.category = ItemsCategories.SurgeProtectors; 
            if (category == 10) 
                sItem.category = ItemsCategories.Instructional; 
            Console.Write("Make:        "); 
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            sItem.manufacturer = Console.ReadLine(); 
            Console.Write("Model:       "); 
            sItem.model = Console.ReadLine(); 
            Console.Write("Unit Price:  "); 
            itemPrice = decimal.Parse(Console.ReadLine()); 
            if (itemPrice <= 0) 
                sItem.unitPrice = 0.00m; 
            else 
                sItem.unitPrice = itemPrice; 
            return sItem; 
        } 
        string GetItemCategory(ItemsCategories cat) 
        { 
            string strCategory = "Unknown"; 
            if (cat == ItemsCategories.CablesAndConnectors) 
                strCategory = "Cables & Connectors"; 
            if (cat == ItemsCategories.CellPhonesAndAccessories) 
                strCategory = "Cell Phones & Accessories"; 
            if (cat == ItemsCategories.Headphones) 
                strCategory = "Headphones"; 
            if (cat == ItemsCategories.DigitalCameras) 
                strCategory = "Digital Cameras"; 
            if (cat == ItemsCategories.PDAsAndAccessories) 
                strCategory = "PDAs & Accessories"; 
            if (cat == ItemsCategories.TelephonesAndAccessories) 
                strCategory = "Telephones & Accessories"; 
            if (cat == ItemsCategories.TVsAndVideos) 
                strCategory = "TVs & Videos"; 
            if (cat == ItemsCategories.SurgeProtectors) 
                strCategory = "Surge Protectors"; 
            if (cat == ItemsCategories.Instructional) 
                strCategory = "Instructional"; 
            return strCategory; 
        } 
        void DescribeStoreItem(StoreItem item) 
        { 
            string strCategory = GetItemCategory(item.category); 
            Console.Title = "Electronic Super Store"; 
            Console.WriteLine("=-= Nearson Electonics =-="); 
            Console.WriteLine("******* Store Items ******"); 
            Console.WriteLine("Store Item Description"); 
            Console.WriteLine("Item Number:   {0}", item.itemNumber); 
            Console.WriteLine("Category:      {0}", strCategory); 
            Console.WriteLine("Make:          {0}", item.manufacturer); 
            Console.WriteLine("Model:         {0}", item.model); 
            Console.WriteLine("Unit Price:    {0:C}", item.unitPrice); 
        } 
        public static int Main() 
        { 
            Store st = new Store(); 



 

434 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            StoreItem saleItem = st.CreateStoreItem(); 
            Console.Clear(); 
            st.DescribeStoreItem(saleItem); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 Debug -> Start Debuggingبرای اجرای برنامه, فهرست گزینه ی اصلی را باز کرده, سپس :     .2 

 .را فشار دهید Enterحال مقادیر را به ترتیب زیر وارد کنید و پس از هر کدام کلید     .1

=-= Nearson Electonics =-= 
 ******* Store Items ****** 
 To create a store item, enter its information 
 Item Number: 992052 
 Category 
 1.  Unknown/Miscellaneous 
 2.  Cables and Connectors 
 3.  Cell Phones and Accessories 
 4.  Headphones 
 5.  Digital Cameras 
 6.  PDAs and Accessories 
 7.  Telephones and Accessories 
 8.  TVs and Videos - Plasma / LCD 
 9.  Surge Protector 
 10. Instructional and Tutorials (VHS & DVD)TVs and Videos 
 Your Choice? 4 
 Make:        Sennheiser 
 Model:       HD-555 
 Unit Price:  104.00 

4.    Enter  بزنیدرا. 

=-= Nearson Electonics =-= 
******* Store Items ****** 
Store Item Description 
Item Number:   992052 
Category:      Headphones 
Make:          Sennheiser 
Model:         HD-555 
Unit Price:    $104.00 

 

 .امه نویسی برگردیدرا بسته و به محیط برن DOSاکنون پنجره ی     .5
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 if...elseعملگر های 

 (:?)عملگر سه تایی 

یا دستور دوم اجرا  elseغلط بود و اجرا نشد،  if)اگر  elseبررسی شود در غیر این صورت به عنوان  ifچنانچه شرطی دارید که ابتدا به عنوان 

 می باشد." : " و "  ?" شد(، می توان از عملگر سه تایی استفاده کرد که ترکیبی از

 فرمول

Condition ? Statement1 : Statement2; 

اجرا می  Statement2اجرا می شود، در غیر این صورت  Statement1درست بود  Conditionرا چک می کند. اگر  Conditionابتدا  کامپایلر

 .را مشخص می کند دو عدد را باهم مقایسه کرده و عدد بزرگ تر شود. برنامه ی زیر با استفاده از عملگر شرطی

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            var Number1 = 0; 
            var Number2 = 0; 
            var Maximum = 0; 
            var Num1 = ""; 
            var Num2 = ""; 
            Console.Write("Enter first numbers: "); 
            Num1 = Console.ReadLine(); 
            Console.Write("Enter second numbers: "); 
            Num2 = Console.ReadLine(); 
            Number1 = int.Parse(Num1); 
            Number2 = int.Parse(Num2); 
            Maximum = (Number1 < Number2) ? Number2 : Number1; 
            Console.Write("\nThe maximum of "); 
            Console.Write(Number1); 
            Console.Write(" and "); 
            Console.Write(Number2); 
            Console.Write(" is "); 
            Console.WriteLine(Maximum); 
            Console.WriteLine(); 
            return 0; 
        } 
    } 

 مثال
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Enter first numbers: 244 
Enter second numbers: 68 
The maximum of 244 and 68 is 244 

  " ??عملگر " 

ه، می توان یک علامت سوال به نوع داده اضافه کرد که از این طریق مشخص شود متغیر به خاطر دارید که هنگام تعریف متغیر )از( نوع اولی

 داشته باشد. nullableمذکور می تواند مقدار 

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            double? distance = null; 
            Console.WriteLine(); 
            return 0; 
        } 
    } 

باشد )به این معنا که مقداری نداشته  nullممکن است لازم شود مقدار چنین متغیری را به متغیر دیگری تخصیص دهید. چنانچه مقدار متغیر 

ا خواهد بود. بنابراین، ابتدا باید بررسی شود که مقدار متغیر مزبور، باشد یا مقدار آن تهی باشد(، دیگر تخصیص آن به متغیر دیگر بی معن

درخواست بررسی متغیر را می کنید تا مشخص شود مقدار آن مقداری تهی  compilerمقداری تهی است یا مقدار واقعی. به عبارت دیگر از 

 .است یا مقداری واقعی

 وان مقدار آن را به متغیر جدید تخصیص داددر صورتی که متغیر مقداری حقیقی دارد، نه تهی، می ت

 بود، مقداری جایگزین به متغیر نام برده اختصاص می دهید( null)چنانچه متغیر تهی 

 را در اختیار شما قرار می دهد. فرمول آن به ترتیب زیر است. "??"عملگر  #Cبرای پشتیبانی از این امکان، زبان 

TargetVariable = OriginalVariable ?? AlternateValue; 
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را تعریف کرده و این متغیر باید قادر به نگه داشتن مقدار تهی باشد که از طریق افزودن عملگر  OriginalVariableدر وهله ی اول لازم است 

و هم حین را پیش از مقداردهی اولیه تعریف کرد  TargetVariableبه آن امکان پذیر می شود. توجه داشته باشید که هم می توان  ?

 .را به کار می برد ??مقداردهی آن. لازم به ذکر است که هر دو متغیر باید سازگار با هم باشند. مثال ذیل عملگر 

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            double? distance = null; 
            double? fromTo = null; 
            Console.WriteLine("Distance 1: {0}", distance); 
            Console.WriteLine("Distance 2: {0}", fromTo); 
            fromTo = distance ?? 135.85; 
            Console.WriteLine("Distance 1: {0}", distance); 
            Console.WriteLine("Distance 2: {0}", fromTo); 
            Console.WriteLine(); 
            return 0; 
        } 
    } 

 .دو مفهوم زیر را می رساند ;fromTo = distance ?? 135.85دستور 

 .تخصیص دهید fromToبه متغیر  دارد، مقدار مورد نظر را( non-null)در حال حاضر مقدار غیر تهی  distanceاگر متغیر 

 را به آن تخصیص دهید 135.85در حال حاضر مقداری تهی دارد، مقدار  distanceاما اگر متغیر 

 .کد بالا نتیجه ی زیر را تولید می کند

Distance 1: 
Distance 2: 
Distance 1: 
Distance 2: 135.85      
Press any key to continue... 

 دیگر برنامهنسخه ی 

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            double? distance = null; 
            double? fromTo = null; 
            Console.WriteLine("Distance 1: {0}", distance); 
            Console.WriteLine("Distance 2: {0}", fromTo); 
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            Console.WriteLine("---------------------"); 
            fromTo = distance ?? 135.85; 
            Console.WriteLine("Distance 1: {0}", distance); 
            Console.WriteLine("Distance 2: {0}", fromTo); 
            Console.WriteLine("---------------------"); 
            distance = 8284.26; 
            fromTo = distance ?? 135.85; 
            Console.WriteLine("Distance 1: {0}", distance); 
            Console.WriteLine("Distance 2: {0}", fromTo); 
            Console.WriteLine(); 
            return 0; 
        } 
    } 

 این بار برنامه نتیجه ی زیر را ارائه می دهد.

Distance 1: 
 Distance 2: 
 --------------------- 
 Distance 1: 
 Distance 2: 135.85 
 --------------------- 
 Distance 1: 8284.26 
 Distance 2: 8284.26 
 Press any key to continue... 

if...else if  وif...else  

، می توان تنها دو دستور را پردازش کرد. در برخی موارد، لازم است چندین )بیش ازدو( دستور if...elseدر صورت استفاده از دستور شرطی 

 ستفاده کرد. فرمول آن به ترتیب زیر می باشد.ا if...else ifرا پردازش یا اجرا کنیم. برای این منظور می توان از شرط 

if(Condition1) Statement1; 

         else if(Condition2) Statement2 

 

اجرا می شود. چنانچه  Condition1 ،Statement1بودن ( true)را بررسی می کند. در صورت صحیح  Condition1کامپایلر ابتدا 

Condition1  غلط(false )پایلر بود، کامCondition2  را چک می کند. در صورت درست بودنCondition2 کامپایلر ،Statement2  را اجرا

 می کند. هر نتیجه ی دیگری نادیده گرفته می شود. توجه خود را به مثال زیر جلب کنید.

    using System; 
    public enum HouseType 
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    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) type = HouseType.SingleFamily; 
            else if (choice == 2) type = HouseType.Townhouse; 
            Console.Write("Does the house have an indoor garage (1=Yes/0=No)? "); 
            var answer = int.Parse(Console.ReadLine()); 
            if (answer == 1) 
                garage = "Yes"; 
            else 
                garage = "No"; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

 برنامه اجرای از نمونه ای

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Does the house have an indoor garage (1=Yes/0=No)? 1 
 Desired House Type: SingleFamily 
Has indoor garage?  Yes 
Press any key to continue... 

 برنامه اجرای دیگری ازنمونه ای 
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Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 2 
 Does the house have an indoor garage (1=Yes/0=No)? 6 
 Desired House Type: Townhouse 
 Has indoor garage?  No 
 Press any key to continue... 

 

خود به عنوان  #Cهمان طور که مشاهده می کنید تنها دو شرط ارزیابی شده اند. هر شرط دیگری غیر از این دو نادیده گرفته می شود. زبان 

 ایگزین در نظر می گیرد. فرمول آن به شرح زیر است.ج elseآخرین راه حل یک 

if(Condition1) 

    Statement1; 

else if(Condition2) 

    Statement2; 

else 

    Statement-n; 

if(Condition1) 

    Statement1; 

else if(Condition2) 

    Statement2; 

else if(Condition3) 

    Statement3; 

else 

    Statement-n; 

   

Compiler  اولین شرط را بررسی می کند. در صورت درست بودنCondition1 ،Statement1  اجرا می شود. چنانچهCondition2  صحیح

ی( آن اجرا می شود.  تفسیر کند، دستور همخوان )مربوطه trueرا به  Condition-nاجرا می شود. زمانی که کامپایلر  Statement2باشد، 

هر تعداد شرط  else ifغلط باشد، کامپایلر شرط بعدی را بررسی می کند. به عبارت دیگر، می توان با استفاده از دستور  Condition-nحال اگر 
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که لازم است شامل کرد. اگر پس از بررسی جمیع شرایط احتمالی، باز هم فکر می کنید ممکن است شرطی غیر منتظره وجود داشته باشد، می 

 مک بگیرید.ک elseتوانید از 

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            else if (choice == 2) 
                type = HouseType.Townhouse; 
            else if (choice == 3) 
                type = HouseType.Condominium; 
            else 
                type = HouseType.Unknown; 
            Console.Write("Does the house have an indoor garage (1=Yes/0=No)? "); 
            var answer = int.Parse(Console.ReadLine()); 
            if (answer == 1) 
                garage = "Yes"; 
            else 
                garage = "No"; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

 زیر مثالی از اجرای برنامه را مشاهده می کنید.
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Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 3 
 Does the house have an indoor garage (1=Yes/0=No)? 0 
 Desired House Type: Condominium 
 Has indoor garage?  No 
 Press any key to continue... 

 

 

 

 

 Switchدستورهای شرطی 

  Case switch ساختار شرطی 

نتیجه را ارزیابی و بررسی می کند و براساس  switchهنگام تعریف عبارت )که نتیجه ی آن به اجرای برنامه ی خاصی منجر می شود(، دستور 

 می گویند.  caseنتیجه ی احتمالی آن عبارت، دستور را اجرا می کند. به این نتیجه ی احتمالی 

)نتیجه ی ممکن( در صورت لزوم باید جداگانه اجرا شود. بدنه ی  caseفهرست شده و هر  switchنتایج حاصله در بدنه ی اصلی دستور 

 به صورت زیر می باشد. switchمحصور می شود. ترکیب نحوی دستور " { " و " } " داخل کاراکترهای  switch اصلی دستور

 
 
switch(Expression) 
{ 
    case Choice1: 
         Statement1; 
 break; 
    case Choice2: 
         Statement2; 
 break; 
    case Choice-n: 
         Statement-n; 
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 break; 
} 

اجرا می شود به  caseحذف کرد. به عبارت دقیق تر، پس از اینکه کد مورد نظر در  caseرا از  break، می توان کلید واژه ی ++Cدر زبان 

، #Cبعدی اجرا می شود که منجر به سردرگمی و بروز مشکلات در عملیات می شود. اما در زبان برنامه نویسی  break ،caseدلیل عدم وجود 

وقفه در کد ایجاد شود. پروسه ی ایجاد وقفه با استفاده از کلید واژه ی  caseبه منظور جلوگیری از بروز این رخداد، لازم است انتهای هر 

break .امکان پذیر می باشد 

و نوع  (enum)نده می باشد. به این خاطر که عضو شمار integerمورد بررسی قرار می گیرد یک عدد صحیح یا  caseعبارتی که در دستور 

مورد  switchهستند، از آن ها نیز می توان استفاده کرد. در مثال زیر دستور  integerفرم های دیگر  (char)داده های کاراکتر مورد نظر 

 استفاده قرار گرفته است.

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            switch (choice) 
            { 
                case 1: 
                    type = HouseType.SingleFamily; 
                    break; 
                case 2: 
                    type = HouseType.Townhouse; 
                    break; 
                case 3: 
                    type = HouseType.Condominium; 
                    break; 
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            } 
            Console.Write("Does the house have an indoor garage (1=Yes/0=No)? "); 
            var answer = int.Parse(Console.ReadLine()); 
            if (answer == 1) 
                garage = "Yes"; 
            else 
                garage = "No"; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

مزبور با کلیدواژه ی  caseبررسی می کند، گاهی احتمالاتی جز آنچه فهرست شده وجود دارد.  switchهنگام تصدیق نتایج احتمالی که دستور 

default  .مدیریت می شودcase  پیش فرض(default case ) زمانی لحاظ می شود که هیچ یک ازcase  شده با پاسخ یا نتیجه های فهرست

پیش فرض را مورد بررسی قرار می دهد به ترتیب زیر  caseکه  switchی عرضه شده همخوانی یا تطابق نداشته باشد. ترکیب نحوی دستور 

 می باشد.

switch(Expression) 
{ 
    case Choice1: 
         Statement1; 
 break; 
    case Choice2: 
         Statement2; 
 break; 
    case Choice-n: 
         Statement-n; 
 break; 
    default: 
         Other-Possibility; 
 break; 
} 

 

، هر #Cاما در زبان  نیست. break محسوب می شود نیازی به کلید واژه ی switchاین خاطر که آخرین قسمت به default ، بخش ++Cدر  

case  و بخشdefault انیزم خروج خود را داشته باشد که با کلید واژه ی باید مکbreak  .انجام می پذیرد 

 بنابراین، ورژن دیگر برنامه ی بالا به صورت زیر می باشد.

    using System; 
    public enum HouseType 
    { 
        Unknown, 
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        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            switch (choice) 
            { 
                case 1: 
                    type = HouseType.SingleFamily; 
                    break; 
                case 2: 
                    type = HouseType.Townhouse; 
                    break; 
                case 3: 
                    type = HouseType.Condominium; 
                    break; 
                default: 
                    type = HouseType.Unknown; 
                    break; 
            } 
            Console.Write("Does the house have an indoor garage (1=Yes/0=No)? "); 
            var answer = int.Parse(Console.ReadLine()); 
            if (answer == 1) 
                garage = "Yes"; 
            else 
                garage = "No"; 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

 

 نمونه ای از اجرای برنامه

Enter the type of house you want to purchase 
 1. Single Family 
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 2. Townhouse 
 3. Condominium 
 You Choice? 8 
 Does the house have an indoor garage (1=Yes/0=No)? 2 
   
 Desired House Type: Unknown 
 Has indoor garage?  No 
 Press any key to continue... 

 

به کار برد. به عنوان مثال، می توان با استفاده از حروف،  switchرا در دستور  ، می توان دیگر نوع های اعداد صحیحintگذشته از مقدار نوع 

case .ها را اعتبار سنجی کرد. به مثال زیر توجه کنید 

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            switch (choice) 
            { 
                case 1: 
                    type = HouseType.SingleFamily; 
                    break; 
                case 2: 
                    type = HouseType.Townhouse; 
                    break; 
                case 3: 
                    type = HouseType.Condominium; 
                    break; 
                default: 
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                    type = HouseType.Unknown; 
                    break; 
            } 
            Console.Write("Does the house have an indoor garage (y/n)? "); 
            var answer = char.Parse(Console.ReadLine()); 
            switch (answer) 
            { 
                case 'y': 
                    garage = "Yes"; 
                    break; 
                case 'Y': 
                    garage = "Yes"; 
                    break; 
                case 'n': 
                    garage = "No"; 
                    break; 
                case 'N': 
                    garage = "No"; 
                    break; 
                default: 
                    garage = "Not Specified"; 
                    break; 
            } 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

 از اجرای برنامهنمونه ای 

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 3 
Does the house have an indoor garage (y/n)? y 
  
Desired House Type: Condominium 
Has indoor garage?  Yes 
Press any key to continue... 

 switch دستورات شرطی 

 را اجرا کنید. Microsoft Visual Studioابتدا       .8
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 کلیک کنید. ...File -> New Projectیجاد برنامه ی جدید، در فهرست گزینه ی اصلی، روی برای ا      .2

 را انتخاب کنید. Empty Projectدر لیست میانی، گزینه ی       .1

 را بزنید. Enterتغییر دهید و کلید  NationalBank3اسم پروژه را به       .4

 کلیک کنید. ...Project -> Add New Itemگزینه ی اصلی مراجعه کرده،  به منظور ایجاد فایل جدید، به فهرست      .5

 را از لیست میانی انتخاب کنید. Code Fileگزینه ی       .6

 انتخاب کنید. Customerاسم فایل مورد نظر را       .4

 را کلیک کنید. Addحال       .1

 را به صورت زیر اصلاح کنید. Customer.csفایل       .1

    public enum AccountType { Checking, Saving, Other } 
    public class Customer 
    { 
        public string AccountNumber; 
        public AccountType Type; 
        public string FullName; 
        public double Balance; 
        public short PIN; 
        public Customer(string acnt = "000-000000-000",AccountType category = AccountType.Other,string name = "John Doe") 
        { 
            AccountNumber = acnt; 
            Type = category; 
            FullName = name; 
            PIN = 0; 
            Balance = 0.00D; 
        } 
    } 

 <- NationalBank3راست کلیک کرده سپس :  NationalBank3روی  Solution Explorer. برای ایجاد فایل جدید، در پنجره ی 82

Add -> New Item... 

 را بزنید. Enterید تغییر دهید و کل Managementدر لیست میانی باید حتماً انتخاب شده باشد. اسم آن را به  Code File. گزینه ی 88

 . فایل مورد نظر را به ترتیب زیر تکمیل کنید.82

using System; 
    public class Management 
    { 
        private Customer CreateNewAccount() 
        { 
            byte typeOfAccount = 0; 
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            Customer client = new Customer(); 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.Write("Enter a number for the new account(000-000000-000): "); 
            client.AccountNumber = Console.ReadLine(); 
            Console.WriteLine("What type of account the customer wants to open"); 
            Console.WriteLine("1 - Checking Account"); 
            Console.WriteLine("2 - Savings Account"); 
            Console.Write("Enter account type: "); 
            typeOfAccount = byte.Parse(Console.ReadLine()); 
            if (typeOfAccount == 1) 
                client.Type = AccountType.Checking; 
            else if (typeOfAccount == 2) 
                client.Type = AccountType.Saving; 
            else 
                client.Type = AccountType.Other; 
            Console.Write("Enter customer name: "); 
            client.FullName = Console.ReadLine(); 
            Console.Write("Ask the customer to enter a PIN: "); 
            client.PIN = short.Parse(Console.ReadLine()); 
            return client; 
        } 
        public double GetMoney() 
        { 
            double amount = 0; 
            Console.Write("Amount: "); 
            amount = double.Parse(Console.ReadLine()); 
            return amount; 
        } 
        private void ShowAccountInformation(Customer cust) 
        { 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("Customer Account Information"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.WriteLine("Account #:    {0}", cust.AccountNumber); 
            Console.WriteLine("Account Type: {0}", cust.Type); 
            Console.WriteLine("Full Name:    {0}", cust.FullName); 
            Console.WriteLine("PIN #:        {0}", cust.PIN); 
            Console.WriteLine("Balance:      {0:F}", cust.Balance); 
            Console.WriteLine("==========================================="); 
        } 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
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            accountHolder = registration.CreateNewAccount(); 
            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.GetMoney(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            Console.WriteLine("What do you want to do now?"); 
            Console.WriteLine("1 - Check account balance"); 
            Console.WriteLine("2 - Make a deposit"); 
            Console.WriteLine("3 - Withdraw money"); 
            Console.WriteLine("4 - Transfer money from one account to another"); 
            nextAction = byte.Parse(Console.ReadLine()); 
            switch (nextAction) 
            { 
                case 1: 
                    break; 
                case 2: 
                    Console.Write("Enter the Deposit "); 
                    amount = double.Parse(Console.ReadLine()); 
                    accountHolder.Balance = accountHolder.Balance + amount; 
                    break; 
                case 3: 
                    Console.Write("Enter the Withdrawal "); 
                    amount = double.Parse(Console.ReadLine()); 
                    accountHolder.Balance = accountHolder.Balance - amount; 
                    break; 
                case 4: 
                    Console.WriteLine("Operation not available: You have only one account with us"); 
                    break; 
            } 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 را بزنید تا برنامه اجرا شود. F5. کلید 81

 . اکنون اطلاعات مورد نیاز را به ترتیب زیر وارد کنید.84

 

 
 
 
 
 

 

Account # 202-410443-240 

Account Type: 1 

Customer Name: Paul Martin Eloundou 
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=========================================== 
==-= National Bank =-====================== 
------------------------------------------- 
Enter a number for the new account(000-000000-000)202-410443-240 
What type of account the customer wants to open 
1 - Checking Account 
2 - Savings Account 
Enter account type: 1 
Enter customer name: Paul Martin Eloundou 
Ask the customer to enter a PIN: 8402 
Enter the customer's initial deposit 
Amount: 750 

85 .Enter .را بزنید 

=========================================== 
 ==-= National Bank =-====================== 
 Customer Account Information 
 ------------------------------------------- 
 Account #:    202-410443-240 
 Account Type: Checking 
 Full Name:    Paul Martin Eloundou 
 PIN #:        8402 
 Balance:      750.00 
 =========================================== 
 What do you want to do now? 
 1 - Check account balance 
 2 - Make a deposit 
 3 - Withdraw money 
 4 - Transfer money from one account to another  
 

 را فشار دهید. Enterرا تایپ کرده، سپس  2. در مرحله ی بعدی 86

 را بزنید. Enterوارد کنید و باز  226.85. مبلغ را رقم 84

 خارج گشته و به محیط برنامه نویسی بازگردید. DOS. از پنجره ی 81

PIN: 8402 

Initial Deposit: 750 
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Case های ترکیبی 

هایی که تاکنون به کار برده ایم، تنها یک احتمال را پیش از اجرای دستور مربوطه  درنظر گرفته و بررسی می کرد. همچنین می  caseک از هر ی

، سپس مقدار و نقطه caseرا با هم ترکیب کرد. برای نیل به این هدف، ابتدا  caseتوان برای اجرای دستور مرتبط )همان دستور( چندین 

های مورد نظر، می توان دستور دلخواه  caseدیگری تایپ کنید. پس از ایجاد  caseوارد کنید. حال، با استفاده از فرمول نام برده  ویرگول را

 را اجرا کرد.

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            switch (choice) 
            { 
                case 1: 
                    type = HouseType.SingleFamily; 
                    break; 
                case 2: 
                    type = HouseType.Townhouse; 
                    break; 
                case 3: 
                    type = HouseType.Condominium; 
                    break; 
                default: 
                    type = HouseType.Unknown; 
                    break; 
            } 
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            Console.Write("Does the house have an indoor garage (y/n)? "); 
            var answer = char.Parse(Console.ReadLine()); 
            switch (answer) 
            { 
                case 'y': 
                case 'Y': 
                    garage = "Yes"; 
                    break; 
                case 'n': 
                case 'N': 
                    garage = "No"; 
                    break; 
                default: 
                    garage = "Not Specified"; 
                    break; 
            } 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
            return 0; 
        } 
    } 

 نتیجه ی زیر به دست می آید.

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 3 
 Does the house have an indoor garage (y/n)? Y 
 Desired House Type: Condominium 
 Has indoor garage?  Yes 
 Press any key to continue... 

 Enumerationاستفاده از 

را به  enumerationید مقدار می باشد. برای این منظور، با switch، پردازش آن در دستور enumerationیکی از اصلی ترین کاربردهای 

switch  ارسال کرد. مقادیرenumeration  سپس در دستوراتcase .پردازش می شوند 

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
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        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var PropertyType = ""; 
            var choice = 0; 
            var garage = ""; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            switch ((HouseType)choice) 
            { 
                case HouseType.SingleFamily: 
                    PropertyType = "Single Family"; 
                    break; 
                case HouseType.Townhouse: 
                    PropertyType = "Townhouse"; 
                    break; 
                case HouseType.Condominium: 
                    PropertyType = "Condominium"; 
                    break; 
                default: 
                    PropertyType = "Unknown"; 
                    break; 
            } 
            Console.Write("Does the house have an indoor garage (y/n)? "); 
            var answer = char.Parse(Console.ReadLine()); 
            switch (answer) 
            { 
                case 'y': 
                case 'Y': 
                    garage = "Yes"; 
                    break; 
                case 'n': 
                case 'N': 
                    garage = "No"; 
                    break; 
                default: 
                    garage = "Not Specified"; 
                    break; 
            } 
            Console.WriteLine("\nDesired House Type: {0}", PropertyType); 
            Console.WriteLine("Has indoor garage?  {0}", garage); 
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            return 0; 
        } 
    } 

 نمونه ای از اجرای برنامه

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Does the house have an indoor garage (y/n)? N 
Desired House Type: Single Family 
Has indoor garage?  No 
Press any key to continue... 

 AND عطف منطقی 

 مقدمه

 .د با یک خریدار بالقوه ملاقات دارد و سوالات زیر را از برنامه می پرسدتصور کنید دلال املاک و مستغلاتی که از برنامه ی شما استفاده می کن

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Program 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var value = 0D; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
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                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.Write("Up to how much can you afford? $"); 
            value = double.Parse(Console.ReadLine()); 
            Console.WriteLine("\nDesired House Type:      {0}", type); 
            Console.WriteLine("Maximum value afforded:  {0:C}\n", value); 
            return 0; 
        } 
    } 

می خواهد ولی توان پرداخت  (single family house)نوار تصور کنید مشتری به این سوالات پاسخ می دهد : می گوید که خانه ی تک خا

 .را ندارد 550،000$بیش از 

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Up to how much can you afford? $550000 
Desired House Type:      SingleFamily 
Maximum value afforded:  $550،000.00 
Press any key to continue... 

 

 ههنگام بررسی خانه برای چنین مشتریی، دو پارامتر باید در نظر گرفته و اعتبار سنجی شود : خانه ی مذکور باید برای تک خانوار تعبیه شد

 .ساس، دو دستور به شکل زیر می نویسیمباشد. بر این ا 550،001$باشد و قیمت آن زیر مبلغ 

a. The house is single family 
b. The house costs less than $550،000 

 

 یاز لیست املاک و مستغلات، چنانچه خانه ای با این مشخصه )تک خانوار بودن آن( پیدا کریدم آن را داخل فهرست املاک مورد نظرمان قرار م

 .دهیم

Type of House House 

The house is single family True 
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 .یا پایین تر از آن، خانه را بررسی می کنیم 550،000$از سوی دیگر، در صورت پیدا کردن خانه ای با قیمت 

 

Price Range Value 

$550،000 True 

  

را انتخاب می کنیم که )هر( دو مشخصه ی فوق را دارا  یکی از راه های ترکیب دو مقایسه، پیوند دادن آن ها است. برای مشتری مزبور خانه ای

خواهد بود. اگر قیمت خانه بیش از ( false)باشد، طبق خواسته ی مشتری، مقدار شرطی آن غلط  town houseباشد. اگر خانه ی مورد نظر 

 .ناصحیح خواهد بود Boolean Valueباشد، باز هم مقدار  $550،000

 

Type of House House Value Result 

Town House $625،000 Town House AND $625،000 

False False False 

  

 اجرا می شود. &&با  AND، عملگر بولی #Cدر 

 مثال

     using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 



 

458 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

            var type = HouseType.Unknown; 
            var choice = 0; 
            var value = 0D; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            Console.Write("Up to how much can you afford? $"); 
            value = double.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.WriteLine("\nDesired House Type:      {0}", type); 
            Console.WriteLine("Maximum value afforded:  {0:C}", value); 
            if (type == HouseType.SingleFamily && value <= 550000) 
                Console.WriteLine("\nDesired House Matched"); 
            return 0; 
        } 

}     

  

 نمونه ای از اجرای برنامه 

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Up to how much can you afford? $450000 
Desired House Type:      SingleFamily 
Maximum value afforded:  $450،000.00 
Desired House Matched 
Press any key to continue... 

 

ر بهبود خوانایی برنامه، می توان هر طرف شرط دو شرط را با هم ادغام می کند. به منظو( logical conjunction)اساساً، ترکیب عطفی منطقی 

 را داخل پرانتز جای داد.
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 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var value = 0D; 
               . . . 
            if ((type == HouseType.SingleFamily) && (value <= 550000)) 
                Console.WriteLine("\nDesired House Matched"); 
            return 0; 
        } 
    } 

پیدا کردیم. پس اولین شرط لازم برای مشتری برآورده شد. به کمک عملگر بولی ( single family)تصور کنید خانه ای با مشخصه ی اول 

AND ،مبلغ مورد نیاز از قدرت خرید مشتری فراتر است  750،500$، به سراغ معیار دوم می رویم. تصور کنید خانه ای که در نظر گرفته ایم :

، اگر هم شرط اول درست باشد، در صورت ناصحیح بودن شرط ANDاست(. در جبر بولی  falseاست. بنابراین، شرط دوم برآورده نمی شود )

 .یا معیار دوم کل شرط غلط تلقی می گردد

Type of House House Value Result 

Single Family $750،500 Single Family AND $750،500 

True False False 

  

 مثال

     using System; 
    public enum HouseType 
    { 
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        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    class Program 
    { 
        static void Main() 
        { 
            var type = HouseType.Unknown; 
            int choice; 
            var value = 0M; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.Write("Up to how much can you afford? $"); 
            value = decimal.Parse(Console.ReadLine()); 
            Console.WriteLine("\nDesired House Type:      {0}", type); 
            Console.WriteLine("Maximum value afforded:  {0:C}", value); 
            if (type == HouseType.SingleFamily && value <= 550000) 
                Console.WriteLine("\nDesired House Matched"); 
            else 
                Console.WriteLine("\nThe House Doesn't Match the Desired Criteria"); 
        } 

}     

 نمونه ای از اجرای برنامه 

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Up to how much can you afford? $750000          
Desired House Type:      SingleFamily 
Maximum value afforded:  $750،000.00          
The House Doesn't Match the Desired Criteria 
Press any key to continue... 
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هزینه بر می دارد. اگرچه دومین شرط صحیح  420،000$ی چندین خانوار( پیدا کرده ایم که )برا townhouseحال تصور کنید خانه ی از نوع 

 .کلاً غلط می شود ANDاست، اولین معیار در نظر گرفته نشده. در جبر بولی، چنانچه حتی یکی از شرایط ناصحیح باشد، عملیات 

Type of House House Value Result 

Town House $420،000 Town House AND $420،000 

False True False 

  

 مثالی از اجرای برنامه، زیر قابل مشاهده می باشد :

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 2 
 Up to how much can you afford? $420000 
 Desired House Type:      Townhouse 
 Maximum value afforded:  $420،000.00 
 The House Doesn't Match the Desired Criteria 
 Press any key to continue... 
 

تی که هر دو ،پیدا کنیم، هر دو شرط برآورده می شود. در جبر بولی، در صور345,000$با قیمت  (single family)چنانچه خانه ای تک خانوار 

 .محسوب می شود trueنیز  ANDشرط صحیح باشند، عملیات 

 

Type of House House Value Result 

Single Family $345،000 Single Family AND $345،000 

True True True 
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 نمونه ای از اجرای برنامه ی بالا را زیر رویت می کنید.

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 1 
 Up to how much can you afford? $345000 
 Desired House Type:      SingleFamily 
 Maximum value afforded:  $345،000.00 
 Desired House Matched 
 Press any key to continue... 

 .جدول بالا را می توان به صورت زیر ادامه داد چهار

If Condition1 is If Condition2 is Condition1 AND Condition2 

False False False 

False True False 

True False False 

True True True 

  

دو شرط درست باشند. در برخی موارد لازم است ارزیابی می شود که هر  trueهمان طور که مشاهده می کنید عطف منطقی تنها زمانی به 

چندین شرط )بیش از دو شرط( را با هم ادغام یا ترکیب کنیم. تصور کنید مراجعه کننده ای قصد خرید خانه ای با گنجایش ظرفیت یک خانوار 

(single family house ) و مجهز به پارکینگ(indoor garage)   به عبارت دیگر خانه ی مذکور باید  قیمت آن است را دارد. 450،000$که

 .سه شرط زیر را داشته باشد
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a. The house is a single family home 

b. The house costs less than $450،001 

c. The house has an indoor garage 

 برنامه ی زیر شرایط بالا را مورد بررسی قرار می دهد.

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var value = 0D; 
            var hasIndoorGarage = false; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.Write("Up to how much can you afford? $"); 
            value = double.Parse(Console.ReadLine()); 
            Console.Write("Does the house have an indoor garage (1=Yes/0=No)? "); 
            int ans = int.Parse(Console.ReadLine()); 
            Console.WriteLine("\nDesired House Type:      {0}", type); 
            Console.WriteLine("Maximum value afforded:  {0:C}", value); 
            Console.Write("House has indoor garage: "); 
            if (ans == 1) 
                Console.WriteLine("Yes"); 
            else 
                Console.WriteLine("No"); 
            if ((type == HouseType.SingleFamily) && (value <= 550000) && (ans == 1)) 
                Console.WriteLine("\nDesired House Matched"); 
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            else 
                Console.WriteLine("\nThe House Doesn't Match the Desired Criteria"); 
            return 0; 
        } 
    }   

ابتدا شرط اول را چک می کند سپس شرط دوم را مورد  compilerهمان طور که پیش تر ذکر شد، زمانی که دو شرط با هم ترکیب می شوند، 

در وهله ی اول درستی اولین شرط را ارزیابی می  compilerبررسی قرار می دهد. به همین ترتیب، چنانچه لازم است سه شرط لحاظ شود، 

 کند.

Type of House 

A 

Town House 

False 

  

ط باشد، کل شرط نادرست اطلاق می گردد ، صرفنظر از نتیجه ی شرط دوم. اگر شرط اول صحیح در صورتی که شرط اول )یا هر یک از شروط( غل

 بود، شرط دوم ارزیابی می شود.

Type of House Property Value 

A B 

Single Family $655،000 

True False 

  

 چنانچه شرط دوم نادرست بود، کل ترکیب غلط تلقی می گردد.
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A B A && B 

True False False 

حین ارزیابی سه شرط بالا اگر شرط اول یا دوم ناصحیح باشد، به دلیل اینکه کل شرط نادرست محسوب می شود، دیگر دلیلی برای بررسی 

شرط سوم وجود ندارد. اگر هر دو شرط اول و دوم غلط باشند باز هم ارزیابی شرط سوم لزومی ندارد. فقط در صورت صحیح بودن دو شرط 

 شرط سوم ارزیابی می شود. مذکور

Type of House Property Value Indoor Garage 

A B C 

Single Family $425،650 None 

True True False 

بار دیگر، چنانچه شرط سوم نادرست باشد، کل  .A && B && Cترکیبی از سه شرط بالا در عطف منطقی بدین صورت نمایش داده می شود : 

 شرط غلط می شود.

A B A && B C A && B && C 

True True True False False 

  

 مثال

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
Up to how much can you afford? $425000 
Does the house have an indoor garage (1=Yes/0=No)? 0  



 

466 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

Desired House Type:      SingleFamily 
Maximum value afforded:  $425،000.00 
House has indoor garage: No 
The House Doesn't Match the Desired Criteria 
Press any key to continue... 

 

A B C A && B && C 

False Don't Care Don't Care False 

True False Don't Care False 

True True False False 

 .در نظر گرفته می شود که هر سه شرط درست باشند( true)کل شرط تنها زمانی صحیح 

 A B C A && B && C 

False False False False 

False False True False 

True False False False 

True False True False 

False True False False 

False True True False 

True True False False 

True True True True 
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  : or فصل منطقی

 مقدمه

را دارد. کلیه  condominiumو  single family ،townhouseحال در نظر بگیرید بنگاه معملات املاک هر سه نوع خانه ی 

یک طبقه، برخی دو طبقه و تعدادی دارای سه طبقه می باشند.  single familyها فقط یک طبقه دارند. برخی از خانه های   condominiumی

 سه طبقه ای می باشند.  townhouseولی تمامی خانه های 

، condoمی پسندد. حال چنانچه شرکت ما چه خانه داشته باشد چه  condominiumمراجعه کننده ی دیگری قصد خرید خانه را دارد و وی 

قه باشد )مشتری به هر دلیلی تمایل به بالا رفتن از پله ها را ندارد(. هنگام بررسی املاک بنگاه، با در نظر گرفتن شرط نباید بیشتر از یک طب

 بالا، دستور های زیر را می نویسیم.

a. The property is a condominium 

b. The property has one story 

 ها تنها یک طبقه دارند، معیار موردنظر برآورده می شود.  condoی ، به این خاطر که کلیه condoدر صورت پیدا کردن 

 Type of House House 

Condominium True 

 املاک دیگر، به خصوص آن دسته ای که بیش از یک طبقه دارند، نادیده گرفته می شوند.

Number of Stories Value 

3 False 

ارزیابی  falseاول به صحیح، دیگر عملوند دوم را ارزیابی نمی کند. چنانچه عملوند اول به در صورت ارزیابی عملوند  (||) orعملگر شرطی 

در قالب جدول  orبه صحیح یا غلط ارزیابی شود. ترتیب عملیات  orشود، این عملوند دوم است که تعیین یا مشخص می کند که کل عبارت 

 زیر به نمایش گذاشته شده است.
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Condominium One Story Condominium OR 1 Story 

True False True 

 مثال

    using System; 
    public enum HouseType 
    { 
        Unknown, 
        SingleFamily, 
        Townhouse, 
        Condominium 
    } 
    public class Exercise 
    { 
        static int Main() 
        { 
            var type = HouseType.Unknown; 
            var choice = 0; 
            var stories = 1; 
            Console.WriteLine("Enter the type of house you want to purchase"); 
            Console.WriteLine("1. Single Family"); 
            Console.WriteLine("2. Townhouse"); 
            Console.WriteLine("3. Condominium"); 
            Console.Write("You Choice? "); 
            choice = int.Parse(Console.ReadLine()); 
            if (choice == 1) 
                type = HouseType.SingleFamily; 
            if (choice == 2) 
                type = HouseType.Townhouse; 
            if (choice == 3) 
                type = HouseType.Condominium; 
            Console.Write("How many stories? "); 
            stories = int.Parse(Console.ReadLine()); 
            Console.WriteLine("\nDesired House Type: {0}", type); 
            Console.WriteLine("Number of Stories:  {0}", stories); 
            if ((type == HouseType.Condominium) || (stories == 1)) 
                Console.WriteLine("\nDesired House Matched"); 
            else 
                Console.WriteLine("\nThe House Doesn't Match the Desired Criteria"); 
            return 0; 
        } 
    } 

 نمونه ای از اجرای برنامه
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Enter the type of house you want to purchase 

1. Single Family 

2. Townhouse 

3. Condominium 

You Choice? 3 

How many stories? 6  

Desired House Type: Condominium 

Number of Stories:  6  

Desired House Matched 

Press any key to continue... 

 

 .وجود ندارد. در این صورت، دیگر املاک را در نظر می گیریم condominiumاکنون تصور کنید بین املاک موجود در بنگاه، هیچ 

  

Type of House House 

Single Family False 

موجود است، به دنبال آن خانه ای می گردیم که فقط یک طبقه داشته باشد. در صورت پیدا  single familyچنانچه تعداد محدودی گزینه ی 

 .کردن گزینه ی مورد نظر، شرط دوم برآورده می شود

Type of House One Story Condominium OR 1 Story 

False True True 

 مثال

Enter the type of house you want to purchase 
1. Single Family 
2. Townhouse 
3. Condominium 
You Choice? 1 
 How many stories? 1 
 Desired House Type: SingleFamily 
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 Number of Stories:  1   
 Desired House Matched 
 Press any key to continue... 
 

را در املاک موجود پیدا کنیم که یک طبقه داشته باشد، هر دو شرط لازم برآورده می شود. جدول زیر این  condominiumاگر گزینه ی 

 .عملیات را به نمایش می گذارد

Type of House One Story Condominium OR 1 Story 

False True True 

True True True 

  

 .ثال بالا را نمایش می دهدبرنامه ی زیر م

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 3 
 How many stories? 1          
 Desired House Type: Condominium 
 Number of Stories:  1          
 Desired House Matched 
 Press any key to continue... 
 

 تولید می کند که هر دو شرط غلط باشند. falseتنها زمانی کلاً نتیجه ی  orعملیات بولی 

If Condition1 is If Condition2 is Condition1 OR Condition2 

False True True 

True False True 

True True True 
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False False False 

  

 مثالی دیگر

Enter the type of house you want to purchase 
 1. Single Family 
 2. Townhouse 
 3. Condominium 
 You Choice? 2 
 How many stories? 2          
 Desired House Type: Townhouse 
 Number of Stories:  2          
 The House Doesn't Match the Desired Criteria 
 Press any key to continue... 

 فصل های ترکیبی

 گاهی اوقات لازم است به جای دوشرط، سه شرط ارزیابی شود. برای این منظور از فصل های ترکیبی کمک گرفته می شود.

 نحوه ی شمارش در حلقه

 تکرار/ حلقه ی شرطی

 ارزیابی شود.  falseای دستور مورد نظر ادامه می دهد تا شرط بیان شده حلقه یک نوع دستور شرطی است که به بررسی شرط و اجر

 معرفی تکرار شرطی

8.      Microsoft Visual Studio  .را اجرا کنید 

 کلیک کنید. ...File -> New Projectبرای ایجاد برنامه ی جدید، در فهرست گزینه ی اصلی، روی       .2

 را از لیست میانی انتخاب کنید. Empty Projectگزینه ی       .1

 را بزنید. Enterانتخاب کنید و کلید  NationalBank4اسم پروژه را       .4

 ....Project -> Add New Itemبه منظور ایجاد فایل جدید، به فهرست گزینه ی اصلی مراجعه کرده، سپس       .5

 ، واقع در لیست میانی کلیک کنید.Code Fileروی       .6
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 تغییر دهید. Customerاسم فایل مورد نظر را به       .4

 را کلیک کنید. Addحال       .1

 را به ترتیب زیر اصلاح کنید. Customer.csفایل       .1

    public enum AccountType { Checking, Saving, Other } 
    public class Customer 
    { 
        public string AccountNumber; 
        public AccountType Type; 
        public string FullName; 
        public double Balance; 
        public short PIN; 
        public Customer(string acnt = "000-000000-000", AccountType category = AccountType.Other,string name = "John Doe") 
        { 
            AccountNumber = acnt; 
            Type = category; 
            FullName = name; 
            PIN = 0; 
            Balance = 0.00D; 
        } 

}     

 NationalBank4 -> Add -> New، راست کلیک کرده سپس Solution Explorer. برای ایجاد فایل جدید، در پنجره ی 82

Item... . 

 را بزنید. Enterتغییر داده و کلید   Managementبهاز لیست میانی اسم مربوطه را  Code File. پس از انتخاب 88

 . فایل را به صورت زیر تکمیل کنید.82

    using System; 
    public class Management 
    { 
        private Customer CreateNewAccount() 
        { 
            byte typeOfAccount = 0; 
            Customer client = new Customer(); 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.Write("Enter a number for the new account(000-000000-000): "); 
            client.AccountNumber = Console.ReadLine(); 
            Console.WriteLine("What type of account the customer wants to open"); 
            Console.WriteLine("1 - Checking Account"); 
            Console.WriteLine("2 - Savings Account"); 
            Console.Write("Enter account type: "); 
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            typeOfAccount = byte.Parse(Console.ReadLine()); 
            if (typeOfAccount == 1) 
                client.Type = AccountType.Checking; 
            else if (typeOfAccount == 2) 
                client.Type = AccountType.Saving; 
            else 
                client.Type = AccountType.Other; 
            Console.Write("Enter customer name: "); 
            client.FullName = Console.ReadLine(); 
            Console.Write("Ask the customer to enter a PIN: "); 
            client.PIN = short.Parse(Console.ReadLine()); 
            return client; 
        } 
        public double GetMoney() 
        { 
            double amount = 0; 
            Console.Write("Amount: "); 
            amount = double.Parse(Console.ReadLine()); 
            return amount; 
        } 
        private void ShowAccountInformation(Customer cust) 
        { 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("Customer Account Information"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.WriteLine("Account #:    {0}", cust.AccountNumber); 
            Console.WriteLine("Account Type: {0}", cust.Type); 
            Console.WriteLine("Full Name:    {0}", cust.FullName); 
            Console.WriteLine("PIN #:        {0}", cust.PIN); 
            Console.WriteLine("Balance:      {0:F}", cust.Balance); 
            Console.WriteLine("==========================================="); 
        } 
        public static int Main() 
        { 
            return 0; 
        } 

}     

 Whileحلقه ی  

 از فرمول زیر استفاده کنید.while نام دارد. برای ایجاد حلقه ی  whileیکی از عملگرهایی که برای اجرای حلقه به کار می رود 

while(Condition) Statement; 



 

474 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

کلیک کنید. در  #Visual Cرا انتخاب کنید. حال دوبار روی لیِبلِ  ...Insert Snippetروی بخش دلخواه راست کلیک کرده، سپس گزینه ی 

 دوبار کلیک کنید. whileلیستی که نمایان می شود، روی 

اجرا می شود.  Condition ،Statementرا بررسی می کند. در صورت صحیح بودن  Conditionابتدا  while ،compilerبه منظور اجرای شرط 

به صورت تکرار  Statementباشد،  true /صحیح  Conditionبار دیگر بررسی می شود. مادام اینکه  Statement ،Conditionپس از اجرای 

 )به( غلط ارزیابی شود، حلقه اتمام یافته و از آن خارج می شود. Conditionچک می شود.  فقط زمانی که 

  

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var stories = 0; 
            while (stories <= 4) 
            { 
                Console.WriteLine("Number {0}", stories); 
                stories++; 
            } 
            return 0; 
        } 

}     

 ه ی زیر به دست می آید.نتیج

      Number 0  

        Number 1  
        Number 2  
        Number 3  
        Number 4  
   Press any key to continue… 

 
ر یا عبارت مورد نظر برای شرط، متغی در نظر بگیرید تا بتواند از مقدار ارجاع compiler، باید مکانیزمی برای whileبرای اجرای صحیح شرط 

فرم متغیری است که مقداردهی اولیه می شود، اگرچه ممکن است در قالب عبارت های دیگر نیز ظاهر  /استفاده کند )که گاهی در قالب 

  شود.به ترتیب زیر با مثال روشن می whileشود(. شرط 
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 whileبه کاربردن 

 را بدین صورت اصلاح کنید. Management.csفایل   .8

    using System; 
    public class Management 
    { 
        private int CreateNewAccount() 
        { 
            . . . No Change 
        } 
        public static int Main() 
        { 
            int? Counter = 1; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            while (Counter < 5) 
            { 
                accountHolder = registration.CreateNewAccount(); 
                Console.WriteLine("Enter the customer's initial deposit"); 
                accountHolder.Balance = registration.GetMoney(); 
                Console.Clear(); 
                registration.ShowAccountInformation(accountHolder); 
                Counter++; 
                Console.WriteLine("Press Enter for Next Action"); 
                Console.ReadKey(); 
                Console.Clear(); 
            } 
            return 0; 
        } 

}     

 .را بزنید F5رای اجرای برنامه می توانید کلید  .2

 طلاعات مورد نیاز را به ترتیب زیر وارد کنید.  .1

  

Account # 202-410443-240 

Account Type: 1 

Customer Name: Paul Martin Eloundou 
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PIN: 8402 

Initial Deposit: 750 

  

 Account #: 202-103344-042 

Account Type: 2 

Customer Name: Jimmy Simms 

PIN: 2468 

Initial Deposit 500 

  

Account # 410-240301-443 

Account Type: 2 

Customer Name: Eya Miri 

PIN: 1119 

Initial Deposit: 1500 

  

Account # 718-202404-240 

Account Type: 1 
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Customer Name: Alain Gassila 

PIN: 2226 

Initial Deposit: 220.8 

  

 .را بزنید Enter. اکنون 1

  do...while دستور 

 ، سپس دستور اجرا می شود. در صورت غلط بودن شرط، دستور هیچگاه اجرا نمی شود.ابتدا شرط بررسی می شود whileبا حلقه ی 

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var stories = 5; 
            while (stories <= 4) 
            { 
                Console.WriteLine("Number {0}", stories); 
                stories++; 
            } 
            return 0; 
        } 

}     

دن اجرا نمی شود، زیرا هنگامی که شرط در ابتدای امر بررسی می شود، به علت غلط بو whileزمانی که برنامه اجرا می شود هیچ چیز از حلقه ی 

هیچگاه به اجرای دستور نمی رسد. در برخی موارد ممکن است لازم شود دستوری را پیش از بررسی شرط آن برای اولین بار،  compilerآن، 

 را به کار ببرید. فرمول آن به شرح زیر است. do...whileاجرا کنید. برای این منظور دستور 

do while (Condition); 



 

478 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

صحیح بود،  Conditionرا بررسی می کند. اگر  Conditionرا اجرا می کند، به دنبال آن   Statementابتدا (do...while) دستور مزبور

به صورت تکرار اجرا می شود. زمانی که   Statementدرست باشد،  Conditionرا دوباره اجرا می کند. تا زمانی که  Statementسپس 

Condition  بهfalse ای مداوم دستور( به پایان می رسد.ارزیابی شود، تکرار )اجر 

و  ifقرار داد. مشابه دستورات  doچنانچه دستور مورد نظر کوتاه بود، به طور مثال متشکل از تنها یک خط بود، می توان به راحتی آن را پس از 

while ،Condition  دستورdo...while  دستور باید داخل پرانتز قرار داده شود. به خاطر داشته باشید که کلdo...while  باید به علامت

 ختم شود.   " ;" نقطه ویرگول 

 ورژن دیگری از برنامه ی بالا بدین صورت می باشد.  

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var stories = 0; 
            do 
                Console.WriteLine("Number {0}", stories++); 
            while (stories <= 4); 
            return 0; 
        } 

}     

 نتیجه ی زیر حاصل می گردد.

        Number 0  
        Number 1  
        Number 2  
        Number 3  
        Number 4  
     Press any key to continue... 

  
 بسته به پایان برسانید.  "{"باز آغاز کرده و با  "}"طولانی بوده و بیش از یک خط جا می گیرد، آن را با  مورد نظر Statementچنانچه 

 شمارش و تکرار

 را به ترتیب زیر اصلاح کنید. Management.csفایل      .8

     using System; 
    public class Management 
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    { 
           . . . No Change 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            accountHolder = registration.CreateNewAccount(); 
            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.GetMoney(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                Console.WriteLine("What do you want to do now?"); 
                Console.WriteLine("1 - Check account balance"); 
                Console.WriteLine("2 - Make a deposit"); 
                Console.WriteLine("3 - Withdraw money"); 
                Console.WriteLine("4 - Transfer money from one account to another"); 
                nextAction = byte.Parse(Console.ReadLine()); 
            } while ((nextAction < 1) || (nextAction > 4)); 
            switch (nextAction) 
            { 
                case 1: 
                    break; 
                case 2: 
                    Console.Write("Enter the Deposit "); 
                    amount = double.Parse(Console.ReadLine()); 
                    accountHolder.Balance = accountHolder.Balance + amount; 
                    break; 
                case 3: 
                    Console.Write("Enter the Withdrawal "); 
                    amount = double.Parse(Console.ReadLine()); 
                    accountHolder.Balance = accountHolder.Balance - amount; 
                    break; 
                case 4: 
                    Console.WriteLine("Operation not available: You have only one account with us"); 
                    break; 
            } 
            registration.ShowAccountInformation(accountHolder); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

2.     F5 .را زده تا برنامه اجرا شود 

 مقادیر مورد نیاز را بدین صورت وارد کنید.      .1
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Account Number: 301-240410-202 

Account Type: 1 

Customer Name: Frank Trombs 

PIN: 9731 

Initial Deposit: 40.1 

 را بزنید.  Enterحال کلید      .4

==========================================  
==-= National Bank =-======================  
Customer Account Information  
-------------------------------------------  
Account #:    301-240410-202  
Account Type: Checking  
Full Name:    Frank Trombs  
PIN #:        9731  
Balance:      40.10  
===========================================  
What do you want to do now?  
1 - Check account balance 
2 - Make a deposit 
3 - Withdraw money 
4 - Transfer money from one account to another 
Enter your choice: 

 

را  Enterرا تایپ کنید تا به حساب پول واریز شود سپس کلید  2زمانی شما پرسیده شد چه عملیاتی می خواهید انجام دهید،      .5

 فشار دهید.

 را بزنید. Enterوارد کرده و  125.85اکنون      .6

         ===========================================  
==-= National Bank =-======================  
Customer Account Information  
-------------------------------------------  
Account #:    301-240410-202  
Account Type: Checking  
Full Name:    Frank Trombs  
PIN #:        9731  
Balance:      165.95  
=========================================== 
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 بسته شده و به محیط برنامه نویسی بازگردانده می شوید. DOSپنجره ی  Enterپس از زدن . 4

 وید.از محیط برنامه نویسی خارج ش.1

  

 مدیریت دستورات شرطی

For 

به سه بخش تقسیم می شود.  forاغلب به منظور شمارش تعدادی آیتم مورد استفاده قرار می گیرد. در ساختار معمولَش، حلقه ی  forدستور 

ب شمارش را تعیین اولین بخش، نقطه ی آغاز شمارش را مشخص می کند. بخش دوم حد شمارش را تعیین می کند. آخرین بخش تکرار یا تناو

 به این صورت می باشد.  forمی کند. ترکیب نحوی حلقه ی 

for(Start; End; Frequency) Statement; 

مقدار آغازین یا  Startباشد ) ;Count = 0متغیری است که به عنوان مقدار اولیه )آغازین( تخصیص داده می شود که می تواند  Startعبارت 

 باشد(. 2می تواند  نقطه ی شروع حلقه است که

. مثال مذکور نشان می دهد که ;Count < 24انتهای فرایند شمارش را تعیین می کند )کجا شمارش به پایان برسد(. مثال  Endعبارت 

تا عددی  countنقطه ی پایان حلقه است که مشخص می کند مقدار  Endباشد ادامه می یابد ) 24که کوچکتر از  Countشمارش تا متغیر 

حساب نمی شود،  24می رسد، به این خاطر که در مثال مورد نظر خود عدد   24ادامه پیدا کند(. هنگامی که شمارش به  24چکتر از کو

 استفاده می شود.  =>یا  =<شمارش خاتمه می یابد. برای تعیین حد شمارش، از عملگرهای مقایسه ی 

به نقطه ابتدایی اضافه و یا کم  for)مقدار عددی که در هر بار تکرار حلقه مشخص می کند چه مقدار  compilerبرای  Frequencyعبارت 

 باشد. Count++شود( پیش از ادامه ی حلقه اضافه یا کسر کند. این عبارت می تواند عملیات افزایشی مثل 

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            for (var stories = 0; stories <= 4; stories++) 
                Console.WriteLine("Number {0}", stories); 
            return 0; 
        } 

}     
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 نتیجه ی زیر به دست می آید.

        Number 1  

        Number 2  

        Number 3  

        Number 4  

        Press any key to continue... 

 تودرتو کردن دستور شرطی

 .برنامه ی زیر را در نظر بگیرید

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var typeOfHome = 0; 
            do 
            { 
                Console.WriteLine("What Type of House Would you Like to Purchase?"); 
                Console.WriteLine("1 - Single Family"); 
                Console.WriteLine("2 - Town House"); 
                Console.WriteLine("3 - Condominium"); 
                Console.Write("Your Choice? "); 
                typeOfHome = int.Parse(Console.ReadLine()); 
            } while ((typeOfHome < 1) || (typeOfHome > 3)); 
            if (typeOfHome == 1) 
                Console.WriteLine("\nType of Home: Single Family"); 
            else if (typeOfHome == 2) 
                Console.WriteLine("\nType of Home: Town House"); 
            else if (typeOfHome == 3) 
                Console.WriteLine("\nType of Home: Condominium"); 
            return 0; 
        } 

}     

 پذیرفته نیست. 1و بیشتر از  8از کاربر استفاده می شود. هر عدد دیگری کمتر از  1یا  8،2نامه ی بالا به منظور درخواست یکی از اعداد از بر

 مثال

What Type of House Would you Like to Purchase?  
  1 - Single Family 
  2 - Town House 
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  3 - Condominium 
  Your Choice? 8  
  What Type of House Would you Like to Purchase?  
  1 - Single Family 
  2 - Town Hou     3 - Condominium 
  Your Choice? 6  
  What Type of House Would you Like to Purchase?  
  1 - Single Family 
  2 - Town House 
  3 - Condominium 
  Your Choice? 3  
  Type of Home: Condominium  
  Press any key to continue... 

اگر کاربر مقداری نامعتبر وارد کند، سوال بار دیگر تکرار می شود. برای حل این مسئله می توان دستور شرطی را داخل دستور شرطی دیگر 

 کردن دستور شرطی، زیر با مثال توضیح داده شده است.یا تودرتو کردن می گویند. نحوه ی تودرتو  nestingگنجاند )نوشت( که به آن 

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            var typeOfHome = 0; 
            do 
            { 
                Console.WriteLine("What Type of House Would you Like to Purchase?"); 
                Console.WriteLine("1 - Single Family"); 
                Console.WriteLine("2 - Townhouse"); 
                Console.WriteLine("3 - Condominium"); 
                Console.Write("Your Choice? "); 
                typeOfHome = int.Parse(Console.ReadLine()); 
                if ((typeOfHome < 1) || (typeOfHome > 3)) 
                    Console.WriteLine("Invalid Choice: Please try again"); 
            } while ((typeOfHome < 1) || (typeOfHome > 3)); 
            if (typeOfHome == 1) 
                Console.WriteLine("\nType of Home: Single Family"); 
            else if (typeOfHome == 2) 
                Console.WriteLine("\nType of Home: Townhouse"); 
            else if (typeOfHome == 3) 
                Console.WriteLine("\nType of Home: Condominium"); 
            return 0; 
        } 

}     

 مثالی دیگر
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What Type of House Would you Like to Purchase?  
 1 - Single Family 
 2 - Town House 
 3 - Condominium 
 Your Choice? 0  
 Invalid Choice: Please try again 
 What Type of House Would you Like to Purchase?  
 1 - Single Family 
 2 - Town House 
 3 - Condominium 
 Your Choice? 6  
 Invalid Choice: Please try againe 
 What Type of House Would you Like to Purchase?  
 1 - Single Family 
 2 - Town House 
 3 - Condominium 
 Your Choice? 2  
 Type of Home: Town House  
 Press any key to continue... 

 تودرتو کردن شرط ها

 را به ترتیب زیر اصلاح کنید. Management.csc. فایل 8

    using System; 
    public class Management 
    { 
        private Customer CreateNewAccount() 
        { 
              . . . No Change 
            return client; 
        } 
        public double GetMoney() 
        { 
            double amount = 0; 
            Console.Write("Amount: "); 
            amount = double.Parse(Console.ReadLine()); 
            return amount; 
        } 
        private void ShowAccountInformation(Customer cust) 
        { 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("Customer Account Information"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.WriteLine("Account #:    {0}", cust.AccountNumber); 
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            Console.WriteLine("Account Type: {0}", cust.Type); 
            Console.WriteLine("Full Name:    {0}", cust.FullName); 
            Console.WriteLine("PIN #:        {0}", cust.PIN); 
            Console.WriteLine("Balance:      {0:F}", cust.Balance); 
            Console.WriteLine("==========================================="); 
        } 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            accountHolder = registration.CreateNewAccount(); 
            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.GetMoney(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                Console.WriteLine("What do you want to do now?"); 
                Console.WriteLine("1 - Check account balance"); 
                Console.WriteLine("2 - Make a deposit"); 
                Console.WriteLine("3 - Withdraw money"); 
                Console.WriteLine("4 - Transfer money from one account to another"); 
                Console.Write("Enter your choice: "); 
                nextAction = byte.Parse(Console.ReadLine()); 
                Console.Clear(); 
                switch (nextAction) 
                { 
                    case 1: 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        Console.Write("Press Enter for next operation"); 
                        Console.ReadKey(); 
                        break; 
                    case 2: 
                        Console.Write("Enter Deposit "); 
                        amount = registration.GetMoney(); 
                        accountHolder.Balance = accountHolder.Balance + amount; 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 3: 
                        Console.Write("Enter Withdrawal "); 
                        amount = registration.GetMoney(); 
 
                        if (amount > accountHolder.Balance) 
                        { 
                            Console.WriteLine("You are not allowed to withdraw more money than your account has."); 



 

486 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

                            Console.ReadKey(); 
                        } 
                        else 
                            accountHolder.Balance = accountHolder.Balance - amount; 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 4: 
                        Console.WriteLine("Operation not available: You have only one account with us"); 
                        break; 
                } 
                if ((nextAction < 1) || (nextAction > 4)) 
                    Console.WriteLine("Invalid Action: Please enter a value between 1 and 4"); 
            } while ((nextAction >= 1) && (nextAction <= 4)); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

 .برنامه را اجرا کنید F5. با زدن کلید 2

 . اطلاعات لازم را به صورت  زیر وارد کنید.1

Account # 202-410443-240 

Account Type: 1 

Customer Name: Paul Martin Eloundou 

PIN: 8402 

Initial Deposit: 750 

  

 .را بزنید Enter. کلید 4

===========================================  
==-= National Bank =-======================  
Customer Account Information  
-------------------------------------------  
Account #:    202-410443-240  
Account Type: Checking  
Full Name:    Paul Martin Eloundou  
PIN #:        8402  
Balance:      750.00  



 

487 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

===========================================  
What do you want to do now?  
1 - Check account balance 
2 - Make a deposit 
3 - Withdraw money 
4 - Transfer money from one account to another 
Enter your choice: 

 .را فشار دهید Enterرا تایپ کنید تا از حساب پول برداشته شود، سپس کلید  3      .5

 .را بزنید Enterرا به عنوان مبلغ برداشتی تایپ کنید و  425.85      .6

 .را بزنید Enterرا وارد کرده و بعد کلید  2عدد  در مرحله ی بعد      .4

 .را بزنید Enterرا تایپ کنید و  22.84مبلغ       .1

=========================================== 
==-= National Bank =-======================  
 Customer Account Information  
 -------------------------------------------  
 Account #:    202-410443-240  
 Account Type: Checking  
 Full Name:    Paul Martin Eloundou  
 PIN #:        8402  
Balance:      346.99  
 ===========================================  
 What do you want to do now?  
 1 - Check account balance 
 2 - Make a deposit 
 3 - Withdraw money 
4 - Transfer money from one account to another 
 Enter your choice: 

 .را بزنید Enterرا وارد کنید و  3حال . 1

 را بزنید. Enterوارد کنید و  500مقدار مبلغ برداشتی را . 82

Enter Withdrawal Amount: 500  

You are not allowed to withdraw more money than your account has. 

88 .Enter  را بزنید. 

===========================================  
=-= National Bank =-======================  
ustomer Account Information  
------------------------------------------  
ccount #:    202-410443-240  
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ccount Type: Checking  
ull Name:    Paul Martin Eloundou  
IN #:        8402  
alance:      346.99  
==========================================  
hat do you want to do now?  
 - Check account balance 
 - Make a deposit 
 - Withdraw money 
 - Transfer money from one account to another 
nter your choice: 

 .را تایپ کنید 0. 82 

 .خارج گشته و به محیط برنامه نویسی باز گردید DOSاز  Enter. با زدن 81

 قفل کردن تراکنش

، خواهید دانست که امکان زمانی که شما به ایجاد برنامه های )کاربردی( سرویس گیرنده / سرویس دهنده یا منابع فشرده می پردازید

دسترسی چندین کاربر یا بیش از یک منبع به برنامه ی شما یا انجام عملیاتی بر شئی از برنامه ی شما وجود دارد. مثال آن تلاش چندین 

یط سعی دارید شخص بر افزودن رکورد یا خط جدید به یک فایل یکسان است. در برخی موارد با چنین رخدادی موافق هستید ولی در برخی شرا

 از بروز آن جلوگیری کنید. 

ز یبه منظور جلوگیری از دسترسی کاربر یا یک منبع به شئ از برنامه ی کاربردی مورد نظر، لازم است آن قسمت از تراکنش که عملیات در آن جا

 نیست قفل ایجاد شود. برای نیل به این هدف فرمول زیر را به کارببرید.

Declare a Variable 
lock(Variable) 
{ 
    // Do what you want here 
} 
// The variable has been released 

 نحوه ی قفل کردن تراکنش 

 را به صورت زیر اصلاح کنید. Management.csفایل      .8

using System; 
    public class Management 
    { 
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         . . . No Change 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            accountHolder = registration.CreateNewAccount(); 
            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.GetMoney(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                Console.WriteLine("What do you want to do now?"); 
                Console.WriteLine("1 - Check account balance"); 
                Console.WriteLine("2 - Make a deposit"); 
                Console.WriteLine("3 - Withdraw money"); 
                Console.WriteLine("4 - Transfer money from one account to another"); 
                Console.Write("Enter your choice: "); 
                nextAction = byte.Parse(Console.ReadLine()); 
                Console.Clear(); 
                // Don't allow wny other operation on this section 
                // while this section is executing 
                lock (registration) 
                { 
                    switch (nextAction) 
                    { 
                        case 1: 
                            Console.Clear(); 
                            registration.ShowAccountInformation(accountHolder); 
                            Console.Write("Press Enter for next operation"); 
                            Console.ReadKey(); 
                            break; 
                        case 2: 
                            Console.Write("Enter Deposit "); 
                            amount = registration.GetMoney(); 
                            accountHolder.Balance = accountHolder.Balance + amount; 
                            Console.Clear(); 
                            registration.ShowAccountInformation(accountHolder); 
                            break; 
                        case 3: 
                            Console.Write("Enter Withdrawal "); 
                            amount = registration.GetMoney(); 
                            if (amount > accountHolder.Balance) 
                            { 
                                Console.WriteLine( 
                  "You are not allowed to withdraw more money than your account has."); 
                                Console.ReadKey(); 
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                            } 
                            else 
                                accountHolder.Balance = accountHolder.Balance - amount; 
                            Console.Clear(); 
                            registration.ShowAccountInformation(accountHolder); 
                            break; 
                        case 4: 
                            Console.WriteLine( 
                          "Operation not available: You have only one account with us"); 
                            break; 
                    } 
                } 
                // Other objects can access this section now 
                if ((nextAction < 1) || (nextAction > 4)) 
                    Console.WriteLine("Invalid Action: Please enter a value between 1 and 4"); 
            } while ((nextAction >= 1) && (nextAction <= 4)); 
            Console.ReadKey(); 
            return 0; 
        } 

}     

 .تا برنامه اجرا شودرا زده  F5کلید      .2

 .کلیه ی مراحل بخش پیشین را دنبال کنید     .1

 .به محیط برنامه نویسی خود بازگردید     .4

 ایجاد وقفه در جریان دستور شرطی

 به منظور ایجاد وقفه در یک حلقه یا متوقف کردن آن به کار می رود. فرمول دستور مذکور به شرح زیر می باشد. breakدستور 

break;  

از تنها یک کلمه تشکیل شده است، اما به خودی خود یک دستور کامل تلقی می گردد؛بنابراین، باید همیشه در خط مختص به  breakاگرچه 

 خودش قرار گیرد )که به افزایش و بهبود خوانایی برنامه کمک شایانی می کند(. 

پس از آن در خط بعدی قرار گرفته( به کار بسته می شود،  breakصله برای نزدیک ترین دستور پیشین )دستوری که بلافا breakدستور 

به  forو همچنین در حلقه های  while ،do…whileدر شرط  breakالبته منوط به اینکه دستور مذکور )پیشین( قابل اجرا باشد. دستور  

شمرده می شود ولی با استفاده از دستور  82تا  8اختمان از منظور متوقف کردن عمل در حال اجرا بکار می رود. در مثال زیر تعداد طبقات یک س

break  برنامه متوقف می گردد. 1حین شمارش عدد 
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  using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            for (var stories = 1; stories <= 12; stories++) 
            { 
                Console.WriteLine("Story {0}", stories); 
                if (stories == 3) 
                    break; 
            } 
            return 0; 
        } 

}     

 نتیجه ی زیر به دست می آید.

        Story 1  
        Story 2  
        Story 3  
        Press any key to continue… 

 ادامه دادن دستور شرطی

 از فرمول زیر استفاده می کند. continueدستور 

continue; 

در دستورات  continueهنگام پردازش حلقه، چنانچه دستور مورد نظر به مقدار نادرستی برخورد کرد، شما می توانید با استفاده از دستور 

دستور بعدی را نادیده گرفته یا از مقدار غلط و نامعتبر بولی مستقیم به مقدار معتبر بعدی بروید )این  forو  while ،do...whileشرطی 

ترین دستور  نزدیکcontinue ، کلیدواژه ی breakمی باشد که به طور کلی از حلقه خارج می گردد(. مشابه دستور  breakبرخلاف دستور 

بشمارد، به نحوه ی  6تا  8یر قرار می دهد و باید در خطی مجزا قرار گیرد. مثال زیر باید طبقات یک ساختمان را از شرطی پیش از خود را تحت تاث

 در آن توجه کنید. continueاستفاده از دستور 

  using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            for (var stories = 1; stories <= 6; stories++) 
            { 
                if (stories == 3) 
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                    continue; 
                Console.WriteLine("Story {0}", stories); 
            } 
            return 0; 
        } 

}     

 نتیجه

        Story 1  
        Story 2  
        Story 4  
        Story 5  
        Story 6  
        Press any key to continue… 

 
می رسد آن را به طور کامل نادیده گرفته و بقیه ی فرایند را ادامه می  1هنگامی که به عدد  compilerهمان طور که مشاهده می کنید، 

 دهد.

 اصلاح مقداری در حلقه

دستور به مقدار معینی می رسد / داخل حلقه، می توان علامتی گذاشت که بر تکامل یک دستور نظارت می کند، از این طریق هنگامی که تگ 

کردن یک مقدار، چندین مقدار جلو برود( به مقدار دلخواه شما  skipبجای  /به جای نادیده گرفتن تنها یک مقدار )پریدن به اندازه ی یک مقدار

مه پرد. برای این منظور، در حلقه به مقدار جاری توجه کنید و زمانی که به مقدار مورد نظر رسید، آن را تغییر دهید. در مثال زیر از برنامی 

 بشمارد. 85تا  8خواسته شده از 

    using System; 
    public class Exercise 
    { 
        static int Main() 
        { 
            for (var story = 0; story < 15; story++) 
            { 
                if (story == 6) 
                    story = 10; 
                Console.WriteLine("Elevator at: {0}", story); 
            } 
            return 0; 
        } 

}     

 نتیجه
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        Elevator at: 0  
        Elevator at: 1  
        Elevator at: 2  
        Elevator at: 3  
        Elevator at: 4  
        Elevator at: 5  
        Elevator at: 10  
        Elevator at: 11  
        Elevator at: 12  
        Elevator at: 13  
        Elevator at: 14  
        Press any key to continue... 

 

 می پرد. 82، حلقه مستقیم به مقدار 6همان طور که مشاهده می کنید، به محض رسیدن به عدد 

 رفتن به لیبل تعیین شده

تعیین شده( لیبل  /یکی از دستورات پرش محسوب می شود که کنترل )اجرای برنامه( را به بخش )بخش نام گذاری شده  gotoدستور 

باید اسمی را در بخش مورد نظر در تابع درج کرد. لازم به ذکر است  gotoدیگری از تابع همان برنامه انتقال می دهد. برای استفاده از دستور 

لمه تنها یک ک که با لیبل )اسم( نشان می دهیم برنامه باید کنترل را به کجا در تابع همان برنامه انتقال دهد. حال، اسم یا لیبل متشکل از

تعریف کردیم پیروی می کند. اسم مورد نظر )اسم متواند هر چیزی باشد(، به دنبال آن  ++Cاست و از همان قوانینی که برای تعیین اسم در 

 طبقه ای را می شمارد. 84. زیر مثالی را مشاهده می کنید که در آن برنامه طبقات یک ساختمان ". "دونقطه 

   using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            for (var stories = 1; stories <= 14; stories++) 
            { 
                if (stories == 4) 
                    goto CountUpTo3; 
                Console.WriteLine("Story {0}", stories); 
            } 
        CountUpTo3: 
            Console.WriteLine("Our homes have only up to 3 levels\n"); 
            return 0; 
        } 

}     

 نتیجه
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        Story 1  
        Story 2  
        Story 3  
        Our homes have only up to 3 levels 
        Press any key to continue… 

 رفتن به یک لیبل

 را به ترتیب زیر اصلاح کنید. Management.csفایل   .8

using System; 
    public class Management 
    { 
         . . . No Change 
        public static int Main() 
        { 
              . . . No Change 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                  . . . No Change 
                lock (registration) 
                { 
                    switch (nextAction) 
                    { 
                        case 0: 
                            goto EndTime; 
                            break; 
                        case 1: 
                            Console.Clear(); 
                            registration.ShowAccountInformation(accountHolder); 
                            Console.Write("Press Enter for next operation"); 
                            Console.ReadKey(); 
                            break; 
                          . . . No Change 
                    } 
                } 
                if ((nextAction < 1) || (nextAction > 4)) 
                    Console.WriteLine("Invalid Action: Please enter a value between 1 and 4"); 
            } while ((nextAction >= 1) && (nextAction <= 4)); 
        EndTime: 
            Console.ReadKey(); 
            return 0; 
        } 

}     

2 .F5 را زده تا برنامه اجرا شود. 

 اطلاعات مورد نیاز را به صورت زیر وارد کنید.  .1
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Account #: 202-103344-042 

Account Type: 2 

Customer Name: Jimmy Simms 

PIN: 2468 

Initial Deposit 500 

 

 .را فشار دهید Enter. کلید 4

===========================================  
==-= National Bank =-======================  
Customer Account Information  
-------------------------------------------  
Account #:    202-103344-042  
  Account Type: Saving  
  Full Name:    Jimmy Simms  
  PIN #:        2468  
  Balance:      500.00  
  ===========================================  
  What do you want to do now?  
  1 - Check account balance 
  2 - Make a deposit 
  3 - Withdraw money 
  4 - Transfer money from one account to another 
  Enter your choice: 

 .را بزنید Enterرا وارد کنید تا سپرده ایجاد شود، سپس  2عدد   .5

 .را بزنید Enterرا به عنوان مبلغ واریزی وارد کنید و  328.66مقدار   .6

===========================================  
=-= National Bank =-======================  
ustomer Account Information  
------------------------------------------  
ccount #:    202-103344-042  
ccount Type: Saving  
ull Name:    Jimmy Simms  
IN #:        2468  
alance:      828.66  
==========================================  
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hat do you want to do now?  
 - Close the application 
 - Check account balance 
- Make a deposit 
 - Withdraw money 
- Transfer money from one account to another 
nter your choice: 

 .را بزنید Enterرا وارد کرده و  2اکنون      .4

 خارج گشته و به محیط برنامه نویسی بازگردید. DOSاز پنجره ی      .1

 برنامه نویسی را ببندید.محیط      .1

 شرط ها دستورات متدها و

 مقداری را از متد بازگرداندن

 تعریف می کنید، مقداری بازگردانده نمی شود. voidمستحضر هستید هنگامی که متد 

 مثال

    using System; 
    public class Exercise 
    { 
        private void Show() 
        { 
            Console.WriteLine("C# Programming is fun!!!"); 
        } 
        public static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.Show(); 
            return 0; 
        } 
    } 

خبر می دهد که زمان خروج از متد  compilerمقداری برنمی گرداند، با این کار به  عمل بازگرداندن را انجام می دهد ولی voidدر حقیقت، متد 

فراخوان می شود، هیچ مقدار یا نتیجه ای بازگردانده نمی شود و هیچ متغیری نمی توان تخصیص داد(.  voidفرا رسیده است )زمانی که متد 

 را تایپ کنید. به مثال زیر توجه کنید.return ه ی ، کافی است کلید واژvoidبرای این منظور، در بخش مناسب متد 

    using System; 
    public class Exercise 
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    { 
        private void Show() 
        { 
            Console.WriteLine("C# Programming is fun!!!"); 
            return; 
        } 
        public static int Main() 
        { 
            Exercise exo = new Exercise(); 
            exo.Show(); 
            return 0; 
        } 
    } 

در این مثال، عملیات بازگشت هیچ کار خاصی انجام نمی دهد. در بخش بعدی فایده ی استفاده ی آن در دستورات شرطی را توضیح خواهیم  

 داد.

 هامتدها و شرط  

8.      Microsoft Visual Studio  .را راه اندازی کنید 

 کلیک کنید. ...File -> New Projectبرای ایجاد برنامه ی جدید، در فهرست گزینه ی اصلی، روی       .2

 کلیک کنید. Empty Projectدر فهرست میانی، روی       .1

 را بزنید. Enterانتخاب کرده، سپس  NationalBank5اسم پروژه را       .4

 را انتخاب کنید. ...Project -> Add New Itemبه منظور ایجاد فایل جدید، فهرست اصلی را بازکرده و گزینه ی       .5

6.      Code File .را از لیست میانی انتخاب کنید 

 تغییر دهید. Customerاسم فایل را به       .4

 را کلیک کنید. Addاکنون       .1

 را به صورت زیر اصلاح کنید. Customer.csفایل       .1

    public enum AccountType { Checking, Saving, Other } 
    public class Customer 
    { 
        public string AccountNumber; 
        public AccountType Type; 
        public string FullName; 
        public double Balance; 
        public short PIN; 
        public Customer(string acnt = "000-000000-000", 
                        AccountType category = AccountType.Other, 
                        string name = "John Doe") 



 

498 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

        { 
            AccountNumber = acnt; 
            Type = category; 
            FullName = name; 
            PIN = 0; 
            Balance = 0.00D; 
        } 
    } 

 ....NationalBank5 -> Add -> New Item، راست کلیک کرده سپس : Solution Explorer. برای ایجاد فایل جدید، در پنجره ی 82

 را بزنید. Enterتغییر داده و کلید  Managementاز لیست میانی، اسم مورد نظر را به  Code File. پس از انتخاب 88

 . فایل را به ترتیب زیر اصلاح کنید.82

    using System; 
    public class Management 
    { 
        private Customer CreateNewAccount() 
        { 
            byte typeOfAccount = 0; 
            Customer client = new Customer(); 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.Write("Enter a number for the new account(000-000000-000): "); 
            client.AccountNumber = Console.ReadLine(); 
            Console.WriteLine("What type of account the customer wants to open"); 
            Console.WriteLine("1 - Checking Account"); 
            Console.WriteLine("2 - Savings Account"); 
            Console.Write("Enter account type: "); 
            typeOfAccount = byte.Parse(Console.ReadLine()); 
            if (typeOfAccount == 1) 
                client.Type = AccountType.Checking; 
            else if (typeOfAccount == 2) 
                client.Type = AccountType.Saving; 
            else 
                client.Type = AccountType.Other; 
            Console.Write("Enter customer name: "); 
            client.FullName = Console.ReadLine(); 
            Console.Write("Ask the customer to enter a PIN: "); 
            client.PIN = short.Parse(Console.ReadLine()); 
            return client; 
        } 
        public double GetMoney() 
        { 
            double amount = 0; 
            Console.Write("Amount: "); 
            amount = double.Parse(Console.ReadLine()); 
            return amount; 
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        } 
        private void ShowAccountInformation(Customer cust) 
        { 
            Console.WriteLine("==========================================="); 
            Console.WriteLine("==-= National Bank =-======================"); 
            Console.WriteLine("Customer Account Information"); 
            Console.WriteLine("-------------------------------------------"); 
            Console.WriteLine("Account #:    {0}", cust.AccountNumber); 
            Console.WriteLine("Account Type: {0}", cust.Type); 
            Console.WriteLine("Full Name:    {0}", cust.FullName); 
            Console.WriteLine("PIN #:        {0}", cust.PIN); 
            Console.WriteLine("Balance:      {0:F}", cust.Balance); 
            Console.WriteLine("==========================================="); 
            return; 
        } 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            accountHolder = registration.CreateNewAccount(); 
            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.GetMoney(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                Console.WriteLine("What do you want to do now?"); 
                Console.WriteLine("1 - Check account balance"); 
                Console.WriteLine("2 - Make a deposit"); 
                Console.WriteLine("3 - Withdraw money"); 
                Console.WriteLine("4 - Transfer money from one account to another"); 
                Console.Write("Enter your choice: "); 
                nextAction = byte.Parse(Console.ReadLine()); 
                Console.Clear(); 
                switch (nextAction) 
                { 
                    case 1: 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        Console.Write("Press Enter for next operation"); 
                        Console.ReadKey(); 
                        break; 
                    case 2: 
                        Console.Write("Enter Deposit "); 
                        amount = registration.GetMoney(); 
                        accountHolder.Balance = accountHolder.Balance + amount; 
                        Console.Clear(); 
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                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 3: 
                        Console.Write("Enter Withdrawal "); 
                        amount = registration.GetMoney(); 
                        if (amount > accountHolder.Balance) 
                        { 
                            Console.WriteLine("You are not allowed to withdraw more money than your account has."); 
                            Console.ReadKey(); 
                        } 
                        else 
                            accountHolder.Balance = accountHolder.Balance - amount; 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 4: 
                        Console.WriteLine( "Operation not available: You have only one account with us"); 
                        break; 
                } 
                if ((nextAction < 1) || (nextAction > 4)) 
                    Console.WriteLine("Invalid Action: Please enter a value between 1 and 4"); 
            } while ((nextAction >= 1) && (nextAction <= 4)); 
            Console.ReadKey(); 
            return 0; 
        } 
    } 

 بازگشت شرطی

بعضی از توابع با توجه به پردازشی که روی عملیات شرطی انجام می دهند مقداری را برمی گردانند. به عبارت دیگر، می توان دستور شرطی، 

 .لب کنید، داخل تابع نوشت و مقداری را از شرط مزبور بازگرداند. توجه خود را به مثال زیر جifمانند 

    using System; 
    public class Program 
    { 
        enum HouseType { Unknown, SingleFamily, Townhouse, Condominium }; 
        public static int Main() 
        { 
            var type = GetHouseType(); 
            switch (type) 
            { 
                case HouseType.SingleFamily: 
                    Console.WriteLine("\nType of Home: Single Family"); 
                    break; 
                case HouseType.Townhouse: 
                    Console.WriteLine("\nType of Home: Townhouse"); 
                    break; 
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                case HouseType.Condominium: 
                    Console.WriteLine("\nType of Home: Condominium"); 
                    break; 
                case HouseType.Unknown: 
                    Console.WriteLine("\nType of Home. Unknown"); 
                    break; 
            } 
            return 0; 
        } 
        private static HouseType GetHouseType() 
        { 
            var type = 0; 
            Console.WriteLine("What Type of House Would you Like to Purchase?"); 
            Console.WriteLine("1 - Single Family"); 
            Console.WriteLine("2 - Townhouse"); 
            Console.WriteLine("3 - Condominium"); 
            Console.Write("Your Choice? "); 
            type = int.Parse(Console.ReadLine()); 
            if (type == 1) 
                return HouseType.SingleFamily; 
            else if (type == 2) 
                return HouseType.Townhouse; 
            else if (type == 3) 
                return HouseType.Condominium; 
        } 
    } 

ند چه زمانی یکی از سه مقدار نام برده برگردانده شده است. در حقیقت این متد می تواند مقداری مشخص می ک ()GetHouseTypeمتد 

ه به جز سه مقدار مذکور دریافت کند، اما در آن صورت )چنانچه کاربر چنین مقداری را وارد کند(، متد جاری نمی داند چه کار باید بکند. ب

 زیر مواجه می شوید. errorبا  #Microsoft Visual Cد و در محیط نمی شو( compile)همین دلیل، برنامه ترجمه 

a value return: not all code paths 'Program.GetHouseType()' 

 returnبرای حل این مشکل، باید دستوری ارائه دهید که مقداری غیر از مقدارهای درنظر گرفته را شامل شود. می توان این کار را با نوشتن 

 مقدار خود را دارد انجام داد.نهایی که 

 مثال

    using System; 
    public class Program 
    { 
        enum HouseType { Unknown, SingleFamily, Townhouse, Condominium }; 
        public static int Main() 
        { 
            var type = GetHouseType(); 
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            switch (type) 
            { 
                case HouseType.SingleFamily: 
                    Console.WriteLine("\nType of Home: Single Family"); 
                    break; 
                case HouseType.Townhouse: 
                    Console.WriteLine("\nType of Home: Townhouse"); 
                    break; 
                case HouseType.Condominium: 
                    Console.WriteLine("\nType of Home: Condominium"); 
                    break; 
                case HouseType.Unknown: 
                    Console.WriteLine("\nType of Home. Unknown"); 
                    break; 
            } 
            return 0; 
        } 
        private static HouseType GetHouseType() 
        { 
            var type = 0; 
            Console.WriteLine("What Type of House Would you Like to Purchase?"); 
            Console.WriteLine("1 - Single Family"); 
            Console.WriteLine("2 - Townhouse"); 
            Console.WriteLine("3 - Condominium"); 
            Console.Write("Your Choice? "); 
            type = int.Parse(Console.ReadLine()); 
            if (type == 1) 
                return HouseType.SingleFamily; 
            else if (type == 2) 
                return HouseType.Townhouse; 
            else if (type == 3) 
                return HouseType.Condominium; 
            else 
                return HouseType.Unknown; 
        } 
    } 

 بازگرداندن مقداری به صورت شرطی

 .را بدین ترتیب تغییر دهید Management.csفایل       .8

    using System; 
    public class Management 
    { 
        private AccountType SpecifyAccountType() 
        { 
            byte type = 0; 
            Console.WriteLine("What type of account the customer wants to open"); 
            Console.WriteLine("1 - Checking Account"); 
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            Console.WriteLine("2 - Savings Account"); 
            Console.Write("Enter account type: "); 
            type = byte.Parse(Console.ReadLine()); 
            if (type == 1) 
                return AccountType.Checking; 
            else if (type == 2) 
                return AccountType.Saving; 
            else 
                return AccountType.Other; 
        } 
        private Customer CreateNewAccount() 
        { 
            Customer client = new Customer(); 
             . . . No Change 
            return client; 
        } 
        public double Deposit() 
        { 
            double amount = 0; 
            Console.Write("Amount to deposit: "); 
            amount = double.Parse(Console.ReadLine()); 
            return amount; 
        } 
        public double Withdraw(Customer cust) 
        { 
            double amount = 0; 
            Console.Write("Amount to withdraw: "); 
            amount = double.Parse(Console.ReadLine()); 
            if (amount > cust.Balance) 
            { 
                Console.WriteLine( 
                "You are not allowed to withdraw more money than your account has."); 
                Console.ReadKey(); 
                return 0.00D; 
            } 
            else 
                return amount; 
        } 
        private void ShowAccountInformation(Customer cust) 
        { 
             . . . No Change 
        } 
        public static int Main() 
        { 
            double amount = 0; 
            byte nextAction = 0; 
            Customer accountHolder = null; 
            Management registration = new Management(); 
            Console.Title = "National Bank"; 
            accountHolder = registration.CreateNewAccount(); 
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            Console.WriteLine("Enter the customer's initial deposit"); 
            accountHolder.Balance = registration.Deposit(); 
            Console.Clear(); 
            registration.ShowAccountInformation(accountHolder); 
            do 
            { 
                Console.WriteLine("What do you want to do now?"); 
                Console.WriteLine("0 - Close the application"); 
                Console.WriteLine("1 - Check account balance"); 
                Console.WriteLine("2 - Make a deposit"); 
                Console.WriteLine("3 - Withdraw money"); 
                Console.WriteLine("4 - Transfer money from one account to another"); 
                Console.Write("Enter your choice: "); 
                nextAction = byte.Parse(Console.ReadLine()); 
                Console.Clear(); 
                switch (nextAction) 
                { 
                    case 1: 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        Console.Write("Press Enter for next operation"); 
                        Console.ReadKey(); 
                        break; 
                    case 2: 
                        amount = registration.Deposit(); 
                        accountHolder.Balance += amount; 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 3: 
                        amount = registration.Withdraw(accountHolder); 
                        accountHolder.Balance -= amount; 
                        Console.Clear(); 
                        registration.ShowAccountInformation(accountHolder); 
                        break; 
                    case 4: 
                        Console.WriteLine( 
                       "Operation not available: You have only one account with us"); 
                        break; 
                    default: 
                        return 0; 
                } 
                if ((nextAction < 1) || (nextAction > 4)) 
                    Console.WriteLine( 
                    "Invalid Action: Please enter a value between 1 and 4"); 
            } while ((nextAction >= 1) && (nextAction <= 4)); 
            Console.ReadKey(); 
            return 0; 
        } 

} 
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 .را زده تا برنامه اجرا شود F5. کلید 2

 .. اطلاعات لازم را به این ترتیب وارد کنید1

 Account #: 257-484902-444 

Account Type: 1 

Customer Name: Josh Nay 

PIN: 5008 

Initial Deposit 250 

 

=========================================== 
=-= National Bank =-====================== 
------------------------------------------ 
ew Account Number (000-000000-000): 257-484902-444 
hat type of account the customer wants to open 
 - Checking Account 
 - Savings Account 
nter account type: 1 
nter customer name: Josh Nay 
sk the customer to enter a PIN: 5008 
nter the customer's initial deposit 
mount to deposit: 250 

 .را فشار دهید Enter. کلید 4

=========================================== 
==-= National Bank =-====================== 
Customer Account Information 
------------------------------------------- 
Account #:    257-484902-444 
Account Type: Checking 
Full Name:    Josh Nay 
PIN #:        5008 
Balance:      250.00 
=========================================== 
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What do you want to do now? 
0 - Close the application 
1 - Check account balance 
2 - Make a deposit 
3 - Withdraw money 
4 - Transfer money from one account to another 
Enter your choice: 

 .را بزنید Enterرا وارد کرده، سپس  3. حال به منظور برداشت مبلغ مورد نظر از حساب 5

 .را بزنید Enterرا به عنوان مبلغ واریزی تایپ کنید و کلید  164.37. 6

=========================================== 

==-= National Bank =-====================== 

Customer Account Information 

------------------------------------------- 

Account #:    257-484902-444 

Account Type: Checking 

Full Name:    Josh Nay 

PIN #:        5008 

Balance:      85.63 

=========================================== 

What do you want to do now? 

0 - Close the application 

1 - Check account balance 

2 - Make a deposit 

3 - Withdraw money 

4 - Transfer money from one account to another 

Enter your choice: 

 .را بزنید Enterرا وارد کنید و  2. اکنون عدد 4

 .را بزنید Enterوارد کنید، سپس  116.18. مبلغ سپرده را 1

=========================================== 

  ==-= National Bank =-====================== 

  Customer Account Information 

  ------------------------------------------- 
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  Account #:    257-484902-444 

  Account Type: Checking 

  Full Name:    Josh Nay 

  PIN #:        5008 

  Balance:      201.81 

  =========================================== 

  What do you want to do now? 

  0 - Close the application 

  1 - Check account balance 

  2 - Make a deposit 

  3 - Withdraw money 

  4 - Transfer money from one account to another 

  Enter your choice: 

 .را بزنید Enterکلید  را وارد کنید و 3. در این مرحله، عدد 1 

 .را بزنید Enterرا به عنوان مبلغ برداشتی وارد کنید، سپس  300. رقم 82

Amount to withdraw: 300 

        You are not allowed to withdraw more money than your account has. 

 .را بزنید Enter. کلید 88

 .بزنیدرا  Enterرا وارد کرده و دوباره  2. عدد 82

While (true) 

را بکار بردیم، وسیله ای برای بررسی شرط مورد نظر نیز گنجاندیم. به جای این کار همچنین  whileتاکنون در موقعیت های مختلفی که شرط 

 قرار داد. trueمی توان ثابت صحیح بولی را داخل پرانتزهای مقدار 

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            while (true) 
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                Console.WriteLine("C# Programming is fun!!!"); 
            return 0; 
        } 
    } 

زیرا دستور نام برده به کامپایلر می گوید " تا زمانی  این نوع دستور معتبر بوده و کار می کند ولی هیچ راهی برای متوقف کردن آن وجود ندارد،

چیست ؟ در نتیجه، برنامه بدون هیچ گونه  "this"". سوال مطرح این است که منظور از  "(…،as long as this is true)"که این درست است 

بدنه ی دستور مزبور، لازم است وسیله ای برای  در، while(true)توقف و برای همیشه ادامه پیدا می کند. بنابراین، در صورت ایجاد شرط 

را  ifارزیابی شود(. برای نیل به این هدف، باید شرط   falseمتوقف کردن کامپایلر فراهم کرد )به عبارت دیگر، راهی که از آن طریق شرط به 

 .برد به کار

 مثال

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            int i = 0; 
            while (true) 
            { 
                if (i > 8) 
                    break; 
                Console.WriteLine("C# Programming is fun!!!"); 
                i++; 
            } 
            return 0; 
        } 
    } 

 1می شمارد ولی بمحض رسیدن به  1تا  2درخواست می کند جمله ای را در صفحه ی کنسول نمایش دهد که از  compilerاین بار برنامه از 

 .متوقف شود. برنامه ی فوق این نتیجه را به دست می دهد

C# Programming is fun!!! 

C# Programming is fun!!! 

C# Programming is fun!!! 

C# Programming is fun!!! 

C# Programming is fun!!! 

C# Programming is fun!!! 

C# Programming is fun!!! 
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C# Programming is fun!!! 

C# Programming is fun!!! 

Press any key to continue... 

 

ته می توان از هر مکانیزم دیگری برای متوقف کردن حلقه کمک گرفت مادام اینکه شرط استفاده کردیم. الب breakدر برنامه ی بالا، از عملگر 

 را به نمایش می گذارد. شود. مثال زیر شیوه ی دیگری از متوقف کردن حلقه falseمورد نظر 

    using System; 
    public class Exercise 
    { 
        public static int Main() 
        { 
            int i = 0; 
            while (true) 
            { 
                if (i < 8) 
                    Console.WriteLine("C# Programming is fun!!!"); 
                else 
                    return 0; 
                i++; 
            } 
        } 
    } 

 تیجه ی آن با مثال پیشین یکسان می باشد.ن

می توان ابتدا متغیر بولی را تعریف و مقداردهی اولیه کرد، یا می توان متغیر بولی به کاربرد که مقدار آن از  ،while(true)به جای استفاده از 

 پیش شناس و مشخص است. مقدار مربوط می تواند از یک متد بیاید یا از هر وسیله ی دیگری. 

  while (true)استفاده از 

 .را کلیک کنید ...File -> New Projectبرای راه اندازی برنامه )کاربردی( جدید، به فهرست گزینه ی اصلی مراجعه کرده و   .8

 .را از لیست میانی انتخاب کنید Empty Projectگزینه ی   .2

 .تغییر دهید DepartmentStore8اسم پروژه را به   .1

 .کلیک کنید ...Project -> Add Classور ایجاد کلاس جدید، در فهرست اصلی، روی به منظ  .4

 .را کلیک کنید Addانتخاب کرده، سپس  StoreItemاسم کلاس را   .5

 .فایل را به ترتیب زیر اصلاح کنید  .6
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    using System; 
    using System.Collections.Generic; 
    using System.Linq; 
    using System.Text; 
    namespace DepartmentStore8 
    { 
        public class StoreItem 
        { 
            public int itemNumber; 
            public string itemName; 
            public string itemSize; 
            public decimal unitPrice; 
            public StoreItem() 
            { 
                itemNumber = 0; 
                itemName = ""; 
                itemSize = ""; 
                unitPrice = 0.00M; 
            } 
            public StoreItem(int code, string name, 
                             string size, decimal price) 
            { 
                itemNumber = code; 
                itemName = name; 
                itemSize = size; 
                unitPrice = price; 
            } 
        } 
    } 

 

 ...DepartmentStore8 -> Add -> New Itemپس : ، راست کلیک کرده سSolution Explorerدر پنجره ی .4 

 .را از لیست میانی انتخاب کنید Code Fileگزینه ی  .1

 .را بزنید Enterتغییر داده و  Inventoryاسم آن را به . 1

 .. فایل را به ترتیب زیر اصلاح کنید82

    using System; 
    using DepartmentStore8; 
    public class Inventory 
    { 
        static int Main() 
        { 
            StoreItem si = null; 
            bool itemIsValid = true; 
            Console.Title = "Department Store Inventory"; 
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            Console.WriteLine("Department Store Inventory"); 
            while (itemIsValid) 
            { 
                si = new StoreItem(); 
                Console.WriteLine("------------------------"); 
                Console.Write("Enter Item #:     "); 
                si.itemNumber = int.Parse(Console.ReadLine()); 
                if (si.itemNumber < 0) 
                    itemIsValid = false; 
                else 
                { 
                    Console.Write("Enter Item Name:  "); 
                    si.itemName = Console.ReadLine(); 
                    Console.Write("Enter Item Size:  "); 
                    si.itemSize = Console.ReadLine(); 
                    Console.Write("Enter Unit Price: "); 
                    si.unitPrice = decimal.Parse(Console.ReadLine()); 
                    Console.WriteLine("=-= Store Item =-="); 
                    Console.WriteLine("Item #:     {0}", si.itemNumber); 
                    Console.WriteLine("Item Name:  {0}", si.itemName); 
                    Console.WriteLine("Size:       {0}", si.itemSize); 
                    Console.WriteLine("Unit Price: {0}", si.unitPrice); 
                } 
            } 
            return 0; 
        } 
    } 

 .. برنامه را تست کنید88 

 .. اطلاعات مورد نیاز را به صورت زیر وارد کنید82

 Item Number: 279475 

Item Name: Wool Jersey Ruffle Dress 

Size: 8 

Unit Price: 150 

Item Number: 729070 

Item Name: Mid-Weight Flat-Front Wool Trouser Pants 



 

512 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

Size: 36W - 30L 

Unit Price: 69.95 

Item Number: 297004 

Item Name: Ponte Pencil Skirt with Pleated Detail 

Size: 16 

Unit Price: 80 

Item Number: -1 

  

Department Store Inventory 
  ------------------------ 
  Enter Item #:     279475 
  Enter Item Name:  Wool Jersey Ruffle Dress 
  Enter Item Size:  8 
  Enter Unit Price: 150 
  =-= Store Item =-= 
  Item #:     279475 
  Item Name:  Wool Jersey Ruffle Dress 
  Size:       8 
  Unit Price: 150 
  ------------------------ 
  Enter Item #:     729070 
  Enter Item Name:  Mid-Weight Flat-Front Wool Trouser Pants 
  Enter Item Size:  36W - 30L 
  Enter Unit Price: 69.95 
  =-= Store Item =-= 
Item #:     729070 
Item Name:  Mid-Weight Flat-Front Wool Trouser Pants 
Size:       36W - 30L 
Unit Price: 69.95 
------------------------ 
Enter Item #:     297004 
Enter Item Name:  Ponte Pencil Skirt With Pleated Detail 
Enter Item Size:  16 
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Enter Unit Price: 80 
=-= Store Item =-= 
Item #:     297004 
Item Name:  Ponte Pencil Skirt With Pleated Detail 
Size:       16 
Unit Price: 80 
------------------------ 
Enter Item #:     -1 

 .را بسته و به محیط برنامه نویسی بازگردید DOS. پنجره ی 81 

 بازگشت

به  1تا  8نه مشخصی تا کمینه ی معینی بشمارید. به عنوان مثال، برای شمردن اعداد فرد از تصور کنید می خواهید اعداد فرد مثبت را از بیش

 .این ترتیب عمل می کنیم

9، 7، 5، 3، 1 

را از آن کم می کنیم تا مقدار قبلی را به دست  2توجه داشته باشید که برای انجام این عملیات، بالاترین مقدار را در نظر می گیریم، سپس 

در برنامه نویسی برای حل این مشکل، ابتدا تابع را می نویسیم سپس کاری می کنیم که تابع خود را فرابخواند. این پایه ی بازگشت در آوریم. 

 برنامه نویسی است.

 معرفی بازگشت

 .یدرا کلیک کن ...File -> New Projectبرای راه اندازی برنامه ی کاربردی جدید، در فهرست گزینه ی اصلی،       .8

2.      Empty Project را از لیست میانی انتخاب کنید. 

 .را بزنید Enterتغییر دهید، کلید  Recursionsاسم پروژه را به       .1

 Recursions -> Add -> New Item، راست کلیک کرده سپس : Solution Explorerدر پنجره ی       .4

 .یدکلیک کن Code Fileدر لیست میانی روی       .5

 .را فشار دهید Enterانتخاب کنید و کلید  Calculatorاسم فایل را       .6

 ایجاد متد بازگشتی

 .یکی از فرمول های موجود برای ایجاد متد بازگشتی به صورت زیر می باشد
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ReturnValue Function(Arguments, if any) 
{ 
    Optional Action . . . 
    Function(); 
    Optionan Action . . . 
} 

تعریف کرد. پس از  voidواژه ی  متد بازگشتی با یک مقدار بازگشتی شروع می شود. در صورت برنگرداندن یک مقدار، می توان آن را با کلید

. در اسمش، متد قادر است یک یا چند آرگومان بگیرد. اغلب مواقع، متد بازگشتی حداقل یک آرگومان می گیرد، سپس آن را اصلاح می کند

 .باید رعایت کرد بدنه ی متد، می توان هر کاری که لازم است انجام داد. دو قاعده ی اصلی وجود دارد که حین پیاده سازی متد بازگشتی 

 .متد باید خود را در بدنه ی خود فراخوانی کند

در غیر این صورت، متد تا ابد ادامه پیدا می پیش یا پس از فراخوانی خود، متد باید شرطی را بررسی کند که به متد اجازه ی توقف بدهد. 

 کند.

به عنوان آرگومان می گیرد. به ( integer)برای مثال بالا )منظور مثال بازگشت می باشد(، می توان ابتدا متدی ایجاد کرد که عدد صحیح 

واحد از آن  2آرگومان را نمایش می دهیم، سپس  منظور درک بهتر این مطلب، فقط اعداد مثبت را در نظر می گیریم. در بدنه ی متد، مقدار جاری

 .کم می کنیم و در مرحله ی پایانی خود متد را فراخوانی می کنیم

    using System; 
    public class Exercise 
    { 
        static void OddNumbers(int a) 
        { 
            if (a >= 1) 
            { 
                Console.Write("{0}, ", a); 
                a -= 2; 
                OddNumbers(a); 
            } 
        } 
        public static int Main() 
        { 
            const int number = 9; 
            Console.WriteLine("Odd Numbers"); 
            OddNumbers(number); 
            Console.WriteLine(); 
            return 0; 
        } 
    } 
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 همان طور که مشاهده می کنید متد خود را در بدنه اش فرا می خواند. نتیجه ی زیر به دست می آید.

Odd Numbers 
  9، 7، 5، 3، 1، 
  Press any key to continue...     

 زگشتیایجاد متد با

 برای ایجاد تابع بازگشتی، ابتدا فایل را به صورت زیر اصلاح کنید.    .8

   using System; 
    public class Calculator 
    { 
        private long Factorial(long number) 
        { 
            if (number <= 1) 
                return 1; 
            return number * Factorial(number - 1); 
        } 
        public static int Main() 
        { 
            long factor = 0; 
            Calculator exo = new Calculator(); 
            Console.Write("To calculate a factorial, enter a (small positive) number: "); 
            factor = long.Parse(Console.ReadLine()); 
            Console.WriteLine("The factorial of {0} = {1}",factor, exo.Factorial(factor)); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

 برنامه را تست کنید.    .2

 را بزنید. Enterرد کرده و را وا 1عدد     .1

  

To calculate a factorial، enter a (small positive) number: 8 
 The factorial of 8 = 40320 
 Press any key to continue... 

 خارج شوید. DOSاز پنجره ی  Enterبا زدن کلید     .4
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 استفاده از متدهای بازگشتی 

ارزشمندی برای ساختن سری ها و لیست ها عرضه می کنند که در حقیقت مقادیر افزایشی یا کاهشی هستند متد های بازگشتی مکانیزم های 

که از یک الگو پیروی می کنند. تصور کنید به جای تنها نمایش دادن اعداد فرد )همان طور که بالا نشان دادیم(، می خواهیم آن ها را به 

اضافه می کنید و بعد نتیجه ی آن را به  1را به  8دارید و  5تولید می کند. اگر  8، 8رت داشتن افزایشی اضافه کنیم. در صو /صورت تصاعدی 

)اضافه کنید( و غیره.... این فرایند را می توان به ترتیب زیر نمایش داد. 5  

 

1 = 1 

1 + 3 = 4 

1 + 3 + 5 = 9 

 1 + 3 + 5 + 7 = 16 

1 + 3 + 5 + 7 + 9 = 25 

  

را در نظر می گیریم. 8عملیات، ابتدا  برای اجرای این . را  2باز می گرداند. در غیر این صورت،  8یا کوچک تر از آن بود، متد  8چنانچه عدد مساوی 

اضافه می کنیم. این پروسه را ادامه دهید تا به مقدار آرگومان برسید. متد به ( 2+8)را به نتیجه ی حاصله  2اضافه می کنیم، سپس  8به 

ایجاد یا پیاده سازی می شود.ترتیب زیر   

   using System; 
    public class Exercise 
    { 
        static int AdditionalOdd(int a) 
        { 
            if (a <= 1) 
                return 1; 
            return a + AdditionalOdd(a - 2); 
        } 
        static void OddNumbers(int a) 
        { 
            if (a >= 1) 
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            { 
                Console.Write("{0}, ", a); 
                a -= 2; 
                OddNumbers(a); 
            } 
        } 
        public static int Main() 
        { 
            const int Number = 9; 
            Console.WriteLine("Odd Numbers"); 
            OddNumbers(Number); 
            Console.WriteLine(); 
            Console.WriteLine("Sum of Odds: {0}\n", AdditionalOdd(Number)); 
            return 0; 
        } 
    } 

 نتیجه ی زیر حاصل می گردد.

Odd Numbers 
 9، 7، 5، 3، 1، 
 Sum of Odds: 25 
 Press any key to continue... 

  به کاربردن متدهای بازگشتی

 . فایل را به ترتیب زیر اصلاح کنید.8

    using System; 
    public class Calculator 
    { 
        private long Factorial(long number) 
        { 
            if (number <= 1) 
                return 1; 
            return number * Factorial(number - 1); 
        } 
        private long Permutation(long n, long r) 
        { 
            if (r == 0) 
                return 0; 
            if (n == 0) 
                return 0; 
            if ((r >= 0) && (r <= n)) 
                return Factorial(n) / Factorial(n - r); 
            else 
                return 0; 
        } 



 

518 
 7 واحد -  دوم طبقه 651 پلاک - صادرات بانک جنب - ملک خيابان از تر بالا - شريعتی خيابان - تهران : آموزشگاه آدرس

88146323 - 88446780 - 88146330 

        private long Combinatorial(long a, long b) 
        { 
            if (a <= 1) 
                return 1; 
            return Factorial(a) / ((Factorial(b) * Factorial(a - b))); 
        } 
        public static int Main() 
        { 
            long factor = 0; 
            long second = 0; 
            Calculator exo = new Calculator(); 
            Console.Write("To calculate a factorial, enter a (small positive) number: "); 
            factor = long.Parse(Console.ReadLine()); 
            Console.Write("To calculate a permutation and the combination, enter a second (small positive) number: "); 
            second = long.Parse(Console.ReadLine()); 
            Console.WriteLine("Factorial:   F({0}) = {1}",factor, exo.Factorial(factor)); 
            Console.WriteLine("Permutation: P({0}, {1}) = {2}", factor, second, exo.Permutation(factor, second)); 
            Console.WriteLine("Combination: C({0}, {1}) = {2}",factor, second, exo.Combinatorial(factor, second)); 
            System.Console.ReadKey(); 
            return 0; 
        } 
    } 

برنامه را تست کنید.      .8  

 را بزنید. Enterرا وارد کنید و بعد  20 به عنوان اولین عدد درخواستی،      .2

 را فشار دهید. Enterرا وارد کرده و کلید  5به عنوان عدد دوم،       .1

To calculate a factorial، enter a (small positive) number: 20 
To calculate a permutation and the combination، enter a second (small positive) 
 number: 5 
Factorial:   F(20) = 2432902008176640000 
Permutation: P(20، 5) = 1860480 
Combination: C(20، 5) = 15504 
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ضمن تشکر از انتخاب شما،امیدواریم مطالب این کتاب برای شما مفید بوده  پایاندر 

 باشد.

دات خود را از طریق علاوه بر این می توانید پیشنهادات و انتقا

 با ما در میان بگذارید.  Book.tahlildadeh@gmail.com رایانامه
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